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Preface 
Congratulations on your purchase of Samplitude Music Studio 2013! 

Creating your own music or video soundtracks in a home studio has become more 
and more popular. But the wide variety of available equipment and software often 
confuses both beginner and professional musicians alike. You may find yourself 
asking questions like "What do I really need?", or "What's the best value for my 
money?" 

Samplitude Music Studio 2013 is the perfect solution: Fast and easy-to-handle music 
production on your PC, from recording to mastering. Transform your PC into a 
complete sound studio. 

All you need to produce and arrange in high-quality is a conventional sound card, but 
additional studio equipment can easily be added.  

The following pages will introduce to you in detail the various functions and 
possibilities offered by Samplitude Music Studio 2013. 

Have fun with Samplitude Music Studio 2013.  

Your 

MAGIX team 
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Support 
Dear MAGIX customer, 

Our aim is to provide fast, convenient, solution-focused support at all times. To this 
end, we offer a wide range of services: 

• Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration at www.magix.com 

• The online community, on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 150,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials and 
a discussion forum. The multiple experts, found round-the-clock at 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

• Email support for MAGIX products:  
For every new MAGIX product you will receive, as of date purchase, 12 months of 
email based customer service. 
Premium email support: 
For priority support, or if you want the MAGIX support team to help with non-
MAGIX related hardware problems you can purchase a Premium email support 
ticket. Log in at http://support.magix.net and click on "Purchase access code", 
the ticket is for a specific problem, and is valid until it is solved, it is not restricted 
to an email. 

Please note: To be able to use the Premium email support and free product email 
support via the Internet, you have to register your MAGIX product using the serial 
number provided. This can be found on the CD case of your installation CD or on the 
inside of the DVD box. 

• Additional telephone service: 
Besides the large number of free customer service offers, we also offer a fee-
based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 
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Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  
Denmark: 45 699 18763 
Sweden: 46 852 500713  
Finland: 35 89 42419023 
Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 
Phone: 1-305-722-5810  
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Introduction 

What is Samplitude Music Studio 2013? 
Samplitude Music Studio 2013 is a multitrack recording and editing application for all 
types of audio material featuring unlimited editing options. It's easy to use and follows 
three simple steps: 
 

1. Download and record 
You can download CD tracks, MP3 songs, wave files, video soundtracks, or sounds & 
samples from the hard disk, the CD-ROM drive, or the Internet. You can even make 
your own recordings from a stereo system or with a microphone. Everything you 
download or record is displayed as an object on the Arranger's tracks.  
 

2. Arrange and edit 
Basically, all tracks stacked virtually above each other will be played simultaneously, 
and everything that follows horizontally will be played in subsequent order. However, 
you can mute the objects stacked above each other.  

Every object – that is, every sound, every song – can be cut up or have effects added. 
For example, if you want to shorten a song, move the object with your mouse to the 
length at which you would like the song to be – done! Want to freshen up your 
sound? Then open the equalizer and either select a preset that fits, or modify your 
sound "by hand”. 

Arranging and editing is essentially all about cutting, blending, adding, mixing effects, 
and placing audio material into the right positions and into the right tracks. But it’s 
also about play and experimentation. If it fits, throw it in! Without experimentation 
there is no innovation. Samplitude Music Studio 2013 allows you to experiment, and 
experiment wildly. There’s no risk of your audio material being damaged. All editing 
functions are "non-destructive”. 
 

Export and use 
Regardless what you're experimenting with, in the end something usable should come 
out of it. Samplitude Music Studio 2013 has everything you need to be productive: 

• Homemade audio CDs which can be played by any standard CD player 
• Unique MP3 collections, e.g. as a source of material for your MP3 player 
• Podcasts: Simply export the project as a podcast and - if you want - publish it 

online using MAGIX Podcast Service online (the MAGIX Podcast Service can be 
reached via the "Online" menu.) 

• And much more. The export principle is simply "what you hear is what you get". 
That is, what you export sounds exactly as it sounded in the arrangement during 
playback in Samplitude Music Studio 2013. 
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What’s new in Samplitude Music Studio 2013? 
96 kHz 
Thanks to the high, 96 kHz, sample rate, the signal is now measured 96000 times a 
second, instead of 48000, like earlier. Together with the 32-bit rate, a much more 
precise digitalization takes place, resulting in a high sound quality like in professional 
productions.  
 

128 tracks 
With ambitious projects that works with track doubling, aux tracks, plug-ins, etc., 
track number sky-rockets pretty fast. The new version lets you arrange on 128 tracks 
(instead of the 64 earlier) - enough space for the most complex multi-track projects. 
 

4 Vita Solo instruments 
The four new Vita Instruments, rock drums, string ensemble, bass machine and world 
percussion, can be found as before via the "Synth"> "Vita" buttons.  
 

Vita 2 sample player 
In its 2nd version, Vita Sample Player has a new "Tube distortion" function, a new 
user interface as well as more sounds: 

• Rhodes: Rhodes clean / Rhodes Phaser / Rhodes smooth / Rhodes wah 
• Ethno Percussion: DunDun / Framedrum / Gamelan Chimes / Sourdo / Tablas / 

Drums / Udu African / Talking Drums 
• More orchestral woodwinds: Piccolo / English Horn (each in two variations) 
 

Additional improvements 
• 5 essentialFX in a new skin (ChorusFlanger, Phaser, StereoDelay, Compressor, 

VocalStrip) 
• Guitar tuner 
• Music Maker compatibility: Project files (*.mmm) from the latest MAGIX Music 

Maker generation can be loaded without any problems. 
• New Soundpool user interface 
• Mastering Suite 4.0 with an integrated 6-band equalizer 
• MIDI learn (in the mixer) 
• Various detail improvements 
 



 

18   

www.magix.com 

The features 
The best possible sound quality 
This feature is especially important to every music lover: Samplitude Music Studio 
2013 offers unique sound quality for digital music editing. 

• 100% sound neutrality: Benefit from Samplitude, professional audio software 
that's been used for years in sound studios and radio & TV stations around the 
world. Samplitude's unique feature is that the original sound of audio files is not 
diminished by any specific audio discoloration, as is often the case with other 
programs. 

• 24-bit/48 kHz recordings: Your own recordings can be made with the correct 
hardware in professional, high-quality, high-resolution 24-bit/48 kHz format. 

• 32-bit floating point: Internal sound processing is executed via the 32-bit floating 
point process for especially differentiated and high-quality calculation. This way, 
the audio picture can be created with especially high dynamics. Digital distortion 
and clipping is virtually impossible. 

 

Formats and interfaces 
Import: MIDI standard formats (MID, GM, GS, XG), WAV (24- & 32-bit), WAV with 
codec, MP3, CD-A, OGG Vorbis, AIFF, FLAC, MOV. 

Export: MIDI standard formats (MID), WAV (24-bit), WAV with codec, MP3, CD-A, 
OGG Vorbis, AIFF, WMA, FLAC. 
 

Synthesizers 
Samplitude Music Studio 2013 comes with the following synthesizers that you can 
play directly on your PC keyboard, via your mouse or with a MIDI keyboard: 

• Vita: A sampler with incredibly realistic-sounding, "classical" instrumental 
sounds like different guitars (Power chords, clean electric guitar, acoustic guitar, 
bass guitar), different pianos, percussion, strings, brass, woodwinds (each as an 
individual set & as an ensemble set), and much more. 

• Beatbox 2: For computer beats and computer sounds 
• LiVid (Little Virtual Drummer): For "real" acoustic drum tracks 
• Drum Engine: Perfect drum sounds 
• Robota: For "mean" electronic sounds 
• Revolta 2: An analog, varied, and powerful-sounding 12-voice synthesizer 

featuring a sound matrix, noise generator, and nine effect types. With this 
synthesizer, you can create any electronic music you can imagine. The sound 
presets were created by the sound designer for Access Virus and Rob Papen's 
Albino. 

• Lead Synth: "Analog modular" synthesizer 
• Century Guitars: Authentic guitar sounds. 
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• Loop Designer: Cut loops yourself 
• Atmos: For nature sounds or atmospheres like rain, thunder, or wind 
 

Effects and effect plug-ins 
Samplitude Music Studio 2013 offers the following effects and effect plug-ins: 

• Equalizers: 10-band graphic and 4-band parametric 
• Echo/Reverb + Room Simulator 
• Vocoder 
• Vandal SE: Authentic simulation of classic guitar effects, tube amplifiers, and 

speakers. 
• essentialFX: Basic effects for unique sounds (Stereo delay, chorus/flanger, 

phaser) 
• Vintage Effects Suite, consisting of chorus, flanger, analog delay, distortion, 

filters, and the low-fi effect BitMachine. 
• Mastering Suite 3.0, consisting of equalizer, vitalizer (stereo enhancer), 

multiband compressor, and audio meter + limiter. 
• Compressor with many presets such as limiter, Deesser, noise gate, expander, or 

leveler and in different models, e.g. as the multiband compressor Multimax. 
• Tape simulation: High-quality simulation of analog tape compression 
• Stereo FX: For editing the stereo bandwidth 
• Declipping: For eliminating digital clipping 
• Timestretching/Resampling/Pitchshifting: For correcting pitch and length 
• Elastic Audio easy: Dynamic pitch correction with harmonization (creates up to 

four choir voices) 
• AM-Track SE: High-quality tape machine sound emulation makes typical aspects 

of the large, saturated sound characteristics of magnetic recordings a digital-
quality reality. 

 

Audio & MIDI 
The MIDI format is extremely important in modern music production. You can use 
MIDI files to control external devices such as synthesizers and samplers and internal 
software audio generators such as VST plug-ins from your computer. 

With Samplitude Music Studio 2013 you can arrange, load, record, edit, and play 
MIDI data just as easily as audio data. For MIDI recordings and editing you can use 
the specialized MIDI Editor with Piano Roll, Drum Editor, Velocity/Controller Editor 
and Event List. Recording can be started directly from the arranger by setting the 
recording mode in the track header to "MIDI record" or "Audio record". 
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Multitrack recorder (MR-64) 
The multitrack recorder (MR-64) looks like a hardware mixer and can also be 
operated in the same way. In contrast to earlier mixers, now it can be opened using 
the "View" menu in order to conduct multi-track recordings just like with a real mixing 
board. The MR-64 unites the advantages of the analog look with digital technology: 
realistic appearance, direct workflows, and familiar functionality. 
 

Soundpool 
A collection of loops is included, and many more can be found at Catooh. The loops 
are categorized into "styles" (e.g. ambient, dance, hip hop, rock, etc.) and 
"instruments" (e.g. drums, bass, guitars, etc.). The name of the loop file also informs 
you about the kind of sound you can expect. Every loop can be previewed by clicking 
it. Monitoring is adjusted to the loops in the arranger. For example, you can create and 
play back a framework of bass and drums first, while the Soundpool manager 
searches for suitable guitar sounds which are automatically adjusted to the rhythm of 
the drum track and the pitch of the bass track during previewing. Every loop can be 
loaded into the arranger by dragging it or by double clicking.  

You can find the Soundpool Manager in the docker (or in the "View" menu > 
"Manager"). 
 

Jam Session 
The JamSession lets you create complete songs single-handedly. The program 
simulates working with hardware "Looping delays", like, for example, the Gibson 
Echoplex. The difference is that Samplitude Music Studio 2013 creates an 
arrangement  during "looping" which can later be edited and compiled into a 
complete song. During a Jam Session, everything you do is recorded. The most 
important thing with the Jam Session is the fun factor – there can never be too much 
of it! 

Activate "Solo Jam Session" via the "Playback" menu. 
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Tutorial 
In this chapter we will introduce the most important features of Samplitude Music 
Studio 2013. You will learn how to create an arrangement with audio and MIDI as well 
as the powers of both formats. You will also receive information about essential parts 
of the program so that you can take advantage of all possibilities of Samplitude Music 
Studio 2013. 
 

Step-by-step mode 
Samplitude Music Studio 2013 offers a step-by-step mode for beginners and users 
who want to achieve results quickly. All major tasks when producing music in a virtual 
recording studio are solved in five, clearly defined steps. 

 

Recording: First, vocals and instruments are recorded on multiple tracks. 

Editing: The recorded material is then edited, with a focus on cutting and arranging.  

Mixing: The tracks are mixed, i.e. positioned within the volume and stereo panorama. 

Mastering: In the end, the entire sound is edited with effects. 

Export: After you have completed all stages, the next step is to "output" your 
material, either as a classic audio CD or as a song file in MP3 or WAV format. Or you 
can upload and publish your song directly on the Internet. 

In what follows, we will present these five steps in more detail, because "Easy Mode" 
offers the fastest start into the program. 
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Quick setup 
After starting the program for the first time, the "Easy Setup" dialog appears. In this 
dialog, you can specify which sound card configurations you would like to use. Usually 
you will not have to change anything, because Samplitude Music Studio 2013 
automatically selects the correct settings. If you are using several sound cards, 
however, you can select the one you want to work with from the menu. 

 

You can also set your plug-in directory for VST plug-ins and other elements.  

The settings dialog appears only once when you start the program for the first time, 
giving you the chance to check and adjust the settings of Samplitude Music Studio 
2013. After that, you can open the dialog by pressing "y" on your keyboard (or via 
"File" > "Program settings" > "System/Options"). 

• Beginners should not change the settings at all and simply click "OK". 
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Start selection 
The start dialog, which appears after every program start, opens: 

 

In "Project settings", you can give your project a name (for example, the name of the 
song you want to record) and specify the number of tracks and a track directory. 
Everything can be changed at a later stage. 

The main purpose of this dialog is to open a new or an existing project that was saved 
previously. Since we are still at the beginning, we don't have any existing projects yet. 
Therefore, we will create a new project: 

• Click on "New project". 

The interface will open in step-by-step mode with the "Recording" setting. 
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Recording 
In this view, you can do recordings via a connected microphone, for example. 

 

It is recommended not to record an entire song at once, but to record the different 
instruments and voices one after another on different tracks. For example, if you 
wrote a song that you usually accompany with the guitar, you should record the guitar 
without vocals first and then add the vocals later, in a second step. This has the 
advantage of being able to entirely focus on one aspect, i.e. the instrument or vocals, 
thereby improving recording quality. 

The top area displays multiple empty tracks of your project, which are arranged one 
below the other. The control panel for the recording is located below the tracks. The 
large display, especially of the time display, enables better control of the recording. 
This is useful, because as a singer or pianist, you do not want to have to look at the 
screen continuously in order to follow the progress of the recording. Thanks to the 
large display, a side glance from the distance is sufficient to see where the recording 
stands. 
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• You can activate background music via 
Accompaniment. This function is more of a 
gimmick and allows you to experiment! Let 
yourself be inspired by the different 
accompaniments to create your own 
melodies. 

• Metronome adds a regular clicking sound, which serves as a rhythmic orientation. 
The sound should be output via headphones to ensure that it is not recorded. You 
can select different speeds via the arrow keys. 

• Practice Speed allows regular playback speed to be reduced. This way, you can 
record at half speed and use the result with normal speed. 

• Monitor lets you preview audio material and monitor it while recording. The level 
displays what enters the sound card inputs. If it reaches the upper red range, the 
input level is too high. In this case, you should reduce the input volume. 

If you are ready to start your first test recording, click on the red "Record" button. 
Samplitude Music Studio 2013 now starts recording and indicates this in the record 
window by displaying a counter with the passed record time. 

After recording is complete, an audio file with the recording appears in the top track. 

 

Now you can record on other tracks. The red button to the left of every track displays 
which track is currently being recorded. In the top picture this is track 2.  

 

You can enable any track for recording by clicking with the mouse and then record on 
any track. 
 



 

26   

www.magix.com 

Editing 
In the "Editing" view, the record field is deactivated and only the Arranger is visible. 

 

Samplitude Music Studio 2013 offers almost unlimited possibilities for audio editing. 
In step-by-step mode, the focus is one removing slight irregularities from the audio 
material. 

Let's just say you accidentally knocked the microphone against something while you 
were singing and now your otherwise good recording is ruined because of the cracks. 
Instead of using the cleaning effects from the effects menu, we can simply cut out the 
crackling. This is the easiest and most effective method for removing isolated cracks. 

• Play back your recording (the easiest way to do so is by using the spacebar on 
your keyboard) and search for the section that you want to cut out.  
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• You can move the playback marker in the bar ruler above the first track at any 
time by clicking. 

 

• If necessary, zoom into the display to get a better view of the waveform display. 
To do so, use the horizontal and vertical zoom buttons located in the bottom 
right-hand corner: 

 

• Place the playback marker just before the crackling and press the "t" key on your 
keyboard (or click on the "Scissors" symbol in the toolbar). 

• Now place the playback marker just after the crackling and press the "t" key 
again. 

• Click on the isolated piece containing the crackling and delete it from the track. 

 

Did you cut out too much by mistake? No problem: The object handles located at the 
edges can be used to recover deleted material and vice versa, to remove bothersome 
rests. 
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• To do so, select the section you want to edit with the mouse. 

 

• Move the mouse pointer exactly on top of the handle. After it has turned into a 
double-arrow, you can move the front part to the right or to the left with the 
mouse button held down – ideal for fine-tuning your cuts. 

As mentioned before, Samplitude Music Studio 2013 offers many more editing 
possibilities. We will discuss more options later. For now, we will leave it at this 
simple editing exercise. 
 

Mixing 
The next area of the step-by-step mode opens the mixer. All other elements are 
hidden to provide a better overview.  

 

With the Mixer you can adjust and even automate the volume and panorama of the 
recorded tracks. Furthermore, you can add effects and much more.  
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• Adjust the volume of the individual tracks with the sliders in the lower part of the 
mixer until you have a balanced result and every instrument in the song is 
sufficiently accounted for.  

• Take some time and experiment with the effects (Aux, Inserts, Sound FX, 
Dynamics, EQ) on the individual tracks. 

 

Mastering 
The "Mastering" area of the step-by-step mode opens the Mastering Suite, which is 
used to optimize the overall sound. 

 

The Mastering Suite includes four devices, which are organized on top of each other 
in an effects rack. Which device is used for what purpose? 

Equalizer: For regulating the sound characteristics. You can set four frequency bands 
separately in the graphical control panel. 

Vitalizer: A stereo effects processor that allows you to change the stereo width. In 
"Multiband mode" only the mids are edited. 

Multimax: A multiband compressor for editing the volume and the sound impression. 

Limiter: To prevent overmodulation. 
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Export 
After successfully passing through the four stages of the step-by-step mode, the 
result is a first, perfect song. The last stage, "Export", is where you decide what you 
want to do with your song.  

 

There are four options to choose from: 

Burn CD: An audio CD that can be played back on any CD player is the typical way of 
exporting your song. 

Save as WAV: An audio file in WAV format is the standard format for audio 
productions. It can be played back with different software and on multiple devices and 
features crystal-clear sound. 

Save as MP3: MP3 is a space-saving alternative to WAV that can be played back 
directly in the player. 

Upload: This uploads the song directly to the Soundcloud or Facebook community. 

This was intended as a first, quick overview of the step-by-step mode! 
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Switch workspace 
Now that you have a rough idea of what digital music production is about, lets take a 
look at the advanced options. Let's go to the "Workspace" box at the bottom of the 
screen and switch to "Power User" mode, the mode for ambitious users. 

 
 

Recording in the Arranger 
You can also record directly in the Arranger, i.e. outside of the step-by-step mode. 
Here's how it works: 

• If necessary, activate the transport control via "View" > "Transport Control". 
 

Recording the first track 
• Right-click on the red record button on the transport control. 

 

This opens the recording dialog. You can change all recording settings here. 

• The "Monitor" button is activated as a default. The monitor function allows you 
to preview the recording material or to listen to it during recording. The level 
displays what enters the sound card inputs. If it reaches upper red range, the 
input level is too high. In this case, lower the input levels. 
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• Click on the "Record" button. Samplitude Music Studio 2013 now starts recording 
and indicates this in the record window by displaying a counter with the passed 
record time. 

 

• Now stop the recording at a suitable position by pressing the "Stop" button. 

Samplitude Music Studio 2013 then stops recording. You can now either use the 
recording or delete it. You can repeat the recording without saving the first attempt 
on your hard drive. If you want to use your recording, Samplitude Music Studio 2013 
will add the audio material to the first track as an object. 

 

You can listen to the result anytime by clicking on the "Play" button in the transport 
console or by pressing the space bar. 
 

Record another track 
Now we will record a second track. If the record dialog is still open, please close it. 

• Activate the "Record" button in a second track by clicking on the red "Record" 
button to the left in the second track. The track is now ready for recording. 

• Right-click on the "Record" button in the transport control. You can now enter 
further settings for recording. As we want to play the first track while the second 
is being recorded, you will have to activate "Playback while recording". 

 

• Click on the "Record" button. 
• Now stop the recording at a suitable position by pressing the "Stop" button. 

Note: "Playback while recording" mode requires that your sound card can play audio 
material while recording new material (full duplex mode). Some sound cards can 
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either record or play, but can't do both at once. In such a case you should deactivate 
"Playback while recording". 

 

Integrate audio material 
Now add new, already available audio material. Audio material can be added to your 
virtual project (VIP) from different sources and in different file formats. You can add 
audio CDs, WAV files, MP3 files, sample CDs (such as the MAGIX Soundpool 
series), as well as other audio files. There are various options available for loading 
audio material: 

• In the menu bar, click on "File > Import > Load audio file..." and select an audio 
file via the import dialog. 

• Activate the integrated file browser via the "Files" button at the lower edge of the 
screen (or via the menu "View > Manager > File manager"). This accesses all 
drives and folders on your computer. Any audio file can be dragged to the track 
by pressing down the left mouse button (drag & drop). 

 

• You can also drag audio files directly from Windows Explorer into the Samplitude 
Music Studio 2013 arrangement.  

• Audio tracks first have to be copied onto the hard drive separately. To do this, 
click in the top menu bar of Samplitude Music Studio 2013 on "File > Import > 
Load audio CD track(s)...". 
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VIP and wave projects 
A wave object is created for each audio object that you can see in the arranger. You 
can generally work on two project types:  

• Virtual project (VIP): This is an arrangement made up of different objects. The 
tracks in the virtual project are for recording or loading audio material onto 
several tracks. You can conveniently record and create sound on different tracks. 

• Wave project: This is the audio material of one object. 

Hint: If you delete an object in a virtual project, the audio material and the 
corresponding wave project on your hard drive will be retained. 

Switch to a wave project (your first recording, for instance), mark the corresponding 
object in the VIP by clicking on it, click into the top menu bar of Samplitude Music 
Studio 2013 on "Object", and select the option "Edit wave project...".  

 

If you have opened a wave project, then you will see the wave display of the audio 
material in enlarged view. The acoustic properties are directly visible in wave form, 
and where there's something to see, there's something to hear, and the higher the 
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peak of the wave form, the higher the volume will be. Press the space bar on your 
keyboard to play back the wave project. 

In wave projects you can directly edit your audio material. Direct editing of the 
material is particularly useful: Mark a range in the wave project with the mouse and 
then press "Del". After editing the audio material you can close the wave project. You 
now have to decide whether you want to accept the changes or discard them. If you 
want to accept the changes, then click on "Save project". The original audio file will 
now be overwritten. 
 

Arranging MAGIX Soundpool loops 
Up until now, you have only been working with your own material. Next, we would 
like to show you how to build your own songs using the included Soundpool loops. 

MAGIX Soundpools offer professionally produced, short audio files - so-called 
"samples". They have been produced to be perfectly combined with each other and 
looped. "Looping" means creating an entire instrument track from a single audio 
sample. This entails replaying the sample sequentially to provide the impression of a 
repeating musical leitmotif. This process is used today in almost every area of modern 
pop music. 

• It's best to create a new, empty arrangement first. Click on "File" and select the 
option "New virtual project (VIP)". 

• Select the "Soundpool" tab in the docker (or "View" > "Manager" > "Soundpool 
Manager"), to view the included soundpool samples. 

 

• The "styles" are displayed on the left side of the Soundpool manager. If you have 
inserted, for example, a MAGIX Soundpool DVD, you can select a style here. 
Samplitude Music Studio 2013 shows "Rock" because this style is included. 

• Next, you can select the instruments that you would like to use. At the start, we 
recommend choosing a drum sample to create the initial percussive structure. 
Open the "Drums" directory in the "Instruments" section. 

• To preview, click once on a file in the file list. To load it, drag the desired file to 
the track. 
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• Every object can be moved with the mouse in the Arranger - horizontally along a 
track or vertically between tracks. Drag the drum loop onto the first track all the 
way to the left to the beginning of the track. 

 

• Next, the sample is looped, and the short object is turned into a repeating loop. 
To do so, click on the bottom right handle of the audio object and drag the mouse 
to the right the amount that you need for your first song part. Circa 8 beats 
should be enough at first. The object will be properly placed on the first 8 bars of 
the first track. 

• Make sure that the playback range is as long as the extended sample - 8 bars in 
our example. To do so, click above and to the right in the timeline and drag out 
the playback range to match the length of the looped object. 

 

• Now press the play button (spacebar is faster). The drum sample will loop for 8 
bars.  

This means that the playback cursor starts right at the front, moves across the 
playback range, and then transfers to the start again once the end is reached without 
any interruptions. You can also move the playback marker independently of the 
playback range by clicking on the lower section of the timeline. 

Note: All additional loops can be previewed during playback and inserted. This way 
you can listen to the "candidates" when testing new samples in combination with 
the arrangement. If continuous playback gets on your nerves after a while, then you 
can always interrupt it by pressing the spacebar again. 

• Next, load a fitting bass. Open up the bass folder, test some of the bass samples 
there, and then drag a bass loop you like onto the second arranger track 
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Note: Melody-creating instruments are ordered according to pitch, meaning that 
you can choose between several variations for each sample that was produced in 
several pitches. By combining different variations of a pitch, you can produce chords. 

• Add new instruments to your drum and bass loops. This way, any number of files 
can be dragged from any folder into the arranger and positioned on top of one 
another, on multiple tracks, or behind one another. 

 

This way you can create complete songs or professional bases for own recordings. 

• Because not all instruments are normally looped for the entire arrangement, gaps 
should be built into the architecture of your song to provide musical variation. To 
do this, looped objects can be cut or loaded multiple times to create the required 
empty spaces.  
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Add synthesizers 
The track editor does not only manage synthesizers. It can also be used to adjust all 
settings that affect the selected track. You can open the track editor via the "View" 
menu. To open the software synthesizer folder of Samplitude Music Studio 2013, click 
the "Plug-ins" button in the track editor. 

After selecting a synthesizer, the corresponding control console will appear where 
you can program the rhythms, melodies, chords, and sounds of the synthesizer. 

Synthesizers become independent objects after they are programmed, and then they 
can be moved around just like other objects on the arranger. 

 

Exception: Vita (and all associated Vita instruments) and Revolta 2 remain coupled in 
the track where they are placed. They are controlled via MIDI objects. For MIDI 
objects, the played sound is defined by the track.  

Experiment with the various synthesizers in Samplitude Music Studio 2013 to 
discover the possibilities. 
 

Edit objects 
Editing objects is the same for all object types. The following options are equally 
available for audio objects, synth objects, and MIDI objects 

• Many object edits require that the object is already selected. Individual objects 
can be selected with a mouse click. Multiple objects can be selected with a held-
down Ctrl key. If you click on the track next to an object, you can draw a 
rectangular frame by holding down the mouse key. All objects found inside the 
frame will be selected ("rubber band selection"). 

• All objects in VIP can be shortened by dragging one of the lower object handles 
using the mouse until it turns into a double arrow.  Now, the object can be 
shortened. This way, bothersome regions at the beginning or at the end of a 
recording can be cut off by simply displacing the ends inward. 

• If "Create looped object" is activated under "Edit" in the "Object" menu, you can 
stretch the object as you wish with the right handle. Use this feature to create 
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entire rhythm tracks from short drum samples by simply stretching the object 
apart. 

• Two fade handles are found on both top corners, which can be dragged inwards 
in order to fade the object in and out. The handle at the center can be used to 
adjust the volume of objects. 

 

• Several objects can be combined with others to make up a group, to avoid the 
objects being unintentionally moved out of relation to each other. To do so, first 
select the individual objects. Then select "Object" > "Group" > "Create group" (or 
click in the tool bar on the "Group" symbol).  

• All objects can be split into multiple objects. To do so, select the "Split objects" in 
"Edit" menu under "Split" (or use the "T" key on your keyboard). The selected 
object will be split at the position where the playback marker is. 

• By right-clicking an object you can open a context menu where you can select the 
object editor. The object editor is also integrated in the docker and constantly 
available. It can be used to make all important settings for the corresponding 
object. You can add effects to audio objects or change quantization of MIDI 
objects. 

 

The object editor is always open in the docker for easy access. It changes its settings 
depending on which object is selected. 
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MIDI recordings 
MIDI recordings are created for operating VST instruments or external synthesizers 
with the help of a MIDI keyboard. The instruments will not be recorded as audio data, 
but rather remote controlled via the MIDI data format. Every detail of this remote 
control - i.e. every button press, every note, every velocity level - can be corrected and 
edited retroactively via the MIDI editor. Please read more on this in the section 
"Editing MIDI (view page 42)". 
 

What is MIDI? 
A few words about MIDI: MIDI files do not contain the actual sound like audio files, 
but only the note control information. This data is interpreted and played back by the 
VST instrument or synthesizer.  MIDI is thus a kind of remote control for synthesizers. 
This has some advantages: 

• MIDI files need a lot less memory than wave files. 
• MIDI files can be adapted to any tempo (BPM) without affecting the sound. The 

playback tempo is simply changed. 
• Transposition of MIDI files to other pitches is also easy. As a result, a section in a 

song does not have to be saved in several different keys. The version in C major is 
perfectly sufficient. It can then be transposed to any key easily. 

The disadvantage of MIDI files: The audio is not yet determined and is only produced 
during playback. 
 

Preparing a MIDI recording 
Prepare an empty track in your VIP for recording.  

• To do so, click on the red "Record" button in the track head.  
• Then open the "Track Editor" if necessary via the "View" menu to be able to make 

adjustments for the track. 
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• Use the small triangle to open up the MIDI section. 

 

Here you can now define the in- and outputs for your MIDI data on the selected track. 

• Input (In): This could be a MIDI keyboard which you use to enter MIDI notes and 
which are then recorded by Samplitude Music Studio 2013. 

• Output (Out): This could be a virtual instrument (VST instrument) that plays 
back the MIDI notes entered via the MIDI keyboard as sounds. To select a VST 
instrument, click the small triangle next to "Out" in the Track Editor and select 
"New instrument". 

Note: All global MIDI settings can be found in the "System" dialog ("Y" key), 
submenu "MIDI".  

"In" and "Out" in the Track Editor allow you to assign a special "Receive" and "Send" 
channel to every track for MIDI data. This is important if you want to control an 
external synthesizer via a MIDI keyboard, for example. 

For instance, if your MIDI keyboard is transmitting on MIDI channel 1, you should 
enter the value "1" in the "In" menu. During recording, Samplitude Music Studio 2013 
will receive all MIDI notes transmitted on channel 1 by a MIDI keyboard. 

You can generally assign a specific MIDI channel to external MIDI synthesizers. For 
instance, if your external synthesizer is addressed via MIDI channel 4, you should also 
enter the value 4 under "Channel Out" in the Track Editor in order to be able to 
address the external synthesizer via this track. 
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MIDI record modes 
There are several methods of recording MIDI, and you can set the MIDI record mode 
in the transport control.  

 

• Normal: This recording mode corresponds to that of audio recording, i.e. a new 
MIDI object is created over the existing object for each recording process. The 
old object remains intact. This way you can record multiple takes of a passage 
and then compare them in the Take Manager later on. 

• Overdub: The data is recorded into an already existing object, and available and 
newly recorded MIDI data is mixed together. 

• Multi-overdub: The data is recorded into an already existing object, available, and 
newly recorded MIDI data are mixed together. However, existing objects remain 
the same. 

• Replace: The data is recorded to an existing object and any MIDI data is 
overwritten.  

After you have selected MIDI record mode, you can prepare the corresponding track 
by clicking on the "R" button for recording. Now start recording by clicking on the 
"Record" button in the transport control. 
 

Edit MIDI 
MIDI Editor 
Use the MIDI Editor to edit MIDI files. You can open it by double-clicking on a MIDI 
file (or via the "Object" menu > "MIDI Editor").  

You can also use the MIDI Editor to program melodies. To do so, create an empty 
new MIDI file (Object menu > New MIDI file) and then open the MIDI Editor to input 
notes. 

The MIDI editor displays the MIDI data of the selected MIDI object. You can click the 
MIDI objects in the arranger one after the other and get direct access to the 
corresponding MIDI events. 

MIDI files can be displayed and edited in the MIDI Editor in five main areas. 

 
List Editor (Event List) 

 
Matrix Editor (Piano Roll) 
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Drum Editor (toggle between the Drum Editor and Piano Roll possible) 

 
Controller Editor (for example, velocity, MIDI volume…) 

 
Score Editor (Note display) 

Ever areas offers corresponding tools: pencils or eraser-tools. 

Fundamentally, changes, for example, moving or deleting notes, refer to all selected 
MIDI events (red) with just a few exceptions. You can, for example, select a group of 
notes in the Piano Roll and then change the attack velocity for this group of notes in 
the Controller Editor, modifying all selected notes simultaneously. 

Note: The MIDI Editor has a menu of its own. When it is integrated in the docker, at 
first it remains invisible, but can be accessed with a right-click on the grey area 
between two tools as a context menu. If the MIDI Editor is dragged and dropped 
form the title bar docker, the menu will appear as usual with an own menu bar. 

 

Working with the matrix editor 
The matrix editor is particularly useful for conveniently arranging MIDI notes (piano 
roll). 

 

In the matrix editor, you can edit MIDI notes for controlling sound generators like 
synthesizers, drum machines, and virtual instruments (VST instruments). If a MIDI 
instrument is activated, you can play it via the keyboard at the left of the screen. 
Clicking on a key makes the synthesizer create the corresponding sound. 
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 Now select the pencil tool and paint the notes into the score 
sheet. MIDI notes can also be sustained by holding the left 
mouse button or double-clicking. 

 The "Eraser" tool deletes notes from the note field.  

 The "Step recording" button enables step-by-step audio 
recording.  

Tip: The tool for drawing the pattern is particularly interesting. Use the selection tool 
to select specific notes and press the key combination "Ctrl + P". The selected notes 
are played as a sound pattern. Switch to the pattern drawing tool. You can now 
easily sketch the sound pattern with only one click. 

Tip: Pressing the "left" and "right" arrow keys on your keyboard moves 
forwards/backwards in the notation, respectively. The cursor up/down keys adjust 
the note pitch in stages. 

 

Using the Controller Editor 
In the Controller Editor your can adjust MIDI parameters such as velocity. A simple 
click on the Controller button of the MIDI Editor opens or closes the Controller Editor.  

 

It appears below the Piano Roll. 

 

Tip: If you can't see all buttons, you can enlarge the view by clicking on the scroll bar 
between the piano Roll and the Controller area and dragging the Controller Editor. 
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On the left you can choose from various drawing tools as well as determine the MIDI 
parameter to be controlled (such as velocity, foot pedal, vibrato, filter cutoff). By 
clicking on the small arrow button you can open a context menu with further options.  

 

The Controller Editor can simultaneously control up to four different parameters that 
can be selected using the four small arrow buttons. 
 

Multi-object editing 
You can edit several MIDI objects together in the MIDI editor. In an opened MIDI 
editor, you can include additional MIDI objects by clicking on them while holding 
down the "Shift" key. The MIDI events of these objects are displayed together. 

 

In the MIDI editor, you can access the 
displayed MIDI objects via the flip menu next 
to the name. 

The current object range can be highlighted by clicking the button behind the name. 
Areas lying outside the current object will be grayed-out and the notes of other 
objects will be paler, but still selectable. For more information on this, please consult 
the MIDI chapter in the PDF manual. 
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From MIDI to audio 
If you are controlling an external MIDI synthesizer in your arrangement, you can 
convert its sounds into audio tracks with the Samplitude Music Studio 2013 record 
function. This is particularly recommended if you want to enrich sounds created with 
your external MIDI synthesizer with audio effects, convert your project into MP3, or 
burn it onto disc. 

• Connect the audio output of your external MIDI synthesizer to the audio input of 
your sound card. 

• Set an audio track to "armed" by pressing "R". 
• Start audio recording as usual. The MIDI data will be played and recorded 

simultaneously via the record function. The result is an audio file that can be 
edited and exported together with other multimedia files. 

Tip: Do not delete MIDI tracks in the arrangement after you have generated audio 
files from them, simply mute them with the "Mute" button. You can then later 
change melodies and beats composed via MIDI and record them as audio files 
again. 

Note: If you prefer VST instruments as synthesizers, it makes more sense to use the 
Track freeze (view page 355) function from the "Track" menu. 

 

Effects 
You can considerably enhance your music productions with effects. Clever use of 
effects adds depth to your song and simply sounds better. Samplitude Music Studio 
2013 has plenty of effects. Experiment with the various effects in Samplitude Music 
Studio 2013 and learn how to use them. 
 

Calculating audio effects 
You can add audio effects in three different levels: audio objects, tracks, and in the 
master. When played, effects are first calculated in the audio objects. Track effects 
are then added. The master effects are added last. 

First, start with the object effects to distort individual objects while other objects in 
the same track remain the same. For instance, if you have saved a groove consisting 
of several audio objects on one track, you can edit the last object of the groove with a 
distorter. 

Use track effects like reverb, etc. on any objects located on a single track. Finish off 
your song with powerful master effects that have an effect on the entire song. 

Effects in audio objects: Right-click on an object to open the context menu and add 
an object effect. You can access the object effects directly via the context menu. 
Object effects can be selected and subsequently edited via the object editor. 
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Effects in tracks: To adjust track effects in the 
mixer, open the mixer by clicking on "Mixer" in 
the lower part of Samplitude Music Studio 2013. 
In the "Ins" section, click on the arrow symbol of 
an effect slot in the corresponding channel. 

 

Effects in the master: Open the mixer to add 
master effects. You will find the master section at 
the right edge of the mixer. Here you can install 
the desired master effects. 

Hint: Track effects and master effects are 
always real-time effects. 
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Burn CD 
Once your VIP is finished, you can burn it onto disc. Click on the button with the CD 
symbol. The CD burning dialog now opens. 

 

Now click on the "Burn CD" button... 
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Program desktop overview 

VIP window 

 

1 Menu bar: You can find the menus in the Samplitude Music Studio 2013 main 
window, directly below the title bar. A keyboard shortcut can be assigned to each 
menu entry. 

2 Toolbar: Toolbars are made up of buttons which carry out specific commands with 
a mouse click. They can be found above and below the project window. More 
information on the individual button bars can be found in the button overview. 
More information on the individual toolbars can be found in the keyboard shortcut 
overview. 

3 Grid/Marker bar: The grid/marker bar is positioned above the first track in the 
VIP. In the upper half, you will find the marker bar where markers and playback 
markers can be positioned. The lower half displays the grid list which displays the 
project time depending on the selected unit of measurement. You can also open 
various ranges. 

4 Project window/Section: "Section" refers to the visible part of a project in the 
project window. Which part of the project is displayed, depends on the position of 
the section and the zoom level. 
There are many commands for moving (scrolling) the visible section and 
customizing its size (zooming). These can be opened via the menu view, the 
grid/marker bar, and the shortcut keys. 
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5 Track box: The track box is the front section of a VIP track. It contains various 
controls which range from mixer functions and monitoring commands to other 
track parameters. More information on the individual controls of the track box can 
be found in the Track box overview. 

6 Track editor: The track editor enables access to all important parameters of the 
selected track. Record and monitoring status, volume, panorama, MIDI/audio in- 
and outputs, plug-ins, AUX sends and EQ settings are displayed in well-arranged 
sections and can also be edited directly in this view. 

7 Setup/Zoom/Position buttons: This part of the workspace helps manage each of 
the four different setup and zoom settings project section displayed in the VIP 
window. Similarly, the "Pos", "Len", "End", "Mouse", and "Mixer" fields can be 
configured with a right-click. 

8 Docker: Here you will find different manager windows and the visualization, time 
display, transport console, object editor and MIDI editor windows. You can take 
each of the windows from the title bar in the docker and position or dock them 
elsewhere. Click on "+" (far right) to open or close the displayed windows. 

 

Managers/Docker 
In "View" menu you can open the so-called "Docker", which offers a useful 
combination of various editing windows. In addition to various Manager windows, the 
docker also unites visualization, time display, transport console, Soundpool, object 
editor and MIDI editor in a tab window.  

 

The docker can be minimized by clicking on the "minimize" symbol in its top bar or 
into the tab that is already open. If you click a tab again, the docker will be maximized 
again. 

Using the "+" key, you can open a new tab in the docker. The editing windows can be 
individually turned on or off in the "View" menu. 

To remove a listed tab window again, just drag this out of the Docker lead or double-
click on the appropriate tab window. The corresponding dialog window will now 
appear in its own window. 

You can return the window to the docker through repeated double clicks on the 
individual window or by dragging the window onto the tab bar. 
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Docking 
In Samplitude Music Studio 2013 you can couple certain dialog and display windows 
to pre-determined areas on the VIP window or the docker, or use them as freely-
floating windows. 

In an undocked state, the corresponding dialog appears with a conventional title bar. 

 

If you move the title bar of such a window into the docker area, the docker will turn 
light green, indicating that the window has been docked. 
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After releasing, the window will appear integrated into the docker. 

 

The window can also be docked in other VIP areas. Moving is always accomplished 
by drag & dropping the title bar. 

During moving, the arrow symbols appear on the surface, to show the area where the 
window may be docked. The area above the dockable range will become light green to 
indicate that the window may be docked here. 
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Transport control 
Keyboard shortcut:  Ctrl + Shift + T 

 

The transport console window contains the most important commands for playback, 
recording, and positioning. 

Play / Stop / Forward / Rewind: These buttons let you control position, just like with 
a tape. 

Right clicking the "Play" button: This opens the "Stereo master" mode's playback 
parameters window. You can specify the sample rate, playback device, 
scrubbing/varipitch options here. 

Right click the "Record" button: Opens the recording parameters window. Adjust 
recording settings like "Play while recording" here. You can also start a mono or 
stereo recording straight from this window. 

Record button: Starts the recording for all activated tracks, i.e. tracks with a red "R" 
button in the track info to the left. The recording devices must be set to "R" with a 
right click.  

Time display: Displays the current playback position. The units can be selected by 
clicking on the small triangle. 

Area buttons: Using the "1" and "2" you can save areas. You can re-open previously 
used areas using the arrow symbol. 

L/E time display: Displays the length and end position of an area and can be edited by 
double clicking. 

Marker button: Opens the Marker Manager for detailed marker editing. You can find 
more information in the "Managers" chapter. 

Marker buttons 1...12: The current playback position can be saved on each of the 12 
marker buttons. If one position has been saved, the marker will appear bright. Another 
click on the same marker moves the play position to the corresponding marker. The 
marker bank can be reset with right-click, after which it can be re-assigned anew. 

Audio flip menu: Here you can set the appropriate recording mode. 

Standard mode (playback during recording): This is the typical recording mode 
during multi-track productions: Additional tracks will be recorded in addition to 
already existing audio material. 
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Recording without playback (background tape control): If you have selected this 
option, playback of already existing objects is deactivated and the recording marker 
will remain at the recording start position. Playback may be started manually, for 
example in case "read after write" is required. Set the play cursor at a different 
position and start playback by pressing the "Play" button. The recording will not be 
interrupted by doing so. This way you can make changes to already recorded material 
without interfering with the recording process. 

Punch marker mode: In this mode recording takes place only between punch start 
markers and punch end markers. This setting corresponds to the "Punch" button (see 
below). 

Auto Jam Session: Opens the "Auto Jam Session" window. 

Mon: Activates Record Monitoring from Samplitude Music Studio 2013, whereby all 
tracks with activated "R" display the incoming signal on the peakmeter. Right clicking 
the "Moni" button lets you select from the various monitoring modes. 

Note: Detailed information about monitoring can be found in Samplitude Music 
Studio 2013's help chapter "System settings -> Global audio options -> Monitoring 
settings". 

Sync: Open the dialog with the synchronization settings. Further information can be 
found in the help chapter "MIDI in Samplitude Music Studio 2013 > Synchronization". 

Punch: sets Samplitude Music Studio 2013 into the Punch mode. In this mode, only 
the range between the punch starter marker and the punch end marker is recorded. 

If you haven't created any punch markers, these will be set automatically when the 
recording button is pressed. If the recording is started when punch markers already 
exist, the recording button will flash until the start marker has been reached as well as 
once the end marker has been passed. It will be continuously lit during the recording 
between the markers. End the punch recording by pressing the record button again; 
playback will not be interrupted. Playback will stop if you press the "Stop" button. 

In: sets the starting point for a punch recording. 

Out: sets the out point for a punch recording.  

When the Alt key is held down, you can set additional punch in/out markers. 

Loop: Switch into the Loop Mode, where playback will replay a specific section in a 
loop. 

MIDI record modes: The following MIDI record modes are available: normal, overdub, 
multi-overdub, and replace. This decides whether newly recorded MIDI files are 
inserted into the VIP. 
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Tempo section: You can adjust playback speed and tempo of the entire arrangement 
in the tempo section of the transport control. All objects in the VIP will be adjusted in 
their speed using timestretching.  

 The "Beat grid/snap (view page 60)" button enables you to activate and 
display the beat grid. 

 Use the "CLICK" button to switch on the metronome click. Right clicking the 
"CLICK" button opens the metronome options window to configure the pre-
counter and click volume. 

Scrub Control: Using the Scrub Control wheel you can variably set playback speed. 
This helps when searching for various audio passages. The buttons beneath it can be 
used to start playback forwards and backwards at a slower speed. 
 

Track Editor 
1 Track number display and track name: A right-click 

on the track name opens the "Track settings" dialog. 
2 S: mutes all except the selected track. 

3 M: mutes the selected track. 
4 Record symbol: activates the track for recording. 
5 Lock: prevents the objects in the track from being 

accidentally moved or deleted. 
6 Volume symbol: enables the input signal to be 

previewed. 
7 Volume entry field and volume control 
8 Level control display: Both LED rows display the 

input and output signal for the track. 
9 Panorama: controls stereo position in the mix. 
 

 

 

 

10 FX: opens the track effects settings of the activated track.  

11 MIDI: sets the track to MIDI recording and opens the MIDI section in the Track 
Editor. 

12 Automation: is for Automation of MIDI controllers, VST parameters and certain 
effects in the track. 
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Automation 
1 Right-clicking opens the context menu 
2 Select the plug-in you would like to automate here. 

 

3 Select the parameter you would like to automate 
here. 

The slider controls the selected parameter while automation is drawn. 
 

MIDI 
1 Arrow: Opens and closes the respective dialog box. 
2 In device: Opens the MIDI input device menu. 
3 Out device: Opens the MIDI output device menu. 
4 Channel in: Set the MIDI input channel here. 
5 Channel out: Set the MIDI output channel here. 
6 Program: This slot is responsible for selecting the 

program for the MIDI instrument. 

 

7 Bank MSB: Set the device-specific control change 
messages for controlling your external instrument 
here. 

 

8 LSB: Set the device-specific control change messages for fine-tuning your 
external instrument here. 

9 Drum map: Select a drum map for allocating MIDI notes to the device-specific 
sound here. 

10 Transpose: Transpose the notes of the respective MIDI input or output up or 
down here. 

 

Audio 

 

 

"In" slot: Specifies the audio input device, i.e. a 
sound card. 
"Out" slot: Specifies the audio output device. This 
may be a sound card output or (in "MIDI" mode) a 
VST instrument, for example. 
Gain: Set the sensitivity of the input here. 

 

 



 

Program desktop overview 57  

 

Plug-ins 

 

Activates the sound effects rack containing various 
track effects, plus a compressor. 
In the first slot, you can also select a MAGIX synth 
to be controlled via the track. Clicking on the button 
to the right of the field beside "Plug-ins" activates 
and opens the "DirectX/VST plug-ins" dialog to put 
together a plug-in setup for this track. 

 

AUX 

 

Here you can specify the AUX send feed for which 
you can then select the desired effects in the AUX 
return channel in the Mixer view. 

 

EQ 
Contains the parametric EQ for this track. Right-
clicking opens a convenient input window. 

 

Comments 

 

Track info section for quickly adding notes on 
tracks. 
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Track box 
The track box of each track offers a roundup of Track Editor settings. 

 

1 Track number display and Track name: By right-clicking the track name you can 
open the "Track settings" dialog. 

2 S: mutes all except the selected track. 

3 M: mutes the selected track. 
4 Record symbol: activates the track for recording. 
5 Volume symbol: enables the input signal to be previewed. 
6 Lock: prevents the objects in the track from being accidentally moved or deleted. 

7 FX: opens the track effects settings of the activated track.  
8 Level control display: Both LED rows display the input and output signal for the 

track. 
9 Volume control slider: controls the track volume. 
10 Panorama- slider: controls position in the mix. 

Both the "Vol" and "Pan" buttons activate curves that allow the volume and panorama 
in the track to be automated. 
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Symbol bars 
Symbol bars, also known as tool bars, offer quick access to important Samplitude 
Music Studio 2013 functions. All symbol bars (toolbars) can be moved freely on the 
monitor. To do so, click on the separator at the left edge of the group of icons and 
drag the toolbar to the desired location. These will snap in at different positions in the 
window. You can also switch, for example, position bar and tool bar. 

Additionally, toolbars can also be adjusted according to your own needs. To do so, 
select the "Adjust toolbar" button in the context menu. 

To quickly sort a toolbar's individual buttons, click on the corresponding icon and drag 
it to the desired position while holding down the "Alt" key. You can use the same 
method to remove icons from the toolbar by holding the "Alt" key, dragging the icon 
outside the boundaries of the toolbar, and then releasing it. 

Note: The visibility of certain toolbars depends on the selected workspace (view 
page 64), with some toolbars being hidden in some workspaces. Every toolbar can 
be hidden and displayed independently from the selected workspace in the "View" > 
"Toolbars" menu. 

 

Toolbar 1 

 

 New Virtual Project 

 Load VIP 

 Load audio file 

 Export/save 

 Undo (Undo) 

 Restore (Redo) 

 Remove 

 Copy 

 Paste 

 Split object  

 Glue object together 

 Auto crossfade on/off 

 Crossfade Editor 

 Group 

 Dissolve group 

 List field Mouse mode (view page 88) 

 List field Object mode (view page 66) 
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Toolbar 2 

Note: Toolbar 2 is normally hidden 

 

 Set marker 

 Set CD track 

 Set subindex 

 Set pause 

 Set CD end 

 Set track markers at object ends 

 Make CD 

 Play 

 Play as loop 

 Play section 

 End playback (stop) 

 Recording options [R] 

 Record 

 Solo Jam Session 

 Mixer 
 

Tempo tab/tempo buttons 

 

The tempo tab is found in the tool bar. Here you can change important beat settings 
(view page 473) without having to always open project options. Click the magnet 
button to activate the snap grid. Below the button next to it you will find a menu for 
the following beat settings: 

Object grid: This option activates the object grid. This lets objects snap exactly to the 
edges of other objects. 

Area grid: This option activates the area grid and lets you use the current area as a 
grid basis. 

Time grid: This option activates a grid, which uses beat settings as its basis. 

Time grid (relative): This option also activates a grid, which takes beat subdivisions 
as its base. The selected object will maintain a relative distance to the snap markings 
when moved. 

Frame grid: This option activates a frame-based grid. 
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Specify the snap length (for beat snapping only). Values range from every 4 beats, 
every 2 beats, every beat, musical measure and same as quantization. 

The setting Musical measure means that, signatures based on quarter notes serve as 
a quarter snap unit, and time signatures based on eighth notes serve as a eighth snap 
unit. The snap therefore follows the time signature and observes any time signature 
changes. 

Warning: When the grid is active, the playback cursor jumps according to the set 
grid value when forward and rewind buttons are used in the transport console. If you 
would like to temporarily shut off the transport controls, press the "Alt" key 
simultaneously. 

Activate grid: Here you can globally turn the grid on or off. 
Keyboard shortcut:  Ctrl + # 

Grid and snap settings: This option brings you to the  Project options - General (view 
page 473) dialog, where you can change additional grid and snap settings. 

In the field labeled with Q you can set the quantization value, which will be used for 
MIDI Quantization (view page 207) and can serve as the grid if the corresponding 
grid setting "like quantization" is selected. Right clicking the field opens the MIDI 
quantize settings. 

Note on "Input Q": In the  button skins (e. g. "Camo") you can also find the button 
"Input Q" in the MIDI area of the Track Editor. If this function is active, then 
recorded MIDI notes will be quantized according to the current settings 
immediately. The original position may be restored at any time via the menu item 
"Object -> Quantize -> Reset Quantization". 

 

Position bar (left side) 

 

 To beginning 

 One section left 

 Half section left 

 Half section right 

 One section right 

 until the end 

 To previous object edge 

 To next object edge 

 To previous marker 

 To next marker 
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 Enlarge range (zoom in) 

 Reduce range (zoom out) 

 Zoom extents 

 Zoom to range 

 1 pixel = 1 sample 

 Zoom range 1 second 

 Zoom range 10 seconds 

 Zoom range 60 seconds 

 Zoom range 10 minutes 
 
 

Position bar 2 

 

 Reduce range vertically (zoom out) 

 Increase range vertically (zoom in) 

 Show all vertically 

 Show range vertically 

 Zoom into waveform 

 Zoom out of waveform 

 Overview mode 
 
 

Mouse mode bar 

Note: Mouse modes and object modes can also be set in the corresponding list 
fields on the toolbar. For this reason, this bar is normally hidden. For a complete 
description of mouse modes, go to mouse functions and mouse modes (view page 
88)) 

 

 Universal mode 

 Area mode 

 Object mode 

 Curve edit mode 

 Object/curve mode 

 Object cut mode 

 Pitchshift/timestretch mouse mode 

 Panorama draw mode 

 Volume draw mode 

 Curve edit mode 

 Waveform draw (only in wav projects) 
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 Scrubbing Mode 

 Zoom mode 

 

 Object mode (view page 66) "Hold all objects" 

 "Normal object mode" 

 "Connect curves to objects" mode 

 "Connect objects until pause" mode 

 "Connect objects on one track" mode 

 "Connect objects on all tracks" mode 

 CD special mode 

 Color mode 
 

Range bar 

 

 Play cursor back to range start 

 Play cursor to range end 

 Fold range to left 

 Flip Range right 

 Range start to previous zero crossover 

 Range start to next zero crossover 

 Range end to previous zero stage 

 Range end to next zero stage 

 Range editor 

 Move object start left 

 Move object start right 

 Move object(s) left 

 Move object(s) right 

 Move object end left 

 Move object end right 

 Step size for moving objects 
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Workspaces 
Working spaces serve to bundle menus and symbol bars for certain tasks such as 
mastering, editing or recording.  The available work spaces can be selected in a 
separate selection menu. 

 

You can create and save your own work spaces. First, set the program screen as you 
see fit. You can hide certain menu options (menu "File" > "Program settings" > 
"Keyboard shortcuts and Edit menu") and change symbol bars (right click on symbol 
bar). Finally, save the changed settings in one of the presets. 

Creating a new work space: To create a new work space, right-click of the selection 
menu, select in the context menu "New work space" and give it a fitting name. The 
new work space contains all settings of the previously activated work space as well as 
your later changes. All further changes will be automatically saved in the work space, 
explicit saving of the work space isn't necessary. 

Adjusting the workspace: Open the context menu and click on "Edit Workspace". 
Here you can select which symbol bars should be displayed and edited. You can 
activate or deactivate each bar individually, or add/remove individual symbols. 
Additionally, you can hid individual menu options under "Edit menu". To do so, select 
the corresponding menu option using keyboard shortcuts and then press the "Show 
menu option" or "Hide menu option" button. 
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Functional overview 

Objects 

 

Audio objects contain references to the audio files that form their base. You can also 
speak of referencing an audio file with an object. An audio object references audio 
files and calculates parameter settings such as volume, panorama, object length, 
sound changes, effects or fades in realtime. Pitch changes, timestretching, AUX send 
routing and plug-ins can be calculated this way. 

MIDI objects reference a corresponding MIDI file. In contrast to audio, where audio 
files are saved to the hard disk, MIDI files are saved together with objects, and are 
directly coupled to the corresponding objects.  
 

Loading an audio file into a VIP object 
Method 1: Loading a file into a VIP 

Mark a range in the VIP and load the wave file with "File -> Open project -> Audio 
file". The file is inserted at the beginning of the selected range as an object. The range 
also denotes the track into which the wave file is inserted. 

Method 2: Drag & drop from Windows Explorer 

Open Windows Explorer and arrange the Explorer and Samplitude Music Studio 2013 
windows so that both are at hand. Access the audio file in Explorer that you would like 
to use, and then simply drag it over into Samplitude Music Studio 2013 while holding 
down the mouse button. 
 

Load ranges from wave projects into the VIP 
• Open a wave project.  
• Mark the range which is to be incorporated into a virtual project. 
• Create a new virtual project with "File -> New multitrack project" ("E") or with 

the corresponding button in the toolbar.  
• Tile the open windows by pressing enter. 
• Drag the selected range in the wave project into the virtual project by clicking the 

left mouse button into the range and then dragging it into a VIP track. 
• A new object is created in the VIP at the position the mouse button was released. 
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Accessing audio material in an object 
• Select any object. 
• In the object menu, select ”Destructive editing”. The same menu option is 

available from the context sensitive menu by right clicking on the object. 
• This opens the corresponding wave project window. The marked range 

represents the audio material that is used in the VIP object. 
 

Moving and duplicating objects 
Once one or several objects have been selected, they can be shifted vertically (by 
track number) and horizontally (in the timeline) while holding the left mouse button. 
As soon as you let go of the left mouse button, the object will be placed at the current 
position. 

If several objects have been selected in different tracks, the selected group can be 
moved vertically only so far that all objects remain within the tracks. 

If "Shift" is pressed when moving the objects, the time position is retained and you 
can only change the track. 

If "Ctrl" is pressed while moving the object selection, then a copy of the object 
selection is created. In this case, the copy of the original object selection is placed at 
the destination. The original objects maintain their position. 
 

Object modes: 

 
 

Normal Object Mode 
In this mode you can move objects and edit the end and start positions, fade in and 
out phases, and object volume. 
 

"Lock all audio in time" 
This mode locks all objects to stop them from being moved accidentally. Object mode 
"Lock all audio in time": Holding down the "Alt" key at the same time temporarily 
deactivates the mode for the selected objects. 
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Link curves with objects 
In this mode you can shift track automation curves together with the objects that are 
being moved. 
 

Link objects until pause 
The means that the chosen object is selected and moved together with all subsequent 
objects on this track. This ensures that the pauses between the objects remain intact 
when moving a particular project range. 

This function also applies to multiple selected objects arranged along various tracks. 
 

Link objects on active track 
In this mode, all objects on the current track are selected and moved together. 
 

Link objects on all tracks 
In this mode, all objects appearing in the arrangement are selected and moved 
together from the mouse position. 

Note: By using the object modes "Connect objects until pause" and "Connect 
objects on a track" together, the markers in the top arranger track may also be 
moved when objects are moved. Moving objects in the object mode "Group objects" 
simultaneously moves the marker independent of the selected track. 

 

Changing object borders in virtual projects 
The lower object handles of a selected object can be used to alter the object borders. 
The mouse can be used to change the object beginning or end. The object length can 
only be changed within the confines of the physical wave project window. 

This means that the beginning of the object can not be extended beyond the 
beginning or end of the corresponding wave project. Conversely, the end of the object 
cannot be extended beyond the beginning or end of the corresponding wave project. 
 

Fade in / Fade out and object volume 
The object handle in the top center can be used to set the object volume. The exact 
volume level in dB during the change is visible in the pop up window at the object.  

The top left and right-hand handles of the object change the fade in and fade out 
settings of the object. 

Since these changes are applied in real time during playback of the project, then the 
original audio material is left intact. This allows easy set up of fades and volume levels 
without having to fear data loss. 

The curve types when fading in and out can be set in the crossfade editor. 
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Overlapping objects 
A track (channel) can only play back one object at a time. 

If one object is moved over another object, then the previous object is partially or 
completely taken out of the playback list (much like one sheet of paper covers 
another partially or completely). The invisible part of a covered object will not be 
audible. By moving the covering object out of the way, the covered section or the 
complete object can be made audible again. To create a crossfade between two 
objects that are intersecting each other, the crossfade editor in the "Edit" menu can be 
used. 
 

Looping objects 
Looping repeatedly plays an object or object range. You can change the length of 
objects by dragging out the length handles. 

An object is normally played back between the object start and end. A loop object 
also starts from the beginning of the object, once the loop starting point has been 
reached only the set loop range will be repeated until the object end. 

The easiest option to loop is to open the object's context menu and choose the option 
"Create looped object" (shortcut: Ctrl + L). The entire object is treated as a loop. If 
you now drag the length handle at the back to the right, you will see a vertical dash at 
the previous object end. For this marking onwards the object will be played back 
again, it is looped and can be stretched out to the right. 

An object loop may be edited in far more detail by using the object editor. In Loop 
Mode you can set and customize the loop start, loop length as well as the loop end 
within the object. Skilled looping omits time-consuming cutting. 
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Object Editor 
The centerpiece of object-oriented working is the object editor, which can function as 
a tool for a single object as well as multiple ones. 

Note: There is an object editor for MIDI objects as well. Detailed information can be 
found in the chapter "MIDI in Samplitude Music Studio 2013 -> Working with the 
MIDI object editor (view page 173)" 

 

The object editor is divided in three sections "FX", "Fades", and "Time/Pitch". The 
object editor may be left open to edit objects - the view automatically adjusts to the 
selected object.  

To open the object editor, select an object and press "Ctrl + O" or double click on the 
object. The Object Editor opens in the Docking bay. 

The Object Editor can also be opened for an unselected object by positioning the play 
cursor over the object you want to edit and pressing Ctrl + O. The track containing the 
object must be activated. 

To select all objects at a certain play cursor position, activate a track with no object at 
that position. Press "Ctrl + O" and all objects located at the cursor position will be 
selected, the object editor will open for the topmost object in the track list, which also 
features the lowest track number. 
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Object editor: Basic functions 

 

The selection options for the three different dialog windows of the object 
editor are displayed to the left. 

FX: Here you can set the gain, plug-ins, sound FX rack, EQ, panorama and 
volume. 

Position: Here you can set the wave position and object position. 

Time/Pitch: Here you can set timestretch/pitchshift algorithms. 

 

The section on the far right is the same for all three dialog windows: 

 

The object name is displayed in the upper text field and this may also be edited. In the 
square field to the side, you can select the object color. 

Using the arrow keys you can "jump" up or down to the object of a neighboring track. 
Use the double arrow buttons to jump to the previous or next object. If multiple 
objects are selected, these buttons will not be active. 

1-4: You can save the various object editor settings in 4 snapshots. These snapshots 
apply to the entire project, so that you can easily transfer the effect settings of an 
object to another (or multiple) object(s). 

This can be done by left clicking on the corresponding button. If a snapshot has been 
saved in the respective button, you can overwrite it by holding down the "Shift" key + 
left clicking. Clicking the number keys loads the snapshot. You can quickly compare 
the various object editor settings by switching between the snapshots.  

You can also access these functions via the context menu of the snapshots. You can 
also delete snapshots there. 

To all: If the "To all" option is active all selected objects are updated when the object 
editor is opened. No matter in which of the three object editor windows, all recently 
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applied settings that have been made in a selected object, will be applied to all other 
selected objects.  

Note: 

- Volume changes are transferred relatively in an object, i. e. they are increased or 
decreased relative to the volume of other selected objects. 

- The EQ settings are always completely transferred, in contrast to previous 
versions where only the edited bands were transferred.  

Bypass FX: This deactivates all object effects, EQ/panorama settings, and AUX sends. 

Play/stop: This button corresponds to the normal playback function (shortcut: space 
bar). 

Phi: The Phi button causes a 180 degree phase rotation. By right clicking on the Phi 
button you can invert the left and right channels individually. 

Lock: The activated "Lock" button corresponds to the key button's switch in the 
object. The object is then protected against any inadvertent horizontal movement. 
Additional locks against vertical moving, volume adjustment, fades, length 
adjustments, ripples or deletion can be set in the system settings (shortcut: "Y") 
under "Program > Object lock definitions". Locking can be temporarily cancelled by 
pressing the "Alt" key. 

Solo: This button moves the play cursor, during playback, to the start of the selected 
object and plays that only. Track-dependent busses and AUX paths are also observed 
at playback. 

Mute: This button mutes the selected object. By right clicking you can also mute the 
left and right channels individually, too. 

Commentary: You can type comments relevant to the selected object in this field. 
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Object effects 

 

In addition to the numerous effects available for individual tracks and the master area 
of the mixer, audio objects may also feature effects. All settings are retained when 
moving or copying objects. 

By crossfading between objects of different settings, you can also fade between the 
different effect settings. CPU-intensive effects may therefore be used more 
efficiently, since they are only processed as required (unlike a track effect set up as an 
AUX send effect). 

The "Effects" or context menu also makes it possible to access the object effects. 
 

Plug-ins/Sound FX 
The plug-in section provides you with quick access to installed effect plug-ins on the 
object level. 

Here, plug-ins and insert effects can be selected by clicking the arrow symbols of 
each plug-in slot.  

Just by clicking you can switch the sought plug-ins on or off. Right clicking opens the 
interface of the respective plug-in.  

The button to the right next to Plug-ins disables all plug-ins. Right clicking on this 
button opens the Plug-in (view page 359) dialog. Here you can load even more plug-
ins than are visible in the slots. You can also save and load plug-in effect settings in 
this dialog. 

Sound FX opens the SoundFX rack (view page 97) with the internal effects provided 
by Music Studio, Vocoder opens the Vocoder (view page 374). 

Using the button "Offline FX", you can apply all effects as offline effects to an object. 
Select the effect in the corresponding effect dialog and confirm using the "OK" button. 
It is also possible to edit either the left or right channels individually. 

To remove a plug-in or an effect, select "No effect" from the corresponding plug-in 
slot in the menu. 
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Under "EQ" you can set four frequency bands. The blue button in the header switches 
the equalizer on and off. By right clicking on the controller/blue button, you can 
access the dialog window for the fully parametric 4-band equalizer (view page 101). 
 

Gain 
Use gain to control the level of the object at the beginning of the processing chain, 
before all other effects. 
 

PAN 
Here you can edit the panorama as well as the stereo width of the active object. 
 

Vol 
Vol: The volume is controlled using this fader. 

Double clicking on the fader sets it to 0 dB. 

Norm.: The Norm. button normalizes the maximum level of the object to 0 dB 
 

Position 

 

Use this dialog to set object-related time positions (start, length, end) for the selected 
object. In the entry field "Step size" the measurement unit can be changed on the far 
right just by clicking. The following units are available: samples, milliseconds, 
hours/mins/secs, SMPTE (24, 25, 29.97 non drop, 29,97 drop, 30), 
SMPTE/milliseconds, CD-MSF, feet and frames 16 mm (40fpf) and feet and frames 
35 mm (16fpf), noise reduction (meter). 
 

Content 
Audio file: Here the referenced wave project can be exchanged, copied and renamed 
directly in the object editor. Open the file exchange dialog by clicking the folder 
symbol beside the name of the audio file. If the audio file is used by multiple objects, 
you can indicate whether it should be switched for the currently selected object or for 
all referenced objects. 

Wave position: The arrow buttons do not affect the position of the object or its 
length, they move the audio material in the object left or right. 
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With the option Reverse playback an object will be played backwards. The audio files 
are not changed. 

Hint: Please note that there are some limitations when using additional effects on a 
backwards-playing object. This refers to wave editing or using timestretching 
effects, especially Elastic Audio. Furthermore, reverse playback requires more 
resources as track speed cannot be used here. 

 

Position 
The starting time of the object on the timeline, object length, and object end can be 
set here by entering a number or using the arrow buttons. 

Using the arrow buttons beside object start / position the object can be moved 
forward to the start of the project or towards the end of the project. 

The arrow buttons beside object length move the start of the object, they work just 
like the front lower object handle. 

The arrow buttons beside object end shorten or lengthen the object, they work just 
like the back lower handle. 

The step size shows the position/length adjustment made upon clicking on the arrow 
button. The unit of measurement to the right beside the input value can be changed in 
the context menu (right-mouse click to open). 

The lower part of the menu features corresponding presets for each selected 
measurement, e.g. for the unit of measurement "Bar/beats", the following step sizes 
are used: 1/64, 1/32, 1/16, 1/8, 1/4, 1/2, 1Beat, 2Beats, 1Bar, 2Bars, 4Bars. 
 

Pitchshifting/Timestretching 

 

Pitchshifting and timestretching can be used in parallel independently of each other, 
except for in the Resampling mode. 

Pitchshift: You can shift pitch either in half tones (mouse wheel + Ctrl) or per cent 
(mouse wheel + Shift) or enter it as a pitch factor of the original value. 
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Timestretching:  Speed correction can be made either as new object length/stretch 
length or as stretch factor of the original value or you can indicate the desired tempo 
as BPM (Beats Per Minute). 

The button "<< from loop or range" makes it possible to extract the BPM value from 
one selected range or the object length and enter it as the "Original BPM". Enter the 
number of quarter notes in the dialog that opens and then confirm with "OK". This is 
important if the object tempo is not entered correctly and another tempo needs to be 
compensated. 

The values can also be adjusted in stages using the knob. 

If you wish to change the original speed ("Original BPM"), you will see that the speed 
of the object you wish to correct adapts to that of the set stretch factor. The modes to 
be selected are Resample, Standard, Smooth, Beat Marker Slicing, Beat Marker 
Stretching, Monophonic Voice. 

"Edit" opens a clear display of the already named parameters. If you move through the 
individual modes with the mouse, a detailed explanation will appear for each mode.  
 

You can learn more about individual algorithms in the menu reference under "Menu 
Effects > Time/Pitch > Resampling / Timestretching / Pitchshifting (view page 
371)". 

 
"Reset" restores all pitchshifting and timestretching settings. 
Elastic Audio provides a high-quality tool for pitch customization. The "Elastic Audio" 
button opens the activated object in the Elastic Audio Editor. 

The Use Elastic Audio (Pitch Automation), changes the pitch using Elastic Audio. 
 

Ranges 
Ranges are selected parts of an arrangement which are defined for editing or 
accessing later on.  

Example 1: A certain section of a song is to be completely removed from the 
arrangement. To do so, first define a range that contains the material to be removed. 
Next, activate the defined range for all tracks by double-clicking twice in the beat bar 
of the range. If you press the Del key now, the material will be deleted from the 
arrangement. Parts located behind the range will be automatically moved forward, 
closing the gap. 

In a similar fashion you can also copy the material inside the range to the clipboard in 
order to insert it at a different location. First, create a range for all tracks as described 
above and press Ctrl + C ("Edit" > "Copy"). Now, set the playback cursor at the 
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position where the material should be inserted. Select the first track and press Ctrl + 
V ("Edit" > "Insert" > "Insert from clip"). Now the material will be added to the track 
as new objects. 

Example 2: A selected range can be played back in a loop, in order to create loopable 
sequences. Activate the "Loop" button in the transport console. During playback the 
range borders can be moved in order to find the optimal loop. 
 

Selecting a range 
To select a range, move the mouse pointer to the top half of an object and press the 
left mouse button. Move the mouse pointer within the object while holding down the 
mouse button. An inverted rectangle appears between the starting point and the 
current mouse position. Once you let go of the mouse button, the range will be 
selected. 

The play cursor always automatically remains at the beginning of the range, even if 
you can't see it at this moment in time. To expand the range to other tracks, click on 
the top half of the selected object again and drag the mouse down vertically while 
keeping the mouse button held. Now click the section with the "Shift" key held down, 
and every object featuring a middle point within the selection rectangle will be 
selected. 

 

A range may also be selected by dragging the mouse across the timeline. This will 
then be indicated by a different color. Double clicking this range in the timeline selects 
a range in the selected track; double clicking again selects the range over all tracks, 
and double clicking once more restores the simple timeline selection.  

The timeline selection enables the play cursor to be positioned outside the range. The 
range will remain in loop mode. This way, playback may be started in front of or 
within a loop. In this case, the range edges may also be modified during playback. The 
playback range may be deleted by dragging to size 0. . Click the range borders in the 
timeline to position the play cursor at the playback borders. Double clicking the 
timeline outside of the range removes the playback range. 
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Leaving a range 
To select a different range, click somewhere in the project other than the current 
range, and simply draw a new range. 
 

Reactivate range 
To reactivate an earlier range, use key combination "Shift- + Back arrow" (or "Edit" > 
"Range" > "Reactivate last range"). By clicking on this command repeatedly you can 
restore the last five ranges. You can execute the same function by clicking on the 
button with the left arrow in the transport control. 

 
 

Change range borders 
You can change range borders by placing the mouse on the edge of a range in the grid 
bar until the cursor turns into a double arrow. Now you can reset the range borders by 
dragging in the horizontal direction. 

If you want to change only one border of an existing track range such as beginning, 
top edge or bottom edge, left-click on the existing range and hold down the mouse 
key. Now you can drag the mouse with the held down key in the direction that you 
want tot change the range. As soon as the edge of the existing range has been 
crossed, the range edge will follow the movements of the mouse pointer. After you 
have redefined the range, you can release the mouse.  

You can also change a range using the Shift + arrow keys. 
 

Horizontal movement of a range 
Click with the left mouse key while holding down the Shift key inside an existing range 
on the grid bar, hold the mouse key and move the range in the horizontal direction. 
 

Save/recall range 
Selected ranges can be saved and recalled using "Edit" > "Range" > "Remember 
range" or with Alt + Function key F2-F10 and reopened with "Edit" > "Range" > "Get 
range" or Ctrl + F2 to F10. 

Note: Alt+ F4 is excluded since it is a Windows shortcut for closing windows.  

Using Alt + F11 you can save unlimited ranges and assign them names. 

Additional special functions for defining, changing and using ranges can be found in 
"Edit" > "Range".  
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All saved ranges are displayed In the Range Manager, where they can be numerically 
edited and recalled. The manager is found in the docker or can be opened via "Edit" > 
"Range" > "Range editor". 

Tip: All menu commands for range editing can be found in the menu reference "Edit" 
> Range" (view page 346). 

 

Wave projects 
Wave projects include audio files. VIP objects reference to corresponding wave 
projects open in the background. The reference solely the audio files and receive 
working instructions as to what the computer is to do with these files.   

All audio edits take place normally directly in the VIP and are "virtual" or "non-
destructive". This means that they are saved to the hard drive as a file only during 
export In some cases it might be desirable to edit audio material directly already 
during editing.  In such cases you can find the associated audio file for each object via 
the command menu "Object" > "Edit wave object". 

Wave projects are for direct editing of data saved to the hard drive. This art of audio 
editing is called "destructive", although editing steps can be reversed with Ctrl+Z (or 
"Edit" > "Undo"). 

When a VIP is opened, you normally cannot see the individual wave windows. To 
make them visible as icons, activate the "Wave projects to icons" options in "View" > 
"Window". To make them disappear again, select "Hide wave projects". 

In the title bar of the wave window you will find the project name, bit resolution, 
sample length and the resulting disk space.  

You can also load audio files without VIP and edit them in a virtual Wave Editing 
Mode. For this the "Open wave projects in destructive mode" option must be 
deactivated in Program Settings (Y). Files loaded via "File" > "Load audio file" will be 
opened in a wave project, which works virtually, similar to a VIP. 
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Marker 
Position marker 

Position markers serve to "remember" position points. They are visible as in a special 
line at the top edge of a project as named orange bars. Markers can be placed during 
playback as well as during recording. 

• Markers in wave projects are saved in the audio file (*.wav) as so-called audio 
markers and are available in this form in other applications as well. 

• Wave project markers can also be displayed in VIP objects (VIP display options). 
• A project can contain any number of markers. The first ten can be called up 

directly using the number keys and are assigned names "1" to "10". You can save 
them using the "Shift + Number Key" key combination. By pressing the 
corresponding number key you can jump back to the marker once again. 

• By going to "Playback" > "Marker" > "Marker by the name..." you can define and 
name additional markers.  

• To delete a marker, click on it and press the Del key. You can move markers by 
grabbing and dragging them. The mouse cursor will turn into a double arrow. 

• If you right-click within a marker line, a context menu will appear from which you 
have access to all important commands. 

• Manage and name markers in the Maker Manager ("View" menu or in the marker 
context menu). 

• To stretch a range between any two markers, click on the first marker. Then, click 
on the second marker while holding down the Shift key. This selects a new range. 

• To move quickly between marker positions, use the keyboard shortcut 
("Playback" menu > "Move play cursor" > "Marker left/right". 

CD Markers 

CD markers are triangular markers for various CD burn functions. They can be set in 
the "CD" menu. There are 

• CD Title Markers 
• CD Subindex Markers 
• CD Pause Markers 

You can find additional information on tempo markers in the Burning CDs" (view page 
279) chapter. 

Tempo markers 

Tempo markers serve to change the arrangement's tempo.  

• Tempo markers for tempo change at a certain position. 
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• Tempo markers for changing the tempo type starting from the marker position 
(e.g. from 4/4 to 3/4 beat)  

• Grid position markers assign a musical position to a certain position on the grid. 
This way, the bar frame/grid and MIDI events can be easily synchronized with 
existing audio material. 

You can find out more about beat markers in the "Changing the beat" (view page 
226). 
 

Volume 
The volume levels of objects and tracks/channels can be changed at various stages. 
 

Wave Project Level 
The volume level changes are applied to the audio material with "Effects -> Normalize 
-> Normalize file", or with "Fade in/out". 

The audio data is changed. The computer usage is not affected during playback. 
 

Object level 
Every object can have an independent setting for its volume level. This can be 
performed by changing the upper handles of the object or with "Effects -> 
Amplitude/Normalize -> Normalize object". 

The audio data is not changed. The calculations are performed in real-time during 
playback. 
 

Track level 
The volume of every track can be changed dynamically with the volume automation 
curve and the volume fader in the mixer or the VIP. 

The audio data is not changed. The calculations are performed in real-time during 
playback. 
 

Output mode 
You can setup the output mode in the playback parameter dialog ("P"). 

With the "Sample rate" option you can choose a different sample rate as playback. 
"Device" allows you to select the desired playback device (if you have more then one 
active sound card). 

Please note that some sound cards are not be able to playback all sample rates.  
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Note: Different recording and replay devices for individual tracks can be selected in 
the track information dialog rather than the play parameter window. Track 
information opens by clicking on the track number.  
 

Record 
Hard drive recording 
The device used to digitize audio signals is already included on the sound card and is 
called an analog/digital converter (A-to-D, ATD or A/D). In order to record, the A/D 
Converter gathers samples of the signal to be digitized in determined time lapses and 
measures its frequency. The rate is called ”sample rate” and normally lies in the kHz 
ranges. KHz means a vibrating frequency of several thousand times per second. The 
higher the rate, the more samples are taken by the A/D converter and the more 
natural the digital transformation of the sound will be. 

The precision with which the A/D converter measures the analog signal is 
determined by the sample resolution. The finer the resolution, the better the digital 
transformation. 

CD-quality audio recordings are recorded with a sample rate of 44.1 kHz and 16-bit 
resolution. 
 

Recording source 
First of all, the recording source must be connected to the sound card. There are 
several ways to do this, depending on your equipment. 

Microphone: Microphone signals must first be amplified before the sound card 
modifier can record them. Most sound cards have separate microphone inputs that 
pre-amplify signals, but the results are rarely professional. 

Quality: Connection to an external mixer or external microphone amplifier produces 
far better results. 

Amplifier: If, for example, you possess a guitar amplifier that has a line-out output, 
you can connect it with the line-in input on the sound card. 

Stereo system: The stereo system’s amplifier usually has a separate line-out. If 
instead, you see ”Aux. out sockets,” then you should use these. Connect them with 
the input on the sound card (usually shown in red). Normally, a high-fidelity (hi-fi) 
amplifier has cinch sockets and sound card mini-stereo catch sockets. You must have 
the corresponding cable to connect these properly. 

If the amplifier doesn’t have separate outputs (other than the loud speakers), then 
you can use the headphones socket for recording. In this case, you need a cable with 
two mini-stereo headphone connectors. This process has an advantage: you can 
control the signal level through the phones input. The disadvantage is that phones 
outputs are normally not very good. With cassette recordings, always use the 
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cassette deck line out. Record transfers often leave you no other choice... Never 
connect a record player’s outputs directly to the sound card, because the phono signal 
must be pre-amplified first. If you don’t have a pre-amplifier, the only way to do this is 
via the phones output or an external amplifier 
 

Adjusting the signal 
Digital recordings through the sound card need optimal control in order to obtain the 
best sound quality. 

Once the recording source is connected to the sound card, open the recording dialog 
with the "Record" button and start the recording source. 

You can check the control on the LED displays in the recording dialog. 

If the level is too high, reduce the incoming signal. If the recording source is connected 
through the amplifier or tape deck’s line out connectors, then you can reduce the 
incoming signal only by using the sound card’s mixer window. This is located in the 
recording dialog under the "Level control" tab. 

If you reduce the input sensibility with the sliding regulator (fader), then you also 
reduce (with many sound cards) the precision of the resolution of the digitized analog 
signal. This is why these controls should be kept at the loudest possible setting! 

The standard for optimal adjusting is naturally the loudest section of the material. This 
should be turned to the maximum setting 
 

Digital transfer 
With the recording function, digital audio data can be transferred to the hard drive 
through a digital interface (e.g. S/PDIF or ADAT). 

ADAT or DAT recorders normally produce data with a sampling rate of 48 kHz. For a 
CD project with 44.1 kHz you must convert the sampling rate. This is carried out in 
real time by Samplitude Music Studio 2013. The digital signal is read at 48 kHz, but is 
automatically converted and inserted into the project as an audio file at 44.1 kHz. 

For this to occur correctly, you must first set the sample rate of the incoming signal in 
the recording dialog. Click on the "Dev." button in the recording dialog. In the 
following dialog (sound card characteristics), set the audio recording formats 
supported by the sound card. 

Now, connect the digital output of your recorder to the digital input of your sound 
card, and now start recording! 
 

24-bit audio support 
Audio files in Samplitude Music Studio 2013 can not only be recorded in 16-bit 
quality, but also in far superior 24-bit resolution. Simply click the ”device” button in 
the recording dialog, and select the ”24-bit” option under ”sound card properties”. 24-
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bit recordings require a high-quality audio card with 20 or 24-bit converters, as well 
as a 24-bit-compatible NME drive. 24-bit audio material can also be transmitted via 
audio cards with SPDIF digital interfaces. 

We have had positive experiences with the 24-bit audio cards produced by Marian, 
RME, SEKD and Terratec. 

The high resolution audio files are stored and edited in the 32-bit ”floating point” file 
format by Samplitude Music Studio 2013. This ensures the full 24-bit quality 
independent of the gauge. The dynamics may increase to over 140 dB, while the 
recording’s jamming transmission sinks (depending on the type of audio card) to 110 
dB and more. Thanks to floating point processing, there is no need to worry about 
internal editing being distorted. Floating point processing only starts to distort at 
around 1,500 dB above zero, in contrast to a 16-bit signal which distorts immediately 
once the zero dB line has been crossed. 

Even in cases whereby audio material is intended for burning onto a 16-bit CD, it is 
worth selecting 24-bit recording, since all effects calculations are made in a higher 
quality and therefore no ”rounding” mistakes can be detected in the audible 16-bit 
range. 

24-bit recordings (via storage as 32-bit float files) take up twice as much storage 
space on the hard disk as 16-bit recordings. But with current hard disk storage 
capacities, it works out as a good compromise when one considers the increase in 
quality. 

High resolution audio files can be imported and exported as 24-bit wave files, 
enabling trouble-free file exchange with other high-quality audio systems. 
 

Further recording dialog possibilities 
The recording dialog also offers: 

• A string instrument tuner for creating the best sound possible before recording. 
Deviations from the standard pitch are graphically displayed. 

• The option of laying track markers (either manually or automatically) while 
recording a CD.  

• The option to directly incorporate a variety of audio formats, e.g. to save hard 
disk space. 

Please read the “Recording options” section of the “Playback menu” chapter to learn 
about all of the recording dialog options. 
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Folder tracks 
Multiple tracks that belong together can be combined in a folder track in order to 
bring more order to your multitrack arrangement.  

You can add a new folder track via "Track" > "Add new tracks" > "New folder track".  

Now you can drag and drop other tracks into the folder track. The contained tracks 
will be displayed inside a frame. 

 

A folder track can be recognized by a folder symbol in its track box. 

 

The folder track can be opened and closed by clicking on the folder symbol. 

Individual tracks can be gotten out of the opened folder track via drag & drop. A "(F)" 
is attached to the folder track number in the Track Manager. If you would like to 
delete a folder track, you will be asked in a dialog window whether all tracks contained 
in the folder should be deleted as well. 

Mute, Lock and Solo of the folder track affect all tracks contained therein.. Volume 
regulation of the folder track scales the individual faders relative to each other. 
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Tips & tricks 
A few tricks that help make working with Samplitude Music Studio 2013 easy: 
 

Working with projects 
• The "A" key will select the complete sample as a range. 
• "Home" and "End" set the play cursor to the beginning or end; all selected ranges 

will disappear. 
• A range can be selected from one exact marker position to the next by clicking on 

the marker above the wave. Next, hold "Shift" and click on the second marker. 
• Using the "Shift + mouse click" a range can be moved horizontally. 
• "Shift + Ctrl + arrow keys" will flip a range to the right or left. This is a great way 

of testing a loop at a different position. 
• Objects in Virtual projects can be displayed in two different modes. By pressing 

"Tab" you alternate between the modes. Pressing "Shift + Tab" will open a dialog 
window in which you can set the parameters of the display modes. 

• Using "Ctrl + mouse click" on an object copies the object. 
• Double clicking the mouse button on the volume curve creates and deletes 

volume handles. Activate the volume automation curve with "V" in each track of 
the VIP! 

• Change the function of the mouse buttons in VIPs with "Preferences -> Mouse 
mode", or use one of the mouse mode buttons in the mouse mode toolbar! 

• The function "Lock objects" allows you to lock objects to prevent accidental 
movement. This is especially useful for multitrack recording when the individual 
tracks need to stay in sync with each other. 

• To determine the tempo of a selected range (BPM), open the snap definition 
dialog ("Shift + R") and select the number of beats the selected range represents 
(for example: 4) in the "Free bar snap" section. Next, click on the "Get range" 
button in the "Free bar snap" section to retrieve the length of the selected range. 
The BPM display in the "Fixed bar snap" section now displays the BPM of the 
audio section. 

• Try the right mouse button on various components of the VIP window! A 
context-sensitive popup menu is displayed which features useful functions 
depending on the window component you clicked on. Among them are objects, 
"Record" and "Mute" buttons, and the scrollbars. 

• "Delete" deletes markers when the play cursor (real-time cursor) is located 
exactly on the marker. The same key deletes any selected objects and deletes 
ranges that are selected. 

• "T" separates a selected object at the position of the play cursor. If a range is 
selected within the object, the object is separated on the range borders, which 
results in three objects. If auto crossfade mode is active while the separation 
takes place, Samplitude Music Studio 2013 adds smooth crossfades at the 
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separation points. These crossfades can later be edited for further refinement. 
Use the crossfade editor to change the crossfade aspects. 

• Multiple zoom levels can be saved to the four "Z" buttons in the lower left-hand 
corner of the virtual project window. Use "Shift + left mouse click" to store a 
zoom level to a specific preset button. When clicking on a previously assigned 
preset button, the zoom level is recalled. The "S" preset buttons can be used with 
"Shift + left mouse click" to store a complete window configuration set. This 
includes the scroll position of the window and the mute/solo assignments for the 
tracks. This offers four mute/solo groups that can be quickly recalled. 

• Multiple objects can be selected by holding "Ctrl" and individually clicking on the 
desired object. 

• Holding "Shift" and clicking the mouse button behind the last object you want to 
select will select objects between the two points. 

• wave, HDP, and RAP projects, as well as stored objects, can be opened with 
Windows Explorer by dragging them from the Explorer window to the Samplitude 
Music Studio 2013 window. A special menu option is available to open Explorer 
from within Samplitude Music Studio 2013 with "Tools -> Explore the HDP 
directory". The default folder opened in Explorer is the same as the HD project 
settings in the system dialog ("Y"). 

• "Shift + Tab" can be used to display the VIP display mode dialog. This dialog 
allows you to change VIP display aspects like the VIP window behavior when an 
object or range is moved toward the currently displayed window borders (VIP 
border scroll). 

• Press "Enter" and all open windows are tiled on the Samplitude Music Studio 
2013 screen. This is a good starting point when using drag & drop functionality to 
move ranges and objects between individual project windows. 

• Use the menu option "Edit -> Edit tracks" to manipulate complete tracks. This 
includes adding new tracks, inserting tracks and rearranging tracks. 

 

Mixer 
• Clicking the right mouse button on a mixer effect control knob or element opens 

the associated effects dialog. 
• A double click on the middle of a control knob or element returns it to the passive 

default setting. Another double click resets the element to the previous position. 
• Clicking on the left or right outer limits of a control knob changes the setting in 

individual increments. 
• In the mixer window, multiple channels can be soloed simultaneously. When 

holding "Shift" and clicking on "Solo", all previously soloed channels are un-
soloed and the single channel is soloed. 

• The "Master normalization" function in the mixer window can be used to 
instantaneously adjust the output level to 0 dB, no matter how loud or soft the 
master output signal is. 
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Performance 
If errors occur during playback, you have the following options: 

• Increase the VIP and HD buffer in the system dialog ("Y"). 
• Zoom out to project full view ("A" button at position bar) 
• Deactivate the "Autoscroll" function in the playback parameters dialog ("P"). 
• Reduce the number of displayed image elements of the VIP window in the object 

display in virtual projects dialog ("Shift + Tab"). 
• Bounce several tracks by mixdown and mute the original tracks. 
• Reduce the used real-time effects in the object editor or mixer. 
• Do not use plug-ins, since they increase the CPU load. 
• In Windows NT, the playback performance of the hard disk system is particularly 

good if the corresponding files are played for the first time. So, if a VIP with many 
tracks is not played perfectly, save it, close all windows ("H") and open the VIP 
again. Now the NT file system performance is optimum again. 

• It often helps to run two copies of Samplitude Music Studio 2013 at the same 
time (simply start it twice from the desktop). This allows you to work on an 
extensive effect processing, a longer recording, the creation of a CD, or any other 
unattended procedure, while working on another aspect of a second VIP or 
project. When working on dual processor systems in Windows NT, both 
instances use the full capacity of one of the processors. Even under Windows 95 
this technique can be used to work more effectively. Make sure you disable the 
option "Check space bar for playback…" in the system dialog ("Y") to prevent the 
program in the background to stop any process. 

 

Recording / Playback 
• The recording window can be displayed by pressing "R". The recording can be 

started with "R" and stopped with "S" when the recording window is displayed 
and active. 

• Playback can be started and stopped with the space bar. When stopping, the play 
cursor returns to the original position. If the playback is stopped with "0" on the 
numeric keypad, the cursor will stop at the current playback position. Continuing 
to hold "0", while moving the mouse (scrubbing) can alter the exact position. 
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Mouse functions and mouse modes 

Universal mode 
Right mouse button: Displays context sensitive pop-up menu. 
Left mouse button: In universal mode a distinction is made 

between the upper and lower half of a track 
in the VIP. More mouse functions are 
available for the left mouse button. 

 

Mouse functions for the upper half of the track: 
• Stretch and move ranges (with "Shift") 
• Set the start position of the play cursor by clicking next to the object 
• Reduce the horizontal zoom level by double clicking next to a range 
• Increase of the horizontal zoom level by clicking on a range 
 

Select objects 
Single click selects objects (or group of objects). 

Single click + Ctrl selects multiple single objects. 

Single click + Shift selects multiple objects, including all objects between the two 
clicks. 

If you click left next to an object, you can sketch a rectangle with the mouse button 
pressed down by dragging the mouse the right. All objects contained therein are 
selected (lasso function). 
 

Moving objects 
Objects (or a group of objects) are moved if you click into their lower half and drag 
them to the desired position while holding the mouse key. 

Dragging + Shift moves objects or object groups up or down the track list without 
changing the time position.  

Dragging + key "k" move the object under the mouse pointer, plus all objects behind 
on the same track. 
 

Duplicating objects 
Dragging + Ctrl duplicates one or more objects. To do this you also have to click the 
lower half of the object. 

Dragging + Shift + Ctrl duplicates one or more objects and allows the objects to be 
moved up or down the track list without changing the time position. 
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Lasso function 
Object lasso: If you click left next to an object in the lower half of the track, you can 
sketch a rectangle with the mouse button pressed down by dragging the mouse the 
right. All included objects are selected. 

Volume and panorama lasso: If you click left next to an object in the lower half of the 
track, you can sketch a rectangle with the mouse button pressed down by dragging 
the mouse the right. All contained volume and panorama points are selected. 
 

Volume and length of individual objects 
You can individually adjust the volume and length with the five object handles. 

Object handles: The upper handle changes the object volume. The changed level is 
shown in dB in the upper left-hand corner of the VIP. 

Side handles: Fade-in or fade-out. The fade curves used here can be set in the 
crossfade editor. 

Lower handle: Adjusts the length of an object. 
 

Volume and panorama automation curves 
The volume and panorama curves can be used to graphically adjust the volume and 
stereo panorama curves of the tracks. Movable handle points are created on the 
curve. 

Double clicking on the automation curve creates a new curve event. Another double 
click on the same curve event deletes the event. Selected handles can also be deleted 
by selecting "Delete curve handles" from the edit menu. 

A volume or panorama handle is selected simply by clicking it. Several handles are 
selected by holding "Ctrl" while clicking. 

If you click right next to an object, you can sketch a rectangle with the mouse button 
by dragging the mouse to the right. All volume and panorama points contained are 
selected (lasso function). 

Selected volume and panorama points can be moved with the mouse. To move 
several points, you have to hold "Ctrl" while dragging. 
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Range mode (safe mode) 
Right mouse button: Displays context sensitive popup menu. 

Left mouse button: Selecting ranges and moving ranges ("Shift"). Objects or 
automation curves cannot be changed by accident (i.e. "Safe mode").  
 

Create ranges 
In range mode, ranges are sketched by clicking and dragging the mouse pointer while 
holding the mouse button. 

The range mode is a "safe" mode, since objects or curves cannot be moved 
accidentally. 
 

Play cursor 
Single clicks place the play cursor anywhere in the track. 
 

Zoom 
Double clicks outside of a selected range (or no range) zoom out. Double clicks inside 
a selected range zoom in.  
 

Quick switch to other mouse modes 
Using the "." (period key) temporarily switches to the object mode to allow objects to 
be moved.  

Using the "–" (minus key) temporarily switches to curve mode to allow automation 
curve events to be moved and manipulated. 
 

Curve mode 
Right mouse button: Context menu 

Left mouse button: Offers a range of functions. I.e.: 
 

Volume and panorama rubber band 
When you click on the track near an object, you can, by pulling the mouse to the left 
or right, spread a rectangle by holding down the mouse key. This will select all volume 
and panorama points contained in the selection box. 
 

Volume and panorama gradients for the whole track 
Using the panorama and volume curves, volume and stereo panorama graduations 
can be graphically recorded. For this purpose sizing handles which are moved are 
created on the curve. 
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A double click on the volume or panorama curve creates a new handle, and another 
double click clears it. Selected handles may also be cleared by selecting the option 
”clear handles” in menu ”edit”. 

You may select a volume or panorama handle by a single click. You will select further 
handles by holding "Ctrl" while clicking. 

When you click the track on the right beside an object, you can spread a rectangle 
with the mouse held down. This selects all volume and panorama points contained 
within (rubber band function). 

You may move selected volume and panorama handles with the mouse. To move 
several handles, "Ctrl" must be kept depressed. 
 

Curves / Object mode 
This mode differs from the universal mode only in that the track is not split in two 
halves. 

Play cursor, fields, and zooming are not set in the upper part of the track, but rather in 
the beat line above the first track. All other functions are handled by the universal 
mode (tracks are split). 

The curves/object mode is less complicated to use and is therefore a default setting. 
 

Cut mode 
Right mouse button: Context menu 

Left mouse button: You can use the mouse cursor like a pair of scissors to crop 
objects. 
 

Pitchshift / Timestretch mode 
Right mouse button: Context menu 

Left mouse button:The lower right tab allows an object to be compressed or 
stretched. A timestretching effect is created: The object is not played as a loop or 
shorter version, but simply in a different play tempo. 

Using the center tab, the pitch can be altered via pitchshifting. 
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Draw volume mode 
Right mouse button: Displays context sensitive popup menu. 

Left mouse button: Draws volume automation curves into VIP tracks. "V" needs to be 
active for a respective track prior to drawing the volume curve. 
 

Draw panorama mode 
Right mouse button: Displays context sensitive popup menu. 

Left mouse button: Draws volume automation curves into VIP tracks. "P" needs to be 
active for a respective track prior to drawing the panorama curve. 
 

Wave edit mode (only wave projects) 
Right mouse button: Context menu 

Left mouse button: Freehand drawing function for wave format.  
 

Scrub mouse mode 
Right mouse button: Context menu 

Left mouse button: Scrub function. Click project to pre-listen with control over play 
tempo. The project will be played forward and back controlled by the distance of the 
mouse pointer from the actual play cursor position. The larger the distance the faster 
the play tempo. You can set 3 individual scrub modes in the play parameter window . 
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Color mode 
In Color Mode you can color objects or entire tracks. Click on the arrow next to the 
brush symbol first. Next, select the desired color. Now move the mouse over the 
objects and tracks in the arranger: the pointer turns into to a paint bucket. Click on the 
object or track box you would like to color.  

 

You may also apply color to multiple objects across different tracks by dragging the 
lasso over the desired objects (the lasso appears when you drag the paint bucket). 
Release to color all selected objects. 

If you hold down the "Shift" key while doing this, you will color the wave form instead 
of the object. 
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If you hold down the "Ctrl" key while doing this, you will color the object background 
instead of the object itself. 

If the preset color selection is not sufficient, you can also select your own color or 
even create your own personal color palette. 

You also have the option of accessing the color palette for each track by clicking the 
color selector on the right edge of the track header. This also allows a new color to be 
assigned to a track. If multiple tracks are selected beforehand, the color selection will 
apply to all of these. 

Left mouse button: Changes the background color of the object 

Right mouse button: Changes the wave form color of the object. 
 

Zoom mode 
Right mouse button: Zooms out of the project. 
Left mouse button: Zooms into the project. 
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Effects and effect plug-ins 
Samplitude Music Studio 2013 contains many high-quality effects and effects plug-ins 
(MAGIX plug-ins) as well as interfaces for external VST plug-ins and DirectX plug-
ins. 
 

What effects are there, and how are they used? 
There is generally a difference between the effects types. The following effects occur 
in Samplitude Music Studio 2013: 

Real-time effects: These effects are also referred to as "non-destructive" or "virtual" 
effects, and they are added to the original sound while it is played. This means that 
the original file remains unchanged on the hard drive. 

Offline effects: These effects are also called "destructive effects", and they are added 
to the audio file before it is played; either the original file is changed, or a copy is 
created on the hard drive for working with. 

These effects are independent effects modules, i.e. they are provided by third party 
vendors or programmers. In Samplitude Music Studio 2013 we distinguish between 
three types of effects plug-ins: "MAGIX plug-ins", "DirectX plug-ins", and "VST plug-
ins". 

The area of application is a further criteria for effects. The following are integrated into 
Samplitude Music Studio 2013: 

• Object effects (can be accessed via the object editor or the "Real-time effects" 
menu) 

• wave effects (can be accessed via the "Offline effects" menu) 
• Track effects (can be accessed via the trackbox plug-in selection button or the 

trackbox plug-in) 
• Mixer channel effects (can be accessed via the "Insert" section of the mixer): 

These real-time effects affect track effects the same way as complete tracks. 
• AUX effects: (accessible via the track editor and trackbox): These effects can be 

installed identically for several tracks, or individually. 
• Surround effects (accessible via the insert selection box of the corresponding 

Surround bus channel, track editor, and trackbox): These effects serve for editing 
surround material. 

• Master effects (can be accessed via the "Master" section of the mixer): These 
effects are for editing the master sound. 

Most of the effects modules, i.e. equalizers, compressors, reverb, echo, etc., can be 
used in several of the above versions. However, they are only described at one 
position within this documentation. All effects and effect plug-ins that are NOT offline 
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effects and can be activated via the "Offline effects menu" are explained in the 
following sections of this chapter. The other effects which can also be activated via 
the "Offline effects" menu, are described in more detail in the "Offline effects menu" 
chapter. 
 

Saving effect parameters (preset mechanism) 
The effect dialogs contain preset selection boxes. These presets are saved and 
recalled to/from the "FX preset" directory (a subdirectory of the main Samplitude 
Music Studio 2013 program directory). 

If a preset is not located in this directory, it still can be loaded via the "Load setup" 
function, but it will not automatically appear in the selection box, so you'll need to 
browse for it. 

Effects that are added/launched from within the mixer or object editor are pre-
configured with the values assigned to the virtual project. If the virtual project is to 
adopt particular changes made to the settings in the effects dialog, then you will need 
to click on "OK" to transfer them to the VIP. 

You also have the possibility to apply the settings of the last destructive effect; a 
corresponding entry can be found in the "Options" box. If there is no destructive 
application of the effect, then the parameters selected in the list entries will be applied 
to the default parameters for destructive editing. 
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"Sound FX" (object editor, mixer channels, 
Mixmaster) 
Sound FX features an effects rack with the following virtual effects devices: 

 
 

Equalizer 
The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and 
supplies them with separated volume controls, which allows you to achieve many 
impressive effects, from the simple rising of the bass, to total sound transformation. If 
you raise the low frequencies too much throughout the whole level, it can cause 
distortions. In this case, lower the master volume using the master volume control on 
the main screen. 

Thumb controls: Each of the 10 frequency areas can be raised or decreased 
separately by the 10 volume controls. 

Link bands: Using this switch you can match the frequency areas in a flexible way to 
avoid overemphasizing single frequency areas that sound artificial. 

A/B: If you have selected a preset for the effect and later you change it manually, you 
can compare the original preset sound with the new adjustments using the A/B 
switch. 

Reset: Reset inserts the sound effect into the neutral starting position where no 
processing power is used and where no effect is calculated in the sound. 
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Touchscreen (right EQ section): This is the ”sensor field” of the EQ: Use your mouse 
to draw a curve that will be transferred immediately into the corresponding EQ 
control adjustment. 
 

Compressor 
The compressor is essentially an automated dynamic volume control. Tune dynamics 
are limited; loud passages stay loud, and low-passages become louder. Compression 
is often used to make the material more powerful. The degree of compression is 
adjusted by the ratio control, and ”Threshold” determines the entry threshold. Rise 
and decrease of time can be influenced by attack and release. 

The processing is realized ”in advance”, as often occurs in high-quality studio 
equipment. This means that there won’t be any overdriven peaks or other artifacts, as 
the algorithm can never be ”surprised” by the peak levels. 

Sensor field: The sensor field of the compressor can be intuitively altered with mouse 
movement. 

Ratio: This parameter controls compression intensity. 

Threshold: Adjusts the entry threshold of the compression. 

Attack: Adjusts the time in which the algorithm responds on the rising level. Short 
attack times can produce a ”pumping” sound as the volume is reduced or raised. 

Release: Adjusts the time in which the algorithm responds to decreasing levels. 

A/B: If you have selected a preset for the effect and later you change it manually, you 
can compare the original-preset-sound with the new adjustments using the A/B-
switch. 

Reset: Reset places the sound effect to the neutral starting position where no 
processing power is used and where no effect is calculated in the sound. 

Load/Save: Stores the current adjustments as an effect file in order to use them for 
other projects. 
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Enhancer 
The Enhancer enables the justification of the audio material in the stereo panorama to 
be adjusted. If the stereo recordings sound unfocused and undifferentiated, an 
extension of the stereo base-width can often provide better transparency. 

Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the complete 
panorama. The reduction of left and right levels is displayed under the control 
buttons. 

Pan-direction: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme 
left), unchanged base width (normal stereo), and maximum base width (wide, 
extreme right). Raising the bandwidth (values over 100) diminishes the mono 
compatibility. This means that recordings edited this way sound hollow when listened 
to in mono. 

Maximize strengthens the spatial component of the recording, which also increases 
the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to review the orientation of the signal in the 
stereo balance and the effect of the stereo enhancer. To maintain mono-compatibility, 
the "cloud" shown should always be higher than it is wide. 
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Echo / Reverb 
Reverb 

"Reverb" gives you a high-quality reverb which can be specified further using "Room 
Size", "Time" and "Color" and mixed into the original sound with "Mix". You can 
choose between various reverb styles in the presets. 

Room size: This controller controls a room simulator, which calculates the reverb 
effect according to the room size. If the controller is turned all the way to the left, then 
it sounds as if the audio object was recorded in a very small room. If it is turned all the 
way to the right, it sounds as if the audio object was recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" level. 

Color: Control the sound of the reverb here, dampen or brighten it. 

Mix: This controller determines how much of the unprocessed original sound (dry 
signal) is subjected to reverb (wet signal). 

Echo 

The echo effect is further refined with "Delay" and "Feedback" amounts and 
calculated into the original sound by means of "Mix". 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the left, 
there is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 
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Parametric equalizer (track effects, mixer 
channels, Mixmaster) 

 

This dialog contains a 4-band parametric equalizer. With the parametric 4-band 
equalizer, filters can be activated on four freely selectable frequency bands in order to 
adjust the sound of a sample. You can produce wide-band frequency adjustments for 
both high and low pass ranges as well as small-band corrections of specific frequency 
ranges. 

Use the Play/Stop button to activate the real-time preview function. This lets you 
check the acoustics of the filter setting before it is calculated into the sample by 
clicking "OK". 

Freq. (frequency): The center frequency of the individual filters can be set between 10 
Hz and 24 kHz with the frequency controllers. Freely choosing the frequency enables 
multiple filters to be set to the same frequency in order to have a greater effect. 

Q (Bandwidth): Here you can set the bandwidth of the individual filters to between 10 
Hz and 10 kHz. 

Gain: These controllers allow you to raise or lower the filter. Setting the controller to 0 
deactivates the filter and doesn't use CPU power. 

Volume: Use this controller to adjust the master volume should the level rise or sink 
too much while filtering. 
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Setup 1-3: Here you can switch between three different filter setups so that an 
acoustic comparison between the various settings can be performed, for example, 
during the preview function (Play/Stop button). 
 

MAGIX Mastering Suite 
MAGIX Mastering Suite is a special effect rack for use with the mixer master channel. 
Its effects serve the so-called "Mastering" with which the finished mixed music file is 
given its last one-over. 

The On/Off switches can switch the effects on and off individually. Each effect has a 
range of presets that can all be picked from a list along the lower border of the effect. 

The settings of all effects can also be saved 
together as one preset so that you can use 
your ideal mastering setting again for other 
arrangements. 

 
Each effect can be reset by pressing the 
"Reset" button. You can press the "Bypass" 
button to temporarily deactivate the 
effects. 

 

6 Band Equalizer 
The parametric equalizer has six filter bands that you can use to shape the sound of 
the music track. Each band is a filter with a typical "bell shape". Within a certain 
frequency range around an adjustable middle frequency you can increase or reduce 
the signal level gain. The width of this frequency range is called bandwidth. The 
bandwidth is defined by the Q value. The higher the Q value, the narrower and 
steeper the filter curve.  

You can influence the basic sound of the mix by increasing and decreasing the 
broadband so as to give it more "depth" (lower center 200-600 Hz) or more "air" 
(Highs 10Khz). You can also decrease the narrowband width (high Q-value) in the 
frequency response to remove disruptive frequencies. 
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Sensor field: The sensor field displays the resulting 
frequency response of the equalizer´. The frequency 
is displayed horizontally and the increase or decrease 
of the respective frequency is displayed vertically.  

The blue bullets 1-6  symbolize the six frequency bands. You can move them around 
with the mouse until you find the frequency response you want. 

 

You can control the output level of the equalizer with the Peak Meter . With the 
Master Gain Controller beside it you can offset the level changes resulting from the 
EQ adjustments. 

You can access additional settings for each frequency band by clicking on the bullets. 

 

You can use the knobs to set the values for each band. There is also a numeric field 
for each parameter where values can be entered. 

Gain: This controller allows you to raise or lower the filter. Setting the controller to 0 
deactivates the filter so it does not use any CPU power. 

Freq: The center frequency of the individual filters can be set between 10 Hz and 24 
kHz with the frequency controller. Freely choosing the frequency enables multiple 
filters to be set to the same frequency in order to have a greater effect. 

Q (Bandwidth): Here you can set the bandwidth of the individual filters to between 10 
Hz and 10 kHz. 
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Bands 1 and 6 are special: Their Filter Curves can be edited in three different modes. 
The four editing points in the graphic have different functions in each mode. 

 Peaking: Here the effect curve is brought closer to the working point (which 
represents the peak of the curve) from both sides simultaneously. 

 Shelving (Basic setting): Here the working point displays the beginning of the 
filter curve. From this point on there is a gentle increase or decrease in the 
frequency. 

 High or Low Pass:In Band 1 the working point displays the frequency which is 
filtered out of particularly high or low frequencies.  

 

Multimax 

 

MultiMax is a compressor with three independent frequency bands. The dynamics 
are edited separately for each band. 

The advantage of a multi-band compressor versus a "normal" compressor is that the 
"pumping" tendency and other unwanted side effects are dramatically reduced while 
editing the dynamics. For instance, it can prevent a bass top peak from "reducing" the 
entire signal. 

Multi-band technology also lets you specifically edit individual frequency ranges. 

Link: When this function is activated, when one slider is moved, all others change in 
the same proportion. However, the way the dynamics are edited is not affected. 

HiQ: When the "HiQ" (High Quality) setting is activated, more precise algorithms are 
used, which raises the processor load. It is recommendable to turn on this setting 
before exporting. 

Frequency band settings: Frequency band settings takes place directly in the graphic. 
Simply click on the separator lines and move them. 

Lo/Mid/Hi: These knobs control the degree of compression for each frequency band. 

Presets: In Multimax you can open various presets for various user cases. For 
example: 

Cassette NR-B decoder: Samplitude Music Studio 2013 simulates decoding of Dolby 
B + C noise suppression if a Dolby player is not available. Cassettes recorded with 
Dolby B or C sound more muffled and slurry if played back without corresponding 
Dolby. 



 

Effects and effect plug-ins 105  

 

Leveler: This setting automatically sets the entire material to an identical volume 
level. Access to volume control is hidden. This way you can even out steep volume 
differences between songs. To equalize volume variations between different songs, 
the function "Normalize loudness" is also provided in the "Effects" menu. 

DeEsser: These special presets serve to remove overly present "s" sounds in voice 
recordings. 
 

Enhancer 
The Enhancer enables the justification of the audio material in the stereo panorama to 
be adjusted. If the stereo recordings sound unfocused and undifferentiated, an 
extension of the stereo base-width can often provide better transparency. 

Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the complete 
panorama. The reduction of left and right levels is displayed under the control 
buttons. 

Pan-direction: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme 
left), unchanged base width (normal stereo), and maximum base width (wide, 
extreme right). Raising the bandwidth (values over 100) diminishes the mono 
compatibility. This means that recordings edited this way sound hollow when listened 
to in mono. 

Maximize strengthens the spatial component of the recording, which also increases 
the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to review the orientation of the signal in the 
stereo balance and the effect of the stereo enhancer. To maintain mono-compatibility, 
the "cloud" shown should always be higher than it is wide. 
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Limiter 

 

The Limiter prevents clipping by automatically 
lowering any volume levels that are too high. Quiet 
parts remain unaffected. Unlike the Compressor, this 
feature attempts to preserve the basic sound as 
much as possible.  

 

Digital Audio Meter 

 

On the lower border of the MAGIX Mastering Suite there is a digital audio meter 
which provides separate control method displays for 10 wave bands on each channel. 
This device is used for orientation purposes, e.g. selective equalizer editing. 
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Vintage Effects Suite (track effects, mixer 
channels, mix master) 
Analog Delay 

 

This delay offers creative playing along with common delay effects. "Analog" in this 
case means, for instance, that you can change the delay times while playing without 
the risk of typical, scratching artefacts developing. Instead, the times are softly faded 
out, similar to the old tape echo machines that used the tape speed to change the 
delay and where the system also had a certain sluggishness.  

"analog" in terms of this delay also means that typical tape echo sounds can be 
mimicked, e.g. tape speed fluctuations and reduced highs during playback 
("feedback"). The feedback has a two-band filter that can be used to create dark, high, 
or mid repetitions depending on the settings.  

These properties can be useful, for example to create "wild" dub/reggae-style delays 
that move towards the center of the sound with each repetition and even grind 
slightly. In this case, "analog" means that you cannot digitally overdrive the delay. 
Even in a 'looped' repetition, the signal cannot be distorted indefinitely, but it is 
compressed by an increasingly slight degree and distorted similar to a tape. 
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Analog delay parameter 
Analog delay has the following parameters: 

Delay type 

Delay type (l + r): Left and right delay times can be controlled separately (see below). 
You can choose a note value for the control pots to snap to. Even and syncopated 
note values from 1/2 to 1/32 are available. Note that the delay times are always in 
relation to the project’s current tempo. 

 Link button (lock symbol): Press this button to control the “delay type” pots for 
both channels simultaneously. 

Mix: Adjusts the ration between the original signal and the echo. 

Modulation 

Speed: The tape warble speed. Low values result in very light fluctuations, high values 
result in drastic warbling. 

Depth: The warble intensity. When this control is turned all the way to the left, there 
is no pitch modulation. For a subtle "analog" feel, we recommend a setting between 
the 9 and 11 o’clock position. 

Filter 

"Low"  This control progressively reduces the bass frequency as it is turned 
to the right, making the signal sound "thinner". 

"High"   Once turned all the way to the right, the control only attenuates the 
treble very lightly; turned completely to the left, the delay repetitions 
become progressively less treble. 

Feedback 

Width: This controls the stereo width of the delay repetitions. When you turn 
“Width” to the right, an additional effect is produced: the panning of the delays 
increases. This is commonly referred to as a "ping-pong" delay. 

Drive: When this control is turned all the way to the left, the delayed signal is 
repeated only once. Turned all the way to the right, the feedback is seemingly endless 
and the repetitions continue for a long time.  

The actual strength of the effect is dependent on the material, since the feedback loop 
(as explained earlier) is addressed via compression and uses a "tape saturation" 
effect. If you send a "loud" signal to the delay, then the feedback will sound longer 
than at a lower level as compression "brings it up" to a certain level. If you are used to 
"purely digital" delays, then this might take some getting used to, but it will probably 
sound "livelier". 
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Flanger 

 

The "Flange" effect is similar to that of the chorus, but does have a different technical 
and historical background. It came about by chance: Someone (various sources say 
John Lennon) slowed down one of two running interconnected tape machines in a 
studio with his hand. The result: The rather brief delay of the second signal compared 
to the first resulted in cancellations within the frequency spectrum, leading to a so-
called comb filter effect (the sum of both signals creates "peaks" and "lows" in the 
spectrum that look familiar to the teeth of a comb).  

Flanging is basically a chorus effect, but it has a lower delay time (less than 10 ms). 
"Release" or signal doubling is not highlighted here; the result is a much more creative 
frequency response deformation.  

A "complete" flange effect will definitely require feedback: The flange portion is 
returned to the input to increase the effect. People often talk about the "jet effect", 
since it resembles a jet on take-off. 
 

Flanger parameters 
Speed: Modulation speed. 

Depth: The overall amount of modulation. 

Feedback: The volume of the internal feedback loop. 
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Mode:  

Normal: Flanging. 

Dual: Two parts, panned left and right.  

Quad: Four parts, alternately panned left and right. 

Quad pan: Like “Quad”, but the “Depth” control also sets the intensity of the signal’s 
pan movements between left and right. 
 

Filter 

 

"Filter" is a "modulation" effect like chorus and flanger. However, it controls the 
frequency response of a modulation source as well as the pitch. There are various 
filter types and modulation sizes available for this.  

Possible areas of application are synthesizer sounds (filter sweeps on pads) or 
creative distortions of drumloops (e.g. for variations, fills, etc). With guitars you can 
create typical 'wah' effects: either by tempo modulation or in a special mode, 
modulation via the envelope curve. The decisive factor is the current signal strength 
above the frequency set for the filter. 
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Filter parameters 
Speed: The modulation speed is set by note values ranging from 1/1 to 1/16 (even or 
dotted). Similar to analog delay, the tempo information is automatically provided by 
the arrangement.  

A peculiarity of the final position of the controller:  
Tempo synchronization stops and modulation is controlled via the signal level. 

Freq: This is the base frequency for modulating the filter, and generally takes place 
above this frequency, i.e. the modulation increases the filter frequency. 

Depth: This control determines the modulation depth, i.e. the amount by which the 
speed control (or envelope mode, as described above) increases the base frequency. 
For extreme effects, turn “Freq” all the way to the left and “Depth” all the way to the 
right. 

Filter modes 

Low-pass 
 
A filter with a slope of 24 dB/octave and a small amount of 
resonance. The treble frequencies above the base frequency 
(cut-off frequency) are filtered steeply. This is great for 
filter sweeps on synth pads and drum loops. 

Band-pass 
 
Only the frequencies around the base frequency are passed 
through the filter (24 dB slope with resonance). Use this 
mode to create wah-wah effects for guitars. 

Band 
elimination 
(„Notch-Filter") 

 
Two parallel filters (–36 dB) with linked base frequencies 
create two ‘notches’ in the frequency spectrum. This allows 
you to create interesting sounds (e.g. guitar chords), and it 
sounds similar to a phaser. 

High-pass 
 
This mode achieves the opposite effect to the low-pass 
filter. Frequencies below the base frequency are filtered 
steeply. If you ‘thin out’ sections of your track (for example, 
a drum track) with a tempo-based modulation, this can 
sound very effective when contrasted with the full-range 
frequency spectrum (for example, if the filter is turned off 
for the next object). 

 



 

112   

www.magix.com 

Chorus 

 

The chorus pedal creates characteristic "floating" sounds which one typically 
recognizes from guitar or synth pads. You can add acoustic "depth" to an instrument 
to add more power to the sound or to create the illusion that it exists multiple times.  

The chorus sound is created by using the so-called Doppler effect. You probably have 
noticed this phenomenon daily life: The sound of an approaching ambulance sounds 
higher than when it is moving away. This effect is a result of the speed of the sound 
which first increases and then decreases, thus also changing the sound pitch. If there 
were a second siren at your location, an oscillation would develop between both 
sounds (just like when two instruments are out of tune). 

Chorus also splits the signal in at least two: direct sound and effects part. The double 
effect is created by a short signal delay of the effect.  

This delay is within the range of 10-30 ms (as in this one), this means that it is short 
enough to be perceived as an "echo". The times would also be similarly short if you 
were to double a guitar track for instance. A short delay in the mix already sounds 
"doubled" but is not authentic. This is where the above-mentioned "out-of-tune" 
effect comes in: The pitch of the effect signal is slightly modulated by gently "drifting" 
forward and backward in the delay curve. The result is a floating effect where the 
speed is influenced by drifting 
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Chorus parameters 
You can enter the following parameters to control the floating effect: 

Speed: Modulation speed. Low speeds create an even, continuous development. High 
speeds produce vibrato-like qualities, but can also result in an "underwater" effect. 

Depth: Modulation depth. This determines how strongly the speed affects the pitch 
modulation.  

Mix: This sets the balance between the direct signal and the effects signal.  

Mode: You can choose between four operating modes of the chorus effect:  

“Normal” is a combination of the direct signal and the detuned delay signal.  

“Normal, low-pass” is designed for bass-heavy signals like bass guitar. The bottom 
end of the signal stays clear and well-defined, the effect is only audible for the mid 
and treble frequencies.  

“Dual” makes the source sound more lively than a single "part". The sound is spread 
over the stereo panorama, which makes this mode seem "wider". The character of the 
sound becomes livelier than with a single voice only, and it is also distributed over the 
stereo panorama, making the mode sound "broader". 

“Quad, low-pass” is ideal for creating sounds such as deep synth pads with tight bass 
frequencies. 

Tip: Similar to the stomp boxes our vintage effects are modeled on, there is a 
"footswitch" below the pedal’s logo that can be clicked to turn the effect on or off for 
A/B comparisons. All the effects of the Vintage Effects Suite have been designed 
like this. 
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Distortion 

  

The distortion pedal is a "high gain" distorter for crunch and lead guitar sounds. If you 
like typically "British" amp sounds and want to quickly record a guitar track with little 
effort, this pedal is for you. 

An entire valve pre-amp circuit has been modeled, including the typical EQ curve. The 
amplification is "valve-typical", i.e. it doesn't start quickly but is harmonic and soft. 
Even at full power the pedal still reacts softly to a guitar and its settings (e.g. pick-up 
choice and tone controller). For instance, you can influence the distortion even more 
by using the volume knob on the guitar. 

There are only three parameters on this effect; however, these interact with each 
other and can thus generate quite a variable sound: 

• Low: The "bass" controller. This allows you to set the share of basses, even after 
the distortion. The type of prefiltering is important for guitar amps in particular, 
and is characteristic for the basic sound. You should set the bass controller 
depending on the basic sound of the guitar and the sound you are aiming for 
("powerful" or "cut"). 

• High: Mainly controls the share of highs before and after the distortion. If you are 
not using an external guitar speaker as a monitor, we recommend setting the 
controller to the middle position or even moving it slightly to the right. This way 
the "sharp" highs disappear, which all guitar amps generate without the suitable 
loudspeaker. At the same time the mids stand out more, which gives the sound 
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more "kick". On the other hand you can further emphasize the highs if you want 
the sound to be more neutral.  

• Drive: The level of distortion. This controls the amplification used to operate the 
"virtual valve circuit" (max. 60 dB). As the level increases, the valve goes into 
overdrive and generates typical distortions. For a slightly distorted sound 
("crunch"), it's sufficient to set the controller to 10-11 hours at maximum; the 
modeled circuit also provides the usual "weight" for power rock chords, and 
more. The further you turn this controller to the right, the more the mids of the 
signal move to the fore so that the "high-gain" lead sound is better heard.  

You can also use the distortion effect in combination with the amp simulation! 

 

BitMachine 

 

Audio material can always be edited into high quality with Samplitude Music Studio 
2013. Nevertheless, there are some situations, for example, a more imperfect lo-fi 
sound would perfectly suit a drum loop or a synthesizer sound. 

Remember, for example, the first hardware samplers from the 80s that usually only 
ran at 8 or 12-bit rates and at low sample rates. With the BitMachine, changing the 
sound with such an "antique" device is no problem. 

You can use the BitMachine to bring back to life the times when minimalist and 
scratchy soundchips in home computers were commonplace. 

The BitMachine opens up a gateway to "acoustic time travel" where you can 
encounter bit and sample rate reduction and downstream filters based on analog 
models.  

Furthermore, the effect has a modulation section with which you can control 
individual parameters using an oscillator (LFO) or the input signal.  

We have designed a range of "typical" presets to demonstrate the time travel abilities 
of the BitMachine. These can be opened at the top right of the interface 

The following section describes the details of BitMachine: 
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"Filter" section 
The filter in the BitMachine is a digital model of one of the most well-known filters in 
music electronics, i.e. the "Chamberlin 2-pole" filter used in old Oberheim 
synthesizers. These types of filters sound exceptionally musical. They can also be 
used quite creatively in the BitMachine, but should not be used exclusively to smooth 
out existing artifacts.  

The filter works in the so-called "high-pass" mode, i.e. it lets through deep frequency 
(or medium) material according to setting, and dampens highs and medium areas. 

Freq: 

You can specify the cut-off frequency of the filter using "Freq". Filtering starts above 
this frequency. 

Reso: 

The signal in the area around the cut-off frequency can be strongly elevated to just 
below self-oscillation. Sharp, cutting sounds are possible at this level, and the effect 
becomes even clearer when you vary the cut-off frequency. 

Drive: 

Both of the individual filters of the connections mentioned above have the ability to 
overmodulate themselves internally. With the "Drive“ dial, you can regulate the 
amount of overmodulation. The more you turn this dial up, the more the signal is 
overmodulated. In this case, the parameters of the internal workings of the filter 
interact with one another. Increasing drive weakens the resonance, but, at the same 
time, the signal gets more volume, more bass and becomes acoustically fuller.  

Note: The two smaller dials from this section are explained under "Modulation". 

 

"Modulation" section 
You can automate your effects via the settings in the modulation section. 

Here, you’ll find the so-called low frequency oscillator (LFO), which resonates with 
adjustable speed. You can influence the speed and type of resonance. 

To influence the resonance, use the two small dials in both the reduction and filter 
areas. These four dials display modulation targets.  

Example: You’ve left the dial for the sample rate at its default setting. Change the 
small dial beneath from its middle position to either side. The modulation for the dial 
value is added to the sample rate: The LFO now controls these parameters 
proportionately and the sample rate reduction resonates at this modulation. 
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You can use this technique on other dials as well. You just have to make sure that the 
main dial isn’t turned up to full, because then the modulation wouldn’t have any 
effect. The modulation is always added to the set value. 

Example: Turn the small dial beneath the "bits" dial fully to the left (Value: -50) and 
the one beside it (beneath "sample rate") to the right (+50). You’ve now assigned a 
modulation to both parameters with the LFO. They are not changed uniformly, but 
rather opposite to one another: A negative setting is nothing more than an inversion 
of the modulation, so you’re effectively turning down the control signal. 

Waveforms of the modulation section 

We’ve already explained this example with the help of sine oscillation. The LFO can 
be in: 

• Sine form 
• Square wave (0 or 1, no intermediate level) 
• Random value (an internal randomizer will be queried at the set speed) 

Oscillator speed 

The LFO speed is specified with the "speed“ dial. If the "sync“ button is active, then 
the LFO adapts to the song speed, and the dial locks musical values into place (e.g. ¼ 
note). Rhythmic paths of the sound distortion are therefore enabled. You can also 
switch off this synchronization and set the speed manually (in Hz).  

Modulation with the "Envelope follower“ 

In the modulation section you’ll find a fourth button, the audio input signal. If this 
mode is active, then the signal itself can be called upon to extract “modulation 
tension”; a so-called "envelope follower" continuously scans the volume of the input 
signal. 

Note: The BitMachine doesn’t recognize the type of audio signal automatically. For 
this reason, you should set the input sensitivity roughly with the "gain“ dial. To do 
this, use the control LED: With accurate detection of the signal dynamics, assigning 
the four small dials to modulation lows is easier and you can use the full control 
range.  

In envelope mode, the "speed“ dial is used to control the response speed of the 
envelope (the display now switches to milliseconds). Lower times result in a faster 
response, higher times make the envelope rise (and fall) slower. You should 
experiment with the signal according to its complexity. The presets provided can only 
point you in a rough direction. 
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"Reduction" section 
Bits 

This dial controls the resolution of the audio material. Turning the dial to the left 
results in 16-bit quantization (CD quality). The further it is turned to the right, the 
lesser the signal dynamic becomes. In extreme cases (1-bit), there are only "on“ or 
"off“ states.  

At the intermediate levels, you’ll notice an increase in the background noise and a 
decrease in the dynamics. For example, 8-bit quantization will exhibit dynamics of 
only 48 dB. Quieter points in the material sound noisy and very quiet points sound 
"capped“. This effect is amplified the more you turn the dial to the left until it starts 
crackling or "groaning". 

Sample rate 

The audio material is "down-calculated" with this dial, i.e. the internal sample rate is 
reduced. A new separation ratio between old and new rates is created. In relation to 
this ratio, a sample from the data stream will be "dropped“ at the various points. 

Note: The two smaller dials from this section are explained under Modulation. 

 

Tape simulation (plug-in) 
Tape simulation offers you the possibility of giving your recordings an "analog touch" 
by imitating typical aspects of a tape recording. In a lot of studios, 1" and 2" tape 
machines are still used because they are thought to create a fullness of sound, 
"warmth" and "saturation" that contrasts with the more neutral and analytical sound 
of digital technology. 

There are numerous factors that are decisive for the sound expressiveness of tape-
based recordings. Some of these are: 

• Distortions that occur when the tape is played in the saturation range, 
• changes to the frequency response, since recording and playback-side filter steps 

prepare the signal. All machines also feature more or less pronounced peaks in 
the frequency spectrum, above all in the bass range (so-called "head bumps"), 
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• loss of highs through self-erasure resulting from the HF stream ("bias", pre-
magnetization) and intermodulation between the wanted signal and the HF 
signal. 

 

Level: Sets the input level. You decide when the "virtual tape" is saturated and how 
strong the effect of this color effect should be. The signal will gain more "loudness". 

EQ low/hi: Adjusts the frequency response (spectral balance controller). You can 
choose whether you would like the output signal to have a richer bass level or 
whether it should have more highs. This adjusts the pre-filtering at the "recording 
end" as well as playback equalization. 

However, please note that the frequency response of the simulation will not be 
neutral even if the "EQ low/hi" controller is set to neutral. There will always be some 
slight frequency-selective amplification.  

The distortion resulting from use of the tape simulation can quickly create "acoustic 
fatigue", especially for material that is rich in highs. A direct 1:1 comparison with the 
tape section switched off reveals the differences more easily. Slight editing with the 
simulation is generally sufficient to achieve an "analog touch". 
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essential FX 
MAGIX essential FX is a collection of "bread and butter effects" for the most 
important applications. They are embedded as VST plug-ins (MAGIX plug-ins 
directory) and may be used in the object or in the track. For object application, see 
"FX plug-ins" in the "Audio effects" chapter or "Track effects" in the "Mixer" chapter. 

These are simple but solid tools with clear feature sets for daily application. They 
include fewer controllers and require less resources. 
 

MAGIX Plug-Ins 
Console 
Some MAGIX plug-ins show a so-called "Console at the top edge when they are 
opened – a display bar for managing presets with expanded settings options. 

 

A menu containing available presets is located behind the display. To the right is a 
prev/next button, which lets you leaf through presets. 

 Presets can be saved with this button. MAGIX  plug-ins use its own save 
format (*.fxml) 

 
You can return the presets to their initial settings by clicking on the 
"Reset" button. 

 
Bypass switch: Routes the signal directly to the output instead and 
bypasses processing. Internally, processing is continued so that you can 
toggle between processed and unprocessed material anytime. 

 
A/B comparison: Very useful for trying out settings. The controller setting 
"A" memory is normally activated when the interface is opened. 

As this is the initial status, "B" also contains the same settings. If you would like to 
experiment without losing the current setting, press the "B" buttons and try other 
settings. To transfer the values to "A", press the copy button between the two letters. 

 
"?" button: This opens the online help for the plug-in. 

 

Parameter Smoothing 
Each plug-in offers soft controlling. Pot settings are softly faded internally from the old 
value to the new one. This is particularly noticeable when playing in "Live" mode. Due 
to performance reasons, switches (e.g. on/off) and some settings of VariVerb Pro 
that change delay times directly or indirectly are excluded from this action. 
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Vpot Controls 
Some controllers snap to the middle setting, which may be useful for quickly returning 
to a "neutral" status. It is extremely difficult to adjust the fine settings within close 
proximity of this snap point. You can temporarily deactivate this snap mode by 
holding "Shift" before touching the controller. 

Use the mouse wheel to adjust the controllers. A combination of the mouse wheel 
and "Shift" key reduces the increase/decrease by factor ten. 

Apropos the controller movement, note that all plug-ins follow the host settings 
regarding linear or circular mouse movement.  You can usually choose whether you 
prefer up/down or a circular movement to adjust the value. 
 

essentialFX presets 
By clicking on the tool symbol in the graphic display, you can open the presets.  

Under "Tweak" you can find specific settings options for each effects device. 

Under "eFX Globals" you can find settings options for graphic level display as well as 
mouse control. 

 

eFX Globals 
These settings are valid for all essentialFX. 

Metering: Here you can set the meter display.  

• Decay Time controls reaction speed.   
• Peak Hold controls the hold of the highest peak. 
• Brightness controls the display brightness. 
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Mouse: Here you can set the display reaction to mouse movements in the essential 
FX graphic display. 

• Linear mode lets the faders move in response to vertical and horizontal mouse 
movements. 

• Circular mode lets the faders be controlled by circular mouse movements. 
• Mode As Host lets the faders move in response to the mouse exactly how mouse 

settings in Samplitude Music Studio 2013  specify it. 
• [Shift] Factor specifies the factor for fine adjustment of individual faders with the 

mouse with simultaneously held Shift key. 
 

Chorus/Flanger 
This plug-in offers a simple way to make signals sound more interesting, "spacier", 
thicker, etc. by modulating or delaying the pitch - the classical domain of application 
is for guitars, Hammond organs, electric pianos, or synths. 

Chorus and flanger are two closely related effects, which are combined into a single 
plug-in. They normally differentiate in terms of delay time, type of modulation, and 
degree of internal feedback. 
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Chorus flanger parameters 
IN / OUT: Here you can set the input and output level. 

mode: 

- Stereo chorus:  Compared to mono chorus, two copies of the original are created, 
modulated against each other in pitch, and then fed accordingly to the set mix ratio to 
the left and right output channel. 

- Mono Flanger & Stereo Flanger In contrast to the Chorus Effects the lower delay 
periods and a slightly changed modulation are processed. 

- Ensemble: This creates a denser chorus, similar to Boss/Roland CE-1: Instead of two 
voices, six are generated. Two internal sine LFOs for de-tuning, whereby for both 
LFOs the second and third voice phase length by 120°. This results in a denser-
sounding effect that is also less warped. 

• Rate: This specifies the speed of the modulation. Lower rates provide slight 
hovering effects, and high speeds produce a wobbling, typically distorted 
"underwater" sound. 

• Depth: This parameter specifies the depth of the modulation, i. e. the maximum 
deviation of the modulation and the resulting pitch bending. 

• phase: This fader moves the right channel's oscillator phasing relative to the left, 
wave is put back to the right. So that the Tremolo effect drifts apart in the stereo 
field with ever increasing values. At 180° both oscillators work in reverse, 
therefore the stereo effect is at its strongest. 

• Feedback: This parameter defines the portion of the delay that is sent back to the 
input. Feedback causes the effects of modulation to be more drastic and cutting. 
Nullification of the feedback is set at the middle of the fader. Set to the right, the 
feedback is fed to the input equi-phasal; to the left, the feedback occurs. Both 
variants may sound very different depending on the signal, since they prefer 
different frequency ranges for dissonance. 

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Low Cut: This knob sets the filter frequency of a high-pass filter. Signal 
components below this frequency will be filtered out. 
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Phaser 
The phaser is often mistaken for a flanger due to its typically sharper and cutting 
effect. In any case, the pitch is not modulated. Instead, the modulation process 
burrows multiple notches into the frequency response, somewhat like a comb filter. 
Just like an airplane taking off, the phaser functions with a similar jet effect. It is 
suitable for enduring signals like synth surfaces or for producing sound designs to 
create atmosphere or distortion effects. 

 
 

Phaser parameters 
IN / OUT: Here you can set the input and output level. 

Mode: The selection includes a number of filter stages. At 4 stages/8 stages, a more 
plastic effect is achieved, and more complex patterns are reached at 16 stages. Please 
note that the more stages are involved, the more computing time will be needed. 

• Rate: Speed of filter modulation. The essential effect is the same for both chorus 
and flanger. 

• Depth:  Similar to chorus/flanger, whereby it's the filter notches that are 
addressed, and not the pitch modulation. 

• phase: This fader moves the right channel's oscillator phasing relative to the left, 
wave is put back to the right. So that the Tremolo effect drifts apart in the stereo 
field with ever increasing values. At 180° both oscillators work in reverse, 
therefore the stereo effect is at its strongest. 

• Feedback: The feedback portion produces a more drastic effect in this case. 
Similarly to the chorus/flanger, co-phasal or opposite-phase feedback is possible.  
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• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Center Freq: Sets the mid-frequencies of the phaser. The filter modulation acts on 
these frequencies. 

 
 

Stereo Delay 
The stereo delay is a simple too for typical bread and butter delay effects. The stereo 
delay offers the "analog algorithm", which features the sound of echo devices of 
yesteryear. 

 
 

Stereo delay parameters 
IN / OUT: Here you can set the input and output level. 

Mode: This selects between the essential algorithms. 

Digital: Normal, transparent delay 
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- Analog tape: Analog tape delay simulation. In this mode, a band echo is simulated 
with a typical compression and saturation behavior, including phase shifts with high 
feedback settings. 

Analog BBD: Simulation of a bucket brigade delay (BBD, bucket brigade delay). These 
devices, which originate from the pre-digital era, used analog building blocks for 
storage. The signal was held for a short time in a relatively simple circuit and then 
moved on to the next. This "bucket brigade" principle created a longer signal delay. 
BBDs create different delay times by varying the system beat (clock), meaning  that 
for short delays the beat is faster, and for longer it is slower. 

• Tempo sync: If this button is active, the plug-in is directed at the host/sequencer 
tempo. In this mode, changes are made to the delay period via the L/R delay 
using the musical snap grid (e. g. 1/4 note). 

• Delay L/Delay R: Specify the delay period for the left and right channels here. 
• Damping: This specifies the cut-off frequency at which the highs are dampened 

during the delay. This useful  for making the delays reverberate more naturally or 
for creating special effects (reggae/dub-style effects). 

• Feedback: This parameter regulates the internal amplitude of the delayed signal 
that is fed back to the input. In "Digital" mode, this process is completely 
transparent; in "Analog", on the other hand, higher values, a very loud input 
signal, or the sum of these will make the use of dynamics compression audible. In 
both modes, the nullification of the feedback parameter is in the center of the 
fader. To the right, the plug-in works in "Dual delay" mode (both sides work 
independently), and to the left, "Ping pong" mode will be activated (the delayed 
signal alternates between the left and right sides). 

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Feedback Low Cut: This control sets the filter frequency of a high-pass filter for 
the "feedback". Signal components below this frequency will be filtered out.  

• Tape / BBD Noise: Here you can control system noise for both analog modes. 
Especially if you work with high feedback rates, noise can create quick or stable 
oscillation, making the effect even more authentic. 

• BBD Stages: Here you can determine the count of  For very long delays, chips 
with many memory cells are used. This explains why bucket brigade echoes with 
long delays sound so muffled and dirty. Please keep in mind that the shorter the 
delay, the faster is the "virtual" system beat. For performance reasons, the system 
beat is limited. The limit is displayed below the delay control (with deactivated 
"tempo sync") as soon as it is reached, e. g. 46 ms (min). 

• BBD Compander: Here you can simulate Compander settings. Due to per-cell 
loss, BBDs have low system dynamics. For this reason, some have an integrated 
compander (compression at the input, counter-expansion at the output). Strong 
compander settings interact noticeably with the input signal, especially with high 
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feedback, because the input effects the expansion ration at the output, even 
when there is no signal at the input. 

• BBD Clock Drift: This parameter can add drift (during audible jitter effects) by 
slightly varying the system beat of BBD cells. It works similarly to an LFO, but is 
randomized. 

 
 

Vocal Strip 
This plug-in combines several components in one special tool which is ideal for 
working with speech or vocal tracks. Virtually all recurring voice signal edits are 
integrated in a compact, simple interface. 

 

The signal flow is set by the e_FX_VocalStrip and is directly represented by the 
position of the fader. 
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Vocal Strip Parameter 
IN / OUT: Here you can set the input and output level. 

• highpass: This fader determines the cut-off frequency for a steeply sloped 
highpass filter (24dB/octave) to remove part with low frequencies, such as 
rumbling or noises created when touching the microphone. 

• gate: With gate you can attenuate the signals that fall below the threshold. Here, 
a smooth curve and a maximum 'softening' of up to 24dB is used to avoid hard 
transitions. 

• DeEsser: The effect is very similar to that of the eFX_DeEsser. Here, however, the 
application frequency is set. The filter used in eFX_VocalStrip works in another 
range. The fader determines the degree of reduction. 

• compression: For the most part, an eFX_Compressor component contributes to 
working parameters for optimizing voice recordings. The further the fader is 
turned the lower the threshold and higher the compression ratio. The Attack and 
Release times are selected according to the program.  

• tone: This EQ corresponds principally to the filter network, which is also used in 
the eFX_TubeStage plug-in. With this you can simply and effectively calibrate the 
sonic balance of the voice signal, e. g. for better integration into the mix. 

Tweak  

• DeEss DetFreq: Determines the frequency of the filter used for detection, and 
filter blocking in the signal route. Typically the sibilants in speech or singing 
voices are in the 6 - 8 kHz range. 

• CompAutoMakeup: The maximum level is retained while overall level is reduced. 
• Comp Attack: Here you can determine how fast the compressor responds after 

reaching the threshold. 
• Comp Adapt.Rel.: Rising values cause the compressor to work increasingly with 

"Adaptive Release". This means that the longer and harder the compressor 
intercedes upstream in the signal path, the longer is the resulting release phase.  
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Note: Detailed information about compressor-specific settings can be found under 
"essentialFX > Compressor > Compressor Parameter (view page 129)". 

 

Compressor 
This plug-in is a simple but effective tool for reducing the dynamics of a signal. 
Percussion tracks may be modeled more compactly and with more pumping, vocals 
may be integrated into the mix better, or the entire sum or group or signals may be 
made denser. 

In contrast to some other plug-ins, this type works the compressor with a 
comparatively soft curve and an adaptable regulation process, it therefore 
compresses completely musically. Additionally a separate input (external sidechain 
signal) can be defined as the regulation source. 

 
 

Compressor Parameter 
IN / OUT: Here you can set the input and output level.  

Internal sidechain corresponds with conventional methods; this selects the actual 
input signal to control the compression process.  

If another track in the project triggers the compression, select External sidechain 
here. This will use a second stereo track routed to the plug-in. Make the regular 
adjustments in the arrangement to route the sidechain signals. 
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soft clip: Soft clip is switched on directly at the output in order to catch any 
overmodulations. 

• SC filter: This fader determines the application/middle frequencies, that are 
filtered with the control signal for level detection. The filter works selectively as a 
high-pass, band pass or low-pass. In many cases evaluating the detection is a 
good for optimizing the leveling process. So, for  example "high-pass" filtering 
enables complex sources (drums or sum signals) to achieve consistent regulation 
without typical pumping artifacts, since the process is mainly activated via mids 
and highs.  

• Using the filter type switch the properties of the detector circle can be drastically 
changed. The speaker symbol is there to preview changes.  

• Threshold:  This sets the response threshold for regulation. For example, -20 dB 
indicates that the input/sidechain signal is only compressed once it reaches -20 
dB; below this level, no change or hardly any change will take place. Note that 
this plug-in deals with the threshold window independent of the program. It can 
be the case that a small regularization has already taken place at -25dB. This so-
called soft-knee characteristic ensures a soft, musical compression process. 

• Ratio:  This parameter regulates the compression ratio. For example , a value of 
10:1 means that when the threshold level is reached, the input level is increased 
by 10dB, while the output is only 1dB louder. A lower compression, e. g. 2:1, is 
recommended for subtle compression of group or sum signals, while 50:1 
produces a very hard limiting that cannot be made inaudible by even the most 
transparent compressor. 

• Attack &  release: This parameter specifies how quickly the compressor responds 
when the threshold is reached (attack) or how quickly the signal applies normal 
amplitude once the signal drops below this level (release). The transient time 
settings can be defined in another area. Note that due to the adaptable plug-in 
leveling actual times may differ. This semi-automatic process favors quick 
adjustment, without leading to the often dreaded artifacts (rough sound image 
with rushed regulation, overly low/inefficient compression with long time 
constants). 

Tweak  

• Adaptive release: With increasing values, the compressor works increasingly with 
"Adaptive release". This means that the longer and harder the compressor 
intercedes upstream in the signal path, the longer is the resulting release phase. 

•  Auto makeup gain: Normally, you have to continuously adjust level reduction to 
generate "compression" at the same maximum level. This is done by activating 
auto makeup gain. The volume difference expected from the set working 
parameters is determined and applied as an output factor after master regulation. 
If you prefer to adjust the "classic" level reduction and amplification manually, 
you can deactivate this function. 

• Mix: Addition of the original signals is done to get transients and spectral balance 
form the source. A "mixed" signal is particularly discreet, more transparent, and 
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less "squishy" with vocals, whereby the compressed part usually has a higher 
level reduction than without adding the original. 

 
 

Vandal SE 

 

Virtual Guitar & Bass Amplification 

VANDAL is a complete simulation suite for guitarists and bassists. The plug-in is 
capable of simulating the entire signal chain, from input to stomp boxes, amplifiers, 
microphone loudspeaker boxes and post-processing studio effects, all in top quality. 
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Quick start via preset selection 
Would you like to know about everything that's possible with Vandal SE? Play 
yourself or use some of the presets. These are available via the list in the upper edge 
of the interface.  

A preset includes all settings for the main elements of Vandal SE: Stomps, amp 
settings, cabinet simulation, and studio effects. 

 
 

Tuner 
The best amp or the best simulation is useless if the guitar is out of tune. VANDAL 
offers its own chromatic tuning device for this. You can use it like any analog device: It 
automatically displays the note that has been struck (in octave) and the display 
visualizes deviations (in cents). 

 

The following describes the major components of VANDAL. The stations are 
described according to their position in the signal chain. 
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Input 
The station that you will most likely want to activate first is the input controller. Just 
like with a genuine guitar or bass setup, it's important to ensure the highest possible 
input level, in order to work optimally. This is even more important for distorted 
sounds and natural high-gain playing styles. Use metering  for this, too.  
As required, activate the noise gate and adjust it so that it lightly suppresses the input 
signal during pauses in playing. VANDAL does not cut the input on classic gates too 
hard, but rather regulates them finely via the signal energy beginning at the highs 
(where noise is most audible). 

 
 

Stomp boxes 
The real world has produced a series of effect devices popular with guitarists and 
bassists in the "stomp box" format. We've also included a rich palette of these 
devices. Vandal SE includes four "stomp slots" that can be equipped with effects from 
the list. The signal flow within this chain runs from left to right. Since all of the 
controls are self-explanatory, we won't describe them here. 

 
 

Vandal - Amplifier 
Vandal SE basically offers 2 different amplifiers: Guitar Amp and Bass Amp. The 
amplifier type depends on the selected preset. 

During development, a large selection of famous amplifier brands and models were 
not included. To guarantee that you are nevertheless able to get a number of different 
sound characteristics out of your Vandal SE amp, the amplifiers are set up variably. 
Internally, circuit designs work absolutely the same as the real devices. In several 
ways, however, Vandal SE goes in its own direction in terms of the sound it offers. 
 

Guitar amp 
The Vandal SE guitar amp offers three different pre-amp modes and two switchable 
end stage models. These basic configurations differ according to the selected preset.  

The guitar amp is set up with three channels. These may be set up with the pre and 
post gain controllers per channel (Clean, Crunch, and Lead) for the desired mix ratio. 
Don't worry about switching things around: The amplifier will remember the gain 
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settings when channels are changed. These are the gain presets for the different 
playing styles within a song. 

 

Voicing: We have provided Vandal SE pre-amps with something that we call Curve 
EQ. For example, if you take a simple EQ pedal and shape the signal a little before the 
amp, then this may change the sound quite drastically. Curve EQ does something 
similar: It's located (in some cases multiply) at strategically important points between 
individual amplifier stages and filters the signal, before it is distorted by the next 
stage. Move the curve in both directions and navigate through the spectrum using the 
"Freq" controller. This will give the amp a completely different character... 

Equalization: The actual sound control (the "tone stack") functions rather 
conventionally: Vandal SE offers low, mid & high settings. Everything functions like 
the passive sound regulation network in genuine amps, so that the controllers 
influence each other to produce numerous variations. 

Reverb: Surf and twang simply need on-board spring reverb. We relied on well-known 
reverb springs for modeling. Everything sounds natural with complete authenticity. 
 

Bass amp 

 

After roughly setting the Gain controller, the bass signal will first be treated with the 
Contour circuit. This filtering stage works similarly to the "Loudness" function by 
cutting the (lower) mids and lifting the deep bass and highs. It's sort of like an "instant 
slap". 

Next, the signal passes through the compressor stage (Comp). This is a simple but 
extremely musical, visual design: The bass triggers a light source that is coupled with 
a photo resistor which dampens the signal. This may already be familiar to you from 
the most famous studio compressor for bassists, i.e. Urei LA2A, which functions 
according to the same principle. 
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After any possible compression, Drive provides the option to take the bass sound to 
the next level. Saturating the signal takes place depending on the frequency: In spite 
of a possibly high level of distortion, the basses remain relatively clean and contoured. 

The equalization stage offers 4 frequency ranges, whereby the two mid bands are 
variable. The final master volume controller specifies the volume of the final stage. As 
with the guitar amp, the end tubes are also engaged in this case as much as remains 
sensible. 
 

Rack effects (FX1/FX2) 
There are effects that don't always work well before the amp, e.g. reverb or delay, 
especially when they are distorted. Normally, these effects are better placed at the 
end of the signal chain. 

For final processing and enriching, we offer two separate studio-quality effects units 
just like real 19" rack devices. 

Many algorithms create a stereo signal. Take care that the sequencer track operates 
the duct in "stereo" mode. 

 

Effects units may be selectively operated one behind the other (serial) or parallel. 
Switching may be changed via the mode switch. 

The following algorithms & effects are available: 

• Mono delay (msec & tempo sync): Possibly a simple delay with free selection of 
delay time or synched to the sequencer tempo with a musical raster. In case of 
high feedback values, a reduction of the damping frequency is required to provide 
naturalness to echoes. 

• Stereo delay (msec & tempo sync): Like mono delay; features two models. 
Repetitions may take place on separate channels (feedback controller to the right: 
dual delay) or in ping-pong mode (controller to the left), whereby the signal 
alternates between the sides.  

• Chorus: Produces a typical "floating/shimmering sound" by modulated detuning 
of a signal to "thicken up" its sound or spread it across the stereo field. Detuning 
is achieved by a short delay, the length of which can be varied by the modulation. 
This produces the so-called "Doppler" effect and broadens the signal. 

• Flanger: Algorithmically similar to chorus, but different in that the delay time is 
significantly lower and delay works with repetitions (feedback). A flanger sounds 
more "cutting" and up-front than a chorus. 

• Phaser: A modulation effect just like chorus & flanger, but in this case no 
detuning takes place. Filter components periodically alter the signal's "phase 
response" (principle of the "phase shifter"). Characteristic notches are produced 
in the frequency spectrum response (comb filter effects). 
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• Room reverb/hall reverb: Reverb offers realistic simulation of realistic 
reverberation. Room creates the impression of a small to mid-sized recording 
room, while Hall produces the sound impression of a concert hall. A particular is 
that both effects algorithms provide a modulation parameter, which may remove 
possible resonance at low dosages and can produce a soft chorus effect at higher 
values. 

• LoFi: This algorithm gives the sound a little bit of "grit", or a certain measure of 
signal destruction depending on its setting. Turn down the internal sample rate as 
much as you like to steal a few bits from the sound's resolution. This is definitely 
unconventional... 

• Vintage compressor: Ideal for thickening up the signal a little. The algorithm 
emulates an older popular circuit design that is similar to studio legends like the 
Urei 1176 or simple compressor pedals. A so-called "FET building block" controls 
the volume via the input level simply, effectively, and quite musically, as well as 
the set compression ratio and the attack and release. 

• 3-band EQ: This sound controller works like a conventional mixer with controller 
for bass, highs, and two controllers for the (variable) mids. This adds the final 
polish to your sound. 

 

Analogue Modelling Suite: AM-Track SE 

 

am-track SE is a pure analog compressor simulation. The tape simulation contained in 
the full version (Analog Modeling Suite am|track http://pro.magix.com/de/audio-
plugins/analogue-modelling-suite.175.html) isn't included. It is primarily used for so-
called "tracking", i.e. editing individual channel strips or subgroup signals. The 
compression takes place in the "vintage" setting, whereas an additional "vca" setting 
is available in the full version. The plug-in recognizes the number of incoming signals 
and, if necessary, edits the signal in mono. 

am|track SE limitations compared to the full version: 

• No Tape simulation  
• no "VCA" mode in the compressor, only "Vintage" operation can be implemented 

along with the presets. 

http://pro.magix.com/de/audio-plugins/analogue-modelling-suite.175.html�
http://pro.magix.com/de/audio-plugins/analogue-modelling-suite.175.html�
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• Some Expert compression settings (view page 141) are integrated in the interface, 
parameters: "ahead" (pre-delay) and "adapt release" (switchable release 
automation) are missing. 

(Release automation is always activated in the SE Version, which corresponds to the 
set value of the middle setting of the 'capacity' controller.) 

Below, am-track is explained and its features compared to "normal" software 
compressors and available features. 
 

Compressor Section 
Two completely different compressors work in AM-Track, each with their own 
independent control and sound methods. 

You may be wondering why we mention sound when talking about a compressor, 
since compressors merely relate to control actions. This isn't as simple as the idea of 
"making loud quiet".  

Various designs, algorithms, and topologies for solving the actual problem (dynamic 
reduction), which all have their own unique character, have come from the history of 
analog and digital signal processing. For example, pre-filtering in the detector circle 
and the type of detection have a large influence on the audio results. Plenty of 
hardware compressors have the same established VCAs (voltage controlled 
amplifier), but they all sound different and influence a signal, an entire production (or 
even a genre) with their "signature sound". We intend to provide you with acoustic 
variation via these dynamic tools in the digital world. 

The two operating modes of the AM-Track may be selected using the switch 
"vca/vintage": 
 

VINTAGE Mode 

 

This mode appears as a preset when AM-Track is started. It has 
less parameters than the VCA mode and has audibly less of a 
"surgical" quality, but more of a trimmed sound character. 

"Vintage" mode simulates a circuit design from the time when VCAs were not yet or 
could not be fully implemented. Instead, a FET (field effect transistor) was often used 
as a controllable resistor. This, together with constant resistance at the circuit's gate, 
builds a so-called voltage splitter, i.e. this forms a resistance change at the FET 
(caused by a change in voltage at its gate), which results in a damping of the input 
signal. A very simple detector circuit is used to activate the FET, which obtains its 
signal from the output of the compressor (behind the whole control circuit).For older 
designs, this feedback loop provides a stabilization of the work parameters and is one 
of the decisive factors for the often-quoted soft and musical compression of 
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exponents of this design, e.g. the Urei 1176 or 1178. The control circuit sees the layout 
of its previous work and oscillates to the signal. 

 

The disadvantage: The set time parameters for attack and release depend slightly on 
the program. In some cases, it's actually advantageous with vocals, bass, or even 
drums (e.g. subgroup, ambience, mics). You should rely completely on your ear for 
this. 

Because of the feedback topology, the maximum gain reduction is usually lower than 
VCA devices with forwards detection, usually 20 dB. This way, there is almost always 
a level-matching amplifier in the feedback loop. The "drive" fader of the AM-Track 
regulates the so-called feedback amplification. This can be so high that the detector 
be saturated by a loud input signal, resulting in signal peaks being swallowed up. 
Simultaneously, the setting becomes more intense as quieter signals also start 
reaching the threshold. You can creatively implement this according to the situation 
to create complex signal compression, which doesn't much sound like dynamic 
compression due to the transients that slip through and release at high "drive" levels. 

The stated release of the signal, technically known as a ratio reduction, is also caused 
by the centerpiece of the circuitry: the FET. Level reduction works entirely as a 
function of its characteristic curve, resulting from the non-linear behavior of this 
element. The FET virtually comprises part of the input resistance of the compressor 
circuit. As a result, the input/output response curve does not create a plateau when 
"drive" is high, which would be the case for a reference line featuring a high ratio or 
even limiting. A saturated FET may no longer complete the job it was marked out to 
do, i.e. to keep its output at low Ohm values. Once again, signal peaks pass through 
the entire circuit unaffected, but the average level may be compressed severely. From 
a technical point of view, the control process appears incomplete, but sounds 
pleasantly open and airy depending on its application.  

The entire detection is dependent on the spectral balance in the virtual AM-Track 
circuit, the highs are automatically less strongly compressed, so that even extreme 
settings sound less flat and more lively. 
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It's the same story with deep bass. On closer listening, you'll find that with strong 
compression, the signal still retains its power, which would otherwise be lost if the 
envelope were to follow shortly afterwards. 

"Vintage" mode has another feature: the output of the compressor in the signal flow 
features an emulation of a transformer-coupled matching-level amplifier. This 
contributes to some subtle, non-linear distortions at high levels, but is very much 
frequency-dependent. 
 

VCA Mode 

 

In VCA mode, the parameter selection and the circuitry design 
correspond to a modern compressor with a VCA element as the 
control circuit and a forward automatic gain control in the 
detector section ("feed-forward design", i.e. the controlling 
signal for level reduction is taken from the input signal). 

The typical basic sound for this category is accurate, largely neutral and, in relation to 
the adjustable parameters, easily predictable. 

In VCA mode, the control signal is accessed at the input where it firstly executes a 
controllable low-cut (which may be set up via  "detector hp freq" in "Expert" mode). 
The filter makes sure that deep-frequency signals have less influence on the 
adjustment settings; this is a popular trick for more power, e.g., when using drums in a 
sub-group.  

The filtered signal then arrives at the detector. With the forward gain control, 
previously set parameters apply fully and affect the adjustment settings immediately. 

 

In contrast to this, there is a "feedback" method which provides a second compressor 
mode. 
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Compression Parameters 
Vintage Mode 
In this mode, you can intuitively (by ear) use the dynamic editing features with just 
three knobs. Do whatever you want, but keep in mind: less is sometimes more... 

• Drive: You can use the "drive" potentiometer to control the amplification factor in 
the feedback loop, i.e. the signal strength which the detection circuit calculates. 
Furthermore, the internal "ratio" changes within a limit, the more "drive" there is, 
the higher the compression ratio. 

• Attack and release: The same basic conditions as VCA mode apply here. 
However, not only do you change the actual control response time after 
detection, but the "temporal window" in the detector must be adjusted as well. 
Additionally, the feedback arrangement method does cause a certain amount of 
unpredictability. You should expect less control over the device in this mode, but 
more leniency on its part.  

 

VCA Mode 
The regular set of parameters of dynamic compressors is available in this mode: 

• Threshold: The threshold above which dynamic reduction begins. 
• Check the threshold display if necessary (thr): If the input signal reaches the set 

threshold, the blue dash will move around the arrow symbols. If this dash moves 
upwards, the threshold is below the average level and compression is active. 
Inversely, if the dash moves below the marking, the input signal becomes too 
quiet to be able to reach the threshold; compression will be applied. 

• Ratio: This ratio (1:n) specifies by which factor the signal should be reduced once 
the threshold has been reached. For example, if the threshold is set to -20 dB and 
the ratio to 1:4, an input signal of -10 dB will only be amplified by 2.5 dB (10 dB : 4 
= 2.5 dB). 

• Attack: This is the response time, e.g. how long the arrangement takes to execute 
the required level reduction. Short attack times intercept level peaks, and longer 
ones let them through unimpeded (compression only starts past this value). 

• Release: This is the time allocated to the circuit to reach the normal amplification 
factor. 

Note on attack & release: In general, short attacks are used for moderate 
compression and making the transient response softer; longer times retain the "bite" 
of a specific instrument at larger compression rates or make the sound a bit 
snappier. With more difficult sources, like a very dynamic vocal track (ballads), for 
example, you can use a longer attack so that the arrangement runs more smoothly 
and quietly; the release time may be trimmed audibly to match the pauses or the 
song speed. 
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Shorter release time may be used for modern, aggressive "close up" vocals, e.g. 
when breathing sounds are an important stylistic device and the voice should sound 
very full and compact. 

• Knee: Use this parameter to specify the shape of the characteristic around the 
threshold. A "hard knee" means that the transition of 1:1 amplification for level 
reduction occurs abruptly; a "soft knee" on the other hand starts much lower than 
the threshold and moves the characteristic softly into the reduction. A "hard" 
setting is useful for effect-filled, acoustic compression, e.g. individual drum 
tracks. A softer setting is useful for complex and sensitive sources like guitars, 
pianos, or vocals. The more complex the signal, the easier it will be to notice a 
difference. For less sensitive sources, this parameter is usually less important. 
Note that for "soft knee" settings, the "threshold" value will need to be re-
adjusted, since the compression starts at a much lower level. 

 

Compression Expert Settings 
Of course, you can efficiently compress a lot of data with AM-Track without having to 
press the "Expert" button or try out additional options. However, we have added a few 
"handy" parameters behind the front panel. This applies equally to both compression 
modes. 

 

• Look ahead: AM-Track is always ahead of the signal. You can specify how many 
milliseconds you want to "look ahead". The audio signal path is delayed according 
to the signal route so that the detection circuit is fed first with the input signal 
(so-called "look-ahead delay"). You can increase the attack time and still avoid 
fast peaks. The latency compensation in the host program ensures that other 
tracks in the arrangement are adjusted and that no time delay occurs. For 
percussive signals, you can even set the delay all the way to "0". 

• Detector hp filter: This high-cut filter is positioned before the two compressors' 
detection circuit. You can use it to specifically exclude basses and mids from 
these rules. Complex signals with bass and hi information like a subgroup or 
complete mixdown produce fewer "pumping" artifacts. This is because low-
frequency signals feature the most power and therefore always trigger regulation 
and modulate other frequency ranges in the volume 

• Auto makeup gain: Normally, you have to continuously adjust level reduction to 
generate "compression" at the same maximum level. This is done by activating 
auto makeup gain. The volume difference expected from the set working 
parameters is determined and applied as an output factor after master regulation. 
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If you prefer to adjust the "classic" level reduction and amplification manually, 
you can deactivate this function. 

• Adaptive release: This is "semi-automatic", i.e. you can roughly adjust the release 
time, and AM-Track reduces it according to the current signal power from "a little 
(1%)" to "considerably slower (100%)". In "Vintage" mode, this regulation 
method is particularly intense, since it affects the feedback loop process. For 
instance, if you are editing vocal tracks or dense, complex material, it can sound 
"calmer" or more "musical" if adaptive release is activated. 

• Capacity: Adjusting the "capacity" controller sets the time response of the 
"adaptive release". The greater the capacity, the more sluggish the release 
adjustment. You can therefore influence larger parts of the compensation 
response. For instance, if you want to use vocals that have been "moved 
forward", you should use a short release time (maybe 80-100 ms) and a greater 
value for semi-automatic (e.g. 80). Vice versa, you can reduce automatic feed by 
switching the relation (smaller capacity, generally greater release time). 

• Comp mix: Parallel compression is a popular "studio trick", particularly with 
complex material. Adding the original signal retains the transients and spectral 
balance of the source. You can add compression by turning the mix controller. A 
mixed signal is particularly discreet, more transparent, and less "squishy" with 
vocals, whereby the compressed portion usually has a higher level reduction than 
without adding the original. 

 

Track dynamics 
Samplitude Music Studio 2013 provides two different dynamics modules: one that 
can be opened via the "Offline effects" menu (talked about in further detail in the 
corresponding chapter), and a second one that is only available via the track effects 
and in the mixer. 
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Use this editor to edit the dynamics of a sample. All functions can be previewed in 
real time. 

The graphics display shows the corresponding resulting dynamics curve to improve 
the overview. 

The following functions are available: 

Compressor: The dynamics of a piece are limited, loud sequences are dampened, 
quiet sequences are retained. Compression is often used to add power to audio 
material or to increase the loudness. The level of compression is adjusted by the ratio 
controller, the activation threshold is determined by the threshold. You can also 
influence the attack and release. 

Limiter: Only the loudest passages are limited (above the threshold). Quiet passages 
remain unedited. Limiters are used to reduce the occurrence of big level peaks 
without reducing the master dynamics. After the limiter process, the master level can 
be increased using normalization without having to worry about overmodulation. The 
limiter setup preset sets a threshold of -0.2 dB when using the limiter as a peak limiter 
in the master range of the mixer. 

Limiter 100%: Performs the same editing as the limiter, but the level is immediately 
raised to 0 dB. This corresponds with normalization in one single step. 

Expander: The dynamics of a piece are increased; loud sequences remain quiet, quiet 
sequences become even quieter. Dynamics expansion is often used for recording 
speech with a high noise level. The expansion causes the level of the speech to be 
raised as the noise is suppressed. Please note that a powerful denoising algorithm is 
also provided. 

Gate: Very quiet passages (below the threshold level) are dampened or set to zero. 
This way, hissing can be effectively suppressed during pauses between individual 
takes. Using the "Gate" function also makes sense at high compression levels (ratio > 
5) to raise the most quiet passages and prevent background noise. 

Ratio: This parameter controls the strength of the corresponding effect; 1.0 means 
that there is no effect. 

Threshold: The volume threshold can be set below or above the one which applies 
the effect. 

Attack: Sets how quickly the algorithm takes to react to increasing sound levels. 

Release: Sets how quickly the algorithm takes to react to falling sound levels. 

Gate level: This parameter specifies which levels should be set to 0. 
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Track delay/reverb (track effects) 

 

Use this editor to calculate an echo effect into a sample. To avoid overmodulating the 
sample, there should be a certain volume control reserve, i.e. the sample data should 
not be allowed to reach the maximum/minimum. This can be accessed using the 
normalization function (some 70%), if required. 

Echo delay / Rev. time: This button displays the delay between the individual 
echoes/original signal and the first echo in seconds. You should note that the delay is 
dependent on the sample rate, that is, a change in the sample rate after creating the 
echo leads (logically) to a change in the echo delay. 

Reverb properties: Here the values for the size of the simulated room and the reverb 
coloration can be specified numerically as well as by using the scroll bars. 

Wet/Dry balance %: Here the dampening between the individual echoes can be 
entered as a percent. A number close to 100% results in slower sounding echoes, a 
value under 40% has quick sounding delays. 
 

Elastic Audio Easy 
General information on the Elastic Audio editor 
Elastic Audio is a specialized editor for changing the pitch of audio material. 
Resampling and pitchshifting algorithms can be automated, and a basic frequency 
recognition enables the user to change around considerably the pitches of 
monophonic audio material.  

Pitch-shifting algorithms are able to change a melody in the pitch without influencing 
the tempo. Samplitude Music Studio 2013 provides various pitchshifting algorithms 
that can be used based on existing material. 

Elastic Audio has the following capabilities 

• Recognition of the basic frequency in monophonic audio material. 
• Automatic and manual correction of the basic frequency process in monophonic 

audio material. 
• Manual correction of the pitch of notes from monophonic audio material. 
• Changing melodies in monophonic audio material.  
• Harmonizer for creating additional voices 
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Note on timestretching: Timestretching cannot be automated, but can continue to 
be used statically when using Elastic Audio. 

 

Edit window 

  

The pitch characteristic is shown in the editing window. To customize the pitch 
correspondingly, the original pitch of the audio material must, of course, be known. 
Fundamental to the functionality is therefore a preliminary pitch analysis of the 
material. This is basically only for tonal, monophonic material like solo vocals, solo 
instruments, and speech. 

The analysis function starts automatically when the editor is opened. The analysis 
requires more time with longer objects. After the analysis is complete, the objects are 
split up into individual "slices" according to the recognized pitches. The medium 
pitches of a slice determine its position in the graphic, independent of the set 
progression of the pitch curve inside the slice. On the borders of the slice objects, two 
handles are created on the pitch curve. These handles can be moved in order to 
produce an increasing or decreasing pitch characteristic, but still keep the small 
changes in the basic frequency (vibrato). 

The “Tune” function for automatic pitch correction can be found beside the "Draw 
pitch" function. 
 

Axes labelling and legends 
Y axis: Pitches in notes. The notes can be deselected on the keyboard. They won’t be 
used in the automatic pitch correction or in quantized drawing. The corresponding 
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guidelines for scales can be used by selecting the basic tone and scales in the box 
“Edit slice object”. 

Orange line: New pitch characteristic (editable) 

Grey line: Original pitch characteristic (result of the analysis) 

Red line: Harmonizer voices. 
 

Fundamentals of the Elastic Audio editor 
Opening the Elastic Audio editor 

Select the object that should be edited in the editor. The Elastic Audio editor for a 
selected object is opened via "Menu effects -> Audio". 

Interaction between Elastic Audio editor and objects 

Temporal corrections to notes are not run in the editor itself, but rather by splitting 
and moving the objects in the VIP.  
 

Description of all control elements 

 

These options and parameters always effect the 
whole object loaded into the editor, and therefore 
all the slices. 

Algorithm: You can choose between Monophonic 
Voice (preset), Standard, Resample, 
Timestretching (smoothed) and Beat Marker 
Slicing. 

For more information about the algorithm you can refer to the chapter 
Timestretch/Pitchshift Effect. 

Curve smoothing: This parameter brings about the smoothing of the given pitch curve 
using a time constant (in ms).  When smoothing to a large extent, jump-like pitch-
shifts change from a "kick" to a glissando. 

Formant control: Selecting the Monophonic Voice algorithm may result in so-called 
"formants".  Formants are sound components typical for the character of instruments 
or the human voice. With instruments they mainly result from the geometry of the 
resonance body. With humans the formants are created by the anatomy of the vocal 
tract. 

With most algorithms the formants are also influenced by changing the pitch. With 
the Monophonic Voice algorithm you can change the position of the formants 
independent of the pitch. Acoustically this corresponds with stretching or 
compressing the above-mentioned geometries, which can lead to interesting effects. 
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Options for automatic pitch correction 

Root: The basic tone of the scale. In the chromatic 
scale this setting is still not taken into account. 

Scale: The type of musical key, i.e. the mode. 

Tune Pitch Progression: Performs quantization (alignment) of the marked slices in 
the pitch progression. 

Quantization Smoothing controls the "strength" of the quantization. The lower the 
value, the harder the quantization. This results in the disappearance of repeated small 
pitch alternations in natural sound sources, for example, Vibrato ("Cher effect"). 

Reset: Resets the selected slices. The orange curve is superimposed over the grey 
curve and the slice is reset to the original medium pitch. 

 

Chord: Here you can set the chord that makes up 
the parallel voices of the Harmonizer.  A 
distinction is made between major and minor. The 
settings of the keyboard are taken into account 
unless the option lead voice has been activated. 

Humanize: At a low setting this causes strong quantization of the parallel voices.  This 
makes the effect sound very artificial. If you select a very high humanize value, the 
pitches of the individual voices will vary and the cue will be shifted.  This gives the 
impression of an amateur ensemble. 

Harmonic adjustment: Parallel voices are usually generated by taking the keyboard 
and humanize settings into account. However, if this option is deactivated, then the 
voices are always kept exactly parallel to the orange curve. 

Create Voices: This button generates voices. 

Playback control 
Play: Stops and starts playback of the arrangement. 

Play solo: Only the object loaded into the Editor is played back. 

Bypass: Switches the effect on or off. 
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Tools in the Elastic Audio easy editor 
You can use various tools to edit slices and the pitch curve. The two tools can be 
freely assigned to each mouse button. The tool assigned to the left mouse button is 
displayed in blue and the right mouse button in red. Click with the corresponding 
mouse button on the desired console button. An exception is the zoom tool with 
which can be assigned to both mouse keys. 

 

Selection tool (arrow) 

 
You can now move the slice objects up and down. 

This modifies the pitch of slice objects as a whole, and slice objects and curve handles 
can also be selected. Multiple selection is possible with "Ctrl" or "Shift". 

Freehand draw function 

 
You can freely draw the pitch curve using the draw tool. 

If you press "Shift" as well, a straight line will be drawn between the start position on 
drawing and the current mouse position. When "Ctrl" is pressed, the slice objects are 
combined when drawing. 

Drawing with quantization 

 
This is the tool used for quantized drawing. 

Quantized means that the line is horizontally free but the curve snaps onto the grid of 
the tones of the selected scale under "Tune". 

Drawing a straight line using "Shift" and compiling slice objects with "Ctrl" is also 
possible in quantized draw mode. 

Rubber-band tool 
Use the rubber band tool to bend the pitch curves between two neighboring 
handles. 

Here the middle of the curve is moved while the curve handles remain the same. In 
combination with moving the curve handles at the slice object edges, you can also 
move the pitch characteristic and attain micro-tone structures (vibrato). 

Cut tool 

 
This can be used to split audio material manually into slice objects (according 
to the notes). 

If automatic recognition is not sufficient, then slice objects can be connected to one 
another using "Ctrl" + the drawing pens. 
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Eraser 

 
Use the eraser to reset the output value of the orange curve. 

The pitch characteristic then corresponds to the original again and the curve 
corresponds to the recognized curve. 

Magnifying glass zoom tool 

 
Zoom tool: Left mouse button "Zoom" zooms in and the right mouse button 
zooms out. 

Left-clicking and dragging can stretch out a range which can then be zoomed entirely. 

Navigation tool 

 
With the navigation tool, the visible clip can be moved vertically and 
horizontally. 

 
  

Applications of the Elastic Audio easy editor 
Pitch correction (intonation correction) with monophonic audio material 

Getting started (for all subsequent editing) 
• Load objects into the Elastic Audio easy editor. 
• Set the desired selection state. All slices are selected directly after the analysis. 
• Select suitable algorithms – you should test here to see if "monophonic voice" 

(see above) is the suitable algorithm. 
• Now the pitch can be edited with the mouse tools by editing the orange curve or 

the pitch of the slice objects. 

Manual correction of the whole pitch of a pitch slice 
• Select the slice with the selection tool (arrow). 
• Move vertically with the mouse.  

Automatic correction of the pitch characteristic 
• Select the slice objects with the selection tool (arrow). 
• Select the scale in the Edit slice objects group and, if required, deselect the tones 

which are not to be quantized in the keyboard by clicking on them. 
• Press the "Tone pitch characteristics" button 
• With the parameter "Quantization smoothing" you can reduce the "strength" of 

the quantization. 

In principle, this editing process more or less levels off pitch characteristics inside a 
slice. 

Correction of the increase or decrease in the pitch. 
• Select the slice objects with the selection tool (arrow). 
• Click and drag the pitch curve by moving the two handles at each end of the slice 

objects or on the orange lines.  
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Free redefinition of the pitch / Creation of frequency modulations like warblers and 
vibrato. 
• Select the slices with the Selection tool (arrow). 
• Select the drawing tool (quantized or not). 
• Draw in the pitch modulations. 

Creating "Plastic voices" (Removing vibrato by strong quantization of the micro 
pitch characteristic) 
• Set the parameter Quantization smoothing to 0. 
• Press the "Tone pitch characteristics" button 
• If required, switch off format correction when using the "Monophonic voice" 

algorithm.  

Creating "Robot voices" – quantizing to a pitch 
• Select the slice(s) with the selection tool (arrow). 
• Select the draw tool for quantized drawing. 
• With artifacts: Increase the "Quantization smoothing" parameter. 

Creation of parallel voices 
• Set desired chord. 
• If necessary, change the "Humanize" parameter and press "Create voices" to 

generate the voices again. 
 

Pitch-sliced-objects and VIP objects 
The basic frequency analysis reduces the pitch slices to pieces which ideally 
correspond to one note in the music's melody or one syllable in speech. For speech 
the pitches correspond to the level of the vowels. 

After the analysis, all of the slices are shown selected (blue). 

The subdivision into slices can be corrected manually. The slices are cut apart with 
the scissors tool, and then merged together with the rubber band gripper tool ("Ctrl" 
held down). 

The blue line represents the mid-range pitch for each object and results 
approximately from the average value of the pitches in the slice. 

In selected pitch-sliced objects the functions found in the “Editing sliced-object” 
group can be applied, i.e. the correction of the pitch sequence and the mid-range 
pitch. 

The option to reset the corrections for selected slices is also available. 
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Selecting sliced objects 

Sliced objects can be selected and deselected. "Ctrl + A" selects all slices; clicking on 
the “empty space” deselects them. 
 

Fundamental frequency analysis correction 
General options 

The fundamental frequency analysis and the related fundamental frequency-
dependent pitch-slice-analysis may fail or cause errors for the following reasons: 

• Reverbed material, 
• Runtime stereophonics, 
• False analysis, 
• Voiceless vocals (sibilants...), 
• Noisy sounds. 

In the last two cases, analysis cannot return a result as the fundamental frequency is 
not available. 

MAGIX Elastic Audio provides the user with the opportunity to achieve good results 
using many manual options, whereby the fundamental frequency analysis does not or 
cannot deliver any results. 

Error in the fundamental frequency analysis 

Symptoms: 
Sound: The pitch varies strongly for a short period and does not correspond to the set 
value or characteristic. 

When using the monophonic voice algorithm, additional strongly distorted noises 
arise. The algorithm, which depends on the fundamental frequency recognition itself, 
fails. 

Graphics in the editor: The curve exhibits a short strong jump and behaves in a very 
jerky manner. 

Solutions: 
• With the help of the eraser you can try superimposing the original curve at these 

points. 
• If you set high values for the curve smoothing parameter, then short "hiccups" 

can be reduced in severity or prevented completely. 
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Correction of slice borders 

So that the automatic or manual correction of the mid pitches of slices provides 
correct results, the slice borders have to match well with the note borders. 

The slice borders can be manually changed by connecting 
two slices to one another with the pen Ctrl + or  

and using the cutting tool to cut through at the correct 
position.  

 
 

Key commands and mouse wheel configuration in the Elastic Audio Easy 
Editor 
Play solo/stop Ctrl + Spacebar 
Play/Stop Spacebar 
Select all Ctrl + A 
Refresh view A 
Undo Ctrl + Z  
Show/hide pitch curve Shift + Alt + P 
Enlarge waveform  Ctrl + Arrow up 
Enlarge waveform  Ctrl + Arrow down 
Jump to object start Home 
Jump to object end End cap 
Playback marker to left Left arrow 
Playback marker to right Right arrow 
Zoom in Ctrl + Left arrow 
Zoom out Ctrl + Right arrow 
Change scale tuning (Frequency for "A" concert 
pitch). 

Shift + R 
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Automation 
Samplitude Music Studio 2013 provides lots of comprehensive automation 
possibilities at track level. You can enter automation movements in realtime or draw 
them manually. The created automation data are visible as controller movements in 
the corresponding plug-in or as a curve in the automation track. An unlimited number 
of automation curves are available on each track. The volume automation curve is set 
to 0 dB at the middle of the track and +6dB at the top of the track. 

 

The following dynamics automation settings are available at track level: volume, 
panorama, AUX sends, EQs, and plug-in control elements and MIDI controllers. 
 

Automation – context menu 
To open automation, right-click on the "Vol" button in the track box or on button 
Rd/T in the "Automation" category of the Track Editor. 
 

First entries in the automation context menu 
The first entry indicates which parameter you have automated, e.g. Effect 0 volume or 
Effect 1 pan. By checking the corresponding entry you can activate the corresponding 
automation curve. If you haven't activated an element, No effect (track) will be 
displayed. 
 

Editing curves 
Create 
The curve generator will create a beat-based volume curve for you which pulses 
according to eighth, quarter, half, or full notes. As an option for the beat-based 
envelope curve calculation you can enter a minimum and maximum value, or define 
the delay values. 
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Alternatively, you can also let the curve generator write an envelope curve scan. 

 
 

Invert 
This command inverts the active automation curves. 
 

Thin out 
This function thins out the active automation curve by reducing the number of 
automation events. While recording, the automation events are placed in very short 
intervals. The command "Thin out" reduces the number of curve points. The course of 
the automation is then displayed and reproduced even more accurately.  
 

Copy / Paste / Delete 
The activated automation curve can be copied/pasted into other tracks and deleted. 
 

Inactive 
Use this command to deactivate the selected automation curve. This means it will 
remain intact, but no longer affect the corresponding parameter. 
 

Delete all curves 
This command deletes all automation curves of the corresponding track. 
 

Automation mode 
Specify the Automation mode here. 
 

Do not display automation. 
Deactivate the display of the automation curves for all tracks with this option. 
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Display track automation (default setting) 
If you select this display option, then only the track automation will be displayed. 
 

Display selected curves only 
This function displays only the selected curves for the corresponding track. This helps 
to keep an overview if several automation curves have been created. 
 

Display unselected curves (cannot be activated) (Default setting) 
The unselected automation curves are grayed-out. They cannot be activated with the 
mouse. 
 

Display unselected curves (can be activated) 
The unselected curves are also grayed-out, but can now be activated with the mouse. 

The last section of the context menu lists the ranges for which automation 
parameters are available during automation of the corresponding track or the 
corresponding object.  
 

Automation modes 

 

The automation modes define how automation data should be saved or displayed. Set 
the automation mode for each channel/track. Different automation modes may be 
selected by right clicking the automation button in the mixer channel. Clicking this 
button toggles between the last activated mode and "Read" mode. "Copy to all 
tracks" applies the currently selected automation mode to all tracks/channels. 
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Off mode 
All automation functions are deactivated on Off Mode, all already written automation 
sequences are ignored. 
 

Read mode 
All recorded automation parameters are played in "Read" mode. The automation 
button is usually set to this state. 
 

Touch mode 
In "Touch" mode, automation data is only recorded as long as you touch the selected 
control element with the mouse or touch it from your external controller. Automation 
recording is stopped when you release the corresponding key. Once released, the 
control element will move back to the previously recorded position. You can set the 
fader return time in the "MIDI controller automation" dialog in "Settings -> Time 
constant for user entry". The "MIDI controller automation" dialog can be accessed 
by right clicking the automation button in the track editor. 
 

VST plug-in/VST parameters dialog 
All of the parameters that may be automated may also be selected and activated in 
the VST plug-in's parameters dialog. 

This allows automation to be recorded directly via the selected parameter controllers 
during playback. 

You can open the parameter dialog in the plug-in's menu via "Plug-in -> Parameter". 
 

Recording automation in "Read" mode 
The easiest way to write automation in "Read" mode during playback is via the "Ctrl 
+ Alt + switch/controller" shortcut, while working directly in the plug-
in/instrument/mixer interface. This way allows an automated recording to be made 
at any time. As long this key combination is held down, you may also automate the 
selected parameters in "Read" mode. 

If a mixer/VST control element is clicked with the same key combination "Ctrl + Alt" 
while stopped, a corresponding inactive curve will be created automatically for editing 
in "Draw" mode. 
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"Draw" mode 
Select "Draw automation curves" mode to draw automation curves for a parameter 
or a MIDI controller. 

 

You can now draw the automation curve straight into the chosen track using the pen 
tool for the selected parameters. 
 

Edit automation curves 
Alongside the normal mouse mode for editing already recorded curves (create or 
delete curve point), a special   

 
"Curve edit" mode 

 
or "Object / Curve" mode 

is provided. 

In Curve edit mode you can directly draw, move and delete curves with a double click. 
The mouse cursor switches between a Hand or Moving tool. If your mouse is not 
directly above the curve, you can select an area of automation points using the 
calculation tool. 

In Object / curve mode you can also create new points on the curve or move and 
delete curves with a double click. If you move away from the curve using your mouse, 
you will automatically switch to object mode, in which you can move objects and edit 
the start & end position, the fade-in & fade-out phases, and the object volume. 

Detailed information about curve modes can be found in "Screen elements -> 
Toolbars -> Mouse mode bar". 
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Move automation curve with audio/MIDI data 
To move the audio material to a new position on the timeline along with the 
automation curve, the automation curve will have to be connected to the object. This 
is possible via "Link curves to objects" mouse mode. Click this button in the mouse 
mode toolbar to get started. 

 
Objects may now be moved or copied together with your curve 
points. 

Note: If you only wish to move or copy the curve points, follow the instructions 
above and simply delete the objects once moved/copied. The curves remain intact. 

To copy the curve points, simply use "Curve edit" mode and drag out a section by 
moving the mouse from right to left over a curve while holding down the mouse 
button, copy the curve points via "Ctrl + C", and then insert them into a different 
track at the current play cursor position via "Ctrl + V". 
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Mixer 

Overview 
You can open the Samplitude Music Studio 2013 mixer via "Window -> Mixer". It 
strongly resembles a hardware mixer. As a result of the digital environment, however, 
it is by far more flexible than an analog mixer. 

All settings made in the mixer are processed and edited in real time. This includes 
track and master effects, panorama and level settings, device allocations for individual 
tracks/buses as well as device allocations for the master section. 
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Operating the mixer 
Every VIP track has its corresponding mixer track. However, you can hide any VIP or 
mixer track in the track manager. 
 

Alternative mixer skins 
In "System audio ("Y") -> Design -> Skins" you can select an alternative mixer skin. 
Another option for changing the mixer skins is to click on the system menu in the 
mixer window (the symbol at the top left corner of the mixer window). 
 

Using the keyboard 
• Cursor keys: Select the active mixer element (fader, button, or switch) 
• Page up/Page down: Changes the value of the active mixer element 
• Home: Resets the mixer element to its preset (passive) initial value. Press 

"Home" again, and the element is reset to the last value, allowing a simpler 
comparison between the altered and initial preset states. 

• End: Opens the assigned subwindow of an element, e.g. the EQ window for one of 
the EQ buttons. This corresponds with right clicking on a button. 

• Return: Enables the numeric entry for a marked window box. 
 

Operating the mixer with the mouse and keyboard 
Left click: A control element is selected. 

Ctrl & left click: Several control elements can be selected (multi-selection). 

Shift & left click on buttons: Allows special functions to be changed, e.g. mute single 
track or solo single track (although they are members of an active group). 

Shift & left click on buttons or faders: Reverses the link selection (negative selection). 

Ctrl & left click: A single control element can be temporarily positioned within a group 
by pressing “Alt” and operating the element. 

Double click on numbers: Opens the entry box to allow manual entry of numeric 
values. 

Double clicking on buttons: Resets the control element to its preset (initial) value. 
Double clicking again sets the value back to the changed value. 

Left clicking on value displays, below the faders, or on the left button corners 
decreases the values. If the key is kept depressed, the value is automatically reduced 
until the key is released, or until the end of the scale has been reached. ("Page 
down"). 
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Right clicking on value displays, below faders, or on the right button corners increases 
the values. If the key is kept depressed, the value is automatically increased until the 
key is released, or until the end of the scale has been reached. ("Page up"). 

Right clicking on buttons (e.g. compressor) opens the corresponding window (“End”). 

The level faders can be adjusted very precisely. Click on a fader, keep the mouse 
button pressed, move the mouse pointer away from the fader to the left or right. You 
can then adjust the settings by moving the mouse in a vertical direction. The steps of 
the settings become smaller as the mouse button is moved further away from the 
selected fader. 

The step size of the fader movement also becomes smaller if you keep “Shift” 
depressed while moving a fader. 

There are two ways to change knob settings. After clicking on a knob you can either 
move the mouse around the knob this is the standard method, or move it up and 
down similar to moving the faders. You can reduce the step size of the value settings 
by keeping the “Shift” key depressed. 
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Channel strips 
Each track in the VIP is sent through a specific mixer channel, i.e. the sound settings 
of the respective mixer channel are applied to the objects on the track. 

Each channel strip provides the following setting options. Each individual section can 
be opened and closed by clicking on the corresponding arrow symbol. 

 

Input: Specifies the audio input for the recording. 
Gain: Controls the ratio of signal input to signal output of each channel. 
Aux: AUX parts for various AUX busses can be set using these buttons. 
Right clicking opens the AUX routing dialog. 
Ins:  In addition to the mixer effects , more effects can freely be assigned to 
the channel strips. The selection includes "Sound FX" (the real-time effects 
"Equalizer", "Compressor", "Reverb", "Echo", and "AmpSimulation"), 
"Dynamics" (compressor), and (top slot only) an insert for external plug-ins.  
EQ: This section allows you to change the sound pattern of the track signal 
using a 4-band parametric equalizer. The knobs change the volume of the 
frequency range.  
You can edit the volume and frequency width of each band in the number 
fields. 
Right click on one of the knobs for fine tuning. Samplitude Music Studio 
2013 shows the EQ dialog in which you can specify exact settings. 
Panorama: This adjusts the signal alignment in the stereo panorama. The 
settings of the knob have a different effect on mono and stereo tracks. 
When set to the center position, the track signal is held in the center of the 
stereo picture irrespective of whether the track is mono or stereo. If the 
knob is moved away from the center position, the mono signal is moved 
within the stereo picture (to the left or right). For a stereo track, the 
alignment between the left and right channels within the track signal is 
changed. 
Track number: Right clicking the track number opens a context menu to 
make adjustments to the track settings or to insert a new track or 
aux/submix bus. 
Stereo link: This button to the right of the track number connects the 
current channel with the one to the right of it. All settings and adjustments 
affect both channel strips. 
"RD/T" (Automation): Use this function to record controller movements of 
the volume fader, panorama controller and AUX controller as 
Vol/Pan/Surround or AUX curves during playback. Curves that already exist 
are shown in the mixer by movements of the AUX bars, the panorama 
controller, and volume fader. 

"S" (Solo): The solo button mutes all tracks with the exception of the selected one. 
Right clicking enables the selection of the output device for the track. 
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REC: Arms the track and starts the recording. 

"M" (Mute): The mute button mutes the track. Right-clicking enables the selection of 
the output device for the track. 

Volume fader: Controls the levels of the tracks. 

Monitoring: Click the loudspeaker button to activate the monitoring function. This 
means that audio material can always be passed through the inputs of the sound card 
and forwarded to the outputs. 

If "Hybrid Engine" is set in the options for monitoring, all mixer channel effects for the 
feeds can be used. This requires working ASIO drivers for the sound card. This way, 
Samplitude Music Studio 2013 can be used as a live effect device. 

More details about monitoring can be found in the chapter "System settings > 
Global audio options > Monitoring settings". 

Track name: Shows the name of the VIP track. Clicking opens the track settings 
dialog where you can change the track name, among other things. 

FX: This key activates each track's VST or DirectX extra effects used to configure and 
edit any number of effect sequences. This specifies the sequence in which the effects 
are used. 

Further information can be found in the chapter "Effects and effects plug-ins -> 
Sequence of effects calculations". 

Right clicking on the button opens the control dialog. This lets you add or delete 
effects and makes the individual track effect settings dialogs accessible. You can 
copy, insert, reset, save, or load track effect settings. Specify your personal track effect 
settings in the program directory in "FX Presets > Track FX". Of course, you can also 
create new subfolders as well as "instruments" or "Mid Side Processing". 

Out: Sets the audio output for the channel. This can either be a submix bus in the 
mixer or a wave out device. 
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Master section 
The master section can be found to the right beside the channel strips. 

 

Plug-ins: Set the "Vintage Effects Suite" as well as external VST or 
DirectX plug-ins for the master output signal here.  
SoundFX: Provides access to the real-time effects "Equalizer", 
"Compressor", "Reverb", "Echo", and "AmpSimulation". 
Mastering Suite: Provides access to the real-time effects "4-band 
equalizer", "Stereo FX", "Multimax", and the "Digital Audiometer" 
analysis device. 
Vocoder: Here you will find the Vocoder for the entire signal.  
Limiter: Distortions in the master signal are prevented by the limiter.  
Master equalizer: Provides access to the 4-band equalizer for the 
master signal. 
Stereo Enhancer (StE): This "Stereo FX" lets you modify the stereo 
picture of the complete signal. 
Normalize: This is the master normalization. If you click on this 
button, the output faders are customized in such a way that the 
loudest sections reach 0 dB. This function requires that the loudest 
sections in the VIP be found and played. After clicking the 
"Normalize" button, the program sets the peak value of the complete 
signal to 0 dB.  
To display the maximum values after having made changes, please 
use the "Peak reset" button. This deletes the peak display.  

Clicking the numerical display of the peak value when stopped sets the playback 
marker to the VIP position of this value. 
Link: This button above the faders connects both faders. Use this function to change 
the left and right faders simultaneously. 
Faders: Both of these faders adjust the left or right master signal. Double clicking on a 
fader resets the fader to 0 dB. 



 

Mixer 165  

 

FX: Opens the effects/routing dialog for editing and configuring any number of effects 
chains. This specifies the sequence of the effects. More information can be found in 
the chapter "Effects and effects plug-ins > Sequence of effects calculations". 
Mix to File/On: The buttons "Mix to File" and "On" can be used to mix down in real 
time and to change any parameters of your mix during playback. At the end of 
playback, the created mixdown is written to a wave file. 

1. Clicking the "Mix to file" button opens a dialog to specify the name and place 
where the created wave file should be saved. When the "On" button is active, 
the master output of the mixer can be written to a wave file during playback. 

2. Now start playback of the VIP. 
3. On playback, any parameter may be changed in order to record any live 

adjustments that are made. 
4. At the end, stop the playback of the VIP. 

 

Important: Make sure that the "On" button is deactivated if you do not wish to mix 
the master signal again. Otherwise, the system creates a wave file every time the file 
is played. 

The "Mix to file" function does not necessarily need to be used to record dynamic 
mixer movements during playback. Effects may be controlled via AUX busses, and 
volume and panorama curves may be automated. 

Device / Master out: Enter the playback device for the entire signal here; this can also 
be set in the system/options dialog under "Audio devices". 
 

Global settings 
Some additional buttons for adjusting the global settings of the mixer window and 
mixer handling can be found at the right side of the mixer window. 

This includes (clockwise from bottom left): 

Start track: If the VIP has many tracks, then only a section of the corresponding mixer 
channels is generally displayed in the mixer window. The visible section can be moved 
using the scroll bar at the bottom of the mixer. 

Hold “Shift” down and click on one of the “Start track” buttons to save the current 
view (a left click is sufficient the first time). 

You can recall the previously saved section by clicking again on the “Start track” 
button. 

Preset: By clicking on the preset menu you can select various mixer setups. 
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In the "Options" menu reference, please read the section "Project properties -> 
Mixer setup" 

Setup: A click on the setup button opens the mixer setup dialog.  

Show functions: Right of the master volume fader, individual sections of the mixer 
window can be switched on and off. Particularly the single tracks, master section, 
input pad, AUX section, inserts, EQ, and visualization display. 

+ buttons: The "Aux" category also contains a function for increasing and decreasing 
the amount of aux routes and insert slots. 

Solo/Mute: All solo and mute functions can be globally activated and deactivated 
using this button. 

Bypass FX: Bypasses all mixer effects to compare the settings. 

Auto rec: This display indicates automation data recording such as volume and 
panorama. Automation has to be enabled on at least one track. 

Play/Stop: VIP playback can be started and stopped using this button. A right click 
opens the transport controller. 

Group selected controls: These two buttons are used to group mixer elements and 
ungroup them when they are no longer needed. If you want to create a group, select 
the desired elements by holding down "Ctrl" and then clicking "Group controls". To 
ungroup, choose one of the elements in the group and press "Ungroup controls". 

Snapshots:The "snapshot" function is particularly useful to compare various setups. 
You can easily switch between the setups. Naming snapshots is possible by double 
clicking the name field. The two buttons at the bottom of the last name field enable 
you to save and load snapshots. 

A right click on a snapshot opens a context menu from which snapshots can be 
saved, loaded, and deleted or switched between the banks of snapshots. This allows 
up to 32 mixer snapshots to be saved. 

In this menu, mixer settings can also be stored to a separate file. 

When loading a snapshot, the current mixer settings are temporarily saved and can 
be restored by clicking on “Load last mixer”. This also allows an A-B comparison 
between the snapshot and the current settings. 

Reset (mono): Resets all mixer settings to the default settings for mono tracks (when 
using mono or LR wave projects). 

Reset (stereo): Resets all mixer settings to the default settings for stereo tracks 
(when working with stereo wave projects). 
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Reset aux: Resets all aux shares of the channel strips to their default values (= no aux 
share). 

Reset EQ: Resets all equalizer settings. 

Reset peaks: Resets the LED peak meters (peak hold display). 

Reset FX: Resets all effect parameters to the default settings so that effects can no 
longer be processed. 
 

Buses and routing 
AUX buses 
An AUX bus is a collecting bus combining all signals of the corresponding "AUX 
sends" of the individual channels. AUX buses are usually used for controlling real-
time effects via the volume curve. For this purpose, part of the signal of the desired 
mixer channel is sent to the AUX bus ("AUX send") and effects are added. The AUX 
bus fader represents the "AUX return". This means that the higher the volume of the 
AUX bus, the more effects in the mix will be audible. 

Hint: The AUX tracks contained in the VIP tracks are usually not objects. They only 
provide dynamic effects to other tracks. 

 

Submix buses 
A submix bus combines several tracks. It controls the volume, panorama, and effects 
settings of all tracks that are “routed” to the submix bus. For example, all drum tracks 
(hi-hat track, bass drum track, etc.) can be combined to one submix bus so that the 
entire drum kit can be controlled via the volume controller of the submix bus. 
 

Working method 
• An AUX/a submix bus can be created in the mixer at any time. To insert a 

submix bus after all channels, right click on the number of the last channel shown 
in the mixer. In the appearing context menu, select "Insert Tracks -> New submix 
bus". If the output of several previous channels is now routed through this bus, 
the volume of all of these can be controlled centrally through the new bus. If you 
have created an AUX bus with "Insert Tracks -> New AUX bus", you can channel 
the signals of the previously created AUX sections into the the newly created 
AUX bus. AUX buses are also the target for AUX sends with a lower channel 
number. 

• Right clicking the number of a channel allows the option to select between the 
properties "AUX bus", "Submix bus", or even both for the according channel strip. 

• Submix or AUX buses are always stereo buses. 
• Submix buses can be fed from tracks with a lower channel number just as a 

physical output device. 
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• Submix and AUX buses can be used for all channel effects, including volume, 
panorama automation, and AUX send. You can align your output to output 
devices or submix buses with a higher channel number the same way as any 
other channel. 

• Automation of volume and panning for AUX and submix buses are the same as 
for all other channels. 

 

Embedding external effects devices 
In order to include external effects devices you require an audio interface with several 
in- and outputs, whereas one input/output pair is reserved for the external effects 
device. 
 

Routing the signal 
• You can loop the signal either as an effect or insert. 
• Insert send: Route the channel output directly to the physical output of the card 

that is to feed your external device. 
• Insert return: Select a mixer channel (insert return channel) which the effects 

signal should be sent back to. In the input section of the channel, select the sound 
card input connected to the output of the device you want to loop in. 

• External send effect: Create an AUX bus that is fed from the corresponding AUX 
send from different channels. The output of the AUX bus has to be routed to a 
physical output of the sound card. Connect the output of the effects device to the 
desired input of the sound card. The sound card input is connected to the mixer 
channel by selecting the corresponding input section of the sound card in the 
dialog window of the input section of the AUX return channel. 

 

Tips and tricks 
• Master normalization is a mixer feature which allows you to quickly set the 

output level to 0 dB. If the limiter in the master section is active, then the output 
level is also monitored, thus preventing level clipping. 

• Clicking on the displayed top peak level numbers of the master sets the cursor to 
the VIP peak position. This can be controlled with the function "Play over cut". 

• The mixer function "Mix in file" (to the right below the mixer) writes the master 
output of the mixer to a wave file (or HD wave project). If parameters are 
changed during playback, the sound that was changed live can be recorded. If you 
use the live input of Samplitude Music Studio 2013, then all mixer effects can be 
used in the mix file while recording. Warning: the mix file is overwritten at every 
play start. Therefore, if you want to keep the result, you have to rename this file 
or save it under a different name. 
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MIDI in Samplitude Music Studio 2013 

What is MIDI? 
A few words about MIDI: MIDI files do not contain the actual sound like audio files, 
but only the note control information. This data is interpreted and played back by the 
VST instrument or synthesizer.  MIDI is thus a kind of remote control for synthesizers. 
This has some advantages: 

• MIDI files need a lot less memory than wave files. 
• MIDI files can be adapted to any tempo (BPM) without affecting the sound. The 

playback tempo is simply changed. 
• Transposition of MIDI files to other pitches is also easy. As a result, a section in a 

song does not have to be saved in several different keys. The version in C major is 
perfectly sufficient. It can then be transposed to any key easily. 

The disadvantage of MIDI files: The audio is not yet determined and is only produced 
during playback. 
 

Connect external equipment 
Interface connection 
Please consult your sound card or MIDI interface manual for information about the 
correct connection. The most common ways to add MIDI functionality to computers 
are: 

• Multi-port MIDI interfaces, including separate devices. 
• Sound card with built-in MIDI interface. 
• General MIDI module or keyboard-integrated interface, usually labeled “To host”. 
 

MIDI cabling 
MIDI inputs/outputs: If your computer has an internal or external MIDI port, or has a 
MIDI-capable sound card installed, connect your MIDI keyboard’s “MIDI out” to the 
computer’s “MIDI in” (on the interface, sound card, and so on).  

If your MIDI keyboard can generate its own sounds, connect the computer’s “MIDI 
out” to the keyboard’s “MIDI in”. If your computer (or the MIDI device) offers more 
than one MIDI output, connect any other sound synthesizers to these. If the computer 
only has one MIDI output, you need to connect the second sound synthesizer’s "MIDI 
in" to the keyboard’s "MIDI thru" port. A third device can be connected to the 
second’s "MIDI thru", and so on. The "MIDI thru" port always delivers a copy of the 
signals coming into the device’s "MIDI in". It is preferable, however, to use a direct 
connection from a computer’s "MIDI out" to a device, rather than chaining too many 
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devices one after the other. Timing problems may occur in the chain if a lot of MIDI 
commands are sent in a short space of time. This is due to the slight delays 
introduced by each "MIDI in" to "MIDI thru" transaction. If your computer also 
features several MIDI inputs, they can be used for the connection of MIDI expanders.  

MIDI local off: If your keyboard features an internal sound source, it is important that 
you stop the keyboard from generating sounds directly from its own keyboard. If you 
buy a new keyboard that is to be used without a sequencer and connect it straight to 
an amplifier, you would expect the device to make a sound when you press its keys. In 
other words, the keyboard is internally connected to the sound synthesizer. This 
behavior, however, is not what you want to happen when using your keyboard with 
Samplitude Music Studio 2013. In this scenario, the keyboard is used as the 
computer’s input device, and Samplitude Music Studio 2013 is sending (i.e. playing) 
MIDI information to any connected sound synthesizer, be they the keyboard’s own 
sound generator, a sound card, or any other connected sound module. 

If you wanted to control and record another sound module using your keyboard as the 
input device, its own sounds would play alongside those of the other sound 
synthesizer, which is why the keyboard must be separated from its own internal 
synthesizer. This function is known as “Local OFF”, and is set directly on your 
keyboard. Refer to your keyboard’s manual for information on how to do this. Don’t 
worry about “breaking” the link between the keyboard and its internal sound 
generator – Samplitude Music Studio 2013 will act as the “missing link” in this 
scenario. 
 

Convert MIDI objects into audio files 
If you use VST instruments, then you won't have to convert these MIDI objects into 
audio data before exporting your entire arrangement, since the sound is created on 
your computer and can be processed there. 

If you still wish to do so (to free up processing power on your PC, for example), then 
switch the desired MIDI track to "Solo" and export the arrangement. Then add the 
exported file back into your arrangement and delete the MIDI objects in the exported 
track. 

All MIDI objects which open external synthesizers via a MIDI interface will have to be 
converted into audio objects if you want them to be exported as well. They only 
contain control information for sound reproduction. 

For this to happen, the output of the MIDI synthesizer (e.g. the sound card) must be 
connected to the input of the sound card. The MIDI data can then be played and 
recorded simultaneously via the record function. The result is an audio file that can be 
edited and exported together with the multimedia files. 
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MIDI settings 
Here you can specify which MIDI devices (view page 453) to use in Samplitude 
Music Studio 2013. 
 

MIDI: Import, record, edit 
Recording MIDI tracks 
Just as with the routing settings of audio tracks, you can also tell the program which 
MIDI input to use. 

Open the track settings dialog by right clicking on the field that contains the track 
name (track info box). In the "MIDI" section of the track settings, select the "MIDI 
recording device" which your keyboard or external sequencer is connected to. Select 
the MIDI playback device you use as the "Playback device" or MIDI output device, e.g. 
"MIDI out" of your sound card or a VST instrument. In the same dialog, activate the 
"MIDI" button in the "Recording" section. 

Note: You can activate the MIDI section of the track editor ("Menu window -> Track 
editor") by clicking the "MIDI" button in the track box.  Now right click "Rec" to 
select the MIDI input device as well as the instrument outputs of each selected 
playback device. You should also check the instrument outputs if the MIDI signal in 
the level display can be seen but no sound can be heard, and then adjust this to the 
MIDI output device (VST instrument). 

 

The following MIDI record modes are available: "Normal", "Overdub", "Multi-
overdub", and "Replace". These decide which of the newly recorded MIDI files will be 
added to the VIP. 

You can specify the settings for MIDI record modes in the transport control. Click on 
the arrow on the left beside the "Close" button in the transport control to display this 
section. 

You can also select the MIDI recording modes from "MIDI record mode" in the 
"MIDI" menu. 
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Normal: This recording mode corresponds to that of the audio recording, i.e. for each 
recording process a new MIDI object is created over the existing object. The old 
object remains intact. 

Overdub: The data is recorded into an already existing object; available and newly 
recorded MIDI data is mixed together. If you record over several objects, then these 
are combined into a single new object. 

Multi-overdub: The data is recorded into an already existing object; available and 
newly recorded MIDI data are mixed together, but existing objects remain the same. 
This mode makes sense for recording MIDI controller changes over several objects 
sequentially. 

Replace: The data is recorded to an existing object, and any MIDI data is overwritten. 
Several existing objects are combined into a single object. 

After selecting the mode, make sure that the recording is activated for the track. The 
record button, which is set to standby, changes to violet to signal that this MIDI track 
should record MIDI data. 

Now you can start the MIDI recording by pressing "R". After recording, you will be 
asked whether you want to keep or delete the recording. You also have the chance to 
change the record mode for the recorded MIDI data. After confirming this with "OK", 
your newly recorded material will appear as a "MIDI take" in the VIP. 
 

Importing MIDI data 
Existing MIDI files can be imported into a Samplitude Music Studio 2013 project as 
objects. However, you can also load a MIDI file as a separate object the same way as 
a wave, HDP, or RAP project. 

Menu: File/Open/MIDI (*.MID) … 
Shortcut: Shift + M 
Mouse: Drag & drop from file browser or Windows Explorer. 

If you import MIDI files, please note that only type 0 or 1 MIDI data is compatible with 
the import function. Each file should end with *.MID so that it can be recognized as a 
valid format. 

MIDI files are generally imported like a wave file, irrespective of whether they are 
imported in a VIP window or a MIDI project window. For a VIP you can specify at 
which position you want to insert the new MIDI object. Set the play cursor at this 
position, select a range in the desired track or drag the file from the internal explorer 
or Windows Explorer directly into the track position via drag & drop. 

Hint: The following dialog is automatically displayed if a VIP is already open as an 
active window. If you want to open the MIDI file in a separate MIDI project window 
without inserting the content into a VIP, please ensure that no VIP project window is 
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active. Samplitude Music Studio 2013 will also display the MIDI import dialog if only 
one range of a MIDI project window is dragged into a VIP track. 

 

The import dialog contains status information on the MIDI file you want to load: 

Each standard MIDI file also contains temp information. Samplitude Music Studio 
2013 displays this information in a separate section of the dialog. At this position of 
the import you can decide whether you want to adjust the VIP tempo to the tempo of 
the imported MIDI file. If necessary, a tempo marker is displayed in the VIP. 

If you select the option "All MIDI channels into one track", Samplitude Music Studio 
2013 inserts the MIDI object into the currently selected VIP track. The created MIDI 
object then contains all MIDI channels of the MIDI file. 
 

Editing MIDI objects 
Editing MIDI objects in Samplitude Music Studio 2013 follows the same principle as 
editing audio objects: MIDI objects can be copied, split, and trimmed, have fade 
handles for fading in or out, and a volume handle that scales the MIDI velocity. MIDI 
objects refer to the MIDI data you have recorded while playing or importing, but are 
not saved on the hard drive as a MIDI file but are saved as a project file instead. 

You can edit MIDI object in the MIDI object editor as well as in the different MIDI 
editors, i.e. piano roll, drum editor, controller editor, listen editor and score editor. 
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MIDI object editor 
Object:    Object editor 
Shortcut:   Ctrl + O 
Mouse:    Shift + double click 

MIDI object parameters may be easily edited using the MIDI object editor, which is 
structured similarly to the audio object editor. Among other options, you can set 
sound, length, volume, and program swapping for each MIDI object. 

A Samplitude Music Studio 2013 MIDI object can contain events in up to 16 channels. 
For example, it's possible to control a multi-output VST instrument using a single 
object on several MIDI channels. Notes in the corresponding MIDI editor can be 
edited simultaneously or only in one selected channel within this object. 

 

If there is only one channel in the MIDI object, settings will only be available for this 
MIDI channel. 

You can also use the MIDI object editor to quantize MIDI files into MIDI objects.  

Note: These settings influence the MIDI object in real time and not destructively, 
making the changes invisible in the MIDI matrix or drum editor. 

Important functions and settings in the MIDI object editor: 

Velocity: The velocity fader works comparably to the volume fader in the wave object 
editor. 

Normally, every MIDI note contains a velocity value which determines how "hard" the 
note will be played back. Changing the velocity value in the object editor scales the 
volume of the notes in the MIDI object to their physical maximum or minimal value 
(0 or 127), calculating it together with the actual velocity note value. Changing the 
fader is identical to changing the top-center handle of the MIDI object in the VIP 
track. 

MIDI real time effects: Here you'll find the settings for a MIDI channel: 

MIDI OUT channel: Here you can redirect the MIDI files of a channel to another 
channel. 
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Program: : The values preset here will always be sent if the object is played back 
again. Use these settings if various objects in a MIDI track should use different 
programs of a sound generator. 

Bank High/Low: This sets the MIDI Bank Change bytes. 

Transp.: This button transports all MIDI notes of the corresponding channel. 

Quantization:  While the quantization conducted in the MIDI editor has an immediate 
effect on the start position of the notes, a virtual quick quantization takes place. 
Absolute refers to the absolute resolution of the VIP project, while Relative refers to 
the relative resolution of the object itself. 

Options: 

Mute MIDI Controller:  Switches the MIDI controller off. 

Mute SysEx: Prevents control via the SysEx files. 

Position: Here you can specify the object start / position, object length, object end 
and  step size. The setting is equivalent to moving the object in the VIP track or 
changing the length using the lower length handles right and left in the object. 

Loop:  If you tick the checkbox here, then you will set the MIDI object to "Loop" mode. 
Now drag the bottom left object handle to the left and you will see that the events of 
the MIDI object are arranged in a row, according to the new length of the MIDI object.  

The object name is displayed in the upper text field and this may also be edited. 

In the square field to the side you can select the object color. 

Using the arrow keys you can "jump" up or down to the object of a neighboring track. 

Use the double arrow buttons to jump to the previous or next object. If multiple 
objects are selected, these buttons will not be active. 

If the "To all" option is active all selected objects are updated when the object editor 
is opened. All recently applied settings that have been made in a selected object, will 
be applied to all other selected objects.  

Note: In an object - velocity changes are transferred relatively, i. e. they are 
increased or decreased relative to the velocity of other selected objects. 

Bypass FX: Here you can deactivate all effects 

Freeze: If you click on the Freeze function for an object, this will be calculated as a 
new wave file with all the associated effects. The new Freeze object takes the place of 
the original object. 
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Play/stop: This button corresponds to the normal playback function (Shortcut: space 
bar). 

Lock: The activated Lock button corresponds to the key button's switch in the object. 
The object is then protected against any inadvertent horizontal movement. Additional 
locks against vertical moving, volume adjustment, fades, length adjustments, ripples 
or deletion can be set in the  system settings  (Shortcut "Y") under "Program -
>Object lock definitions". Locking can be temporarily cancelled by pressing the "alt" 
key. 

Solo: This button moves the play cursor, during playback, to the start of the selected 
object and plays that only. Track-dependent buses and AUX paths are also observed 
at playback. 

Mute: This button mutes the selected object. You can also mute the left and right 
channels individually too. 

Commentary: You can type comments relevant to the selected object in this field. 
 

Step recording via keyboard or controller 
keyboard 
In the MIDI editor, so-called "Step recording" may also be executed via the computer 
keyboard or a MIDI fingerboard. Activate the corresponding button first. 

 

A marker shows the scope of the current octave for the following entries. Now you 
can enter MIDI notes step-by-step via your keyboard. Note length and step length 
may be specified via the length quantization values. The most important keyboard 
shortcut for entering MIDI notes using step recording: 

Tab : One step forwards (set pause) 
Shift + Tab : One step backwards 
Ctrl + arrow up/arrow down : Octave entry up/down 
CDEFGAH : Note entry in current octave 
Shift : Enter chords 

Different notes may be entered without the play cursor jumping if you hold down the 
"Shift" key. This enables chords to be played. 

Of course, notes may also be entered in "Step recording" mode via the controller's 
keyboard. 
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MIDI editor 
Notation display, movement, zoom 
MIDI files can be edited in five main areas of the MIDI Editor: 

• Matrix Editor (Piano Roll) 
• Drum Editor (view page 190) (Possible to switch between Drum Editor and 

Piano-Roll) 
• Controller Editor (view page 184) (e. g. velocity , MIDI volume …) 
• Listen editor (view page 187) (Event List) 
• Score editor (view page 193) 

Here various tools are available, for example, pencil or eraser. Exact values for each 
MIDI event can also be set in the edit fields via the Piano Roll. 

With few exceptions, changes such as moving or deleting of notes always apply to all 
selected MIDI events, displayed in red. Changes made to a specific note always also 
apply to all other selected notes. You can, for example, select a group of notes in the 
Piano Roll and then change the velocity of these note groups which modifies all 
selected notes simultaneously. 
 

Notation display in piano roll and controller editor (with velocity curves) 
Notes which are not selected within the editor are displayed in blue. The intensity of 
the color symbolizes the velocity, and the velocity increases as the color gets 
darker/stronger. 

Selected notes: Multiple selected notes are displayed in red, and a more intense color 
symbolizes increased velocity. 

Current event: Appears in bright red with a red border. The properties of the currently 
selected events are displayed in the edit fields above the piano roll. If an event is 
selected with the mouse, it turns into the current event. 

Display of filtered events: You can filter specific events for the display to get a better 
overview of the events of a MIDI object. 

Example: The MIDI object as notes in the MIDI channels 1, 2, and 5. You can now 
make all notes in channels 2 and 5 accessible for the selection and editing tools via 
the selection of the MIDI channels in the channel filter by selecting the two channels 
from the menu. All unselected filtered notes in channel 1 are displayed in gray in the 
piano roll and the list editor. 

Events in the filtered channels can be completely hidden using "Hide filtered MIDI 
data" option in the menu. 
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The list editor provides additional display filters that only function within the list. The 
display filters are initiated with the settings of the playback filters (mute settings), but 
the filters can be set independently of one another. 

Display of muted events: MIDI object settings (in the MIDI object editor, "Ctrl + O") 
can be used to mute notes and filter other MIDI events. This type of "muted" event is 
displayed lighter or paler in the piano roll and list editor. 

Events in front of or behind the beginning/end of the object (recognizable by the blue 
lines in the editor or when the display is active and transparent as grayed-out ranges) 
appear similarly pale as non-muted events within the object borders. 

Events above and below the current picture section: Two small red displays above 
and below the vertical scroll bar to the right-hand side of the MIDI editor screen show 
in red if there are notes outside the screen's display. 
 

Moving and zooming 
The vertical and horizontal view or zoom are adjusted with the scroll bars just like in 
the project window. 

Mouse wheel: Scroll horizontally 
Shift + mouse wheel: Zoom vertically 
Shift + Ctrl + mouse wheel: Scroll vertically 
Ctrl + mouse wheel: Zoom horizontally 
 

Synchronized MIDI editor and VIP screen view 
If you change the horizontal display or zoom using the scroll bars, holding "Shift" 
changes the corresponding VIP window. 

Play/Play solo 
“Play solo” only plays the MIDI object that is currently opened in the MIDI editor 
(corresponding with the filter settings in the “Options” menu). “Play” plays the entire 
arrangement. 
 

Multi object editing (MO-Editing) 
 You can also load several MIDI objects simultaneously in the MIDI editor. All MIDI 
objects selected in the arranger are added to the MIDI editor by clicking the "MIDI 
editor" button in the Docker. 

 

In an already-opened MIDI Editor you can include additional MIDI objects for Multi 
Object editing by clicking in the Arranger while holding down the Shift key. 
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The MIDI editor (and in multi object editing) always shows the current MIDI object 
and the current arranger track from which this object originates. In the field to the 
right you should see the activated VST plug-in for this track. 

 

New MIDI events will always be inserted into the current object (i.e. the currently 
displayed object). In Score mode the current note line is observed.  

If you click on the arrow next to the object/ track display, you will see all MIDI 
objects/MIDI tracks in MO Editing mode listed beneath one another. Here the current 
object or current track has a tick. 

When selecting notes or MIDI events or when clicking using the pen tool the 
associated object becomes the active object. The current Note line will be 
automatically converted in the Note editor. 

You can also copy and insert MIDI notes between multiple objects. 

The Current object area can be highlighted using the button behind the object 
selection field. Areas lying outside the current object will be grayed-out and the notes 
of other objects will be paler, but still selectable. 

 

A display filter for the current track may be activated while in MO editing mode. 
Data from other tracks are then grayed out. If the option "Hide filtered MIDI data" in 
the "Options" menu is activated, then MIDI events that are not current will be made 
invisible. 

 

Note: If the note editor is activated at the same time, only the velocity values of the 
current staff will be displayed in the controller editor. 
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In representing notes, the note system of the current track will be highlighted using 
blue note lines. 
 

Using the MIDI editor: Selecting events 
• Select event: Left click on event 
• Add/Remove event (selection): Ctrl + left click on event 
• Change/Set current event within multiple selection: Left click on selected event 
• Set current event, deselect all other events: Double click on event 
• Selection of events within a line or range: Click while holding down "Shift" 
• Selection of all notes of a pitch: Double click on the assigned key on the left 

keyboard 
• Selection of all notes: Ctrl + A (functions for pitches selected with a key on notes 

with this pitch) 
• Select next or preceding note: Cursor left, right 
 

Selection of MIDI events (piano roll, drum editor, controller editor, list editor, 
score editor) 
Special selection options in the piano roll 
In order to directly select all notes of a certain pitch, double click on a free section 
with this pitch in the piano roll editor or in the keyboard. Hold down the "Alt" key to 
select notes with this pitch only from this click position. 

Holding "Shift" and double clicking on a free area selects all notes (all pitches) from 
the click position onwards. 

Note: If you press "Ctrl" as well during any of these selection methods, the new 
selection is added to the current one (i. e. the previous selection is not canceled). 
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Edit events: Matrix Editor (Piano Roll) 

 

For notes inside the Piano Roll, there are various editing options, so-called mouse 
modes. All the same functions apply in all modes (except for delete) for Note editing, 
so that these modes differ from one another in behavior only when clicking on free 
areas. 

 

Tip: You can switch between mouse modes using number keys 1-9 and the M key, 
but the MIDI Editor must be in focus for this to work. 

 Selection (1) 
Lasso: you can drag a selection frame while holding down the mouse key. 
Clicking on a free range highlights an existing selection. 

 Draw Pencil (2) 
A note can be drawn with a left-click. Beginning and length are determined 
according to the current quantization settings 
Various other drawing modes can be selected with a right-click on the small 
arrow. 

 Drum Pencil (3) 
A sequence of notes is drawn. The note length and interval are determined 
based on the current quantization settings. 
+ Alt Key: The first note's pitch will be retained for all further drawn notes. 
Moving backwards with the mouse (to the left) while holding the key down 
removes already drawn notes. 
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 Pattern Pencil (4) 
This mode allows you to draw entire Drum Patterns (or melody patterns). If you 
want to create a new pattern, you have to select it first in "Selection Mode" and 
press the keys Ctrl+N simultaneously (or go to menu "Edit" in the "MIDI/Drum 
Editor > Create pattern from selection"). If you have created a pattern, you can 
start drawing at any position. Draw the pattern at the position of the deepest 
note of the pattern. This makes an original pitch sound. You can, of course, draw 
in a different pitch. 
+ Alt Key: The first note's pitch will be retained for the following notes. 
Moving the mouse back (to the left) while holding down the mouse button 
removes the notes which were just drawn. 

 Velocity change (5) 
The velocity values for the selected events can be adjusted in relation to each 
other by holding down the mouse key and dragging up or down. 
+ Shift Key: Absolute velocity values will be changed, changing all velocity 
values to the same one. 

 Delete (6) 
Clicking on the selected note deletes all selected notes. Dragging the mouse 
deletes all notes underneath the eraser. 

 Magnifying glass (7) 
Left click: zoom in 
Right click: zoom out 
Left click + drag: Zoom in into a range 
The zoom mode can also be activated temporarily by holding down a special key 
(default: Z key). After releasing the key, the set mouse mode is reactivated. 

 Glue notes (8)  
Glues the note with the next note of the same pitch. 

 Split notes (9)  
A note bar in the matrix is divided into two notes with a click. If the grid is active, 
the separation will take place at the next grid position. 

 Mute (M) 
Individual notes or selected note groups can be muted and unmuted with a click. 
Also available as a command in the "MIDI Functions" menu. 

Tips: 

• Keyboard shortcuts for switching between mouse modes (tools) may be freely 
defined (view page 465).  

• "Delete" mode may be activated anytime by clicking/dragging with the right 
mouse button.  You can, for example, add new notes with the pen using a left-
click and remove already drawn notes with a right-click, without having to change 
the tool. 

• Notes created with the drawing mode receive a MIDI channel and velocity from 
the Edit Fields via the Piano Roll. 

• You can select the next/previous note using the left/right arrows. With the arrow 
up/down you can change the pitch of selected notes in a stepwise fashion. 
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Selecting MIDI events 
(Piano roll, velocity editor, list editor, ) 

Select event  Left click event 
Add/delete event from selection Ctrl + left click event 
Select current event and unselect all 
other events  

Double click event 

Change or set current event within 
multiple selection 

Left click selected event 

Select events from the same line or 
area 

Click while pressing the "Shift" key 

Selects all notes of the same pitch Double click the desired key on the keyboard 
ruler to the left 

Selects all notes Ctrl + A (if a pitch is selected on the keyboard 
ruler, only notes with this pitch are selected)  

Selects the next or previous note  Arrow keys 

As you can see from this list, a simple click is all it takes to choose a specific event for 
editing – even from selections containing several events such as a pattern. 
 

Edit notes with the mouse 
If you move the mouse over a note, the mouse cursor will change and, depending on 
the part of the note, the following options will be available: 

 Change note start time (Grab note bar at the beginning, note end 
remains the same) 

 Change note length (Grab note length at end) 

 + Shift Set fixed note length for multi-selection: Hold "Shift"  and drag the 
current reference note longer/shorter – all notes will have the same 
length 

 + Ctrl Scale note length for multi-selection: Hold "Ctrl" and drag current 
reference note longer – all notes will be lengthened by the same factor 

 Move note freely, pitch and start time change 

  If in "Move" mode "Alt" is also pressed, the note will only be moved 
horizontally, retain pitch (in free move mode, hold "Alt") 

 If "Shift" is pressed while in "Free draw" mode, only the pitch can be 
changed, the position will remain the same. 

/  "Ranges for limited moving": If you activate this setting in the 
"Options" menu, clicking and dragging in the start portion of the note 
only results in a change to the position, while clicking on the end 
portion changes the pitch. 
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Editing selected events (edit fields) 
The properties of each event in the piano roll, controller, and list editor can be edited 
by clicking the edit fields below the editing tools. The following buttons are available 
for each note: 

• Channel 
• Byte 1 (or pitch) 
• Byte 2 (or velocity) 
• (Start) time in bars: beats: ticks 
• Length in bars: beats: ticks 

The display of the ticks has a resolution of 384 PPQ (i.e. 384 ticks correspond to a 
quarter note). 

Used to edit, click, and drag the displayed value. Hold down the left mouse button and 
drag up or down to increase or decrease the value. 

Note: The value adjustments are greater if you press "Ctrl". 

You can also edit the value numerically via the keyboard by clicking on the figure. 

Multi-selecting events leads to a few special features:  

You can change the values relatively by dragging the mouse, using the mouse wheel, 
or entering numeric values and then confirming by pressing "Enter" (for pitch and 
velocity). 

You can make absolute changes by simultaneously holding "Shift" while dragging & 
dropping or by completing your entry with "Shift + Enter". 

Note: MIDI channel changes are always absolute. 

 

Moving and zooming 
The vertical and horizontal view or zoom are adjusted with the scroll bars just like in 
the project window. 

Mouse wheel: Scroll horizontally 
Shift + mouse wheel: Zoom vertically 
Shift + Ctrl + mouse wheel: Scroll vertically 
Ctrl + mouse wheel: Zoom horizontally 
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Controller editor - Selecting and editing events 
The controller editor is located below the piano roll and can be hidden. 

 
It is opened either with a click on the button below the keyboard or via "Alt + 
V". 

The velocity values of existing events are displayed as colored bars in the controller 
editor, whereby darker and higher bars symbolize larger values. The bars are located 
directly below the notes. 

The values of all other controllers will appear in controller editor as ramps. Here, too 
the height of the ramps and their color intensity represent the last defined value of 
each event. The length of the represented ramps reached to the next varying event. 
Selected event ramps are also represented in red. 
 

Tools 
The Controller Editor has its own tools for editing curves and values. 

 
Controller selection: A click on the menu area of the button opens a 
selection menu in which the MIDI controller for editing can be selected. 

 Selection: This is a combi tool used for value changes as well as freehand and 
line drawing. 

Click in the upper range of a controller bar to modify the controller value immediately 
by dragging. Clicking in the lower two thirds of the bar selects the corresponding note 
which is then highlighted in red in the editors. 

Select multiple controller bars by clicking and dragging a range in the Controller 
Editor; individual values can be selected by single-clicking within the bar. Selected 
controller events will be highlighted red. 

Combi tool editing options: 

• Click on the bar end + drag: The controller value can now be adjusted by dragging 
vertically. If you hold the "Shift" key down while dragging, all of the selected 
events will be set to the same value. If you also hold down "Ctrl", then the values 
of multiple selected controllers will be changed relative to one another.  

• Alt + Drag: This activates freehand drawing; the mouse pointer becomes a pencil. 
By dragging in the corresponding controller area, you can draw in any number of 
controller curves. 

• Shift + Drag: This activates line drawing and the mouse pointer becomes a cross 
hairs. By dragging horizontally, you can draw in linear value curves (ramps). 
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Freehand drawing: Draws new controller value curves or individual values by 
single-clicking without dragging. 

By dragging backwards, you can delete your curve during drawing. Shift + Drag with 
the cross hairs to draw a line. 

 
Draw lines: Use the line function to insert a transition between two different 
controller values. 

Hint: If you edit velocity with the draw tools, no new notes are generated; only 
existing velocity values are modified. 
 

Quantize controller events 
MIDI controller events can be quantized and thinned out; select the "MIDI functions" 
menu and the "Quantize/Thin out controller" command to do this. Quantization 
occurs according to the quantization settings (view page 207). 
 

Multi-view 
The four multi-buttons are used to display or hide the view of all possible controller 
curves. Clicking on the menu area of the buttons opens a menu which allows you to 
choose a MIDI controller for this controller slot. 

Selecting and processing notes: By clicking in the upper range of a controller column, 
the controller value can be changed immediately by dragging the mouse. Clicking in 
the lower two thirds of the column selects the corresponding note (displayed in the 
editor in red). 

Tips:  

The size of the controller editor can be determined by the dragging the mouse to the 
top edge (directly below the horizontal scroll bar). 

Several controller events can be shifted simultaneously. First select all values you 
want to move (if necessary, hold "Ctrl" to select different controller types together). 
You can now move the selection in the time box by entering a value and confirming 
with "Enter", or by dragging the mouse.  

Use the display filter function for velocity values. 

In polyphonic events especially the columns are located above each other, making it 
difficult to select the respective note. To edit only notes of a certain pitch, e.g. all C1 
notes in the controller editor, click on the respective key on the keyboard. The key and 
the background of the selected pitch are highlighted. Only notes of this pitch are 
displayed in the controller editor. 

Notes of different pitches, e.g. all C1, D1, and A1 notes can be displayed with "Ctrl + 
Click" (or "Shift + Click" for the area between the clicks, respectively). These are 
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simply display options of the controller editor. Multiple note selection by double 
clicking is not possible. 

A further possibility is to selectively edit controller bars located on top of each other, 
which is based on the fact that the bar of the currently selected note is 
selected/edited using the mouse. Therefore, first click on the note within the piano 
roll, or click on the columns located on top of each other and then select the required 
note using the cursor keys. Then change the controller value by clicking in the upper 
third of the red (current) area of the column. 

Besides directly changing the velocity values of a selected note you can change 
several velocity values at once by clicking in a free space and dragging the mouse 
over several velocity values while holding down the key. You can then also create 
sequences by moving the mouse in a curve. A previous (multi)selection is ignored. 
For example, you can easily create a crescendo or decrescendo effect. 
 

List editor (midi event list) 
Open list editor 

The MIDI editor has an integrated display of all events in list format. This list editor 
can be opened with the button above the keyboard or by using the “Alt + L” keyboard 
shortcut. 

When the list editor is opened and activated for editing it has a narrow red border. 
This is to make clear that certain functions, e.g. select next/previous event (cursor 
keys) or the “Select all” command, refer only to the list. 

Working with the list editor 

The list editor does not only display note events, but also MIDI controller and SysEx 
data. This controller and the data can be hidden and can even be filtered during 
playback (“mute”). 

Double clicking on a SysEx entry in the list opens a simple editor for viewing and 
editing the SysEx information. 

A note always has a "Note on" and "Note off" event. These are always selected and 
edited in pairs (note off events are not displayed by default, but can be displayed by 
checking the box below the editor). 

New events can be created directly in the list editor by using the “Insert" button. The 
current values of the edit fields in the upper frame of the piano roll always apply. 
Therefore, before editing these fields please ensure that no event in the piano roll is 
selected. 
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Tip: If no current event has been selected, you can determine the insert position by 
setting the play cursor. 

 

For editing certain events only, the list editor has a view filter for each column. These 
are small check boxes above the list editor columns. 

Select a representative format, e.g. a note of a certain pitch. Then click on the display 
filter of a specific column to display only events of this type, e.g. of the selected pitch. 
All other events are now hidden. 

View filters can be combined. For example, you can use the “Select all” command 
("Ctrl + A") to select and edit all type 10 control change events (volume) of MIDI 
channel 6. 

MIDI editor tips & tricks 
You can copy & paste MIDI data within the editor and between different MIDI 
objects. MIDI data is always inserted at the current position of the play cursor. 

Duplicating: If the grid is activated (“Options -> Quantization grid active"), the 
selected notes are copied and inserted from the next grid point following the 
selection. They are otherwise inserted immediately after the selection. 
 

MIDI functions 
The "MIDI functions" menu contains advanced quantization (More information can 
be found in the section "Quantization settings" on page 207) and editing functions for 
MIDI notes. 

The commands in the "MIDI functions" menu always affect the selected notes. If no 
notes have been selected, all functions are applied to all notes. 

Legato: Notes may be sustained until the next note, i.e. legato. 
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Quantize notes (default):  A default quantization is applied to all of the selected 
notes. If no notes are selected, then all notes will be quantized. The default action may 
be specified in the Quantization settings (view page 207) dialog. "Quantize notes 
(start and length)" is the default. This function can be accessed via the "Quantization" 
button in the MIDI editor. 

Advanced quantization 
This submenu contains additional quantization commands. 

Start Q: Selected notes will be quantized corresponding to the set grid quantization 
value. Note lengths remain unaffected. 

Start and length Q: Selected notes will be quantized corresponding to the set grid and 
length quantization values. Hard quantization always occurs at 100%.  

Soft Q: This command considers the current level values in the quantization options. 
The simple quantization command always occurs at 100%. In this manner, you can 
always select between approximation (soft) and a harder quantization without having 
to adjust the quantization options every time. 

Length Q: Selected notes will be quantized according to the set length quantization 
value. The start time remains unaffected. 

Quantize notes to grid: The end of selected notes will be quantized according to the 
set grid quantization value. The start time remains unaffected, but the note lengths 
will change. 

Reverse quantization: With this command, you can reverse all completed 
quantization steps. This functions even after the arrangement has been saved. 

Quantization settings: Opens the selection dialog for the Quantization settings (view 
page 207). 

Quantize controller events: Allows you to quantize controller events (view page 186) 
to reduce their number. 

Mute notes (Mute): Mutes and unmutes notes or selected note groups with a click. 

Remove overlaps (polyphonic): Notes may be shortened so that there no longer are 
any overlaps. Chords (simultaneously played notes) are recognized and not 
corrected, i. e. chords are not split up. 

Remove overlaps (monophonic): Notes may be shortened so that there no longer are 
any overlaps. Forces monophonic voice leading. 

Convert sustain pedal to note lengths: This function converts sustain pedal controller 
events (controller 64) into note lengths. All notes which were started after a "Pedal 
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pressed" event (CC64 > 64) will be extended to the "Release pedal" event (CC64 < 
64), and the pedal events removed. 
 

Drum Editor 
After you have opened the MIDI Editor by double-clicking on an object , switch by 
clicking another area. 

 

in the drum editor by clicking it. Instead of piano keys ordered to the left, you will now 
see a list of percussion instruments. 

 

Note: If a Drum Map is already activated in the Arranger track (recognizable by the 
entry next to "map" in the MIDI part of the Track Editors), then the Drum Editor will 
automatically be loaded when MIDI Editor is opened. 

 

Switch to Drum Editor Mode and back. 
After opening the MIDI editor (double click the MIDI object), switch to 
"Drum editor" mode by pressing the drum editor button.  

Instead of the piano keys to the left, you now see a list of drum instruments. 

When you switch from "Drum editor" mode back to the normal piano roll, you will be 
asked if you wish to apply mapping or not. If you add mapping, all mapping settings 
(which makes a note sound different to how it is displayed) will be applied to the 
MIDI object. If notes, for example, are routed through channel 10 (GM drum channel) 
via mapping, the notes will be replaced by corresponding "real" note events on 
channel 10. 
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Cell mode 
"Cell" mode serves to improve the overview as it limits the display to only the most 
important information, note starting points, and velocity. 

Each time position of a bar is displayed as a row of cells in on/off states. The note 
length is not displayed, but rather a unified display width is used. This way, it all looks 
similar to the step sequencer of a drum computer (see Robota (view page 260)). 

The set quantization grid can be read from the width of cells. "Swing" and "Offset" 
settings of the quantization options are also made clearer thanks to cells of various 
widths and by repositioning. 

The height of cells displays the velocity of the note. When drawing new drum notes 
the velocity can be specified via the vertical drawing position within the cells. In 
connection with the "Drum draw" mode, increasingly loud drum rolls can be drawn in 
easily. 

By clicking on the upper edge of a cell and dragging it vertically with the mouse, the 
velocity can be adjusted directly without having to use the controller editor. In 
"Velocity" mouse mode ("Ctrl + 5") it's even easier; all you need to do is click 
anywhere on the cell. 
 

Velocity 
If this button is active, the bar height is used when displaying the velocity value of the 
note. In all mouse modes (except for "Delete") the velocity can be changed by directly 
clicking on a note without have to switch to the controller editor. 
 

Drum Editor trackbox 
In the drum editor, each individual note has its own trackbox, and individual settings 
can be specified for each instrument. When zoomed out, each trackbox can be 
increased in size with a simple mouse click. 

 

S/M: Each individual instrument can be played solo (S) or muted (M). 

Note number: The output note from the instrument can be set here. This can be 
different to the note currently displayed in the MIDI object so that individual drum 
instruments can be substituted. To put the display of notes back into the usual order 
(deep notes at the bottom, highs at the top), click on "Map" at the top and use the 
"Sort drum map" command. 

Instrument name: Double clicking on this field lets you rename your drum instrument. 
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 Quantization options/colors: Use this menu to assign any one of the eight 
different colors to the cells of a drum instrument. The dialog for the instrument's 
quantization options is also opened here. 

The dialog is the same as for global quantization options (view page 207), but the 
settings only apply to the individual quantization options if an individual grid value is 
set for the note as well.  

K Output channel 
# Quantization grid, "Glo" refers to the global value (More information can be found 

in the section "Quantization settings" on page 207) 
L Note length, # corresponds to the grid value, "Glo" to the global value 

 Length of the notation, # corresponds to the grid value (i. e. the entire cell width), 
"Glo" refers to the global value of the note length 

V Velocity scaling: The velocity value of each note is multiplied by the value set here 
in %. 

Scaling is audible, but is not visualized further. The purpose of this setting is the 
customization of the volume ratio between the individual drum instruments. Software 
instruments usually provide their own mixers. 
 

Drum Maps 
Drum maps specify individual instruments, e.g. bass, drum, hi hat, snare, etc. An 
individual output note, MIDI channel, and velocity scaling can be set for each of these 
instruments. 

 The drum map can be set in the drum editor by clicking 
the "Map" field. 

To split the drum names a "General MIDI" map is used by default. It may be the case 
that your synthesizer (regardless if real or virtual) uses a different mapping setup. 

This means that when you play the drum event, the sound you wish to hear may not 
be heard (for example, instead of a bass drum, you get a high tom). In this case you 
will have to re-sort your mapping setup. The settings for individual instruments can be 
specified in the trackbox. For more extensive changes we recommend using the drum 
map editor. There you can save your drum map as a file. 

A project may contain various different drum maps. All drum maps saved in the 
project can be selected via the menu. If you require a drum map from a *.map file, you 
will have to load it into the drum map editor first so that if can be shown in the menu. 
You can edit the individual drum maps in the drum map editor. 
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Drum Map Editor 
The drum map editor can be used to create and edit drum maps. 

The "Drum maps" list on the left-hand side displays all drum maps which are available 
to the project. The drum map GM General MIDI is always available to start off with. 

New: Creates a new, empty drum map. 

Copy: Creates a copy of the existing map. This way you can quickly create variations 
of a drum map with various note allocations which can then be toggled via the drum 
editor. 

Load/Save: Use this to save a drum map (*.map file). This way you can use a drum 
map you created for a synthesizer in other projects as well. All loaded maps will be 
displayed in the "Map" menu of the drum editor. 

Delete: Removes the selected drum map from the project. 

Use the name field to rename the selected drum map. The settings (mapping) of the 
individual notes for each drum map will be displayed below this in tabular format. 

Pitch: This is the incoming MIDI note. 

Instrument: Displays the name of the drum instrument, e.g. "Bassdrum 1". 

Grid: If desired, you can set up a grid for the starting point of the drum events. 

Length: In this field you can set the grid for the note length. 

Output note: This is the note value to which the drum instrument (the incoming MIDI 
note in the "Pitch" field) should be routed or mapped. 

Channel: You can set up an individual channel for each instrument here. 

Quantization options: This opens the dialog for the each instrument's quantization 
options (view page 207). 

Instrument, grid, length... apply to all: This applies the corresponding setting of the 
selected instrument to all other instruments. 
 

Score editor 
The score editor displays the MIDI data of a MIDI object as a score sheet. It 
"interprets" the available MIDI data into real time. If you move or change the MIDI 
data, such changes are immediately reflected in the score image. If you insert a new 
note in the score editor, a corresponding MIDI "Note on" event is created 
immediately. Therefore, do not view the score editor as a score painting program, but 
more as an interpreter for MIDI data. 
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For instance, it is not possible to insert or delete rest symbols directly. Samplitude 
Music Studio 2013 automatically "registers" rests in the gaps between the MIDI 
notes. You will therefore always have a valid score sheet and "complete" bars, even if 
the MIDI object should only contain a single MIDI note: the necessary rests are 
automatically inserted into the bars. 

The common controllers of the MIDI editor in the score editor operate as usual, e.g. 
the eraser is used for deleting notes or the pen for creating, copying, and inserting 
new notes. In this chapter you will learn how you can edit your MIDI objects within 
the regular score. While the event editor contains specific editing options for certain 
details (dynamics, note length), it is better to make MIDI changes directly in the score 
sheet as it guarantees a better overview. 
 

Opening the score editor 
The score editor is integrated into the MIDI editor window. If the MIDI editor is 
opened, then you can activate the linear score view by pressing the "Score editor 
(linear)" button. 

 
Score editor (linear) button 

Navigation: You can adjust the play cursor directly in the score by holding shift and 
clicking the desired position. You can set the playback range by holding the "Shift" key 
and left clicking the left border and right clicking the right border of the range. 
 

Score editor modes 
Samplitude Music Studio 2013 offers two alternatives for viewing the score: linear 
display and page mode.  

The linear note display can be combined with the matrix display to offer ideal MIDI 
editing conditions, since the detail in depth of the matrix editor and overview can be 
supplemented by several score systems. You can select the score in the score sheet 
and perform fine adjustments in the piano roll. Selection and zooms in all editor views 
(linear score, piano roll, event list, velocity editor) are always synchronized. 
 

Linear view 

 
Score editor (linear) button 

For detailed editing of the MIDI data in the score you should preferably select linear 
view mode as both matrix and velocity display are available. All parameters such as 
pitch, note length, and velocity are displayed. 

Please note: Only the notes of the currently active system are displayed in the 
velocity editor if notes and velocity are parallel. The red bar mark indicates the 
currently active system. 
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Notation view in "Linear" mode (move bar between score and matrix) 

The horizontal zoom above the scroll bar zooms parallel to the matrix view. 

In linear mode details can no longer be displayed correctly if you zoom out 
horizontally, since the note symbols overlap. It may then be necessary to reduce the 
size of the notation symbols (+ & - buttons on the right). Despite the no longer 
correctly displayed details, zooming out can still provide you with a good overview, 
particularly in large scores. Samplitude Music Studio 2013 can adjust the notation 
symbols automatically. To do this, please select "Automatic zoom" in the score menu. 
 

Page view 
This page mode displays the notes just like on a musical score sheet, which also 
serves as a print preview. Here you can select notes and allocate them to 
voices/staves and delete them, although you cannot move them with the mouse or 
pen. 

 
Score editor page mode 

Page view is not only useful for preparing a score sheet (e.g. for titles, borders), but 
also for editing longer sequences. The stave break allows you to display considerably 
more bars than with the linear display. 
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Scrolling in full view mode: Use the vertical scroll bar to scroll from page to page. 

 

Page mode as print preview: You should first change the page format (in the score 
properties dialog) to the paper format of your printer before setting up the page for 
printing as the display depends on the page format. You will then see your score 
exactly as it will be printed. 
 

Score sheet 
The automatic conversion of MIDI data into score material is usually sufficient for 
editing MIDI data; in this case, efficiency is required instead of a perfect, ready-to-
print display. However, it may still be necessary to adjust some of the display options 
for the musical material during editing. These display options can be found in the 
"MIDI score properties" dialog, which you can open by clicking the corresponding 
button. 

 
Open score settings dialog for notation system and page properties 

Presets are available here, too. These are pre-programmed standard settings for 
certain instruments or groups such as "strings" or "orchestra". Selecting a preset 
improves the score display and its readability. 

 

Violin clef view (preset) 
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Changing the score by selecting the piano presets 

More information about the score is available below. 
 

Editing MIDI data in the score sheet 
Selection 
As usual you can select notes by clicking them. You can select a group of notes (e.g. a 
chord) by sketching a frame over them while holding down the mouse button. Select 
multiple single notes by pressing "Ctrl". 
 

Note parameters 
The parameters pitch, velocity, and length can be changed for one or several selected 
notes. If you have selected one or several notes the data of the current note will 
appear in the info bar above the score view. Changing a parameter may have a 
comparable effect on all selected notes, just like in the matrix editor. 
 

Move and transpose 
To move notes, first select and then drag them to the desired position. Here the info 
box can help you keep track of the pitch or position. The step size when moving is 
determined by the selected quantization raster in the MIDI editor. 
 

Copy 
Select the desired notes and copy them by holding down "Ctrl" and dragging the 
mouse. Alternatively, you can also use the copy function of the edit menu. 
 

Insert new notes 
You can also insert new notes in the score editor by using the pen. Click on the 
desired position with the pen, hold down the mouse button and, if necessary, correct 
the position and pitch. If you let go of the mouse key, Samplitude Music Studio 2013 
will add a new note of the same length as the selected length quantization value. You 
can only insert new notes into the active stave. For instance, to insert a note in the 
lower part of a piano system, first click on the lower staff in the system on the left.  

Only notes are inserted that correspond with the current pitch. Non-scale notes or 
chromatic intermediate steps are skipped. When you enter conventional music 
material with the mouse, diatonic insert mode increases the chances of hitting the 
correct note. If a new prefix is to be added to the note, you can move the note 
chromatically with the arrow key. This way an inserted F in C major can be 
transformed into an F# by pressing "Page up".  
 

Delete notes 
You can delete notes by: 

• selecting them and pressing "Del" or 
• by clicking on them with the eraser (or the right mouse button) 
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Insert notation symbols 
Clef symbols can be inserted at the current cursor position by pressing the 
corresponding clef symbol in the active system. 
 

Delete notation symbol 
Notation symbols such as clef and pitch cannot be selected, since they are meta 
information for the notation display and no MIDI events have been allocated to them. 
They can also be deleted by clicking them with the eraser (or the right mouse button). 
 

Adjusting and optimizing the score 
Samplitude Music Studio 2013 automatically generates a notation display from the 
MIDI events contained in the MIDI object. This is always correct with regard to pitch 
and position. However, this does not mean that the notation can be read optimally, 
since displaying note lengths also plays an important role in this context. In this case, 
the notation permits more interpretation flexibility so that the user usually has to 
intervene. The illustration shows a typical example of how poor a readable 
transformation of a sixteenth note piano sequence would look in notation.  

This representation may be correct, but it is not readable. Why is that? The MIDI 
events contain very precise information on the start of a note, i.e. its length and pitch, 
which has to be taken into account during playback. It may influence the groove of a 
song if the notes are always slightly shorter than sixteenth notes. If this were to be 
displayed correctly in the notation, then the score would be unreadable as in the 
example above. The MIDI events also do not contain information on whether the gap 
between two notes is a real rest, its harmonic correlations (pitch), and the 
characteristics of the dynamic sequences. This is why automatic processing of 
notation always differs from what would be ideal. Samplitude Music Studio 2013 
includes a number of automatically and manually controllable functions for making it 
easier to read the notation. The reworked version of the the above score illustration 
shows how big the difference can be. 
 

Note allocation in multiple staves 
The term "Stave" refers to an individual line within a stave as well as all staves of a 
score. In cases where it is important to be able to differentiate a score and a staff from 
one another, we use the term "Stave" for the score and "staff" for a single system. 

What is meant by a "Stave" can often be interpreted from this relation, for example, in 
a two-handed piano piece, "upper" or "lower" systems are referenced. 

Samplitude Music Studio 2013 provides multiple systems, e.g. for piano notation, or 
entire scores which can possibly be comprised of up to 16 individual systems. 
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To manually assign notes to a system, click 

 

to move the selected notes one line on a stave higher. Click 

 

to move them one line lower. This results in the note being connected to the line 
(independent of the MIDI channel or pitch). This manually set allocation can be 
undone by clicking on  

 "Automatic staff allocation"  

When transcribing a MIDI piano recording, splitting the notes into a two-line piano 
system using the split point is recommended. The points where individual notes are 
placed incorrectly in a line can be corrected easily by assigning the notes manually 
with a click to the desired stave. 

The automatic allocation of the score to a specific line is flexible. Either the MIDI 
channel of the note event, the pitch, or even a combination of the two can make up 
the criteria. This permits simpler and faster distribution of MIDI notes in the score 
line.  

For example, it's often the case with some standard MIDI files that a particular piano 
piece's lower system notes have a different MIDI channel than that of the notes of the 
upper stave. Let's assume the notes for the right hand are on channel 1 and the notes 
for the left hand are on channel 2. In this case you should set up two staves for the 
stave in the note stave settings. The easiest way to do this is with the "Piano" preset. 
For the first staff, set the MIDI channel allocation to "Ch. 1" in the "Channel" selection 
box and "Ch. 2" for the second staff. Deactivate allocation according to pitch by 
setting the split point to 0 (see MIDI score settings dialog). 

The rules for allocation are as follows: 

If the (preset) option "Automatic stave allocation" is set for the note, then the staves 
will be played through until the MIDI channel corresponds with it and the pitch is over 
or equal to the split point. 

Note: It may happen that some notes are not shown at all as they are not yet 
allocated to a stave. 
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Multi-voice notation 
Up to two independent voices can be annotated for each staff. The voices differ in the 
direction of the note stems: the first voice is always with the stem pointing upwards, 
the second with the stem pointing downwards. Rests are displayed individually for 
each voice. 

Multi-voice notation can simplify the score considerably and enable multiple instruments or 
parts to be displayed in one staff together.  

 

You can set the voice by selecting the notes and clicking on the button or menu 
command "Assign first voice" or "Assign second voice". 

 

This sets the stem direction of the notes, and therefore the voice itself. 

This assignment can be undone by clicking on 

 "Automatic staff assignment for notes". 

For automatic voice assignment, the note's MIDI channel has to be analyzed. 

To do this, set up a MIDI channel for the second voice in the stave properties dialog. 
This can be set individually for each staff. All notes of a stave whose MIDI channel 
has not yet been assigned to a second voice, are added to the first voice. 

Voice assignment via the MIDI channel can be practical when displaying standard 
MIDI files with multi-voice piano pieces if the voices of the right hand are set to the 
first and second MIDI channels and the voices of the left hand are set to MIDI 
channels three and four. In this case, apply the following settings: 

 

Note: If there is no MIDI channel selected for voice assignment, only one voice will 
be annotated (if manual voice assignment does not occur). 
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MIDI score settings dialog 

 
Open score settings dialog for stave and page properties 

Note stave and page format settings can be set here. None of the settings have any 
influence on the MIDI data itself, but rather only on the display of the score. 

 

Note: The affected stave settings are always applied to all MIDI objects situated on 
the current track. The page format settings are global and valid for every VIP. 

 

Stave settings 
All settings for the stave and display parameters/options can be accessed via this 
dialog page. Here you can enter the clef.  

Samplitude Music Studio 2013 provides MIDI files with up to 16 staves on one track. 
For each staff, the clef, display transposition (for instruments that transpose, for 
example, a saxophone), and display quantization can be specified individually. 

Furthermore, an instrument's prefix ("Name") can be set as well as the MIDI channel 
for automatic stave/voice assignment. 

Similarly, the split point serves automatic stave assignment: Notes above the split 
point are added to the upper stave, while those under the split point are added to the 
stave beneath it (as long as the MIDI channel matches). 

The active staff is recognizable via the index marked in red. The list of 16 staves can 
be scrolled vertically using the arrow buttons (up/down). In the lower range the 
display options of the active staff are shown. 
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Optionally, all changes to settings, display options, clef, and display quantization are 
always transferred equally to all staves. 
 

Note display: Interpretation options 
None of the options have any influence on the MIDI files or playback. 

Simplify note lengths (interpretation) 

Displays rests and slurred notes in such a way that the score is as legible as possible 
without influencing playback. 

Automatic staccato articulations 

A staccato symbol is added to a note whose value is considerably longer than the 
"real MIDI note". This is practical when working with simplified length display. 

 

Option: "Simplify note lengths (interpretation)" selected.  

Additional option: "Automatic staccato articulations". 

Hide note overlaps 

Prevents the overlapping of sequential notes which, for example, arises as a result of 
playing legato: 

Recognize triplets 

Activate this option if triplets are present in the MIDI object. 

Please note: The display quantization value always has to be one step finer than the 
smallest discernible triplet value. To recognize one eighth triplets, display 
quantization has to be set to at least one sixteenth (or to 1/64 for 1/32 triplets). 

Strict measure/pulse division 

There are no note or rest values longer than a beat subgroup (pulse). Longer notes are 
displayed as multiple slurred notes. This can simplify the legibility of the score. 
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Larger beam groups 

Beam groups are partially compiled across beat subgroups. This can simplify the 
legibility of the score. 

Recognize grace notes 

Note values which are much shorter than the display quantization value are 
annotated as flam notes as long as a base note is present. 
 

Notation symbols 
Clef 

 

There are four clefs available in Samplitude Music Studio 2013: violin, bass, tenor, and 
alto clef. Samplitude Music Studio 2013 differentiates between base clef and clef 
change. The base clef can be set up for every stave in "Score settings" (and applies to 
all MIDI objects on the current track). A clef inserted from the tool bar, will be 
interpreted as a clef change. Clef changes are possible any number of times in a song 
and also within beats. 

Insert: Activate the staff into which the clef should be inserted (by clicking on the staff 
signature to the left). 

Position the play cursor at the desired insert point and click on the desired clef in the 
toolbar. Move the playback cursor to the desired insert position and click on the 
desired clef in the toolbar. The clef will be inserted musically, not graphically, with a 
clef change at position 10:01:000 (the beginning of the tenth beat) the clef symbol at 
the end of the ninth beat will be displayed according to note set rules. 

Clef changes can also be deleted by clicking on clef symbol with the eraser (or the 
right mouse button). 
 

Beat signature 
The metric and beat signature symbols are created automatically from the tempo 
markers of the VIP project. 

Beat changes are possible at every full beat border. In addition, you might want to 
create a beat count measure marker with the new signature (for example, 6/8) at the 
desired position. If there are no beat count measure changes, then it's enough to set 
the bar type of the piece (for example, 3/4) in the transport control. 
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Accidental 

 Enharmonic change 

Samplitude Music Studio 2013 sets the sharps and flats according to the clef 
description you selected. It is often the case, however, that enharmonic change can 
considerably optimize the legibility of certain passages. In this case you can work 
manually. To change one or more selected notes enharmonically, click on the 
corresponding button. The function transforms flats into sharps and vice versa. 
 

Page format settings 
You can select the page format independent of the printer settings so that it always 
has the same note layout regardless of workplace and independent of the printers 
installed in Windows. 

 

In the score/page format setting, texts for tempo description, composer, and an 
additional text can be entered. Similarly, you can choose which layout elements 
should appear on the page (check boxes for beat numbers, page numbers, and texts). 
 

Printing score 
Samplitude Music Studio 2013 automatically creates the layout of the score and 
allows optimal division of staves and staves on the page. You only need to specify the 
page size, orientation, and page borders. 

• Note size: Here you can scale the size of the note symbols and the printout. This 
is actually irrelevant when working using the monitor's display, since you can 
zoom whenever you want anyway. However, the size of the notes does influence 
at which position a line or page break occurs. 

• Set a value smaller than 100% to get more beats/staves onto one piece of paper. 
• Set higher values than 100% in order to keep larger note symbols on the printout. 
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Print notes 
Activate the print process in the "Score -> Print notes" menu or via the print button. 
Furthermore, a printer dialog window appears which appears differently for each 
printer or printer driver. Depending on the printer there are various options, e.g. the 
selection of pages you wish to print and the number of copies. Make sure that you 
have set up the same paper format for the printer as for the page mode, otherwise the 
printout may be scaled and the page ratio changed. 

The following won't be printed, it's only visible on the monitor. 

• The lines which highlight the page borders on the monitor 
• Mouse pointers 
• The color display of the currently selected notes and playback areas. 

When printing a file (e.g. as a PDF file with a special printer driver) please note that 
you have to activate the option "Save fonts in document" in the printer driver so that 
the notation symbols will be displayed correctly in the document. 

 

Quantize 
Small irregularities when playing to record can be smoothened with the quantization 
function. In contrast to this, mechanical sounding sequences can be made a little 
more groovy by applying the Swing function. 

 Clicking on the Quantize button shifts all selected notes to a 
customizable quantization grid.  

All notes are quantized without previous selection. 

 
1/4, 1/8, 1/16, and 1/32 notes and corresponding triplets can be selected 
as starting points (grid) and lengths.  

The Quantize button always performs standard quantization (the note's start point 
and length are preset). MIDI functions (view page 188) -> Advanced quantization 
provides other quantization modes (e.g. length only or Soft Q). 

The quantization options enable the type and scope of the quantization to be set 
more precisely. 
 



 

206   

www.magix.com 

Quantization grid ("Snap") 

 

If snap is activated, the notes "snap" to the quantization values when they 
are created or edited. 

The quantization values are also considered. For instance, the notes snap to the 
corresponding positions within the quantization window.  

The snap positions are displayed within the piano roll as a matrix. A swing 
quantization is displayed by the different intervals of the vertical partitions in the 
piano roll. The grid can be hidden with the "Show quantization grid" command in the 
options menu ("Alt + G"). 

You can deactivate the snap function while creating or editing notes by holding down 
"Alt" as you draw them. 

Move relatively on grid ("Options" menu): If this option is active, then notes keep 
their original intervals  relative to the grid and not to the note start when they are 
moved; the distance moved snaps to the quantization value. Use this option if you 
want to move unquantized notes a certain distance without disturbing the timing. 

Keyboard shortcut:  Shift + G 
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Quantization settings 
The quantization settings can be found in the MIDI editor menu under "MIDI 
functions -> Extended quantization" or in Samplitude Music Studio 2013's main menu 
under "MIDI -> MIDI quantization settings". 
The dialog with the settings is not "modal", i.e. you can leave it open if you wish, and 
test certain passages with different settings. 

 

The selected quantization settings may be visualized in the top of the dialog. The blue 
lines indicate the target positions for the quantized notes, i.e. the snap points. The 
gray area around this show the quantization window i.e. the target positions that are 
affected by the quantization. 

Q-grid/length: The quantization grid and length at which target points within the beat 
on which the note start points or lengths move (see above).  

Q threshold/ Q window: This parameter may be used to slightly vary quantization by 
excluding notes from quantization that are very close to the next quantization value. 
"Q window" refers to the interval to the left and right of a grid point; events will be 
quantized within this range. Quantization does not take place outside of this window. 
This means that events with distance less than the "threshold" or more then the 
"window" from the grid point will not be quantized. The affected target range will be 
indicated in gray in the dialog graphic. 
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Swing: Starts swinging, groovy playback (for example, triplet). Specifies the division 
for uneven grid points. 

• 50 ... “50-50” division: The odd eighths are exactly half way between the even 
eighth notes (“even” playing method) 

• 67... triplet playing method, 3-2 division 

Offset: The value range in this parameter stretches from -100 to +100. By changing 
the offset values, you move the whole quantization grid. Negative values move the 
quantization to the left, i.e. forward in time; positive values move to the right i.e. 
further in time. The maximum of 100 corresponds with an offset of half the grid width. 

Presentation of blue grid points in the dialog and the grid in the MIDI editor directly 
reflects changes to these values. 

Humanize: The "Humanize" parameter creates another variation option, i.e. notes are 
able to be assigned according to the randomization principle up to a specific interval 
to positions around the exact quantization value. The setting occurs in % of a 16th 
note. The value specified therefore determines the possible interval between the 
quantized notes and the exact quantization value. 

Soft Q: This value sets the strength or "Soft Q" value of the quantization. 

• "100" moves the event precisely to the quantize grid point, 
• "50" shifts the event to the middle between the current position and the 

quantization grid point, 
• "0" means no movement -> Quantization off 

The command "Soft Q" command considers the current level value in the quantization 
options. The simple quantization command always occurs at 100%. In this manner, 
you can always select between approximation (soft) and a harder quantization 
without having to adjust the quantization options every time. 

Standard quantization settings: Select from a list of quantization actions (see MIDI 
functions) that are listed by clicking the "Quantization" button. 

Reset quantization: All notes are rest to there original positions. 

Standard settings: Restores the default values. 
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MIDI editor shortcuts 
Apart from a few exceptions, like using the space bar for stop/playback, the keyboard 
shortcuts can be defined freely with the keyboard shortcut, menu, and mouse editor. 
For some basic functions such as scrolling and zooming, all keyboard shortcuts from 
the VIP are applied. You can explicitly define shortcuts for all commands that are 
available in the MIDI editor menu. 

Hint: The mouse wheel settings are also applied from the VIP, as is the switch for 
the temporary zoom mode (special) which is defined with "Z" 

Playback/Stop Space bar 
Close MIDI editor (apply changes) Return 
Close MIDI editor (discard changes) Esc 

 
File 
Import MIDI Ctrl + I 
Export MIDI Ctrl + E 
 
Edit 
Undo Ctrl + Z 
Redo Ctrl + Y 
Cut Ctrl + X 
Copy tracks Ctrl + C 
Insert Ctrl + V 
Duplicate Ctrl + D 
Select all Ctrl + A 
Create pattern from selection Ctrl + P 
Delete selected MIDI data Back, Del 
Delete all MIDI data Ctrl + back, Ctrl + Del 
Select next event Arrow right 
Select previous event Arrow left 
 
MIDI functions 
Legato Ctrl + L 
Quantize notes Ctrl + Q 
 
Options 
Scroll mode F 
Show event list  Alt + L 
Show velocity/Controller editor Alt + V 
Play clicked notes Alt + P 
Quantization grid active Ctrl + G 
Show quantization grid Alt + G 
Quantization options Alt + Q 
MIDI object editor editor Ctrl + O 
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Audition Panic-End played edit notes Ctrl + F 
 
Mouse mode 
Selection 1 
Draw 2 
Drum (draw) 3 
Pattern (draw) 4 
Change velocity  5 
Delete 6 
Magnifying glass 7 
Glue note mode 8 
Split note mode 9 
Mute notes (Mute) mode M 
Select next event Arrow right 
Select previous event Arrow left 
Event pitch higher Arrow up 
Event pitch lower Arrow down 
Select next grid quantization value Alt + Arrow down 
Select previous grid quantization value Alt + Arrow up 
Select next length quantization value Alt + Arrow right 
Select previous length quantization value Alt + Arrow left 
Move play cursor forward Page down 
Move play cursor forward (fast) Ctrl + Page down 
Move play cursor backward  Page up 
Move play cursor backward (fast)  Ctrl + Page up 
Velocity/controller selection Ctrl+1 
Velocity/controller draw freehand Ctrl+2 
Velocity/controller draw freehand Ctrl+3 
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Software / VST instruments 
Samplitude Music Studio 2013 provides the option of integrating software 
instruments as well as MAGIX synths (e.g. Robota Pro) into a virtual project 
according to VSTi standards (e.g. Sample Tank) and can be controlled via the internal 
MIDI functions and editors. All instruments as well as their multiple outputs are 
seamlessly integrated into the audio engine with all of their effects and routing 
options. The maximum number of instruments is limited by the performance power of 
your processor. You can increase this number by using the integrated freeze function. 

 

Software instrument "Robota Pro" 
 

Installing VST plug-ins 
Install VST plug-ins according to the manufacturer's instructions. VST instruments 
and VST effects are not entered into the Windows registry, but must be saved in a 
certain directory. 

Samplitude Music Studio 2013 searches for installed VST instruments in the "VST 
plug-ins" program subfolder. VST instruments may be installed either in this folder or 
another path may be specified. If a VST plug-ins folder is already installed on the 
system, then please use the existing folder.  

The existing path must be specified in the system settings (shortcut: "Y" key) via 
"Effects > VST/DirectX/ReWire" (multiple VST plug-in folders may be used). Simply 
enter one VST plug-in folder path, then using the folder icon on the right, have 
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Samplitude Music Studio 2013 scan this chosen folder. Then enter in a 2nd VST plug-
in folder and rescan using the folder icon. Now the contents of both VST plug-in 
folders are available. Samplitude Music Studio 2013 will automatically find new plug-
ins that have been installed if they are present in the specified folders.  

If you add VST plug-in subfolders into the main VST folder (e.g. "Equalizer", "Filters", 
"Modulation", etc.), then these will be displayed as submenus when VST plug-ins are 
loaded. 

 

The first time the program is launched, a search for existing instruments and plug-ins 
is executed (when the track settings are opened). In this case, not only are all the 
plug-ins imported, but they are also checked for their usability within the program. 
This search is only required once; the next time it is opened, the track settings will be 
opened immediately. 

Tip: If you have problems with your current configuration, then you may reset all 
paths and installed instruments or plug-ins. To do this, delete the "VSTPlug-Ins.ini" 
file in the Samplitude Music Studio 2013 folder. All paths will have to be newly 
entered. Plug-ins which were removed from the program prior to this will still be 
shown again.  
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Load instruments 
These are managed in Samplitude Music Studio 2013 under "Track menu -> VST 
instrument editor". You can also assign an instrument to each track; the instrument is 
selected as a MIDI playback device. 

Selected instruments or their individual outputs are shown directly in the first VSTi 
plug-in/insert slot of the track box and mixer track and can also be muted (left click) 
and opened (right click) from there. 

 

• Load an instrument by selecting a "New instrument" in the project window as a 
track output. This can happen at various points: 

• Playback device menu (right click the "Mute" button -> MIDI -> New instrument) 
• Plug-ins slot -> VSTi in the track editor 
• "Insert effect slot of the mixer -> VSTi": You will only find this option in the top 

insert slot of the individual mixer channels. 
• "Out" slot -> New instrument in the MIDI section of the track editor. 

• "Out" slot -> MIDI -> New instrument in the audio section of the track editor. 
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Loading routing settings with software 
instruments 
An instrument may also be assigned  to each track as a MIDI output device. 

Additionally, you can route audio output channels from software instruments to any 
tracks of the VIP. MIDI (send) and audio (return) signals from a software instrument 
may be present together on one track (but this is not absolutely necessary). 
Samplitude Music Studio 2013 is fully flexible in terms of individual routing 
configurations. 

When installing a software instrument, the "Routing for multi-channel instruments" 
dialog opens up. Here you may specify new tracks for single audio outputs. 

 

Simple: Audio and MIDI together in a single track: Now all audio signals will be 
routed to the current track where the instrument has been opened. Multiple outputs 
will be mixed together before the mixer effects. Simple mono or stereo software 
instruments may be installed completely in the current track. In this case, the track 
sends MIDI to the instrument and receives the audio signal from the instrument. 

Multi-timbral audio on your own track separated from MIDI routes: Choose this 
setting if you would like to control the VSTi from several MIDI tracks. 

Multi channel: Create multiple new tracks for instrument outputs: Choose this 
option to automatically create new tracks for all VSTi audio outputs. The newly 
created tracks are configured and named automatically. The mono/stereo 
configuration is assumed from Samplitude Music Studio 2013 (Standard). 

Individual outputs can also be routed subsequently to separate tracks. To display 
hidden tracks in the Arranger window again, please use the Track Manager. 
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Advanced options 
Stereo/Mono (standard): Information delivered from the plug-in is used for routing. 

All as stereo/mono: Several plug-ins deliver incorrect information about whether the 
outputs are in mono or stereo. These options force individual outputs to be treated as 
stereo or mono outputs. 

Combine audio/MIDI: Activate this check box to automatically route the MIDI output 
of each individual track to this instrument. 

Hide instrument output tracks in arrangement: All newly created output tracks of 
this instrument are hidden in the arranger but still appear in the mixer window. This 
setting should be used if an instrument's individual outputs are controlled by a single 
MIDI file, and therefore do not contain objects or information in the arranger window. 

Hint: Please note that a virtual synthesizer's audio output can usually be created, 
edited, and mixed in the same track as the MIDI data the instrument is receiving. 
Among other things, this results in a double use of the volume fader which, on the 
one hand, controls velocity or MIDI volume (CC7), and on the other the audio level. 
These are not identical parameters. For instance, you can include a MIDI instrument 
played with high velocity quietly in the mix and vice versa. You can, therefore, 
optionally assign the volume fader differently. To do this, right click on the track's 
volume fader. 

 

Load effects plug-ins 
Effects plug-ins can be used at track, object, and master level. 
 

Apply plug-ins at wave level 
The menu "Offline effects -> DirectX/VST plug-ins (view page 359)" lets you 
calculate the plug-in effects directly into the audio material. During virtual wave 
editing, the plug-ins will be loaded into the mixer's master area (view page 217). 

Note! Destructive editing of audio material can not be undone! It's better to use the 
real-time effects via the object editor or the mixer. 

 

Load plug-ins at object level 
You can apply effects plug-ins at object level via "Real-time effects -> Object 
DirectX/VST plug-ins" menu or via the object editor. 

Object editor 

• Double click an audio object and select the "Object effects" view. 
• Under "Plug-ins", click on a plug-in slot's little arrow. 
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• The plug-ins in the menu are now available to you. 

"Real-time effects" menu 

• Select an audio object in the arrangement by clicking it 
• Next, open the "Real-time effects" menu and select the entry "Object 

DirectX/VST plug-ins" 
• In the dialog, you can load the desired plug-ins for the selected object one after 

the other 
• Right clicking on the loaded plug-in opens its interface 
 

Load plug-ins at track level 
At track level you can load plug-ins in the mixer as well as in the track editor. 

Track editor 

• Select the track for which you wish to load the effect. 
• Open up "Plug-ins" if it is not yet visible. 
• Now click on the little arrow next to the plug-in slot. 
• You can select any plug-in from the menu. 
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Mixer 

• Open the mixer by pressing "M" or via the mixer button. 
• Click on the small arrow next to the insertion slot of the desired track. 
• Now select a plug-in from the corresponding submenu. 

 

Note: Send effects will also be embedded. Add an AUX track and apply the effects 
to it. Bear in mind that the effects will be mixed, i.e. the effect in the AUX track 
should not contain the original signal anymore. 

 

Load plug-ins at master level 
In the mixer's master section, you can 
load plug-ins just like in the mixer 
tracks. Click on the arrow to the right 
beside one of the plug-in slots and 
select the desired plug-in from the 
menu. 

 

Route MIDI instrument inputs 
Nearly all software instruments require MIDI data in order to be heard. To route the 
MIDI input onto a specific track which contains the MIDI data, click on the VSTi 
button in the track editor of the corresponding track and select the instrument from 
the "Out" slot which you wish to activate. Already loaded instruments are mentioned 
in this list. 

To open a completely new instance of an instrument which works independently of 
already existing instruments within the project, select its name from the "New 
instrument" submenu. 
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Instruments with multi-channel outputs 
The number of available individual outputs generally depends on the instrument, and 
this may be adjusted via the instrument's settings. Outputs may be available in stereo 
or mono. 
 

Distributing sounds on multiple single tracks 
This approach, for example, is ideal for all drum samplers if you want to address an 
entire drum set, but prefer to mix and edit the drum sounds individually. 
 

Addressing an instriment on several MIDI channels 
Several MIDI tracks are typically used for so-called "multi-timbral" synthesizers which 
can play several sounds on different MIDI channels simultaneously, whereby each 
addresses a specific sound program (part) on a specified MIDI channel. This also has 
the advantage that such instruments only require one instance of the plug-in for 
several sounds. Multi-timbral software instruments often have separate audio 
outputs. Please remember to route the individual parts to the desired outputs within 
the VST instrument (panel). 
 

Adjust instrument parameters 
The instruments editor (panel) is then opened when an instrument is loaded and can 
be opened again at any later date by right clicking on the VSTi slot in which the 
instrument name is displayed. Alternately, the VSTi editor can also be opened by right 
clicking on the record button on the track -> Instrument output -> VSTi editor. 

The graphical interface opens by default. If the selected instrument (or plug-in) does 
not have its own interface, the parameters dialog will open. This display mode is 
limited to just a few control elements and can only be opened via the menu of the 
instrument window. Use this mode if you find the panel of the plug-in too unclear or if 
it takes up too much space on the screen. In this dialog eight freely selectable 
parameters of the instrument are clearly and numerically displayed. Bar controls can 
be used to adjust the parameter values. 

Alongside the combi-boxes for the selection of all instrument parameters, the "Auto" 
checkbox is also of importance. Once activated, the automatic processes of the 
selected parameters are started. The automation curve is shown in the project track 
and can be edited. The parameter can be automated using the fader. 

Activate automation parameters by checking the "Auto" control box. 

The parameter selection is saved for each plug-in so that the next time you use the 
same plug-in in a different project, the same parameters are used. This way you have 
the advantage that every frequently used parameter of the corresponding instrument 
is available immediately after it has been opened. 
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Instrument panel and parameter dialog 
The instruments editor (panel) is opened when an instrument is loaded and can be 
opened again at any later time by right clicking the VSTi slot displaying the instrument 
name. Alternatively, the VSTi editor can also be opened by right clicking the record 
button on the track -> Instrument output -> VSTi editor. 

The graphical interface opens by default. If the selected instrument (or plug-in) does 
not have its own interface, the parameters dialog will open. This display mode is 
limited to just a few control elements and can only be opened via the menu of the 
instrument window. Use this mode if you find the panel of the plug-in too unclear or if 
it takes up too much space on the screen. In this dialog eight freely selectable 
parameters of the instrument are clearly and numerically displayed. Bar controls can 
be used to adjust the parameter values. 

The parameter selection is saved for each plug-in so that the next time you use the 
same plug-in in a different project, the same parameters are used. This way you have 
the advantage that every frequently used parameter of the corresponding instrument 
is available immediately after it has been opened. 
 

Dialog menu 
Further options can be found in the menu of the instrument window: 

Bypass: Deactivates the instrument and mutes it. Note that some instruments use up 
processing power if bypass is switched on but are still located in the insert slot. In 
such cases, the instrument should be removed completely from the insert if it is no 
longer required. 

Monitoring: This option must be switched on if you wish to be able to hear the 
instrument when it is being played or recorded. If you wish to always have monitoring 
active when the track's record button is pressed, then please select the "Tape 
monitoring" option in the system/global audio options ("Y", "Audio setup" tab) 
dialog. 

Loading/Save patches/banks: Here you can save an instrument's settings and 
sounds. The standard formats for this are: *.fxp for patches or *.fxb for whole banks. 
Some instruments have their own patch/bank format, settings are then loaded and 
saved directly via the instrument's interface. 

Set parameters randomly: Use this function to set all parameters of an instrument to 
a random value. This option can lead to surprising results and provides interesting 
ideas for sound design, thanks to the random generation of a new sound. However, 
you should note that parameters can only be set when they are accessible via the 
interface. For some very complex virtual synthesizers (e.g. modular systems), some 
parameters may not be modifiable using this option. Please note that thanks to the 
random placement of various parameters, very extreme sounds can be generated. 
This may lead to no sound being produced at all or extremely loud volumes and 
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frequency ranges being reached. For this reason you should keep an eye on the 
preview volume when experimenting with this function. 
 

Play and monitor instruments live 
Requirements for playing live 
In order to play virtual software instruments, you will require a MIDI device to enter 
the data. This is typically a MIDI keyboard. Of course, you can also use any other PC 
that transmits MIDI data or a hardware synthesizer. 

For direct monitoring while playing you will in any case require an audio interface with 
ASIO drivers. Simply playing instruments, however, is also possible with MME or 
WDM drivers. 
 

Monitoring 
In order to play virtual software instruments you require a device to enter the data. 
Typically this would be a MIDI keyboard. Of course you can also use any other PC 
that transmits MIDI data or a hardware synthesizer. 

For direct monitoring while playing you will in any case require an audio interface with 
ASIO drivers. Simply playing instruments, however, is also possible with MME or 
WDM drivers. 

• For live monitoring you also have to make the following settings: 
• ASIO drivers (System/Options -> System/Devices -> Global audio options -> 

Playback devices -> Driver system) 
• Activate global record monitoring in the transport control ("Rec M" button) 
• Activate the track monitoring button (loudspeaker symbol) 
• Software monitoring or Hybrid Engine (Options -> System/Global audio options -

> Audio setup) 

Tip: You can also select monitoring mode by right clicking on the "Record 
monitoring" button on the transport control. 

Latency: Please note that a system-dependent delay between pressing the key and 
the instrument sound occurs when you play virtual software instruments. This so-
called latency time is mainly determined by the buffer size set for the ASIO drivers. 
For playing in an acceptable manner we recommend a buffer size of 1024 samples 
max. This corresponds with 23ms at 44.1 kHz. For many users, however, a latency of 
3ms, i.e. 128 samples, is optimum. Please note that the CPU load also increases at a 
lower buffer size. The "live" delay only occurs when an instrument is played, playback 
latency of an already recorded MIDI track over a virtual instrument is compensated 
later. 
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As software instruments are fully integrated into the audio engine of the program, the 
signals can be routed, mixed and equipped with plug-ins any way you like. There may 
be some restrictions when playing, but all functions are fully available during 
playback. 

Hint: Please note that "Track FX monitoring" mode or "Mixer FX monitoring/Hybrid 
Engine" have to be activated. 

 

Latency 
Please note that a system-dependent delay between pressing the key and the 
instrumental sound occurs as you play virtual software instruments. This so-called 
"latency" time is mainly determined by the buffer size set for the ASIO drivers. To play 
in an acceptable manner, we recommend a buffer size of max. 1024 samples. This 
corresponds with 23ms at 44.1 kHz. For many users, however, a latency of 3ms, i.e. 
128 samples, is optimum. Please note that the CPU load also increases at a lower 
buffer size. The "live" delay only occurs when an instrument is played, playback 
latency of an already recorded MIDI track over a virtual instrument is compensated 
later. 
 

Recording and playback of an instrument 
An instrument is recorded much in the same way as a normal MIDI track. Make sure 
that the MIDI recording is active in the desired track and then press the record button 
in the transport control. The recording begins immediately. 

When playing already recorded MIDI tracks, track monitoring should be switched off. 
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Routing VST instruments using the VSTi 
manager 
There are many flexible methods for signal routing of instruments. 

As described in the previous paragraph, an instrument may be fed from several MIDI 
tracks, and the outputs of an instrument may also be sent to several tracks. 
 

Routing instrument outputs 
Instrument outputs may be easily routed by using the VSTi manager. Simply open the 
VST instrument to view the individual outputs, and then right click the "Output 
routing" column. 

 

Now search for the track to be fed the corresponding individual output. The assigned 
output now appears in the target track's plug-in slot. 

Alternatively, you may also route directly to the track box of the arranger: 

To play the output of an already loaded (or instantiated) instrument on a specific 
track, right click the record button for the track, go to "Instrument outputs", and 
select the instrument output available in the project by placing a check mark. Several 
instrument outputs may be used simultaneously in one track. The outputs of several 
different instruments may even be combined into one track. 

Deactivating the instrument outputs works the same way. Remove the instrument 
output by removing the check in front of the corresponding output in the "Instrument 
outputs" submenu. 

Note that the routing options of the mix engine may also be used. A track containing 
the audio return of any instrument may be routed to any bus, AUX bus, or master. 
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Routing MIDI instrument inputs 
Nearly all software instruments require MIDI data to be audible. To route the MIDI 
input to a specific track that contains the MIDI data, click the VSTi button in the track 
editor for the corresponding track, and then select the instrument in the "Out" slot 
that you want to activate. Previously loaded instruments are also featured in this list. 

To open a completely new instance of an instrument which works independently of 
already existing instruments within the project, select its name from the "New 
instrument" submenu. Multiple instances of the same VST plug-in are indicated by 
the number (index) in front of the name of the software instrument. 
 

Solo playback of VSTi instrument outputs 
To preview solo instrument outputs, switch the track receiving the signal from the 
instrument to solo. Even if the MIDI objects (which in effect are responsible for the 
sound) are not present in the track, you will still hear the selected track solo. 
Samplitude Music Studio 2013 automatically recognizes the MIDI track sending the 
signal to the output and allows the instrument continue to receive MIDI data from the 
assigned tracks. 
 

Preset management 
If an instrument has presets, these are displayed in the “Program Slot” (“Prg”) with 
their internal name (if MIDI mode is activated). 

This drop-down menu can be used to easily “step through” the presets of your 
instrument. These presets can also be selected using the “Program” menu of the 
instrument window. 

If your MIDI input device can send “Program change” commands, then you can also 
directly select programs of this instrument. The program slot is automatically updated 
in the track, so you have an overview of the program all the time. 
 

Freezing instruments (freeze) 
Software instruments require CPU power for playback, which at some point can be 
quite considerable and is required during every playback. Therefore, please use the 
"Freeze" function to release the CPU power for VSTi tracks temporarily. You retain full 
control over the MIDI objects of this track, which can be restored (“de-frozen”) at any 
time. 

To “freeze” an instrument, select the “Track freeze” option in the track menu (Ctrl + 
Shift + F). After a short processing time, all MIDI and audio objects are replaced by a 
single, resource-friendly, 32-bit stereo audio object, which is now played back instead 
of the original object and the instrument. The existing automation data and track 
effects are already included in this freeze object. 
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The actual instrument of this track is no longer addressed by MIDI files of this track 
and can even be deactivated, provided that it is not used by other MIDI tracks. 

Select “Track unfreeze” (Ctrl + Shift + U) to change the original MIDI data at a later 
point in time that was "frozen”. The track is now returned to the state in which it was 
"frozen", but again requires the initial CPU power for processing the instrument. 

Alternatively, you can use the feature “Edit track freeze”. In this case, a new single-
track VIP is opened with the original track. This track cannot be played together with 
your arrangement. As soon as you save this project, a new freeze object is processed 
and included in the original project. 

Freeze also works with single outputs in different tracks than the main output track 
(instrument outputs 1+2). You can also freeze these tracks if they do not contain 
MIDI information and do not hold objects. The MIDI data that has been routed to the 
track or to the individual output of the instrument automatically creates an audio file 
that is now played instead of the original instrument. In order to prevent double 
playback of the data, deactivate the single output of the instrument manually in the 
frozen track. 

To edit freeze data you cannot only use the "Track freeze edit" function, since there is 
no MIDI data available on this track that could be edited. Therefore, “unfreeze” the 
track and edit the MIDI data of the send track. You can then refreeze the track. 

Note: As long as the instrument is not entirely unloaded from the track it remains 
loaded into the RAM memory of the system. Samplers or instruments that require 
considerable amounts of memory also require this when their insert tracks have been 
frozen. 
 

Tips on handling virtual instruments 
• You can realize so-called stack sounds (i.e. sounds that use several synthesizers 

and play these in unison) by opening several instruments and activating 
monitoring for all channels. 

• To program beats, you can create and save individual drum maps in the MIDI 
editor that match the respective instruments. 

• If an instrument can limit the amount of voices, then you can use this option to 
save CPU power if you do not require the full number of voices. 

• Some instruments use sound sets according to the "General MIDI" standard. You 
can use these instruments for playing back MIDI files according to the GM 
standard. Please import the entire MIDI file to a single track including all 
channels. Make sure that virtual instruments can also receive program change 
commands that are also saved in such a file, so that the correct sounds are 
played back. 
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ReWire 
If this option is activated, ReWire-compatible client applications (e.g. Propellerheads 
Reason) can be integrated into Samplitude Music Studio 2013 as synthesizers.  

Activate ReWire functionality in the program settings ("Y"). Afterwards, installed 
ReWire applications can be loaded as instruments into a MIDI slot. All ReWire client 
applications appear as individual sections in the selection menu of the plug-in slot of 
the track and are loaded as software instruments (VSTi). The client application should 
always be launched after Samplitude and should be closed before exiting Samplitude. 
Some client applications can be opened automatically by right clicking on their name 
in the MIDI slot (red) – just as you can open the plug-in window for VST instruments 
by right clicking. 

The ReWire application can then be accessed like a software instrument via MIDI, the 
audio output signal of the ReWire client can be routed to the Samplitude Music 
Studio 2013 tracks. The client application runs, starts, and stops synchronous to the 
time position of Samplitude. 

ReWire supports up to 4096 MIDI buses. A ReWire client only registers the MIDI 
buses that are actually available with the host (Samplitude Music Studio 2013). You 
can therefore select the bus within the track in the MIDI channel menu (e.g. the 
receiving instrument for Reason): 
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The "classic" MIDI channel of MIDI notes 
and events is not important, it is replaced by 
the ReWire MIDI bus system. For each track 
a MIDI object is able to control a ReWire 
MIDI BUS. This means that all events of a 
MIDI object apply to the track for this 
ReWire bus, independent of the channel 
number the events originally had. Multi-
timbral MIDI objects, like those created in 
the MIDI file import, cannot be played 
correctly with ReWire. You can, however, 
access the ReWire client across multiple 
tracks on various ReWire MIDI buses. 

Only a few ReWire clients support direct opening of the client application via the host 
application (Samplitude Music Studio 2013). In this case, you will have to start the 
client application manually. You can do this by starting your client application as you 
would normally. It then automatically recognizes the host and starts in a special client 
mode. 
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Tempo editing 

Tempo and time signature changes in the tempo 
map... 
Tempo and time signature changes are an important means of expression of your 
music. You can make these changes in Samplitude Music Studio 2013 by using 
extensive options. 

A precise bar grid is essential for precise editing. Samplitude Music Studio 2013 offers 
you a convenient option for adjusting the bar grid to existing material 
(audio/video/MIDI). 

Changes in tempo can be made using tempo markers. 

The tempo map displays all tempo markers and determines the musical positioning 
for each time position. Simply put: The tempo map defines the beat grid. 

You can adjust the bar grid to certain time positions by using grid position markers 
(e.g. existing audio or MIDI events). To do so, just drag a grid line of the bar grid to 
the desired time position.  

It is even possible to tap the beat hits or entire bar positions of the grid. In this case, 
use the "Grid Fit Mode" of the tempo map (view page 231). 

Besides the Tempo map dialog (view page 232), the transport console also serves as 
optical control of the tempo map. The transport console displays the current values 
for tempo (BPM) and time signature at the current play cursor position. 

In the Tempo map dialog (view page 232) you can specify which objects' or markers' 
position should be adjusted when tempo changes are made. 
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Tempo markers 
Tempo markers appear either as BPM markers or as Grid position markers according 
to the Tempo-map mode. Time signature marker (e. g. 3/4) are by contrast, 
independent from the Tempo Map mode. 

In total there are three types of tempo marker: 

• Time signature marker (blue) 
• BPM marker (red) 
• Grid marker positions (green) 

A time signature marker represent a time signature changes (e. g. from 4/4 to 6/8). 

You can also change the time signature when creating BPM markers and grid 
markers. Set the Tempo marker directly using the menu or indirectly by manipulating 
the tempo in the tempo track with the mouse. 

Another way of accessing and editing the Tempo marker is by using the Marker 
Manager. 
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Tempo Map Modes: BPM Mode / Grid Fit Mode 
In the Tempo Map dialog (view page 232) you can choose between two modes:BPM 
mode and Snap adjustment mode. The selection can be accessed from the menu: 

Play/Rec > Marker > Insert Tempo change 

Play/Rec > Marker > Insert grid marker change 

• In Snap mode you work exclusively with grid position markers and Time signature 
changes. 

• In BPM mode you work exclusively with BPM markers and Time signature 
changes.  

 

Modes can be changed at any point. The Tempo markers remain the same, but 
change their type. The effective Tempo map and beat grid remain unchanged. You 
can toggle between BPM markers and grid position markers at any time. 

Example 1: Initially in the beat adjustment mode the beat grid is adjusted to a MIDI 
recording which contains lots of tempo changes. Subsequently certain musical 
tempo changes such as Rubato and Ritardando can be inserted for individual 
sections in BPM mode. (The tempo track can only be edited in BPM mode, in snap 
mode it serves solely as a display). 

 

Example 2: The time signature of available grid position markers should be changed 
at the start of the piece, subsequently however the beat grid positions should be 
placed more precisely. As changing the time signature moves the beat borders and 
with it the grid position markers, change the markers to BPM markers because this 
will unaffected by time signature changes. This is how you swap to BPM mode. Now 
change the time signature and the go back to the beat adjustment mode in order to 
adopt the beat grid changes. 
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Tempo Change: BPM Marker 
A new project first has a single "Master" tempo which can be defined in the transport 
console or in the project settings (shortcut: "I"). 

This Master tempo affects either the entire project or the start of the project up to the 
first BPM marker.  

Exception: If the tempo should be interpolated to the first tempo marker, the master 
tempo is only effective directly at the project start, to then go linearly to the tempo 
of the next BPM marker. 

You can make any tempo changes directly in the project window at any time or for 
any musical position (even between beats) using the BPM marker or corresponding 
tempo curve point. 

The tempo markers are snapped to the next snap point when the grid is active. By 
dragging the tempo markers and holding down "Alt", you temporarily deactivate the 
grid function. 

Note: Samplitude Music Studio 2013 does not automatically adjust audio objects via 
tempo markers in case of tempo change. In order to change the length of audio 
objects to the defined tempo changes, use the pitchshift/timestretch mode and drag 
them to the end of the rear object edge of the audio object until this matches the 
original beat marking. 

 
 

Time Signature Marker 
Beat counter markers change the time signature from the marker position onwards, 
e. g. 4/4 beat to 3/4. 

Therefore you can only insert time signature marker at bar borders and only position 
them at full beat borders. 
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Grid Position Marker 
Grid position markers assign a specific musical position to a specific time position. If 
you move a grid position marker, you'll see how the beat grid is immediately adjusted. 
In the tempo track you can apply the effects of the beat grid changes to the tempo. 

A grid position marker defines the tempo indirectly, causing the tempo before the 
marker to be adjusted in such a way as to reach the desired musical position exactly 
at the marker position. 
 

Grid Tapping 
You can set grid position markers in the tempo map grid fit mode during playback.  To 
do so, assign the menu command "Insert grid position marker" (view page 346) a 
keyboard shortcut of your choice, e.g. "P". Press "P" in time with the rhythm during 
playback and tap the bar grid or tempo map.  

The following will happen: At the time of pressing the key, the nearest bar position of 
the selected bar grid will move to the current playback position and it will be marked 
with a grid position marker. 

Tips:  

To detect the tempo, work in the bar grid, in entire bar borders first. In a second 
step, you can detect slight tempo variations in the bar grid. 

The BPM mode exceptionally allows you to set a temporary grid position marker 
while dragging with the mouse and the "Alt" key held down in timestretch mouse 
mode (or when loading older VIP projects). 
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Tempo Map Dialog 
Set the playback cursor to the position at which the tempo or Time signature changes 
should occur. Now open the Tempo window from the Marker Menu (right-click on 
time bar) or from the edit tempo menu. 

 

Click on the "New marker" button in the dialog. A marker is inserted at the current 
position. You can now use the marker option to set the properties of this marker. For a 
new tempo marker, enter the required tempo in BPM or the new beat for the time 
signature marker. 

Please note that the settings are only valid for the markers currently selected in the 
marker list. For example, you cannot set marker properties such as type or tempo 
after a new one has been created. 

A time signature marker is always placed at the start of a new bar. If the play cursor 
is at a different position, the marker position is automatically moved to the 
beginning of the next bar. 
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Edit marker/Tempo map window 
If a tempo marker is changed or a grid position marker is moved, this influences the 
following markers and audio/ MIDI projects in the VIP. 

There are two main possibilities: The time position either remains constant, or the 
musical position remains and the time position is adjusted (Tempo/Time Signature 
window). 

The time position in the VIP is the absolute position, the musical position is flexible 
and is displayed by the grid.  

Maintaining the musical grid position means that objects or markers are adapted to 
the newly created grid, its absolute time position in the project therefore changes. If 
the time position is retained the musical position changes accordingly. 

When manipulating the tempo markers, the behavior of markers, audio, and MIDI 
objects is controlled separately. By default, the grid position of MIDI objects and 
tempo markers remains intact, and the time position of markers and objects remains 
the constant. The time position is always observed if you hold the "Alt" key when 
moving the mouse. 

 

 

In this example the first tempo marker in the second image has been changed. The 
MIDI object and the second tempo marker were moved correspondingly so that the 
musical positions (03:01:00) were maintained. 

If you want to keep the time position of objects, select the "On all appointed tracks" 
option 

Additional options: 
Each tempo and grid position marker can be ignored using the “Bypass” option. This 
occurs automatically for grid position markers if illogical bar positions are created 
while moving, e. g. if grid position markers are exchanged (bar 20 before bar 19) or 
are moved in such a way that these bar positions that originate from a previous 
tempo marker cannot be met by tempo interpolation. 
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Ignore All Tempo Markers, use Project Tempo 
With this option you can ignore any previously created tempo markers in your 
project, so that only the project tempo observed. 

Tempo and Time Signature Dialog 

 

This dialog appears when you double click on a previously available tempo 
marker/curve point or if a new tempo marker should be set using a menu command. 
You can enter the desired tempo in BPM here (not for grid position markers) and, if 
needed insert a time signature change. Also you can choose here whether the tempo 
should be interpolated to the previous tempo marker (Ritardando or Accelerando). 
 

Manipulating the Tempo Marker in Timestretch 
Mouse Mode 
The timestretch Mouse Mode simplifies working with tempo markers. Select 
"Pitchshift/Timestretch" mode from the toolbar. 

Create BPM markers by directly clicking the desired playback position and holding 
down "Shift", and you can adapt this tempo by moving the mouse vertically while 
holding down "Shift". You can adapt this tempo by moving the mouse vertically while 
holding down the Shift key. 

You can create grid position markers in "Timestretch" mouse mode by clicking the 
desired playback position and holding down "Alt". 



 

Tempo editing 235  

 

You can create bar position markers with "Alt" + mouse click, and you can move 
them using "Alt" + horizontal mouse movement, e. g. to manipulate the bar grid and 
adapt it to existing audio events. 

 

Tips, examples of use 

Tempo markers can be placed when composing in the MIDI Editor. Subsequent 
MIDI Objects and tempo markers retain their musical position (advanced setting). 

The grid can be adjusted to available audio events, e.g. assigning beat numbers to 
certain time positions. You can either use the "Set new grid position marker" menu 
command to create a marker at a position within the project and assign the 
corresponding bar position, or use "Alt" + mouse click on the respective beat grid 
position and, while holding down the mouse button, immediately move it to the 
required time position (e.g. to the beginning of an object). 

If the project includes MIDI data, this is automatically adjusted (preset). The newly 
created tempo grid is used in the MIDI Editor for subsequent editing. 

When working with MIDI files and complex tempo changes, you can switch off the 
tempo map before starting to record the new MIDI data ("Ignore all tempo markers, 
use project tempo"). After the recording has finished you will be able to switch on the 
tempo map once again, which makes the newly recorded MIDI data adjust itself 
automatically. 
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Synth objects 
Samplitude Music Studio 2013 supplies several synthesizer plug-ins to create your 
own drum pattern, bass, or melody lines. The synthesizers produce "synth objects" 
which are arranged on the tracks together with the other objects. 
 

Working method 
Opening the synthesizers 
The software synthesizers can be found in a special folder which is copied to your 
hard disk on installation. To open it, click on the synth button. 

You can find all available synthesizer plug-ins in the selection box. 
 

Object synths and track synths 
In Samplitude Music Studio 2013 there are two different types of software 
synthesizers: 

Object synths: These synths build up individual synth objects in Samplitude Music 
Studio 2013. A corresponding synth object can be moved onto any track without 
anything changing on the synthesizer settings. Object synths are the Drum & Bass 
machine, BeatBox 2, Atmos, Vita, LiViD, and Robota. 

Note: Object synths can also use object effects. Open the object editor via the 
corresponding object's context menu. 

Track synths: These synths do not form any individual synth objects in Samplitude 
Music Studio 2013, but"normal" MIDI objects instead. They correspond to the 
function of external hardware synthesizers or VSTi plug-ins, which are also controlled 
via MIDI. Like all MIDI objects, they are dependent on the track, that is, the 
corresponding track synth is specified in the MIDI track settings. Correspondingly, the 
track synths can also be selected in the track editor and modified. Vita and Revolta 
belong to this type of software synthesizer. 
 

Programming the synth object 
Depending on the plug-in, various functions to create and control sound can be 
applied via the operating console. Please read the following chapters pertaining to the 
individual synthesizers in this regard.  

To monitor programming, playback can be started and stopped at any time with the 
space bar while the operating console is open. If the synth plug-in has its own play 
button (e.g. the beat box), then it will start the plug-in solo without playing the other 
tracks of the arrangement as well. 
 



 

Synth objects 237  

 

Arranging the synth object 
Once you have finished programming the melodies or rhythms of the synth object, 
you can close the operating console and arrange the synth objects on the tracks. They 
can be stretched or compressed, faded in and out, turned down or up, etc. with the 
help of handles: These steps are the same for all objects.  

The operating console of every synth object can be reopened at a later stage by 
double clicking or via the synth button if you would like to reprogram the object. In 
addition, you can drag as many other synth objects of the same software synthesizer 
as you like onto the tracks and program them separately. 
 

Note for users of older versions of MAGIX 
Music Studio 
This version of MAGIX Music Studio has replaced older technically outmoded 
synthesizers with newer, significantly improved solutions. Other synths were replaced 
by newer, non downward-compatible versions. 

Arrangements created using older versions of MAGIX Music Studio may not function 
properly Samplitude Music Studio 2013 for this reason. MAGIX provides the removed 
synthesizers as an extra download. 

To download... http://rdir.magix.net/?page=DEPBU7N8R5E2 

Note: Downloads require registration. 

 

http://rdir.magix.net/?page=DEPBU7N8R5E2�
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Atmos 
Atmos is a synthesizer which can be used to easily create realistic nature sounds in 
no time. From thunder and lightning to animal sounds and traffic noise, Atmos helps 
you design natural-sounding atmospheric noises for your projects. 

 

• In the upper border window, select the top category "Scenario". You can select a 
desired nature sounds category (for example, "Thunder and Lightning"). 

• In the middle of the window, a collection of control elements appears for 
designing the desired "Ambience". Each element has its own description (e.g. 
"Thunder") and two faders, i.e. "Volume" and "Intensity". The "volume" control 
adjusts the loudness portion of the element. The "Intensity" fader controls the 
behavior of the sound, depending on controller element. For example, with 
"Thunder", you can set how often thunder and lightning should sound; with 
"Rain", the strength of the rain can be regulated (if moved to the far left, light rain 
can be heard, while if moved to the far right, a downpour with loud splashing 
noises is audible). 

• At the bottom right border you will find a master volume fader with which the 
master volume of the synthesizer can be set. Furthermore, the "Randomize" 
setting is also located here. This way you can change the settings of the control 
elements by yourself. 

 

BeatBox 2 plus 
BeatBox 2 is a 16-voice drum computer with hybrid sound synthesis and a step 
sequencer. The proven handling concepts of the "old" BeatBox like matrix 
programming with auto copy have been expanded with comfortable editing of 
velocities and significantly improved sound synthesis, including a multi-effects 
section (one effect per drum instrument). 
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A drum sound is created in BeatBox 2 using a sample (analogously to the old 
BeatBox) which is combined with a synthetic sound that can be created using up to 
three different synthesis models (hybrid sound synthesis). BeatBox 2 plus enables 
detailed editing and automation of all sound parameters. 

There are two styles of interface in BeatBox 2. While closed, you can listen to included 
sounds or those you've made in BeatBox 2 without using too much window space. 

 

Only the most important control elements are displayed when the program window is 
minimized. 

 Volume controller: Controls the volume. 

 Peakmeter and preset name: The peakmeter lets you visually control BeatBox 2. 
Click on the triangle beside the preset name to open the preset list. 

 Next/Previous preset 

 Save preset: The preset includes the drum kit in use, the pattern, and any possible 
automations (view page 243). 

 Play/Stop: The playback controller in BeatBox 2 starts BeatBox without playing 
the arrangement, too.  

 Edit button: The edit button opens BeatBox 2 for you to program your own beats 
and sounds. 

 

Maximized BeatBox 2 plus window 
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 Drum kit: This section loads drum kits (collections of different drum instruments) 
and the individual drum instruments. 

 Selected drum instrument: The settings in the synthesis section (6) and 
velocity/automation (5) always affect the selected drum instrument. 

 Pattern editor: Programs the beat sequence. In the top part, different patterns 
(sequences) can be loaded and saved as well as different settings for the view 
and function of the pattern editor. The matrix is where the beat is programmed: 
One line corresponds to a drum instrument, and a column matches a specific 
time position within 1-4 beats. If a cell is clicked on, then the respective drum 
instrument will be triggered at this position. 

 Velocity/Control: This section has two modes: Velocity and Automation. The 
setting Velocity displays the velocity levels for the selected instrument's beats as 
a column. The Automation set up allows automation to be set for sound 
parameters in the synthesis section (6). 

 Synthesis: The selected sound parameters and effects settings for the selected 
drum instrument can be edited here. 

In the following, the sections of BeatBox 2 will be discussed individually: 
 

Drum kit 

 

This section loads drum kits (collections of different 
drum instruments) and the individual drum instruments. 
You can also try out an already programmed pattern 
with different kits or exchange individual drum 
instruments. 

 

 Select drum kit: Use the <> buttons to switch through the different drum kits. A 
drum kit is a collection of percussion instruments with matching sounds, e.g. 
rock kit or electronic drums à la TR 808. By changing the drum kit, you can add 
an entirely different sound to the rhythm you have already created. 

 Save drum kit: Use this button to save the current collection of drum 
instruments as a kit. 

 Drum kit list: Click on the arrow right of the name to open a complete list of 
available drum kits. 

 Select drum kit: The arrow buttons function analogously to those of the drum 
kit. The sequence of drum instruments in the kit can be resorted via drag & drop. 

 Mute/Solo: The "solo" button switches a drum instrument solo, i.e. all other 
instruments which are not "solo" will be muted. The "mute" button mutes a 
drum instrument. 

New drum or effect sounds can by added to the current drum kit by drag & drop from 
Windows Explorer. Drag a wave file to a drum instrument to create a new drum 
sound based on this sample. BeatBox 2 copies the sample into the sample folder to 
make sure that the instrument or kit created can be used again later. You can drag a 
complete folder with wave files to the drum kit to create a kit based on those samples. 
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Context menu 
Right clicking a drum instrument always opens a context menu: 

• Copy/Paste: Copy an instrument from a track and paste it to another one. 
• Empty instrument: An empty instrument is added. No sound is played, it has no 

name, and is used to clean up an unused track. 
• Default instrument: The standard instrument is added. It has the standard 

parameter for all synthesis shapes and serves as the starting point for your own 
sounds. 

• Reset automation: BeatBox 2's own presets contain automations. These are 
dynamic sound parameters like filter curves or pitch changes. This command 
allows you to completely remove these for the selected instruments. 

 

Pattern editor buttons 

 

 Pattern: Use the <> buttons to switch through the different patterns. The arrow 
to the right opens a list of all available patterns, and the save button stores the 
current pattern. 

 Clear track/all: All events for the selected instrument (track) or all events for 
the pattern (all) are removed by clicking this button. 

 Bar selection: The bar you wish to edit can be selected via the corresponding 
number button. Use the “Follow” button to select follow mode, i.e. the step 
display follows the steps of the currently played beat. All shows all bars of the 
pattern. 

 "1>2-4" Auto copy: If more than one bar is set as the pattern length, "Auto 
copy" mode makes sure that the drum notes set in the first bar are 
automatically placed into the next bars. This also makes it easy to create a 
continuous beat, even with a loop length of four bars. Notes set in the bars 
further back are not affected by the "Auto draw" function, which, for example, 
makes faint variations detectable only in the fourth bar. 

 Bars: The maximum length of a drum pattern is four beats. The length can be 
selected via the small scroll bar. 

 Shuffle: This controller changes BeatBox 2's timing. If the fader is turned to the 
right, the eighth of a rhythm is played more and more like a triplet. If that 
sounds a bit too abstract – simply try it out, ideally with a pure 1/16 hi hat 
figure; you'll soon see what the shuffle fader is capable of. 

 Grid: Here you can set the time resolution of the BeatBox. You can choose from 
1/8 notes (only for very simple rhythms), 1/16 (default), 1/32 (for more refined 
constructions). 
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Pattern editor - matrix 

 

This is the heart of BeatBox. A click on any position in the drum matrix creates or 
deletes drum notes (events). Clicking and dragging draws in a series of notes. 
Together with the velocity editing options (view page 244) (velocity), you can easily 
create drum rolls. 

If "Shift" is held when you click on notes in the range, a rectangle can be drawn out 
which selects the notes contained within this rectangle (lasso selection). Selected 
notes can be copied by dragging them to a new position. If "Ctrl" is also held down, 
then existing notes will remain at the target position. Delete all selected notes by right 
clicking. 

A simple mouse click cancels the selection. The selection is automatically canceled 
after copying. If you want to keep your selection, hold down "Ctrl" while copying. 
 

Keyboard shortcuts 
Many functions in BeatBox 2 can be controlled with the keyboard, for example a beat 
can be triggered with the "Enter" key live in a running pattern. Here's a complete list 
of the keyboard commands: 

General Key command 
Open/Close editor e 

Pattern editor - options 
"1>2-4" Auto copy a 
Follow f 
Display bar 1... 4 1... 4 
Show all bars 0 
Grid finer/rougher +/- 

Selected drum instrument 
Previous/Next Cursor up/down 
Preview p 
Live input Enter 
Mute on/off m 
Solo on/off sec 
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Velocity 
The velocity mode serves for editing the velocity/automation of the individual drum 
notes for the selected drum instrument. 

 

 Reset: Sets all velocity levels to 100% 

 Mode switcher: Switches the section between velocity control and Automation 
(view page 243). 

 Random: The random parameter adds random variations to the set velocities. 
This helps make your beats sound more natural. 

 Amount: No function in velocity mode. 

 Velocity level: Every set note for the selected instrument is displayed as a 
column and can be edited. Multiple columns can be edited at once; see Editing 
velocity values and automations (view page 244). 

 

Automation 
Every parameter for a drum sound, including effects, can be automated, i.e. can 
change during a pattern. For example, you can make your snare drums more lively by 
adding higher voices to loud hits or  by setting accents on individual hits with reverb 
effects. 

 

The synthesizer section below enables the selection of a parameter 
for automation via the small blue LEDs above a parameter controller. 

More about the parameter controllers in the Synthesizer (view page 
245) section. 
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 Reset: Sets all automation values for the selected parameter. 0. 

 Mode switcher: Switches the section between velocity control (view page 
243) and automation switched. This happens automatically during selection 
of parameters. 

 Random: The random parameter adds random variations to the set 
automation. This helps make your beats sound more natural because each 
programmed hit will sound slightly different. The level of the random 
parameter is also influenced by the amount controller (see below), i.e. if the 
amount is at "0", then the randomness will have no effect. 

 Amount: The amount parameter regulates the complete influence of the 
automation values and of the random factor on the selected parameter. An 
amount of "0" does not have any effect at all on the automation; maximum 
level has the greatest effect. The effects of the amount controller on the 
automation values is made visible by a slightly lighter line in the value 
columns. 

 Automation values: The selected parameters can be drawn in as a column 
with the mouse. Automation values can also be drawn between the set 
notes; the sound of the drum instrument changes during playback. 

Automation values are added to the original value of the parameters. 

 
 

Editing velocities and automation values 
Hold down "Shift" and select any number of columns for velocity or automation with the mouse. 

 

The "Copy" button copies the selection to the clipboard. If you select this or that track 
in another editor, then you can paste the notes there now from the clipboard. If the 
target selection is larger than the contents of the clipboard, then it will be inserted 
again. This lets you quickly add a short section throughout the complete length of the 
pattern.  

The three handles allow the velocity or automation values to be edited together. 
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The middle handle increases or lowers the values together. 

 

An object can be faded in or out with the handles to the left and right upper corners of 
the object. 

 

If you move the handles horizontally you can change the curve shape of the transition. 

A single click in the automation section cancels the selection again. 

Note: A selection of velocity values matches the selection of corresponding notes in 
the matrix editor. 

 

Synthesizer 
In the lower section of BeatBox, you can set the sound for the selected drum 
instrument. 

The synthesis in BeatBox 2 consists of a combination of a simple drum sampler and a 
synthesizer. There are three different synthesis models possible for the synthesizer: 
"Phase Distortion Synth" (FM synthesis), "Filtered Noise", and "Physical Modeling". 
The mixed signal of both components is then processed by a multi-mode filter. An 
envelope curve ("envelope generator") time-dependently controls modulations of in 
all components.The details of the synthesis models can be read in the section 
Synthesis models (view page 249). 

 

 Preview drum instrument 

 Save drum instrument 

 Select sample: A click on the arrow selects samples from the categories like 
kick, snare, etc. 
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 Select synthesis mode: Switches between the three synthesis models. 

 Mix: Mix relationship between drum sampler and synthesizer. 

 Parameter controllers: All six sound parameters for a drum sound can be 
directly set and automated via the parameter controller. The parameters in 
question depend on the drum sound currently loaded. By clicking the name of 
a sound parameter, a menu opens for you to add parameter controllers to 
each drum sound's synthesis parameters. 

 Automation: This selects the controller's parameter for the automation (view 
page 243). 

 

Effects section 
Each of BeatBox 2's drum instruments includes an effects unit which is fed in after the 
actual sound synthesis and editing. Each of these effects units includes a series of 
high-quality algorithms to add "audio polish" or to place the sound in a production-
typical context. 

 

 FX on/off 

 Parameter controller: An effects module includes four adjustable parameters. 
The fourth, "Mix", is always available and the remainder possess a function 
dependent upon the selected algorithm. 

 Automation: This selects the controller's parameter for the automation (view 
page 243). 

 Effects algorithm: Click the arrow to select an effects algorithm. 

The available effects algorithms per unit are described in the following. 
 

Mono delay (tempo sync / millisec.) 
Simple, monophonic delay effect 

Parameters 

• Time:  Delay time controlled by musical measure (sync) or free running 
• Feedback:  Repetition 
• Damping:  High damping of the repetition 
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Stereo delay (tempo sync / millisec.) 
Stereophonic repetition, adjustable separately per side 

Parameters 

• Left / Right: Delay times, synced or free running 
• Feedback: In contrast to mono delay, no repetition takes place in the middle 

position of the feedback controller. When turned to the left the type of delay is 
that of the so-called "ping-pong" variety, i.e. the signal is alternately sent so that 
is jumps from one channel to the other. When turned to the right the delay effect 
is "dual mono", in which case left and right sides act as two independent time-
delay units. 

 

Chorus 
Produces a typical "floating/shimmering sound" by modulated detuning of a signal  to 
"thicken up" its sound or spread it across the stereo field. Detuning is achieved by a 
short delay, the length of which can be varied by the modulation. This produces the 
so-called "Doppler" effect. 

Parameters 

• Time: Delay time in milliseconds. This can be understood as the "base" 
modulation which is stretched or compressed by the modulator. 

• Rate: Modulation speed 
• Depth: Modulation amplitude. Low values modulate only a little, higher values 

lead to a clear vibrato. 
 

Flanger 
Algorithmically similar to chorus, but different in that the delay time is significantly 
lower and delay works with repetitions (feedback). A flanger sounds more "cutting" 
and up-front than a chorus. 

Parameters 

• Rate: Modulation speed 
• Feedback: Delay feedback 
• Depth: Modulation amplitude 
 

Phaser 
A modulation effect just like chorus & flanger, but in this case no detuning takes 
placed. Filter components periodically alter the signal's "phase response" (principle of 
the "phase shifter"). Characteristic notches are produced in the frequency spectrum 
response to create so-called "comb filter effects". The phaser effect is suitable for 
pads and "psychedelic" sounds. 
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Parameters 

• Rate: Modulation speed 
• Feedback: Feedback of filter steps 
• Depth: Modulation amplitude 
 

Room reverb / Hall reverb 
In the case of reverb there are two realistic simulations of natural reverberation. 
Sounds receive "atmosphere" and thereby appear lively and "authentic". Room reverb 
simulates a small space with high echo density. Hall reverb mimics the typical reverb 
of large concert halls. 

Since natural spaces never sound "static" because air molecules are constantly 
moving and due to the complexity of reflection processes, both algorithms include a 
modulation parameter which varies the delay time of individual echoes and thereby 
affects the liveliness of the reverb impression depending on strength. 

Parameters 

• Decay: Reverberation length 
• Damp: Damping of highs, simulates absorbtion via air, wall materials, and objects 
• Mod: Modulation strength. 
 

Lo-fi 
This algorithm gives the sound a little bit of "grit", or a certain measure of signal 
destruction depending on its setting. An ideal partner for creative sound design. The 
simulation of early digital synthesizes or samplers is equally possible since their 
AD/DA converters were anything but "true" in the character of their sound. The 
sample rate from the output of the lo-fi effect can be continuously reduced and a 
generous measure of "aliasing" distortion can be produced alongside the unavoidable 
loss of highs which results from "down sampling". Bit resolution is clearly changeable, 
too. 

Parameters 

• Rate: Sample rate 
• Crush: Number of bits 
• Low-pass: Low-pass filter at the output to smooth out induced noise 
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Distortion 
This overdrive effect works similarly to common guitarist effect pedals. Everything is 
possible, from light, bluesy signal saturation to hard "metal shred boards". Here a 
dual-band EQ works on the in and output signals and therefore provides a rich palette 
of sounds. 

Parameters 

• Drive: Controls the internal level and thereby the overdrive 
• Low: Bass portion. 
• High:High portion. 
 

Analog filter 12/24db 
Vintage compressor 
Synthesis models 
The sound synthesis in BeatBox 2 consists of a simple sampler and a synthesizer 
which includes three different synthesis modules. 

Sampler 
The sampler plays short sound recordings ("samples") in different pitches. The 
sampler is intended for creating all kinds of drum sounds; the sounds are static and 
unnatural if the pitch is not altered. This is why the sampler is combined with on of 
the three synthesis models. 

Filtered noise 
White noise is filtered by two band-pass filters with separately setup frequencies and 
resonance. This algorithm is suitable for creating synthetic snares and high hat 
sounds. 

Phase distortion synth 
Two oscillators with regulated phase distortion and thoroughly variable frequency 
modulate each other (FM/cross-modulation/ring-modulation). Depending on the 
setting, this algorithm can be used to create kick, tom, or metallic percussion sounds; 
higher values for frequency and modulation level produce noisier sounds for high hats 
or shaker sounds. Since the oscillator frequency can be set exactly according to the 
musical pitch, this model can be used to produce mass lines or melodies. 

Physical modeling 
This is a simple physical model of an "abstract" percussion instrument. A fed-back 
network of delays is caused to oscillate by an impulse of filtered white noise (exciter). 
Depending on the setting of the exciter, the size of the model (surface), and the 
damping, a wide spectrum of natural sounding percussion instruments like cymbals, 
claves, gongs, or triangles can be created. 
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Multimode filter/Envelope generator 
Following the samplers and synthesizers, an inverse filter (multi-mode filter) is added 
to add the last bit of polish to the drum sound. The envelope generator controls all 
time-dependent processes in the synthesizer and sampler.  
 

Loop Designer 
The loop designer unites both stellar design elements of drum'n'bass style in a 
"device": turned-up beats and rumbling bass lines. With the Loop Designer you can 
create authentic drum'n'bass sounds without any specialized knowledge. 

Tip: Drum'n'bass tracks usually have between 160 and 180 BPMs. The Drum&Bass 
Machine can also be used for other music styles.  e.g. for BigBeat (120 BPM) or 
TripHop (80-90 BPM). 

 

Loop Designer: overview 

 

The top half of the synthesizer controls the rhythm section, the lower half - the bass 
section. You can mute both sections using the M symbol on the left border. This way 
you can, for example, turn off the bass section in order to take only the drum section 
into the arrangement. Only the drum section will then be added to the mixdown file 
when mixing down the arrangement. Next to this are the volume controls, which 
control the volume of both sections. 

You can preview and stop your drum'n'bass creations using the "play" and "stop" 
buttons.  
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Additional buttons: 

 Loads a saved pattern with all settings. 

 
Saves a pattern.  

 Undo for all settings made in all sections.  

 Makes random settings changes in both sections. You can change 
settings later as you wish.  

 
 

Drum section (top half) 
Here complex, authentic-sounding Jungle-Breakbeats can be put together easily. In 
professional recording studios Jungle-breakbeats are made by chopping up arbitrary 
drum loops and putting them back together in a different order. These laborious work 
steps are significantly simplified by Loop Designer.  

The new sequence is determined in the top row, the so-called "step" row. The grey 
cells represent the individual sections ("counts") into which the loop is separated. 

Pick a different note or playback by left-clicking a grey cell. Various notes will be 
represented with a light bar which "grows" toward the top with each mouse click. This 
way, each time you click on the grey cell, the bar expands by one step.  

 

1 of 4: Play Drum Loop starting from the first note. 
 
 

 

2 of 4: Play Drum Loop starting from the second note. 

 

3 of 4: Play Drum Loop starting from the third note. 

 

Full bar: Play Drum Loop starting from the fourth note. 

 

Reverse icon: Play backwards from this position 

 

Stop icon: Stop playback 
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The right mouse key deletes settings of a step bar and the Drum Loop is played in its 
original order. 

 
Pressing the double-arrow button generates a random step sequence. 
You can change this rhythm as you like.  

 

 

Clicking into the blue field in the left part of the drum 
section opens a pop-up menu where you can pick the 
sound of the Drum Loop. When you select another drum 
loop it will load and be played in the way you 
programmed it. 

Tip: You can also send a loop from Soundpool or a wave file to Loop Designer. To 
do so, select the desired loop or file and drag it into the field while holding down the 
mouse key ("drag & drop"). 

In the field under the "steps" row the sound of the loops is defined. The intensity of 
the settings is determined with a control similar to a peakmeter. The higher the bar, 
the stronger the influence on the loop is. With the help of the left mouse key, values 
can be smoothly adjusted. "Volume" controls the loudness (full = loud, empty = 
quiet), "filter" the filter strength (full  = clear, empty = muffled). In the "Flam" row you 
have the option to make the note repeat itself twice in quick succession. This is how 
to program rolls and fill ins.  

Using the top arrow buttons at the right edge you can load pre-defined pattern 
settings. The originally set loop will not be changed. The two lower arrow buttons 
offer presets in the form of standard curves for "volume" and "filter".  

 

The "Filter type" controller selects the type of the filter sound: 
"BP" stands for "bandpass", "LP" for "low pass" and "HP" for 
"high pass".  

 
 

Bass section (lower pane) 
The bass section produces suitable bass lines. 

• The first row of the "Notes" row, determines the order of the sounds i.e. the 
series of notes. Select a cell with the left mouse click, where the lowermost 
represents the lowest note and the topmost  - the highest. A right mouse click 
deletes a cell.  

• In the "Octave" row you can specify the octave of the bass. The slide control 
positions represent the various octave values. If the controller is down, a deep 
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sound is produced, if it is in the top position, you will get a high tone. If the 
controller is in the middle, the pitch will be balanced.  

Just like in the drum section, here you will also find arrow buttons on the right side for 
opening pre-defined patterns and and a double-arrow button for setting arrows. The 
filter can be set analogously to the drum section. The arrow button next to the filter 
area select presets in the form of standard curves.  

You can determine the bass sound in the blue selection field at the left side. You can 
drag loops and WAV sounds into the field using drag & drop just like in the drum 
section.  

Additionally, there are two slide controllers for sound changes to the right: 

 

The "Vibrato" slider makes the bass tone's pitch change. When 
the control is to the far right, the sound vibrates more, if it's to 
the far left pitch isn't changed at all. 

 

The slider "Decay" determines how long should it take to for the 
sound to subside. Set to the far right the sound is very fast 
(about 1 / 4 of a second), on the far left the sound lasts longer. 
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LiViD - Little Virtual Drummer 
MAGIX LiViD helps you to turn your ideas into songs. Enter a few basic details and 
LiViD will play a full drum track, complete with intro, verses, choruses, fills, bridges 
etc.; the entire song structure is laid out for your convenience. Brilliant stereo drum 
samples recorded by professional studio musicians and a freely adjustable 
“Humanize“ function will  create an authentic drum feel with perfect sound quality. 

LiViD features four styles (pop, rock, funk, latin), each of which is subdivided into four 
further substyles, as well as six song sections for each substyle (intro, verse, bridge, 
chorus, outro, fill-in). 

 

Scramble: A random sequence of four one-bar patterns is generated internally for 
each style/substyle/song section. “Scramble” generates a new pattern order. 

Shuffle: Shifts the second and fourth 16th note of a beat back by a freely definable 
amount (100% = triplet rhythm). 

Humanize: Randomly shifts all events backwards or forwards, or leaves them 
unaffected. Note: these shifts are very subtle and not always immediately perceptible! 

Snare: Sets the snare stick style to “normal”, “side stick” (stick hits the rim while 
resting on the skin) or “rim shot” (sticks hits the rim and skin simultaneously). 
Exception: the snare’s quietest velocity level ( the "ghost notes") is always “normal”. 

Hi-hat: Sets the hi-hat sound to “soft” (fully closed) or to “hard” (half-open). 
Exception: completely opened hi-hat (pop, type1, verse). 

Ride: Sets the ride cymbal sound to “ride” (cymbal is hit on the rim) or “ride bell” 
(cymbal is hit on the bell at the center). 
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Robota 
The Robota is a four-part drum computer with virtual analog and sample-based sound 
production. Virtual analog sound production means that the sounds are synthesized 
in real-time, i.e. produced with a synthesizer to recreate the typical analog sounds of 
classical drum computers, such as the Roland Tr-808 and Tr-909, or more recent 
devices such as the Korg Electribe or the Jomox x-cousin. Sample sound production 
uses drum sound recordings (or even other recordings) as the basis for sound 
production.  

After selecting the elementary sound production technique, the sounds of each of the 
4 parts (or instruments) can be edited using modulators.  

The step sequencer programmed with incident lighting helps Robota to play. 4 beats 
in sixteenths (or 2 beats in thirty-seconds) are processed as a loop. At each beat 
position, the playing positions can be set by clicking a button. In "Event" mode, the 
instruments are distributed within the beat pattern. In "Snapshot" mode you can 
adjust additional instrument sound settings.  
 

Sound synthesis 
The four instruments of the Robota are built identically. Each instrument can create all 
kinds of drum sounds –  from hissing hi-hats to phat bass drums.  

During elementary sound production, you can choose between an oscillator with 
selectable wave shapes (sine, triangle or saw tooth) or a sample. In addition, you can 
add a noise generator can be added. The oscillator has a pitch envelope (pitch env.) 
and a volume envelope (attack/decay). It can also be frequency and ring-modulated. 
The depth of the modulation can be controlled via an envelope parameter (Fm/rng 
dcy). There’s also a “Lo-fi” section consisting of distortion (Rectify), bit rate reduction 
(Crush) and sampling rate reduction (down sample). 

Temporal control via an envelope (lofi dcy) will get the best out of the lo-fi effects. A 
multi-mode filter (low-pass/band-pass filter/high-pass) with 12/24 dB steep-side. A 
comb filter can be inserted. The filter frequency can be likewise modulated via an 
envelope. For extra pressure, an adjustable compressor (compressor, comp resp) is 
included, as well as tube amplifier simulation (tube).  
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Parameter (1): To simplify matters, not all parameters 
can be changed on a sound - only those that are 
meaningful for the selected drum sound may be 
changed (snare, kick, high etc.). There are four selected 
variable parameters coordinated exactly with the 
selected preset sound.  
Oscillator waveform (2): The fundamental waveform of 
the Oscillators is selected here. You can choose from  
sinus/triangle/sawtooth/sample. If you have selected 
"Smpl" you can use the rotary knob to select a sample, 
i.e. a previously recorded drum sound. These samples 
are saved in the folder /synth/robota/samples/. If 
select custom samples, they will appear in the selection 
list. 
(3): For each part you can regulate: Filter Cutoff, 
Resonance, Tube, Volume and Panorama (view page 
257). 

 

With select choose the instrument for editing in the step sequencer.  

 “M” mutes the instrument, “S” makes it solo   

 The loudspeaker button allows you to hear a preview. 

Master Section 
Volume regulates the total volume of the Robota. Distortion adds an adjustable tube 
distortion to make the sound “dirtier” and more powerful. The peak meter helps 
control the output level – when it enters the red area, reduce the total volume.  
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Schematic illustration of the Robota synthesis 

 

Here is a detailed circuit diagram of a Robota voice with a description of all control 
parameters.  

Pitch envelope (pitch env) 
Controls the pitch envelope level. 

Tune 
Tunes the instrument. 
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Oscillator shape (osc shape) 
The shaper adds additional frequency shares to the basic sound of the oscillator by 
artificially reshaping the wave shape. A sine wave (shape = 0) can be reshaped up to 
a square curve (shape = max). 

Oscillator waveform 
The fundamental waveform of the oscillators is selected here. You can choose from 
sine/triangle/sawtooth/sample. If "Sample" is selected, you can use the controller to 
select a sample, i.e. a previously recorded drum sound. These samples are saved in 
the folder /Synth/robota/samples/. If you select custom samples, they will appear in 
the selection list. If you are playing your own samples, they will appear in the selection 
list. 

Noise 
Adjust the ratio between the oscillator sound and the noise generator. 

Attack 
Adjusts the attack time. The greater the set value, the softer the attack of the sound. 
The attack rate is also applied to the lo-fi and filter envelope curves. 

Decay 
Adjusts the decay curve. The greater the value, the slower the instrument will decay. 

FM/Ring modulation frequency (Fm/rng frq) 
The fundamental frequency of the frequency or ring modulation.  

FM level (fm lvl) 
At a low frequency FM first adds vibration to the sound, at high frequencies and low 
levels it creates bell-like sounds, as the level increases metal sounds, and finally noise. 

Ring modulation level (rng lvl) 
Ring modulation creates typical auxiliary frequencies. 

FM/Ring modulation decay (Fm/rng dcy) 
Time constant of  FM/ring modulation by-product. Only the beginning of the drum 
sound is affected by the modulation.  

Rectify 
Distorts the audio signal. 

Crush 
Bit rate reduction. Digital artifacts become audible with higher settings.   

Down sample (dwnsmple) 
Sample rate reduction. Ideal for creating the "old school sound" of older digital drum 
machines. As it is increased, the result becomes darker. 
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Lo-fi decay (lofi dcy) 
Time constant of the by-product of the three lo-fi effects which makes the sound 
"dirty". Only the beginning of the drum sound of the lo-fi effects is affected if the 
decay is low. For instance, this makes the kick of a kick drum sound more interesting. 

Filter modes (flt mode)  
Filter mode: High cut – sound portions above the cut-off frequency are filtered out. 
Band pass (BP) – Sound portions above and below the cut-off frequency are filtered 
out. Low cut - All sound portions below the cut-off frequency are filtered out. This 
mode is set as a preset and can not be changed. 

Filter frequency (flt freq) 
The cut-off frequency of the filter. 

Filter resonance (flt reso) 
Filter resonance which increases the sound portions at the cut-off frequency of the 
filter. If the resonance is high, the filter itself can also be used as an oscillator. 

Filter modulation -/+ (flt mod -+) 

Regulates how much and in which direction the filter envelope curve moves the filter 
frequency in which direction. 

Filter-Modulation decay (flt mod dcy) 
Decay time of the filter curve. Smaller values with high resonance create a "zapping" 
sound of the filter, greater values create the typical sweep sound. 

Filter modulation velocity (flt mod vel) 
Specifies how much the filter modulation depth depends on the velocity. If this value 
is increased, louder beats will generate higher filter curves than quieter ones. 

24 dB 
The filter can operate with a slope of 12 dB or 24 dB. This mode is set as a preset and 
cannot be changed. 

Comb filter (comb filt on) 
You can activate a comb filter, a feedback delay that creates resonance-like sounds 
comparable to a plucked string. The delay time and feedback levels are permanently 
linked fo the filter parameters (frequency and resonance). This comb filter is set as a 
preset and can not be changed. 

Compressor 
Controls the compressor strength. This lets you increase the "power" of the drum 
sound. 

Compressor response (comp resp) 
Controls the compressor time. The lower the value, the faster the compressor follows 
the volume. 
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Tube 
Controls the level of the tube amp simulation. It "saturates" the output signal of the 
voice and adds warmth to the sound if the settings are moderate. Increasing the 
settings makes the sound "dirtier". 

Volume/Pan 
Controls the volume and panorama position of the drum instruments. 
 

Sequencer 

  

Incident lighting is used to control the drum patterns just like in all classical drum 
computers and groove boxes. The step sequencer consists of 16 individual step 
buttons with LEDs corresponding to the appropriate partitioning of a beat:  

16ths or 32nds (a half beat is in each case displayed). A button lights up to indicate 
the releasing of the instrument at this point in the beat (= step).  

A left click turns on the step, a further left click deletes the step again.  

 

A pattern can be a maximum of 4 beats long. The length can be modified 
using the fader on the button bar. 

 

The beat to be edited can be selected with the applicable “edit” button. The “Follow” 
button specifies whether the step of a beat is in time. 

"1 > 2-4" auto draw: If more than 1 beat is activated as the loop length, the "Auto 
draw" mode ensures that the drum note set in the first beat is set automatically for 
the following beats. This makes it very simple to produce a continuous beat from a 
loop length of 4 beats. Notes set in the rear beats are not affected by auto draw.  

How to program a drum pattern: 

• Select the pattern length with the fader. 
 

 

• Select “Event” mode. 

 

• If you edit during playback, turn off “Follow”. Select the beat with the “Edit” 
buttons.  
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 • Use “Select” to choose an instrument to edit.  

 • Use the “Clear bar” button to delete all steps in the selected 
instrument. 

 

 

• Turn on the appropriate step buttons, and use the “Velocity” 
controller to adjust the beat velocity.  

 

• Repeat the procedure with the other instruments  

Snapshots 

In addition, you can automate programming of the editable sound parameter of a 
drum sound via so-called "snapshots". You can thereby save the sound parameters of 
a drum instrument on the step buttons of the sequencers. 

Automating the drum instrument with snapshots.: 

 

• Set the edit mode to “Snap”.  
• If you edit during playback, turn off “Follow”. Select the beat with the “Edit” 

buttons.  
• Select an instrument and edit the sound. You can control the sound of an 

instrument even when playback has stopped by using the loudspeaker button. 
• Save the sound as a snapshot to one of the step buttons. 
• Change the sound of an instrument and save the settings to other step button 

Warning: The parameters are not changed abruptly but are faded internally instead, 
in order to avoid crackling. If two snapshots with extreme parameter differences are 
too close together, the drum sounds will sound differently when the pattern is 
played. 

 

• Using the arrow keys, you can jump between the individual 
snapshots during stopped playback.   

• Press “on” to activate snapshot automation.  
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Groove Control 
The secret behind “groove” beats lies in delay. That is, individual beats are either 
anticipated or delayed according to patterns. For example house beats use the 
“shuffle” whereby straight 1/16s are delayed at certain times. 

 

In the Robota there are groove velocity and groove swing presets. Groove velocity 
presets contain for each step of a beat a certain offset to increase or reduce the 
original beat velocity. Groove swing presets contain for each step a time alignment 
that is either anticipated or delayed. The result is a livelier-sounding sequence. The 
strength of the effect can be adjusted with the % regulator.   
 

Setups, drum kits, presets, and patterns 

  

A single instrument sound is saved as a 
preset.   

 

Presets containing all four instruments 
are saved as drum kits.  

All note information plus the snapshots 
are saved as a pattern.  

 

Together (drum kit + pattern) they are 
know as a setup.  

Load/Save 

Presets, drum kits, patterns and setups can be selected with the continuous rotary 
regulators next to the display area. For storing, click on the  “Save” button. Then 
specify a new name in the input field. To store, press “Enter”.  

Note: A drum kit stores only the names of the presets, not the actual parameters. If 
you want to store your own drum sounds that were created by changing existing 
presets, you must first store them as new presets and then as a new drum kit! The 
same applies to the setups, which contain only the pattern and drum kit names. 

If necessary, always store in this order: preset -> drum kit -> pattern -> setup. This 
applies only when creating your own “templates”. If you store your arrangement 
normally, the complete current status (synthesizer + sequencer) of the Robota is 
always stored and correctly loaded later with the arrangement. 
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Vita 
The MAGIX Vita synthesizer specializes in playback of "real" instruments using 
sampling technology. This means that short samples of real instruments in different 
pitches, playing techniques and volumes are used, combined, and played again at the 
correct pitch. 

The VITA synthesizer is controlled via the MIDI objects. If you load Vita via the Media 
Pool, a preset MIDI object will appear first. You can then load different Vita sounds 
via the "Output" menu at the top of the MIDI editor. 

You can adjust Vita's sounds via the instrument menu of the 
trackbox. 

 

 

The Vita interface 

 

1. Layer selection/Peak meter: The Vita sounds, also known as layers, can be selected 
here using the arrows. Right-clicking on the display opens the layer menu. 

2. Main parameter: Here the volume, panorama position, pitch characteristics 
("transpose") and the fundamental frequency ("master tune") can be set. 

3. AMP: This is the volume envelope. With this you can control the timing of a 
sound's volume. A(ttack) stands for the volume increase at the start, D(ecay) for the 
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length of time the decrease in volume takes on a section set with S(ustain) at the 
maximum volume. R(elease) is the length of time it takes for the sound to fade out. 

 

4. FILTER: Here you can switch on a filter which influences the sound. With FILTER 
TYPE you can select the kind of filter you want to use. Cutoff controls the filter 
frequency and "Resonance" controls the strength of the emphasized filter frequency. 
"Velocity" indicates how much the velocity influences the filter frequency, using 
"Gain" you can balance the volume. The filter envelope (ADSR slider) influences the 
filter frequency depending on the time. 

5. DELAY: Here you can switch on an echo effect. "Time" controls the delay time and 
"Level" controls the strength of the echo sound. 

6. REVERB: Here you can switch on a reverb effect. "Time" controls the delay time 
and "Level" controls the strength of the echo sound. 

7. TUBE DISTORTION: This is a tube distortion effect like those found in guitar 
amplifiers. This is normally used for electric guitars but you can also get creative and 
use it for other things. "Drive" controls the strength of the distortion. "High-cut" and 
"Low-cut" filter out the high and low frequencies. 

8. VALUE DISPLAY: This always displays the exact values of the parameter that was 
just adjusted. 

9. DYNAMIC RANGE: Usually the relationship between the created volume and the 
MIDI velocity is proportional. You can compensate for the fact that some MIDI 
keyboards need to be pressed forcefully to produce loud sounds (or conversely 
produce loud sounds with a soft touch) using the "MIDI Input Curve". Using 
"Dynamic and "Dynamic curve" you can manipulate the dynamics of a sound, i.e. the 
relationship between the loudest and quietest sounds. 

10. Voices: Here you can control the number of voices played simultaneously. If notes 
are no longer played, as is the case in some fast passages, you can increase the 
number of voices at the expense of performance. 

11. Keyboard: Here you can preview the Vita sounds. This only works during playback 
or recording. 12. lets you hide the keyboard. 
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Revolta 2 
Revolta 2 is a further development of Revolta. It is polyphonic and playable with up to 
12 tones, including an additional noise generator, a step sequencer, and an extra-
flexible modulations matrix. An effects section with 9 different effects and presets 
(created by a professional designer) make it a full-fledged synthesizer for all kinds of 
lead, sequence, and pad sounds. 

REVOLTA 2 has a whole array of presets. The sounds have been created by 
professional sound engineers and demonstrate the huge potential of this instrument 
from the word start. First off, however, we would like to encourage you to try out the 
various control functions and to experiment as much as you like. The sky's the limit to 
your creativity. 
 

Revolta 2 interface 
Note: The following is only a short description of the Revolta 2 interface. 

 

 

For a comprehensive documentation of this complex synthesizer please click 
the help button on the Revolta 2 interface!   

The Revolta 2 interface can be displayed in two sizes. In "Rack" mode only the 
elements necessary for preset loading are visible: 
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By clicking the edit button you can open the complete interface. 

 

1. Main parameter: Sets the volume, panorama position, pitch characteristics 
("Transpose"), and play modes ("Poly", "Mono", "Legato"). "Glide" regulates the 
portamento time. 

2. Oscillator section: Two oscillators are available with smoothly adjustable curve 
forms and a noise generator. Both oscillators can be tuned to each other and used to 
modulate frequencies. 

3. Amp: This is the volume envelope. Here you can influence the temporal 
progression of a track's volume. A(ttack) stands for the volume increase at the start, 
D(ecay) for the length of time the decrease in volume takes on a section set with 
S(ustain) at the maximum volume. R(elease) is the length of time it takes for the 
sound to ring out. "Vel" specifies how much the envelope curve depends on the 
velocity. 

4. Filter: Here you can switch on different filters to influence the sound. "Filter type" 
selects a filter type. "Cut-off" regulates the filter frequency, "Resonance" controls the 
strength of the amplification of the filter frequency. VEL" indicates how much the 
velocity influences filter frequency, and "Key" changes the filter frequency depending 
on the note pitch ("Key tracking"). The filter envelope (ADSR slider) influences the 
filter frequency depending on the time. "Env mod" controls the strength of the filter 
envelope curve, and with "drive" the filter can be overmodulated. 

5. FX1/FX2: Here you can mix in 2 different effects out of a total of 9 available effects. 

6. LFO1/LFO2/Step sequencer: Two LFOS and the step sequencer can be used to 
modulate single parameters of Revolta 2. 
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7. Options and modulations matrix: The two buttons open the Revolta options page 
for general and preset-specific settings and modulation matrix. In the modulation 
matrix modulation sources are connected with modulation targets. Simple 
modulations like the oscillator (the pitch will be modulated via an LFO) can be set 
quicker directly on the interface. Much more complex modulations are possible in the 
matrix because the matrix offers more modulation sources (e.g. MIDI controller, 
oscillators) and the modulation source can influence more targets.   

8. Value display: The value display shows the exact value of the parameter which was 
just modified. In addition, you can find out the load of the twelve voices. 

9. Preset section: Here you can select Revolta presets. Every sound can be listened to, 
and an A-B comparison between two sounds is also possible (for example, an edited 
and an unedited sound). 
 

Additional Vita Solo synthesizers 
Samplitude Music Studio 2013 includes additional track synthesizers that are based 
on the Vita Sampler engine. 

• String Ensemble 
• Rock Drums 
• Bass Machine 
• World Percussion 

The basic controls are identical for all synthesizers. 

 

One click on the arrow symbol opens a fold-out menu where you can determine the 
general sound of the instrument. If "ECO" appears in the description, this refers to 
especially performance-improving settings which may not sound so "smooth". You 
may also save the settings you changed in order to add them to your favorites lists for 
later use.  

 

You can control the overall loudness of the instrument.  
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You can turn the instrument keyboard on or off with this controller.  

Because these samplers are enhanced for each instrument by tuned effects, the rest 
of controls function analogously to the already familiar synthesizers such as Vita. If 
you would like to know which result certain effects have, you will find explanations in 
the Essential FX, Vintage Effects (view page 106) or Reverb chapters.  

Additional information is also available in the VST plug-ins (view page 211) chapter. 
 

Articulation 
Some Vita Solo Instruments have a special feature: In a bass octave (on the keyboard 
(C0-H0), there are special notes, which let you control the playing style 
(articulation). An alternative sample set is loaded, which lets the bass sound even 
more realistic using various playing styles such as note bending and flageolet. 

Articulation is switched on and continues until normal articulation is switched on 
again through the corresponding note (C0).   

   

On the keyboard at the bottom of the synthesizer interface are the buttons to switch 
articulation, displayed in different colors. In the MIDI Editor appearing above, you can 
watch a practical application of articulation. The notes on 1:4 and 4:1 will be played 
back with varying articulation. Before the next "right" note, normal articulation will be 
switched on again through C0. 
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Surround sound 

Surround panorama module 
In the "Surround Panorama" module the panning of a track or an object is set and 
edited on the Surround bus. 
 

Open the dialog 
• Right click on the Surround pan display of the relevant channel line in the mixer 

(this is only possible if the twin-channel Surround mode is already active), or 
• Right click on the button or regulator in the relevant track in the VIP, or 
• Open the track menu of the VIP in the track information with a mouse right click 

and select “Pan / Surround editor”, or 
• Select the required track in the VIP and select “Track -> Surround panorama 

module” 

In the title line of the Surround panorama module the track is stated that it is currently 
being edited. 

Example: “Surround panorama module: Track 4” 
 

Display elements 

 

In the panorama display the loudspeaker channels of the Surround setup are shown 
as blue dots. Activating the options underneath the panorama display allows the 
following information to be displayed in addition: 
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Name 
The loudspeakers are designated with defined abbreviations: “L” (left), “C” (center), 
“R” (right), “Ls” (left Surround), and “Rs” (right Surround). 
 

Volume 
A level indicator appears next to each loudspeaker and shows the value of the level 
share that the sound source is transmitting on this Surround bus. For the stereo 
modes the total of the level of both sources is always shown. If "Shift" is held down 
and the mouse is clicked on a source, only the value for this source will be shown 
briefly.  
 

Sound field 
The input signal is presented as a field made of concentric circles. Each red line 
corresponds to a level-gradient of 3 dB in the sound field. The loudspeakers are 
arranged in such a way that the distance between each loudspeaker and its neighbor 
is constant. This arrangement makes a uniform distribution of the sound source 
possible to all channels. Level relationships are created between the channels that 
cannot be achieved in other modes. 
 

Settings 
Surround active 

Activates the twin-channel Surround mode.  

In the deactivated state the stereo position can only be determined via the control 
elements in the track box or the mixer. 

Pan L/R 

This determines the way in which the left-hand or the right-hand channel is placed in 
the Surround field. For the individual cases, please read the section on “Stereo and 
mono signal processing with twin-channel Surround”. 

Width 

Affects the extension range of the loudspeakers. 

Center 

The parameter controls the share of the center in the distribution of the sound source 
to the front channels. In certain working ranges (e.g. film sound) it is customary to 
reserve the center channel for dialog and to mix music and noises without share in the 
center. A signal positioned exactly in the middle is reproduced in the 5.1 format with 
Center = 100% exclusively through the center channel, or with 0% exclusively as a 
phantom sound source through the channels L and R. This parameter is often also 
described as divergence. 
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Automating Surround 

This section of the dialog is described in the section on “Automation of twin-channel 
Surround”. 
 

Stereo and mono signal processing with twin-
channel Surround 
Mono 
The following applies to stereo signals: A mono total is formed from the signal that is 
positioned as a single mono sound source in the panorama. 

The following applies to mono signals: The signal is positioned as a single mono 
sound source in the panorama. 
 

X-Sym. 
The following applies to stereo signals: The left-hand and right-hand channels are 
aligned symmetrically on the x-axis. This enables a stereo signal to be panned very 
easily from front L to Surround L.  

The following applies to mono signals: In addition to the original mono source a 
second (mono) mirror sound of this signal is positioned. 

The mirror axis is the x-axis. 
 

Y-Sym 
The following applies to stereo signals: The left-hand and right-hand channels are 
directed symmetrically on the y-axis. This enables a stereo signal to be panned very 
easily from front L to R. 

The following applies to mono signals: In addition to the original mono source a 
second (mono) mirror sound source of this signal is positioned. 

The mirror axis is the y-axis. 
 

XY-Sym. 
The following applies to stereo signals: The left-hand and right-hand channels are 
aligned symmetrically to the x and the y-axes. This enables a stereo signal to be 
panned very easily from to front L / Surround R.  

The following applies to mono signals: In addition to the original mono source a 
second (mono) mirror sound source of this signal is positioned. This is mirror-
symmetrical to the original course with regard to the x and y-axes. 
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Parallel 
The following applies to stereo signals: The left-hand and right-hand channels are 
kept at a constant distance to one another and shifted parallel to one another during 
movements. If "Ctrl" is held down the distance between the two sound sources can be 
altered.  

The following applies to mono signals: The original and the mirror sound sources are 
kept at a constant distance to one another and shifted parallel to one another during 
movements. If "Ctrl" is held down the distance between the two sound sources can be 
altered. 
 

Stereo thru 
The following applies to stereo signals: The same level shares as with a mono source 
are sent to the various channels, depending on the position of the sound source. 
However, for all left-hand channels only the left-hand signal is used, for the right-hand 
channels only the right-hand signal, and for the center and LFE channels the mono 
proportion.  

The following applies to mono signals: No special function, identical with mono 
mode. 
 

Automation of twin-channel Surround 
Surround panorama module 
Panning movements in track-related Surround panning can be automated. For this 
purpose, first the automation is switched on in the Surround panorama module. This 
can also be done by pressing the button of the relevant track in the VIP window. If the 
sound source is moved during the playing process, this movement is recorded and 
shown in the VIP as a curve. Later editing of this curve is possible with the Panorama 
drawing mode of the mouse in the VIP. 
 

Drawing 
For this automation mode a range first has to be marked in the VIP within which the 
change is to take place. The drawing mode is now switched on in the Surround 
panorama module. Now, any required series of movements of the sound source can 
be drawn in the Surround panorama. This series of movements is carried out in the 
previously marked time range the next time the VIP is played. Later editing of the 
curve is possible with the curve editing mode in the VIP. 
 

Processing the Surround Sound automation 
Possibility 2: Drawing mode in the Surround panning dialog 
In order to prepare the drawing and movement for a Surround sound placement of the 
source signal, a range first has to be selected in the VIP track in which the automation 
is to take place. Then the “Drawing mode” function likewise has to be switched on in 
the Surround panning dialog. After that you can simply put the source signal in the 
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panning dialog into a new position. Samplitude Music Studio 2013 generates the 
automation events automatically in order to generate this movement for the 
automation curves. 
 

Possibility 3: Drawing automation curves in the VIP track 
Samplitude Music Studio 2013 allows you to draw new Surround sound automation 
curves in a VIP track or to change existing curves. Make sure that the button for the 
corresponding VIP track is activated. In the Surround panning dialog the “Automation 
on” function can also be switched on. As the next step the panorama drawing mode 
has to be selected from the toolbar. You can draw new curve events with it in the VIP 
track. Place the mouse pointer close to an existing curve and click the left-hand 
mouse button. While this button is held down you can create new events for this 
curve. 
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Synchronization 
Synchronization is very important to an audio system, since it is necessary to align 
playback and recording speeds of different system components. Synchronization 
enables studio equipment such as tape machines, drum computers, video recorders, 
or sequencers to be linked with different formats like MIDI clock, MIDI timecode, or 
SMPTE timecode so that all of the devices run at precisely the same time. 

Samplitude Music Studio 2013 can be configured to as the master or slave within a 
synchronization system. As a master program, it generates the necessary timing 
information required for other system components; as slave. Samplitude Music Studio 
2013 receives the timecode data to follow during playback or recording. 

Clock on digital systems 

In case digital signal flows are processed, e.g. via ADAT, SPDIF, or MADI, it is 
important to define a clock reference within the overall system. The clock signal is 
transferred via Blackburst, World Clock, or the digital input, and it may be received by 
the receiving or playback computer. External devices such as converters or mixers 
may also provide a clock reference. For these systems, there can be only one master 
but several slaves. 

Note: Don't confuse (Word) clock with timecode. The clock signal is only a digital 
pulse for comparison of the timing between the connected devices and to keep the 
bit rate constant. This enables transmission errors to be prevented. Professional 
digital audio devices normally feature a word clock input and are able to generate 
and receive a clock signal. 

Time-related synchronization of projects 

For more complicated configurations, it is usually necessary to connect various audio 
and video systems via absolute time references. This enables them to operate 
according to the behavior of the master, and the timecode information (transport and 
progress) is implemented correspondingly. 
 

Synchronization formats 
There are different types of synchronization formats. In the synchronization format 
you will find slave device information about the start position, start and stop signals 
and, in extended formats, the precise timing information, which are continuously 
transmitted. 

Samplitude Music Studio 2013 understands and transmits the synchronization 
formats MIDI-Clock (MC) and MIDI timecode (MTC). 
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MIDI Clock 

MIDI Clock only contains the SPP (song position pointer) and the start/stop signals. 
There is no continuous timing information embedded in the MIDI clock signal, nor is 
this transmitted. This type of synchronization is principally therefore only suitable for 
starting and stopping. The greatest drawback of this type of synchronization is the 
fact that Samplitude Music Studio 2013 can verify though whether the audio tracks 
are played back in full sync, but MIDI Clock does not provide further continuous time 
information to allow the internal position to be compared with the external signal. 

You can use this type of synchronization if your system combination shows no timing 
changes. 

MIDI Time Code (MTC) 

If you require a reliable integration of the MIDI tracks of an internal sequencer into 
Samplitude Music Studio 2013's audio tracks, use of the MTC format is 
recommended. 

MIDI Time Code or “MTC” includes so-called time information in addition to the 
MIDI Clock signals, although only start synchronization occurs in Samplitude Music 
Studio 2013.   It is therefore important that both systems have a word clock or are 
connected to any other type of digital audio clock. This helps to successfully avoid 
drifting. 

Chase Lock Sync 

If fluctuations in speed occur, Samplitude Music Studio 2013 can make adjustments 
in slave mode that ensure exact temporal synchronization. This function is called 
"chase lock". The settings can be changed in the Synchronization dialog. This option 
should always be used if a part of the synchronization cannot be clocked centrally via 
black burst, word clock, or the digital input, and Samplitude Music Studio 2013 is the 
"slave". This is the case if the timecode is located on a track featuring a multitrack 
machine. If the systems are coupled via a central digital audio clock, then chase lock 
should not be activated. Please note that resampling to the recording in real time 
according to the timecode fluctuations will be applied if "Chase Lock" is active. This 
causes increased CPU load and may result in unwanted changes to the audio 
material, if this is played later with other timecode references.  

Samplitude Music Studio 2013 supports real "Chase Lock" synchronization, i.e. audio 
playback can be controlled precisely by a received timecode signal (MC or MTC). In 
this case not only the starting point of audio playback is controlled externally, but 
sync also controls playback speed if "Chase Lock" is activated. Samplitude Music 
Studio 2013 is therefore capable of following analog tape devices or VCRs that always 
have some slip for longer periods. 
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Synchronization / Synchronization settings 

 

Master synchronization: Samplitude Music Studio 2013 will slave to 
SMPTE/MTC/MC and can act as the master for MIDI clock and MIDI time code. 

Sync output is directly linked to audio playback so that no delays occur between 
Samplitude Music Studio 2013 and external devices, even with long tracks. This new 
synchronization technology was specially developed for connecting Samplitude Music 
Studio 2013 with MIDI sequencers such as Cakewalk, Cubase, Logic, Evolution Audio, 
MIDI Connections, etc. which can run on the same PC in multitasking mode. 

In this case you should use a virtual MIDI router for internally linking the programs 
like "Hubis MIDI Loopback" from the Samplitude Music Studio 2013 studio CD-ROM. 

Wherever possible, please use MTC -25 frames/sec., since unlike the MIDI clock, no 
tempo changes have to be taken into account. 

If Samplitude Music Studio 2013 is running as master, please set the FX factor to 1.0. 

Slave synchronization with real "chase lock": Samplitude Music Studio 2013 
supports real "chase lock" synchronization, i.e. audio playback can be controlled 
precisely by a received time code signal (MC or MTC). In this case not only the 
starting point of audio playback is controlled externally, but sync also controls 
playback speed if "chase lock" is activated. This way Samplitude Music Studio 2013 
can follow the sync of analog tape machines or VCRs for quite some time, which 
always have a certain slip, without delay. 

This is a very powerful feature which many "professional" systems only offer at a high 
price! 
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By entering the "sync velocity", you can influence the speed of the tempo adjustment. 
The greater the sync velocity, the faster Samplitude Music Studio 2013 will follow a 
tempo change of the sync master; however, this also means that the pitch fluctuation 
in the audio material is greater. 

Only use values greater than 100 if Samplitude Music Studio 2013 does not 
synchronize precisely in standard cases. 

The "chase lock" synchronization uses a real-time resampling routine requiring a 
certain CPU power. Anything as fast as a Pentium 90 processor should suffice. 

When using the hardware pitching feature, the chase lock synchronization uses direct 
access to the sample rate of the sound card in 1 Hz steps. This achieves particularly 
precise synchronization without additional CPU load. However, the sound card has to 
support this feature, as is currently the case with the ARC44 and ARC88 4 or 8 
channel. 

MIDI clock input device: Here the driver must be selected from which Samplitude 
Music Studio 2013 will receive MIDI clocks for the synchronization. 

BPM: Here you have to enter the tempo at which you want to receive MIDI clocks. 

MIDI clock output device: Here you have to select the driver via which Samplitude 
Music Studio 2013 should send MIDI clocks for synchronization. 

BPM: Here you have to enter the tempo you want to send MIDI clocks. 

SMPTE/MTC input device: Here you have to select the driver via which Samplitude 
Music Studio 2013 should receive MIDI timecode for synchronization. 

Sync velocity: The greater the sync velocity, the faster Samplitude Music Studio 2013 
will follow a tempo change of the sync master; however, this also means that the 
pitch fluctuation in the audio material is greater. Only use values greater than 100 if 
Samplitude Music Studio 2013 does not synchronize precisely in standard cases. 

MTC output device: Here you have to select the driver via which Samplitude Music 
Studio 2013 should send MIDI timecode for synchronization. 

Type: Select the proper frame rate. Use 24 frames for cinematic synchronization, 25 
frames for PAL video, and audio synchronization, 30 frames for NTSC video. 

Pre-roll-frames: You can specify, how many frames Samplitude Music Studio 2013 is 
to ignore before the synchronization starts. Here you can account for the fact, that 
certain analog instruments need time to reach the correct speed. In order to have 
Samplitude Music Studio 2013 link up to the proper time values, a certain pre-roll 
frame count can be specified. 

SMPTE offset: The SMPTE offset is indicated in milliseconds and in SMPTE frames. 
The offset is removed from the incoming SMPTE time code signal to line up 
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differences between tape material and recorded samples in Samplitude Music Studio 
2013. With an offset of “60:00:00” milliseconds (1 hour) a tape that was previously 
stripped can be synchronized, if the start point for the recording/playback starts at 1 
hour. Samplitude Music Studio 2013 will, however, start at the correct beginning 
position. 

FX: With this parameter, possible inaccuracies during the positioning of long samples 
can be equalized. Requirement is a flawless synchronization at the sample beginning. 
Follow the instructions in the chapter “problem solutions”. 

Key:  G 
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Burning CDs 
Burning Red Book-compatible audio CDs is a vital feature of Samplitude Music Studio 
2013. You won't require any other software for writing a CD. You can also write CDs 
"on the fly", and all processing is performed in real time during the write process. 
Since trackbouncing was not performed first and no image is created, no extra space 
is required on the hard disk. 

However, sufficient system resources must be available for processing while writing. 
If your PC is too slow and writing is interrupted, then you can of course revert to the 
conventional trackbouncing method. 
 

Writing 
Some years ago, there was only a small number of select studios which were able to 
do CD mastering. Today, writing audio CDs is nothing exceptional and continuously 
dropping prices for CD-R burners and media make them available to nearly everyone. 

The audio material is stored digitally on the CD, this data is read by the CD player, 
and then it is transformed back to the analog plane. While in action, track indexes 
indicate to the CD player which songs start at which position. 

Samplitude Music Studio 2013 can also write an audio CD from the program directly. 
Before the write process starts, the track indexes are directly set in the VIP window, 
and then Samplitude Music Studio 2013 converts stereo sum and indexes into a data 
stream which is fed to the CD burner. 

The CD-R drive modifies an assigned layer of the medium by means of a laser so that 
an audio CD player can read this information as digital audio data later on. 
 

Burning CDs in Samplitude Music Studio 2013 
1. Record individual CD tracks in Samplitude Music Studio 2013 import WAV files into 
VIP tracks. 

2. Mix your recordings using realtime functions of the VIP windows and the Mixer 
windows. The CD will sound exactly as what you hear as the playback from a stereo 
sound card. All settings for playback will be audible on the CD. 

3. Set the track markers to mark the start positions of individual songs. If the VIP 
window has only one stereo track in which each song is laid down as a separate 
object, you can create track markers using the "Automatic indices" button in 
Samplitude Music Studio 2013. An index is set at the beginning of every object. In 
Samplitude Music Studio 2013 tracks and indices can be arranged in any order. 
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Pauses can be adjusted by moving objects, and indices with no pause may be set as 
well. 

4. If you have made all settings, click on the "Create CD" button in the toolbar or 
select "CD > Create CD". The burning dialog opens: 

 

Burn audio CD "on the fly“ calculates all effects in realtime: This option immediately 
starts the burning process as long as a blank CD-R is in the CD-R drive. 

Before burning, create a CD image file: This option creates a stereo wave file before 
burning, corresponding to the first version of the project. It is recommended when the 
system is too burdened or too slow for realtime ("on-the-fly") burning. Please take 
not of the system indicator on the main screen! If it comes critically close to the 100% 
marker, we recommend creating an image file before burning. The image file will be 
automatically deleted after. 

Burn MP3 CD/DVD: You can burn an MP3 CD/DVD with this option. You can find 
MP3 encoder settings via "Format options". 

CD title: here you can enter a CD title, which can be read by some CD players. 

Track list: This option lets you monitor the CD track manager (view page 426), which 
can be reached via the CD menu. All tracks can be listened to and the track markers 
can be moved if needed. 

Display TOC (CD contents): This button opens a text window with the current Table 
of Content. You can also open this data with current CD contents in an external 
editor. 
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Get CD info (freeDB): When you click this button, Samplitude Music Studio 2013 
looks for information to the title in the freeDB.org data base and displays it. 

Burn CD: opens the actual burning dialog. Here you can select the burning speed, 
burn CD text to the blank disc, simulate burning and create the CD as a CD extra 
project. In addition, you can compare the CD after burning with the project data in 
order to compare the error rate. If it is too high, the burning speed has to be lowered. 
Even new CD and DVD burners can cause errors during burning. 

Cancel: closes the dialog without burning. 

Print CD cover: opens MAGIX Xtreme Print Center, an included printing program, 
using which you can print a CD cover. Track information are automatically transferred 
as a table into the print project in MAGIX Xtreme Print Center. 

Help: opens the corresponding section of the Help file.  
 

DSP display 
System capacity is essential to the real time CD writing process. Once the writing 
process started, it cannot be stopped. The CD will be unusable if the the process is 
interrupted. When ”on the fly” is selected, the computer must calculate the playback 
with all real-time functions and simultaneously write the data onto the CD. 

The DSP display is a useful tool to assess possible problems when writing to the CD. 
The table below gives you a clue to the maximum possible writing speed. Individual 
deviations may result due to the configuration of your system and the speed of its 
components. 
 

DSP display and writing speed 
Nearly 100 percent  single speed 

Up to 50 percent  double speed 

Up to 25 percent  fourfold speed 

In particular, when first using a new and unknown computer system it is 
recommended to simulate the writing process first to check the system's 
performance limits. If the system becomes overloaded, reducing the number of tracks 
or real-time effects will help by combining parts of the VIP window (trackbouncing). 

The offline writing process variation offers another possibility. It creates a new stereo 
file first as the basis for the writing process. 
 



 

282   

www.magix.com 

Tools and wizards 

Load audio CD track(s) 
This function allows import and writing of audio files using most CD/DVD ROM 
drives. Data import takes place completely digitally, without any sound loss. HD wave 
projects are created as wav files and can also be loaded in other audio programs 
without having to convert the format. 

To import audio tracks you should proceed as follows: 

1. Open the drive list dialog ("CD" > "Load audio CD track(s)"). A CD track list 
dialog appears. In case there is more than one drive, you can select the right 
one using the "CD drive options" button. 

2. Mark the desired title(s) (using the Shift/Alt and arrow key combination) in 
the track list. 

3. Click "Copy selected tracks..." 
4. Select a name of the wav file or the HD wave project being created and click 

on "Import". 
5. Audio material will be copied form the drive and a progress bar will display 

how the process is proceeding. 
6. Close the dialog. You will see the loaded titles in Samplitude Music Studio 

2013. 
 

 

The track list dialog 
Copy selected track(s): This button starts audio copy. All selected tracks will be 
copied in a wav file or an HD wav project. 

Play: Starts audio playback of the first selected track in the list (as a test). 

Stop: Stops playback. 

Pause: Pauses playback By clicking the play button, playback can be continued. 

Select all tracks: All audio tracks will be selected, e. g. for copying the complete CD. 
Tracks markings can also be created using Shift and Alt and arrow keys. Multiple 
tracks can be selected by pressing "Ctrl + mouse click". 

Get CD info (freeDB): Compares the created CD to the freeDB data base and fills out 
metadata automatically. 

Drive and speed selection: Here you can see the name of the current drive and set 
read velocity. "Maximum" is the standard setting. If you notice read errors, gradually 
decrease writing speed. 
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CD drive options: If you have more than one CD/DVD drive, you can set which you 
want to be displayed here. 

Write text file: Opens a TXT file with all information on the currently created CD. 

Auto crossfade mode: The auto crossfade mode is turned on during import of audio 
tracks. Crossfades will be automatically set between imported titles. 

Take over CD track markers: If this option is activated, track markers will be set at 
the start of imported tracks. 
 

Features of the drive list dialog 
Track list: This button opens the track list dialog for selecting several audio tracks on 
a CD. 

Configuration: This button opens the drive configuration dialog to select special copy 
modes and SCSI IDs. 

Reset: Restores the standard drive settings. 

Add drive: Creates a new drive entry in the list for editing configuration data. 

Delete: Deletes the selected drive entry from the drive list. 

Save setup: Saves the drive list and all configuration data in a *.cfg file. 

Load setup: Loads the drive list and all configuration data from a *.cfg file. 
 

Features of the CD-ROM drive configuration dialog 
Drive name: Edits the name of the drive in the list. This is useful if you create more 
than one entry which access the same physical drive. 

Host adapter number: Specifies the number of your SCSI adapter (normally 0). 

SCSI-ID: Sets your CD-ROM drive's ID. Make sure you set the correct ID, there is no 
error checking! 

SCSI-LUN: Selects the SCSI LUN parameter (normally 0). 

Alias: Selects your CD ROM drive's manufacturer. 

Normal copy mode: Copies the audio data without any software correction. 

Sector synchronization copy mode: Copies the audio data using a software correction 
algorithm. Some CD-ROM drives cannot seek exactly to the same position between 
two read accesses, but Samplitude Music Studio 2013 can correct these differences 
using this algorithm. 
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Burst copy mode: Optimizes the copy process speed (no software correction). 

Sectors per read: Defines the number of audio sectors per read cycle; the higher the 
number, the faster the copy process will be. Not all SCSI adapters support more than 
27 sectors. 

Sync sectors: Defines the number of audio sectors used for sector synchronization. A 
higher number results in a better synchronization, but also in a slower copy process. 
 

Crossfade Editor 
In the Crossfade Editor you can conveniently and efficiently edit all aspects of a 
crossfade. All changes are non-destructive and can be undone via "Undo". 

 

Crossfade Length: The length of the crossfade can be set in varyingly large steps. A 
click on the "+" / "-" buttons increases/decreases the length in small steps, the "++" / 
"--" buttons in larger steps. Use the button "-?+" to customize these step effects to 
your needs. The crossfade length can also be defined by a selected range in the VIP by 
clicking on "Get Range Length". This range has to be selected before opening the 
Crossfade Editor. 

Fade In / Fade Out: There are lots of different curve types available for the crossfade: 

• Linear (0) 
• Exponential 
• Logarithmic 
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• Cosine 
• Sine/Cosine 

The faders can be used to change the curves in the corresponding available range. 
Linear curves require less computer power than non-linear ones. 

Note: The settings for fade in/out in the Crossfade Editor are also applied to the 
selected object if it does not overlap any other object. 

Global Settings: Set: The current settings are defined as preset. This is useful, for 
example, when an object is split with the "T" key and you wish to create a crossfade 
between the two objects. When opening the Crossfade Editor, the specified settings 
are set as default. 

Global Settings: Get: Use this button to get the presets of the Crossfade Editor. 

Get Range Length: The range length of the range selected in the VIP is set as the 
crossfade length. 

Crossfade off: Deactivates the crossfade of the selected object. The fade out time of 
the first object is set to 0.  

Play / Stop: Starts or stops playback in the selected range or at the cursor position. 

Move Crossfade Position: The end of the first object and the end of the second object 
are moved equally. The ++/--/+/- buttons are used to set the crossfade length. 

Shortcut:  Ctrl + F 
 

Waveform generator 
This dialog contains a powerful generator for several test tones. 

 

Select whether the waveform created should be a mono or stereo file. 
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Next, choose between a RAM wave project or HDP; in the first case, the waveform 
will only be created in memory (RAM), and this must be saved separately if you want 
to use the signal again later. 

If a HDP is created, then the waveform created will be available immediately as a file 
on the hard disk. Basic differences are also explained in the chapter "Wave projects". 

Sample rate: The sample rate may be selected between 44.1 kHz and 48 kHz.  

The next section specifies the type of signal to be produced. Select from square, 
triangle, sinus, sawtooth up, sawtooth down, and white noise. 

Length: Enter the desired length of the test tone generated in samples, milliseconds, 
and SMPTE. 

Wave shape parameter: The waveform is finally specified for the pitch and volume 
parameters.  

Once you've made all your settings, click "OK" or press the "Enter" key. The signal 
generated will now appear in a new window and for further editing. 
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Remix Agent 
The Remix Agent is a powerful tool for determining the BPM (beats per minute) and 
the time positions of quarter note beats of any song. This is important, for example, 
when a track on an audio CD has been imported into Samplitude Music Studio 2013 
and other sounds like drum loops, effects, or synthesizer voices are to be mixed in. 
 

Remix agent - Tempo and beat assignment 

 

The Tempo and beat recognition is a powerful tool that determines the tempo 
(measured in beats per minute, or BPM) as well as the timing of the beats for a song’s 
quarter notes. This is important if an audio CD title is imported into Samplitude Music 
Studio 2013, and you want to mix in sounds like drum loops, effects, or synthesizer 
voices. 

When to use the Auto Remix Assistant: 

• When the tempo of the arrangement must be adapted to the tempo of the song.  
• When the tempo of the song must be adapted to the tempo of an existing 

arrangement. 
• When the song is to be cut up precisely to create a remix object which can then 

be rearranged as desired. 
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Requirements 
• The song must be longer than 15 seconds. 
• The songs have to contain "rhythmic" music. 
• The song must be in stereo. 
 

Preparation - Setting the start marker and object end 
Before opening the Auto Remix Assistant, you should set the start marker at the 
position in the song object in the arranger where you want detection to start. If the 
song contains a long intro without beats, set the start marker after the intro. As a rule 
of thumb, the Auto Remix Assistant should always be "fed" dance music.  

• The start marker should be set before a quarter note beat or, better still, briefly 
before a beat at the start of a bar. 

• If the start marker lies before the song object, the object is examined from the 
beginning.  

• If detection is not performed by the end of the song, the object can be shortened 
accordingly with the object handle at the end of the object.  

 

Checking the automatic tempo and bar recognition 
After Tempo and beat recognition opens, the selected track object will be analyzed. 
Following the analysis, the track will be played, and during playback a metronome 
corresponding with the computed result will sound; vertical tick marks visualize the 
quarter note positions in the wave form display. 

The following is indicated: 

• Position of the start of the measure (one): red lines 
• Position of the other quarter notes (two, three or four): green lines 
• Reliably recognized positions: thick lines 
• Unreliably recognized positions: thin lines 
• Tapping is indicated by additional blue lines 

If the tempo and beat information is already available, then dots above the display at 
the corresponding positions will appear. To the left underneath the waveform display 
the metronome volume can be adjusted. To the right the calculated BMP value will 
appear. If the BPM value is valid, the display will be green. 

If the metronome clicks match the rhythm of the music, the bar starts will then be 
determined. If not, you can correct the tempo manually. 
 



 

Tools and wizards 289  

 

Corrections: Manual tempo and onbeat / offbeat setting 
If the result is incorrect, you can help the Auto Remix Assistant with a few mouse 
clicks on the correction buttons.  

There are two possibilities: On the one hand, the “Tempo correction” list offers 
alternative BPM numbers which could also fit with the music. The adjustable BPM 
values are detected automatically, and the total number of BPM can deviate from 
song to song. 

Tap tempo: With difficult audio material we recommend the using tapping input 
mode. Either "T" must be pressed, or the "Tap tempo" button must be clicked in time 
with the music. While repeatedly tapping the tempo correction button, one should 
keep an eye on the color in the BPM display. In the “unlocked” condition (red) the 
tapping is not in time with the music. One should tap until the “locked” condition is 
displayed. After a short time one hears if the result is correct via the metronome.  

Subsequently, offbeat correction takes place if required. If the detected quarter notes 
beats lie around the length of an eighth note (transferred behind the real positions of 
the quarter note beats), then one or more alternatives can be selected from the on 
beat/off beat correction list.  
 

Set the start of the bar 
Start bar correction takes place next. The beat at the start of the bar should coincide 
with the high sound of the metronome, or the red line in the wave form display. 

Correction is achieved in one step: If the start of the beat can be heard, then click on 
"Tap one" once, or press "T". Alternatively, you can also choose how many quarter 
notes the "One" is to be moved back by. 

If the start marker is set right before the first beat of a bar, then no correction is 
necessary. 

Hint: After every adjustment, the metronome and tick mark visualization reacts with 
a delay. 

 

Step 3: Use of the BPM and beat recognition 
With this last step you determine what is to be done with the material currently being 
analyzed. There are three possibilities:  

1. You want to generate remix objects from the song (the analyzed material), 

2. You want to bring your project tempo into line with the tempo of the song or vice 
versa, 

3. You initially only want to save the tempo and beat information in the audio file to 
edit them later. 
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Generating remix objects 
The song is cut up beat by beat into individual objects which can then be used and re-
edited in any required way in the VIP.  

Some usage examples: 

• Generate loops out of complete songs that you can use with your own material. 
• Remix songs, i.e. change the sequence of the remix object, cut and duplicate the 

individual parts or beats of the songs, or enhance the song with any other loops, 
samples, etc. 

Caution! The “Generate remix objects” option can only be selected if the remix agent 
was opened from a VIP. 

Audio quantizing: The new objects are fitted exactly into the beat grid of the 
arrangement. 

In the case of manually produced music there are always slight tempo fluctuations 
which result in different bar lengths. In order to ensure that the objects still fit into the 
rigid beat grid of the arrangement, the "Object timestretching" option is activated and 
used in such a way that the differences in lengths are corrected. 

For small corrections, use resampling. If the necessary corrections are very small, the 
higher-quality resampling technique can be used instead of timestretching.  

Note: If you decide to alter the tempo of your multi-track object later and to adjust 
the audio object in the VIP to the new tempo value, clearly audible pitch changes 
will appear in the remix. 

Remix objects in loop mode: The new objects are put into loop mode. When the 
objects are lengthened with the right-hand object mouse handle, the object will 
continue to be played at its original length. 

Setting arrangement tempo at object tempo: The arrangement (VIP) takes over the 
BPM value it has found. If you want to use the dissected song as the basis for a new 
composition (remixing), this option should be active.  

Note: the time correction is allocated to the objects by setting the object real-time 
timestretching and can therefore be corrected in the object editor. Conversely, 
timestretching settings that have already been set can be over-written. 

Grouping: The remix objects are grouped. 

Use crossfades: The remix objects are superimposed. The parameters of the 
superimposition can be set in the crossfade editor. 
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Exit: The dialog is closed without the changes being saved. 

Adjust tempo: This option offers you the possibility of adjusting the song tempo to 
your project speed or the project speed to your song tempo. 

Caution! The “Adjust tempo” option can only be selected if the remix agent has been 
opened from a VIP. 

Set object tempo to arrangement tempo: This adjusts the object length to the 
existing arrangement. Three different procedures are possible: 

Timestretching: The song's pitch remains constant, but under certain circumstances 
the sound quality may suffer.  

Resampling: Resampling changes the pitch, in the same way as changing the speed 
on a turntable, but significantly retains the sound quality of the song. 

Note: If you decide to alter the tempo of your multi-track object later and to adjust 
the audio object in the VIP to the new tempo value, clearly audible pitch changes 
will appear in the remix with objects edited with resampling. 

Audio quantizing: Audio quantizing calculates the tempo adjustments into the audio 
file. This is done in such a way as if initial remix objects (see below) were being 
produced and immediately compiled into a new audio file. If the recognition is 
uncertain, the result can include extreme tempo fluctuations. It is particularly 
important to set the start marker before calling up the remix agent in such a way that 
the tempo is recognized with certainty. 

The advantage of audio quantizing is that small tempo fluctuations are evened out in 
the music. The bar starts of the music always match the bar starts of the arrangement 
and therefore do not tend to wander away from one another. 

Set arrangement tempo at object tempo: The arrangement (VIP) takes over the BPM 
value it has found. If you want to use the dissected song as the basis for a new 
composition, as with remixing, this option should be active.   

Change global setting: The BPM value of the arrangements (VIP) is set at the 
calculated value. 

Adjust tempo map: From the position of the play cursor to the final position of the 
remix object, a tempo marker is set for each bar in the arrangement (VIP). 

Generate bar marker in the current range: This option enables markers to be set at 
start of each bar in the song (the positions of the lines marked in red in the wave form 
display). 
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Generate quaver markers in the current range: Select this option in order to set 
markers at the positions of the starts of the quaver-bars (the positions of all lines 
presented in the wave form display). 

One example of the use in both cases: 

Mixing two songs:  

1. First, adjust the project tempo to the song over which you intend to dub in the 
second song (“Set arrangement tempo to object tempo”, “Alter global 
setting”). 

2. Then, adjust the tempo of the second song to the project tempo (“Set object 
tempo to arrangement tempo”). 

3. Since the project tempo and the tempo of both songs now match exactly, it 
will be possible to fade from one song to the other without any problem. 
 

Save only tempo and beat information: If this option is selected the tempo and beat 
information is transferred to the audio file. The objects in the VIP and the VIP itself 
remain unchanged. 

Generate beat markers in the current range: With this option markers are set at the 
start of each bar in the song (the positions of the lines marked in red in the wave form 
display). 

Generate quaver markers in the current range: Select this option in order to set 
markers at the positions at the start of each quaver-bar (the positions of all the lines 
marked in red in the wave form display). 
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Harmony Agent 

 

The Harmony Agent is designed to analyze harmonies. 

The music track is analyzed first when you open the Harmony Agent. The Harmony 
Agent tries to automatically identify the harmonies for each quarter beat of the music. 
The correct beat information is an important prerequisite for a properly-functioning 
Harmony Agent. 

During subsequent playback, the detected harmony is played as a chord by an 
internal generator for verification purposes. You can adjust the volume with "Volume 
Generator". "Mute" deactivates the generator. 

The transport control controls playback of the music track. The position slider below 
lets you quickly move to a certain passage. 
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Check and correct the automatic harmony recognition 
After the analysis, you can manually correct harmonies which were not correctly 
identified. Note that major chords are written with capital letters and minor chords 
with lower-case letters. 

Left click on the respective harmony symbol in the wave display. Hold the key if you 
want to mark several subsequent harmonies. If you right click on selected harmony 
symbols, a menu containing alternatives will be displayed. The initially recognized 
harmony is marked with an *. 

If there are no alternatives available, you can select the correct "Keytone" or "Chord" 
from the menu in the "Correction" section. Use the option "Replace selected 
harmony in the entire song" if you are sure that the incorrectly recognized harmony is 
not included in the entire song. Usually, major and minor keys have been mixed up. 

Once you are sure that all harmonies are set correctly, click on "Continue". 
 

Use harmony recognition 
You can apply the information from the Harmony Agent here. There are different 
ways to output harmonies: 

• You can create VIP markers in the arrangement that display harmonies 
graphically in the video monitor as guitar tabs in sync to the music. 

• The information may be saved as an audio file. This also ensures that the 
harmonies are available later. For instance, if you'd like to display the harmony 
information in the time bar (Edit -> Show object marker -> Harmony marker). 

• You can choose between different displays of the harmony symbols. You can 
choose between German, English or Roman symbols to "name" the tones. 
Furthermore, you can set "Predraw" to force single harmony interpretation. "#" 
shows all notes as "sharps" (C#, D#, F#,...), and "b" displays them as flats. 
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Track settings 
Audio 
Output: Specifies the audio output device. This can either be a  bus (submix bus) in 
the audio studio mixer or a wave out device. This parameter can can adjusted in the 
VIP window, in the mixer, as well as in the track settings. 

Surround mode: Activates Surround mode. 

All tracks: Sets the current settings for all other tracks in the VIP. 

Track type: Displays whether the track is set to AUX send and/or a submix-bus. 

Color: The track color set here is displayed in the track editor as well as in the track 
box in front of the track name. If the track is a track folder, then the color will be used 
for the border and all tracks in this track folder. 

Audio recording options 

Audio device: Defines the audio recording device. This setting can be made in the VIP 
window, in the  mixer, or in the track settings. 

Recording file: Specifies the name for the recorded wave file. As a default, the 
following mask is applied: [VIP][tracknumber].wav. If you move tracks, then the track 
number in the file name will no longer match. 

Track name: Change the track names here as they are shown in the track box. 

Track recording options 

Stereo: Records a stereo wave file. 

Mono: Mono recording uses an input device for recording. 

Mono (Mix): Mono recording records a signal which mixes both input devices. 

Record in RAM only: This creates a RAM wave project. The difference from a HD 
wave project is that it opens a VIP in the computer's RAM. This enables a significantly 
better playback performance, but is only suitable for short recordings. 
 

MIDI 
Recording device: Set up the MIDI interface to be recorded. 

Playback device: Set up the MIDI interface on which the track's MIDI information will 
be output. 

All tracks: Applies the settings to every track. 
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Play/Thru parameters 

In Channel: If a MIDI channel is set here, then ONLY this will be used for recording. 

Out channel: If the MIDI object includes multiple MIDI channels, then you can use 
this option to filter out other MIDI channels than the one set. Only events for the 
MIDI channel set here will be output via the MIDI interface. 

Transp.: Transposes the played pitch in semitones up or down. Set the value here to 2 
and play C2, for example: D2 will be played or recorded. The value 12 transposes an 
entire octave up; -12 correspondingly transposes down. 

Program: Sets the MIDI program for the current track.  

Bank Hi (MSB):  According to MIDI specification, "Bank Hi" is required if a bank 
number should be addressed which exceeds the 7-bit MIDI range (0-127 or 1-128). 

Bank Lo (LSB): Enter a bank number. If it exceeds 127/128, remove 128 and enter 1 in 
the "Bank Hi"-field; if higher than 255/256 enter a 2, and so on. 

Note: If you need to switch banks and programs within a track, it's recommended 
that you set this in the MIDI object editor, and that you separate (view page 365) 
the objects at the corresponding positions. 

MIDI Thru active: The incoming signal is immediately forwarded to the set output 
device. 
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Managers 
A manager combines frequently required management and control functions within 
one window, such as for markers, tracks and CD tracks. This includes a file browser 
for finding, previewing and loading media files. 

Managers can be opened within the Docker, but can also be displayed as separate 
windows. Manager windows are multi-monitor enabled and save the last position 
when closing. Multiple managers in various different views can be opened 
simultaneously and independently of one another. 

You can open the Docker providing quick access to all managers and other windows 
via the "View > Managers/Docker (view page 435)" menu. You can also access 
individual managers via the "Managers..." submenu below. 
 

File manager 
Samplitude Music Studio 2013 contains a file browser in the manager where files can 
be previewed and loaded directly into projects. The browser can be used to create 
favorites folders and provides access to all recently opened folders. 

To view the file browser, click on the "Manager" button in the toolbar and then select 
the "File browser" tab at the bottom of the manager window. The file manager can 
also be opened via the menu (view page 435). 

Menu: Tools/Manager/File browser 

 
 

Navigation / Favorites 
The file manager works in a similar way to Windows Explorer; directories and files are 
displayed with directory and file symbols in list form. 

Navigation is achieved with the mouse or keyboard. A drive selection menu found in 
the toolbar lets you quickly switch between all data storage devices connected to the 
workstation. 

A display filter located in the toolbar lets you limit the display to certain media types, 
e.g. .wave, MIDI, or project files, only. "All media files" is the default display. 
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The "Search" option lets you search the current window for directories or files. Enter a 
search item into the input box and click “Enter”. Found directories or files are 
highlighted. You can find and highlight several entries that meet your search criterion 
by entering one or several first letters. 

The file browser opens as a tiled window by default. The right box hosts the favorites 
list, which you can fade out using the “Options” toolbar. Use “Add” or “Remove” to 
add and remove directories from the list of favorites. 

There is a combo box below the favorite list displaying the last used paths and which 
lets you change the current project directory. 
 

Preview audio files 
You can use the "Play" icon in the toolbar to preview a marked audio file, and every 
highlighted audio file is played immediately if the “Autoplay” box is checked. This way 
you can listen to a complete list using the cursor keys only. Clicking on the play button 
again stops continuous playback again. 

Hint: During playback the transport console controls are allocated to the media file. 
Playback and positioning functions are fully available. 

Playback is not routed through the mixer or internal effects. In contrast to the 
playback features of the “Load” window, which uses routines of the operating system, 
playback uses the audio device selected in the "Play" parameters (“P”), usually an 
MME, WDM, or ASIO device. If no playback occurs, first check that the settings and 
routing of this device is correct. 

Note: To preview certain media data, e.g. in WMA format, you have to convert 
these files to wave format. Conversion is done automatically in the background. 

 

Load files from the browser into projects 
Some media files can be inserted from the browser into an opened project at the 
desired time position via drag & drop. If the file browser list is in the foreground, 
pressing “Enter” has the same result. 

If an audio file is dragged from the clip list and dropped into an empty space or into 
the title bar of the program window, it is opened in wave editing mode. 

If several files are selected in the list, all files will be inserted at the current cursor 
position as new objects, and loading options ("Options") will be applied. This way you 
can specify whether all files should be inserted into the current project one after the 
other, one underneath the other, alphabetically, or according to their time stamp 
positions. The load option settings are valid also for files loaded via the load dialog of 
the program. 
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There are further options in the context menu of a media file (right click): 

• Load file 
• Delete file: Physically removes file from storage device. This process cannot be 

reversed! 
• Highlight all files 
• Open via standard link: The file is opened in the Windows application that is 

linked to this file type. This can be an MP3 player or some other wave editor. 
• Open in Windows™ Explorer: Opens the current directory as a new Windows 

Explorer™ window. 
 

Soundpool 
This setting can be used to access Soundpools. Access to the supplied Soundpools is 
via a new, more clearly laid out database overview that enables the display of loops, 
multiple styles and instrument categories, e.g. all bass loops of every installed style or 
every loop of a style. 

If you did not install the Soundpools on your hard drive during installation, then insert 
the Samplitude Music Studio 2013 installation DVD into the DVD drive. The contents 
of the Soundpools will now be imported into the database. Other Soundpool media 
are automatically recognized and added to the database. 

 

We recommend copying media to the hard drive 
and then importing it with "Add style". 

This menu provides several additional options for maintenance and display of your 
Soundpool database: 

Normally, loops can be previewed just by clicking them, even during project playback. 
If "Automatic playback" is deactivated, then use the playback button in the manager. 

The option "Hide instruments without available loops" completely hides instrument 
groups in the Soundpool manager for which there are no loops present in a certain 
style (instead of being grayed out). 

Every detected Soundpool (on CD/DVD or on the hard drive) is added to the 
database and displayed there, even if the corresponding medium is currently not in 
the drive or if the Soundpool has been deleted or moved. The option "Clean up 
Soundpool" removes these entries from the database. "Reset Soundpool" will reset 
the Soundpool database so you can re-import the Soundpools later. 

A Soundpool consists of one or more Styles. Styles are sound libraries that belong 
together and cover a certain musical style. The sounds (sample or MIDI loops) of one 
style all have a certain tempo. You can mix loops from different styles, and the 
tempos will be adjusted accordingly. Within a style, loops are ordered according to 
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instruments, and one instrument folder contains different sounds. Each sound can 
have a different pitch (except for drums and effects sounds). 

 

The Soundpool display consists of several columns: First, all styles available in the 
database are shown. The second column lists the instruments. The third column, 
"Name", contains the list of the sounds found. The respective name, tempo, length in 
bars (1, 2, or 4 beats), and type is listed for them. The different pitches are displayed 
above that (if available). 

The list of samples found is created based on the entry selection in the first two 
columns. With "Ctrl + click" you can reduce or expand selection. No selection ("Ctrl + 
click" on a single selected element) shows all entries from this category.  

If you select an instrument, e.g. "Drums" and "Percussion" and no style, then all drums 
and percussion samples in the whole database will be displayed. 

 
In the search field, you can search the list of the 
sounds found for a certain sound file name. 

There is one principle difference between the types of loops: While audio loops (.wav 
or .ogg) are normal (looped) audio objects that can be applied anywhere in the 
arranger, MIDI loops (MIDI takes) consist of MIDI data + the controlled synthesizer 
(Vita or Revolta). This is automatically loaded to the track where you place the MIDI 
loop. This means that you will need to use a new track for each additional MIDI loop 
which controls a different sound. However, the same loop in another pitch is possible. 

Loops can be loaded by double clicking, drag & drop, or by double clicking the 
corresponding pitch. The objects will be inserted directly behind one another so that 
complete accompanying tracks can be compiled quickly.  

Tip: If you want to search in multiple lists at the same time, open a new manager via 
"Tools -> Open new manager..." and switch to "Soundpool" in the new window. A 
separate search query can be set for each list. 
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Object manager 
The object manager integrated in the manager lists all objects contained in the 
current project and makes it possible to edit selected object parameters. 

To view the object manager, click the "Manager" button in the toolbar, and then select 
"Objects" at the bottom of the manager window. 

Menu: Tools -> Manager -> Object manager 

Keyboard shortcut:  Ctrl + Shift + O 

You can export object manager information as a text file. To do this, click the "Export 
text" button in the toolbar. The Windows™ text editor opens with an excerpt from the 
object manager list. The following information will be saved:  

• Project name and path 
• Track and object name 
• Start position in the project 
• Source file path 

Afterwards, you can find this file in the project folder (Projectname.txt). 

 
 

Object view and selection 
Objects are displayed in a tree structure and sorted according to tracks, whereby only 
tracks are listed that actually contain objects. As an option you can choose to display 
objects of the current tracks only (Toolbar: “Options”). 

You can use the +/- keys of the toolbar to open and close the track object display in 
the entire window. Click on the “+” symbol left of the track number to explode the 
view of a single track. 

Selecting objects: A square check box next to the object name lets you select single 
or multiple objects. These will then appear in the project window as “selected”. If an 
object is selected that is part of an object group, then the other objects of the 
selection are also selected in the project window and object manager. You can 
recognize grouped objects by the number of the object groups in the object manager 
group bar. 
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Search for objects: As in other manager windows, the object manager also provides a 
search option that allows you to search for objects in the current window. Enter a 
search item into the box and press “Return”. Found objects are highlighted, but are 
not selected in the project window. 
 

Deleting, renaming and editing objects 
You can delete objects directly in the object manager by selecting one or several 
objects simultaneously and pressing “Del”. Alternatively, you can delete an object via 
its context menu. 

You can rename objects by double clicking on the object name and entering a new 
name. The procedure of changing a marker position directly in the list is the same. 

To edit an object directly from the object manager, right click on the object you want 
to edit and start the object editor. 
 

Edit object parameters 
The following objects may be edited via the object editor: 

• Object start 
• Object length 
• Object end 
• Volume 
• Lock 

To edit a parameter, double click the respective entry and enter a different value. 
Numeric values may be changed via drag & drop, in which case "Ctrl + Shift" provides 
larger or smaller value changes. "Tab" moves to the next editable value. "Arrow 
up/down" navigates vertically within a text column. 
 

Track manager 
All tracks of the current project are displayed in the track manager and it enables 
direct access to solo, mute, and record. 

To view the track manager, click the "Manager" button in the toolbar, and then select 
the "Tracks" tab at the top of the manager window. 

Menu: Tools > Manager > Track manager 
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Track view and selection 
The track manager contains all of the current project's tracks. You can double click on 
the track number to select a track. The track will be displayed in the project window. If 
the track is outside of the visible display, the project window will scroll to this vertical 
position. 

Search for tracks: As in other manager windows the track manager also provides a 
search option that allows you to search for tracks in the current window. Enter a 
search item into the box and press “Return”. Found tracks are highlighted. 
 

Rename, delete, and insert tracks 
You can delete tracks via the manager by selecting one or several of these tracks and 
pressing “Del”. Alternatively, you can also use the context menu to delete a track. 

You can rename tracks by double clicking on the track names and entering a new 
name. The procedure of changing a marker position directly in the list is the same. 
“Tab” moves on to the next editable value. “Cursor up/down” navigates you vertically 
within a column if this is a text column. 

To edit an object directly from the object manager, right click on the object you want 
to edit and start the object manager. All functions are present in the same way as 
they would be if you opened the object manager from the project window. 

You can also insert new tracks directly in the track manager. Right click on a track 
entry and select “Insert track” from the context menu. A new track is added after the 
final track of the project. 
 

Marker manager 
The marker manager displays all markers contained in the current project, regardless 
of type and makes it possible to jump to them directly from the list or to play them. 

To view the marker manager, click the "Manager" button in the toolbar and then 
select the "Marker" tab at the top of the manager window. 

Menu: Tools -> Managers -> Marker manager 

 You can export marker manager information as a text file. To do this, 
click the "Export text" button in the toolbar. 

The Windows text editor opens with an excerpt from the marker manager list. The 
following information will be saved:  

• Project name 
• Marker type 
• Marker name 
• Marker position in project 
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You can find the file in the project file (Projectname.txt). 

 
 

Marker view and selection 
In the marker manager you can display all of the current project's markers. 

Searching for markers: As in other manager windows, the marker manager also 
provides a search option which allows you to search for markers in the current 
window. Enter a search item into the box and “Enter”. Found markers are highlighted. 
 

Jump to and play from marker position 
Double click on a marker in the type column to position a playback marker on a 
different marker position. 

Playing markers: Select a marker and click on the “Play marker” button in the toolbar. 
A range surrounding the selected marker is created and playback is started. 
 

Deleting markers, changing marker name, position, and type 
You can delete objects directly in the object manager by selecting one or several 
objects simultaneously and pressing “Del”, or you can also use the context menu to 
delete a track. 

You can rename markers by double clicking on the marker names and entering a new 
name, or you can use the context menu. The procedure for changing a marker 
position directly in the list is the same. Please use the same method to change a 
marker position directly from the list. “Tab” moves on to the next editable value. 
“Cursor up/down” navigates vertically within columns if these are name columns. 

Tip: You can change the type in the context menu of the respective marker anytime, 
e.g. if you want to change a position marker into a CD track marker. 
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Range manager 

 

The range manager represents all ranges contained in the current project and makes 
it possible to select them directly from the list.  

In order to display the range manager click on the “Manager” button in the toolbar 
and then select the “Ranges” tab on the bottom row of the manager window.  

Menu: "Tools -> Managers -> Range manager" 
 

Defining and search for ranges 
Defining ranges: To save a range in the manager, you first have to define a range in 
the project window. Next, click on the “Define new range” button in the toolbar of the 
range manager. 

Ranges that are saved using the program's “Save range” feature ("Alt + F2", "Alt + 
F3", etc.) appear in the list with "F2", "F3", etc., as indicators. 

Searching for ranges: As in other manager windows, the range manager also features 
a search option that lets you search for ranges in the current window. Enter a search 
item into the box and press “Enter”. Found ranges are highlighted. 
 

Edit range parameters 
You can edit the following parameters in the range manager: 

• Name 
• Start 
• Length 
• End 

To edit a parameter, double click on the respective entry and enter a different value. 
Numeric values can be changed by drag & drop, and "Ctrl + Shift" allows for larger or 
smaller value changes. “Tab” moves on to the next editable value. “Cursor up/down” 
navigates vertically within a column if these are name text boxes. 
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VSTi manager 
The VSTi manager enables easy display, inserting and deleting of VST, MAGIX, and 
Rewire instruments in the current project. If the instruments are opened, the single 
outputs to the assigned tracks are displayed. Right clicking on the selected instrument 
opens the plug-in dialog of the selected VSTi. Instrument outputs are routed in the 
VSTi manager in "Routing setup". Specify how the outputs should be routed in the 
dialog that appears. Either route all outputs to the current track or create new mono 
or stereo tracks for each output. Pressing the Del key removes a selected instrument 
completely from the project. If only individual output signals are selected, routing to a 
track is canceled by pressing the Del key. 

 

Detailed information about instrument routing settings and about managing single 
outputs can be found in the chapter "Software/VST instruments -> "Routing 
instruments" (view page 221). 

 

SMPTE Generator 

 

If you don't have any external MTC to SMPTE Converter for synchronization with 
analog equipment, this dialog allows you to create audio files containing SMPTE audio 
signals. Place the generated SMPTE signal onto an empty track and route its output to 
the SMPTE synch input of the analog recording device. 

You can choose from the following specifications as SMPTE frames per second: 24, 
25, 29.97, 29.97 drop frame, 30, 30 drop frame. 

The SMPTE start value can be entered in hours, minutes, seconds, and frames. 

You can specify the length in samples, milliseconds or SMPTE code. 

You can choose from the following sample rates: 44,1kHz and 48kHz. 
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Solo JamSession 
The Solo JamSession lets you create complete songs single-handedly. Begin with a 
simple idea, a small riff, or a chord progression. This is then recorded and put straight 
into an endless loop after the recording. 

Now, you can record a melody on a different track. The program simulates working 
with hardware "Looping delays", like, for example, the Gibson Echoplex. The 
difference is that Samplitude Music Studio 2013 creates an arrangement during 
"looping" which can later be edited and compiled into a complete song, because Solo 
JamSession records everything you do. 
 

Open 
•  Start Samplitude Music Studio 2013 and select "New Solo Jam Session" from the 

start selection or 
•  create a new arrangement. 

 

You can start your Solo Jam Session via the Menu (view page 
396) or the "Recording" button in the tab toolbar. 

Shortcut:  J 

Note: Solo JamSession simultaneously serves as a simple recording in the "Easy" 
workspace. Please read more on this in the quick start manual under "Recording" 
(view page 24). 

 
 

Operation 
If you cannot use a MIDI input device or joystick, you should control your Solo 
JamSession entirely via your keyboard.  

The spacebar (or the sustain pedal or joystick button) will trigger different actions 
depending on which mode you selected. 

If you are recording multiple tracks (up to 8 tracks are possible), you may mute 
individual tracks during the session using the keys 1-8. These actions are also 
recorded in the arrangement, so that a complex arrangement is created, even while 
recording. 
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By clicking on "Stop", playback/recording is stopped immediately. 
 

Modes 
There are different recording modes in the Solo JamSession. 
 

Normal 
All material is recorded in the same track. The recording restarts from the beginning 
each time the spacebar is pressed. Old audio material is overwritten. 

The aim of this mode is to record multiple takes at a certain section in the 
arrangement, which can then be interchanged easily in the Take Manager. 
 

Overdub 
New audio material is always placed in a new track. Each time the spacebar is 
pressed, a new track is created where the recording restarts from the beginning. 

The aim of this mode is to record objects one below the other in multiple tracks that 
can then be arranged freely. 
 

Loop recording 
This mode records in an endless loop; therefore, a range has to be selected first. 
Otherwise the total length of the arrangement is defined as the range. 

After each repetition, Samplitude Music Studio 2013 creates a new track in which the 
program records. The material that has already been recorded remains in tact, but is 
set to mute. 

The aim of this mode is to create multiple recordings in a set range, without listening 
to material of the same session that has already been recorded. 
 

Loop Overdub 
This mode records in an endless loop; therefore, a range has to be selected first. 
Otherwise the total length of the arrangement is defined as the range. 

After each repetition, Samplitude Music Studio 2013 creates a new track in which the 
program records. The material that has already been recorded remains in tact and is 
played back during recording of other tracks. 

The aim of this mode is to create multiple recordings in a set range, while 
simultaneously listening to material that has already been recorded. 
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Solo JamSession 
This mode largely corresponds to the behavior of the "old" Auto JamSession. The aim 
of this mode is to create an arrangement even while playing that can serve as a basis 
for a new song. 

By pressing the spacebar several times in a row, the following actions will be 
triggered: 

1. Playback begins. Nothing is recorded yet. 
2. The first recording starts. Record your first beat(s). As a sign that the program 

is recording, the action button turns red. 
3. The recording ends. The recorded section is then inserted into the 

arrangement as a loop and begins playing repeatedly. This serves as a grid for 
the next loops. 

4. The next recording starts. You'll continue to hear the previously recorded loop. 
Now you can add an additional voice to it. 

5. The recording ends, playback of the first and the newly recorded loop 
continues. 
 

The next times start and end other recordings (4 and 5 repeat each other). Every time 
the recording is restarted, it's recorded in a new track. All loops recorded up until now 
are played. 

Double-clicking on the record button stops the last loop recorded. Clicking three 
times ends all running loops. You can use it to separate various sections in the 
arrangement from one another. 
 

Accompaniment 
There are many ways to record a song: 

• Record everything by yourself. Here, the loop that was recorded first is set as a 
measure for the speed of the song in BPM (beats per minute). The buttons 1-8 
function as mute or solo buttons depending on their set modes (see below). 

• You can choose from one of the accompaniments provided. The tempo of the 
song will be determined by the template. 

 

Metronome 
The metronome is useful for users who might need some help, so they don't "lose the 
beat". 

You can select the tempo from the list. "--" means that the speed adapts to that of the 
first recorded loop or to that of the accompaniment (if selected). 
 

Practice speed 
Speed is divided in half or quartered if you activate this button. In the list box, you can 
select whether you want to play and record with 50% or 25%. 
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Monitor 
If the button is activated, the incoming signal is output immediately. 

"Sound FX" enables you to add extra effects to your material. The effects are applied 
to all tracks. 

Technically, these effects are on the track. Activation or deactivation of these effects 
is therefore not recorded. 
 

Options 
The following options are only available in "Solo JamSession" mode. 

Quantization guarantees that newly recorded loops fit into the existing arrangement 
by recording loops whose lengths are exactly multiple times that of the first recorded 
loop or that the loops begin or end on the bar or loop borders. 

There are multiple options for quantization: 

Quantize Length to next whole loop: The new loop is recorded with the same length 
or a whole-numbered multiple (2x, 3x, 4x...) of the original loop length. The loops 
always remain synchronous, but mustn't have the same starting point. This is the 
preset quantization mode. 

Quantize Start + length to next full loop: It's only after the next loop border that 
recording starts. The length is quantized like in "Length to next full loop". The starting 
points of the loops are all at the same time positions. 

Quantize Length to previous loop: The loop end is shortened to the last exceeded 
loop border. This is useful should you always only get around to clicking on the action 
button (spacebar) after the next loop when recording. 

Quantize Start + length to next bar (standard): The starting point of the recording 
and the loop length are adapted to the bar. This is useful if you have recorded the first 
loop over multiple bars. 

Quantize Start + length to the next beat: The starting point of the recording and the 
loop length adapt to quarter beats. This is useful if you want to record very short or 
uneven loops (for example, only ¾ bar). 

Note: The options "Start + length to next bar/beat" are only useful if the speed has 
been set (specified in "Metronome" or by the accompaniment). 

Freestyle: Quantization is deactivated. No more loop starts or lengths are adapted 
when recording. It's only recommended if you want to create chaos or are very 
"precise". 
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Mute/solo effects quantization: This option also quantizes the control of solo, mute, 
and other effects (double speed, half speed, reverse). 

Apply loop effects to last track only: The loop effects are always used on the last 
track only. 
 

MIDI / Joystick setup 
This menu entry opens the dialog "Edit keyboard shortcuts, Menu and Mouse" with 
the Solo JamSession page (view page 467). Here, you can also "learn" MIDI 
commands. 
 

Timestretch patcher 
This tool enables wave files used in Samplitude Music Studio 2013 and other MAGIX 
programs (e.g. MAGIX Music Maker) to be patched.  

Additional information and settings are written into the wave project to make them 
easier to find, thus ensuring better timestretching and pitchshifting results.  

The following can be patched: 

• Algorithms for timestretching/ pitchshifting 
• BPMs 
• Beat markers 
 

Overview 
Algorithms for timestretching / pitchshifting 
Different algorithms (besides the standard algorithm) can be used for real-time 
timestretching and/or pitchshifting for better results. Check 
resampling/timestretching/pitchshifting for more details. With the patcher you can 
store the optimal timestretching algorithm in the wave project. This ensures that the 
"correct" algorithm is used automatically when timestretching/pitchshifting is used 
on these projects as object effects (e.g. with the timestretch mouse mode).  
 

Beat markers 
Beat markers are also saved in the wave project when using beat marker-based 
algorithms. 

In contrast to the timestretching dialog, the patcher is non-modal, meaning that if the 
patcher is open, you can move beat markers in a wave project while checking out the 
timestretching result. 
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BPM value 
Patches the BPM value (beats per minute). This is useful for when the timestretching 
factor must be determined later in order to adapt the wave project to the tempo of an 
existing arrangement. 
 

Patches in brief 
Patches only work if you have opened the wave project in destructive wave editing 
mode and if it is not open in a VIP simultaneously. 

On the right of the dialog (patch) you can select the algorithm to be used and specify 
the wave file tempo. On the left side (test) is the control element from the 
timestretching/pitchshifting dialog. 

It allows you to test the selected algorithm in connection with the "Play/Stop" and 
"Play original" buttons. Patch saves the information in the wave file.  
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File menu 
The File menu contains broad functions for generating, managing, loading, and saving 
projects. 
 

New Virtual Project (VIP) 

 

A new virtual project is created and presented in a new window on the screen.  

New project 

Arranger view: Samplitude Music Studio 2013 opens a new virtual project in the 
normal arranger view. 

Multi-track recorder (MR-64): This opens the MR-64 for quick and easy recording. 
Please also read the chapter "Recording with the multi-track recorder". 

Open project: Opens a dialog for accessing virtual projects. 

Most recently opened projects: This is a list of the virtual projects that were recently 
opened; click a project to open it. 

Project settings 

Left clicking opens a dialog to view more options. 
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Project name: The name of the new VIP should be entered here. A subfolder with the 
name of the project is added automatically in the standard folder selected via the "file 
path". 

Target path: Select the folder where you want to save your project here. 

Project template: You can choose between previously saved project templates in this 
list field. They include all project settings such as track number, device assignment, 
etc. You can create new project templates with the command "File -> Save project as 
template". 

Sample rate: Presets the sample rate of the virtual project. 

Note: Regardless of the project sample rate, you can load objects with different 
sample rates, audio formats, and codings. 

Track number: The track number of the virtual project is defined here. With the 
"Track > Insert new tracks...", commands you can add tracks afterwards at any time. 

A right mouse click opens the dialog with the project options. All settings (e.g. to the 
grid, BPM, CD arrange mode, autosave, etc.) made here apply to every new VIP you 
create! They will be saved in a separate VIP (Templates\Template.VIP). This file, 
template.vip, can also be edited directly, and you can also use the following additional 
settings as a default for each project: 

• Record arming setting of the first track 
• Some mixer setup settings 
• Playback mode 
• Track and master effects settings (e.g. compressor mode, effects sequence) 
• Grid offsets. These can be very important for linking to the timecode. Samplitude 

Music Studio 2013 projects can include a timecode range of 12h. 

Don't show this window again: If this option is active, Samplitude Music Studio 2013 
will create a new project with the standard settings. This may be reset via program 
settings. 

Keyboard shortcut:  E 
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Open 
Here, many different file types can be opened and loaded into Samplitude Music 
Studio 2013. 

Shortcut:  Shift + L for HD wave projects 

Shortcut:  O for virtual projects 
 

Virtual project 
Virtual projects are multitrack projects in Samplitude Music Studio 2013 which make 
use of wave projects. When loading a virtual project, all associated wave projects 
(RAM and HD wave projects) are opened if they were not open prior to loading the 
VIP. The windows of the individual wave projects remain minimized to prevent 
cluttering of the screen. They are initially only visible as icons. 

Once the wave projects are loaded, the VIP project window is displayed. 
 

RAM wave project 
RAM wave projects contain audio data in Samplitude Music Studio 2013’s proprietary 
format. These files are loaded into the RAM memory of your computer, including their 
associated graphic files, marker position information, etc. 
 

HD wave project 
HD wave projects contain audio data which is directly loaded from the hard disk 
together with the graphical information, marker position information, etc. The audio 
format used for these files is the wave format. 
 

Object 
Contains playback instructions (link to a wave project, track, time position, 
parameters, etc.) for audio data. Objects are used in virtual projects. 
 

Session 
A previously saved Samplitude Music Studio 2013 session can be loaded with this 
command. All projects and their related windows are arranged on the screen the way 
they were saved to the session. 
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Load / Import 
Load audio file 
Open a dialog for loading audio files. You can also load multiple files simultaneously. 
Just like with Windows Explorer, you can extend your selection with "Ctrl" + click and 
select a series of files with "Shift + click". 

Note: Due to a particularity of Windows Explorer, the file selection dialog is 
structured from back to the front. Therefore, if you click, for example, Track 1, Track 
2, Track 3 (with Ctrl) one after the other, you will see "Track 3", "Track 2" and "Track 
1" in the input line and they will also be loaded in this sequence. So, if you would like 
to load multiple single titles, select them in the order that is reverse to sequence in 
which they should appear in the project. In order to select multiple files in the 
explorer (Shift + click), proceed as follows: first select the last title on the list, then 
press Shift and select the first title on the list. If you click "Open" now, all tracks will 
appear in the right order in the VIP. 

If a VIP is open, new objects will be created on the selected track, referencing the 
loaded audio objects. If no range is selected in the VIP, the files will be placed with a 
2-second pause after the last object; otherwise, they will be placed at the start of the 
range. The pause length can be changed in the CD/DVD menu in "Set automatic 
pause". 

Every audio file can be previewed before being loaded. 

Warning: The preview function uses the Windows multimedia system standard 
output system (as well as the system sounds). Many audio cards mute the standard 
Windows MME sound system when the ASIO driver is in use; in this case, an error 
message will be issued for the preview function. For this reason, the preview 
function is by default deactivated during ASIO driver use. However, you can 
reactivate it (options for loading an audio file when selecting the multimedia 
functions of a different audio device on your PC, such as the onboard sound 
available on al modern computers). 

Options 
The button at the bottom right in the dialog opens all options. 

Copy files to the project folder: The loaded files will be copied in the folder selected in 
project settings (view page 313). This comes handy, e. g. when loading data from 
external drives, memory cards or CDs/DVDs, since without this option the 
corresponding media has to connected or inserted. 
Additionally, it is useful to activate this option if you are using offline effects (view 
page 400), since otherwise the original file would be edited destructively. 
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Convert other file formats into wave: Compressed audio formats such as MP3 can be 
loaded and played in Samplitude Music Studio 2013 directly. This requires increased 
CPU calculation. Activate this option to convert files like this into an uncompressed 
wave format. 

Tip: It is much easier to search for, organize, preview and load files using the File 
manager (view page 297). 

Shortcut:  W 
 

Load MIDI file 
Load MIDI files via this item. In comparison to the "Load audio file" option, only MIDI 
files are displayed.  

Tip: Files can be searched for, organized, previewed, and loaded much easier using 
the File Manager (view page 297). 

 

Load audio CD track(s) 
This function allows import and writing of audio files using most CD/DVD ROM 
drives. Data import takes place completely digitally, without any sound loss. HD wave 
projects are created as wav files and can also be loaded in other audio programs 
without having to convert the format. 

To import audio tracks you should proceed as follows: 

1. Open the drive list dialog ("CD" > "Load audio CD track(s)"). A CD track list 
dialog appears. In case there is more than one drive, you can select the right 
one using the "CD drive options" button. 

2. Mark the desired title(s) (using the Shift/Alt and arrow key combination) in 
the track list. 

3. Click "Copy selected tracks..." 
4. Select a name of the wav file or the HD wave project being created and click 

on "Import". 
5. Audio material will be copied form the drive and a progress bar will display 

how the process is proceeding. 
6. Close the dialog. You will see the loaded titles in Samplitude Music Studio 

2013. 
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The track list dialog 
Copy selected track(s): This button starts audio copy. All selected tracks will be 
copied in a wav file or an HD wav project. 

Play: Starts audio playback of the first selected track in the list (as a test). 

Stop: Stops playback. 

Pause: Pauses playback By clicking the play button, playback can be continued. 

Select all tracks: All audio tracks will be selected, e. g. for copying the complete CD. 
Tracks markings can also be created using Shift and Alt and arrow keys. Multiple 
tracks can be selected by pressing "Ctrl + mouse click". 

Get CD info (freeDB): Compares the created CD to the freeDB data base and fills out 
metadata automatically. 

Drive and speed selection: Here you can see the name of the current drive and set 
read velocity. "Maximum" is the standard setting. If you notice read errors, gradually 
decrease writing speed. 

CD drive options: If you have more than one CD/DVD drive, you can set which you 
want to be displayed here. 

Write text file: Opens a TXT file with all information on the currently created CD. 

Auto crossfade mode: The auto crossfade mode is turned on during import of audio 
tracks. Crossfades will be automatically set between imported titles. 

Take over CD track markers: If this option is activated, track markers will be set at 
the start of imported tracks. 
 

Save 
The current project will be saved under the available name. If you have not yet 
specified a name for your project, a dialog will open wherein Samplitude Music Studio 
2013 asks you to do so. 

Shortcut:  Ctrl + S 
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Save project as 
You can define the path and name of the new project you want to save your work as. 
RAM projects and virtual projects will be saved with the new names (the source file 
remains untouched). HD wave projects are renamed on the hard disk. Samplitude 
Music Studio 2013 will not generate a copy of it for reasons of conserving space on 
your hard drive. 

Keys:  Shift + S 
 

Save project as template 
This option helps you create project templates that save all project-related settings, 
 e. g. grid type, track number, etc. , without the used objects and HDPs. You can load 
templates when creating new virtual projects ("File" > "New virtual project"). 
 

Save object 
Save your project. This file only contains real-time data (wave files, fades, names, 
etc.), and not the actual audio data. The wave project referenced by the object also 
has to be available if you want to reload the object. 
 

Save session 
Saves a complete Samplitude Music Studio 2013 session. if a session is saved with 
the name „startup.sam“, then it will automatically be loaded by Samplitude Music 
Studio 2013 the next time the program is started. 
 

Export 
Here, VIPs, HD wave or RAM wave projects can be exported to WAV, MP3, 
Windows Media Audio, FLAC, Ogg Vorbis, AIFF and AIFF formats. 

Note: The audio data from HD Wave projects can be further processed or imported 
directly as WAV files by other applications. The use of the "Export sample" function 
is only necessary when the data is to be copied. This increases the space required on 
disk; naturally, copying also requires time. 
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Wave 
Here you can export Wave files. 

Format settings: A dialog with a list of compression codecs appears. Select the codec 
and compression rate you require. 
 

MP3 
Exports the project as an MPEG Layer 3 with the included encoder. By clicking format 
settings, a window for setting encoder options opens. Here you can set export format, 
encoder quality, stereo coding, VBR (variable bit rate) options and labeling using the 
MP3 ID editor. 
 

Format settings 
Output format: Here you can set the output bitrate. Bit rate is the data stream during 
playback of audio or video data. It is given in kilobyte per second (kbit/s or kbps) and 
also determined the file size. An MP3 file that is 3 minutes long and has a constant bit 
rate of 128 kbit/s is ca. 2.8 MB in size. 

Common bit rates for music are 192 kBit for good quality, 256 kBit and more for 
excellent quality. For Internet streaming and speech recording (in mono), 128 kBit are 
enough. 

Encoder quality: The included MP3 encoder can be operated in three "Gears": An 
especially quick ("Fast"), an especially powerful for high sound quality ("Highest"), 
which however requires more time, and a compromise between the two. 

Format: Here you can set whether your MP3 file is exported in Stereo or Mono 
format. 

Variable bitrate: "Use VBR" adjusts the bitrate of the audio material, which means 
that a lower bitrate will be used during quieter parts. Therefore, VBR files are smaller 
than files of comparable quality without VBR. Instead of a constant bitrate there is a 
quality setting. Not all playback programs can process VBR correctly, some will result 
in problems during title length display or when rewinding. 

ID3 editor: Opens a dialog, where you can set ID3 meta data for files to be exported. 
 

Windows Media... 
Exports the project in Window Media Format. 

This format is an optimized audio/video format for the Internet from Microsoft™. This 
format also enables streaming playback of audio files over the Internet. Select a profile 
for the Windows Media file in the "format settings" dialog. Enter the track and artist 
names, copyright details, and descriptions. 
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FLAC 
FLAC is the abbreviation for "Free Lossless Audio Codec". This is a freely savable 
format that can be used to compress your audio data to 50% of their original size. 
Unlike lossy compression methods like MP3 or OGG, the full sound quality is kept 
intact with FLAC. 
 

OGG Vorbis... 
Exports the project in OGG Vorbis format. 

The "Format settings" button opens an additional dialog to select the desired bit rate. 
The scale of compression ranges from 46 kBit/s to 500 kBit/s (for MP3 from 32 
kBit/s to 320 kBit/s). In the stereo options, choose between "Stereo" and "Mono" and 
also select the "Variable bit rate" mode. 
 

AIFF... 
The project will be exported in AIFF format. In the advanced dialog, select the bit 
resolution, stereo format, sample rate, and quality level of sample rate adjustments. 
 

AIFF with Quicktime 
Exports the project in AIFF format. Here, Quicktime is used as the encoder. This 
format also enables streaming playback of audio and video files over the Internet. 

This function requires installed Quicktime on your PC. 

The following export options are available: Format (Linear PCM, IMA 4:1, Quallcomm 
PureVoice), channels (mono, stereo, quadrophonic,5.0, 5.1, 6.0, 6.1, 7.0, 7.1, 8.0), 
sample rate, render settings quality as well as linear PCM settings in file format 8, 16, 
24, 32 and 64-bit. 
 

Convert audio 
Stereo wave -> Mono 
A stereo wave project is copied and converted into a left mono wave project and a 
right mono wave project . 
 

2 mono -> Stereo / LR wave 
Two mono projects are linked to one L&R wave project. This is a convenient way of 
editing joined mono samples with the same operations. 

Here you can connect two mono wave projects to one L&R wave project. You can 
then perform common operations and apply them to all samples. 

After applying the command you will be prompted to activate the second mono wave 
project that you want to connect to the active mono wave project. To do this, click on 
the title bar of the corresponding window. Please note that only mono projects can be 
linked to mono wave projects of the same bit and sample rate. The lengths of both 
projects are adapted to each other. 
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L&R wave > 2 mono 
L& R wave projects can be split into two independent mono projects using this 
function. This way you can break the fixed connection of the samples to one another 
and edit them individually. If you wish to edit them together again, then select the "2 
mono -> L&R wave" function. 
 

LR wave > 1 mono 
The current L&R wave project is converted into a mono mode. If it was a stereo 
project before, then both channels will be mixed. The previous samples are first added 
with 100% of their image and then divided by two to prevent overmodulation 
(distortion). This is equivalent to reducing the volume by 6 dB. 
 

1 mono > LR wave 
The original mono wave project is duplicated and converted into a single L&R wave 
project with the same sample in both channels.  
 

2 mono -> LR wave 
Here you can connect two mono wave projects to one L&R wave project. You can 
then perform common operations and apply them to all samples. 

After applying the command you will be prompted to activate the second mono wave 
project that you want to connect to the active mono wave project. To do this, click on 
the title bar of the corresponding window. Please note that only mono projects can be 
linked to mono wave projects of the same bit and sample rate. The lengths of both 
projects are adapted to each other. 
 

Save in format 
Use this function to convert wave projects between the various Samplitude Music 
Studio 2013 formats for wave projects. 

This can be useful if you want to convert RAM wave projects to HD wave projects, or 
L&R wave projects (2 connected mono samples) into stereo wave projects. 
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Export MIDI File... 

 

The particular file format may also be specified when exporting a MIDI file. One track 
corresponds to format 0, multiple tracks to format 1. In addition, the tempo map may 
also be exported, in which case the support point count per beat for tempo runs can 
be selected freely. 

The standard MIDI file (SMF) export always takes place in the current VIP-PPQ 
resolution. The markers are also exported. 
 

Internet 
Catooh - the Online Content Library 
Find media and download in the arrangement... 
Opens Catooh and loads your files directly into the arrangement. 

Shortcut:  O 
 

Import media backup 
iContent (for example, 3D transitions) which you buy and download from Catooh is 
stored directly in your central My files\MAGIX Downloads\Backup directory. If you 
have downloaded these files from other MAGIX programs, then you can use the 
command "Import media backup" to make them accessible for use in Samplitude 
Music Studio 2013. 
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MAGIX Online Album 
MAGIX Online Album lets you publish your photos and videos directly on the 
Internet. You can also play your music as MP3s in the Online Album. Create your 
personal album website in no time with your own Internet address, and showcase 
everything that's fun about multimedia to the world. 

For example, you can upload especially impressive photos or entire slideshows as 
videos straight from your MAGIX program. Pictures you put on your website can be 
downloaded with ease from the comfort of your own home and integrated into your 
slideshow. 
 

Upload current project as MP3 
Converts your project into an MP3 file and uploads it to your personal MAGIX Online 
Album. 
 

Open my online album... 
This command opens your own MAGIX Online website. You must login and enter the 
page's Internet address (URL) to continue.  
 

MAGIX Website Maker 
Not only is Internet surfing easy! Thanks to MAGIX Website Maker creating websites 
also becomes child's play! 

This service offers: 

• Your desired domain (www.desiredname.com) and a subdomain  (http://your-
name.magix.net/website). 

• 250 MB memory space with 5 email accounts, 1 GB each. 
• Website Maker with website templates, intros. Also animations, text effects, 

form and design objects, picture and graphic templates, and buttons. And 
everything without any ad banners! 

• Photo (*.jpeg), video (*.wmv) & music (*.mp3) options. 
• Additional software: MAGIX web mail for managing your email inbox.  

MAGIX Website Maker offers 3 months of free, non-binding service. This way, you 
have enough time to find out everything about MAGIX Website Maker and all 
existing possibilities for editing and managing your homepage. 

MAGIX Website Maker offers everything for the perfect Flash website: 

• Design templates: Numerous high-quality website templates in the latest 
professional Flash® design with pre-finished, customizable subpages, start pages, 
profile pages, photo pages, video pages, and much more.  

• Text & text effects: Freely positionable text fields with fantastic fonts and 
animated text effects can be added and individually formatted with ease.  
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• Multimedia content: Select your favorite photos, spectacular slideshows, videos 
and an online video player with your own background music, or integrate it all as 
an online music player with playlists. 

• Decorative elements: Attractive design objects, plenty of vector shapes, 
background images, buttons, and much more offer more possibilities for 
designing unique websites than ever. 

• Animation objects: Large selection of dynamic, impressive animation objects for 
breathtaking, moving websites. 

• Links: Easily add links to your own or external websites.  
• Top extras: Enhance your website with a visitor counter, guest book, contact 

form, and many other useful extras. 
Export function: Conveniently add individual components of your website (e.g. 
video player, slideshow, online music player) or even the entire website to 
external sites as an embedded website. 

Proceed as follows: 

After registering your desired domain, you can start creating your website right away. 

1. First, select a design for your website in MAGIX Website Maker 
2. If you would like to place an intro (start animation) at the start of your domain, 

select your intro as a next step. 
3. Now you can replace the mock text with your own text as you see fit. All free-

standing elements on all webpages can also be moved as you please. To do so, 
click to select the element and move it using your mouse. 

4. Once everything is just how you want it, you can put your page online, so that 
your domain can be accessed.  
 

 

Online login details 
Manage login details 
These are options for managing user names (email addresses) and the associated 
passwords so that you are able to access your Online Services without having to enter 
the details each time. 

This information applies to all of my Online Services: If this option is activated, then 
the account details you have entered will be applied to all Online Services. Deactivate 
this option if you have different details for individual services, then choose the 
corresponding service via "Select service and enter the associated login details.  
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Trackbouncing (internal mixdown) 
This command can be applied to compile a project, a sought range or selected objects 
and tracks of a virtual multi-track project (VIP) into one audio file and save it under a 
new name. All real-time editing (cuts, crossfades, mixer settings including mixer 
effects and plug-ins, volume and panorama curves, real-time effects in the object 
editor, etc.) can be integrated into the new project. 

 

Normalize your project before bouncing using the master normalization function in 
the mixer ("N" button) in order to get a precisely calibrated file. All settings in this 
dialog can be saved as presets at any time. 
 

Track bouncing settings: source 
Routing: 

In this field you determine the outputs to be written to the file. 

Only master: The master output of the mixer is written to a file. This is the standard 
for all exporting processes. 

All outputs: All tracks that are not muted will be mixed down together, independent 
of their routing. Suitable for bouncing at object level. 

Field: 

Only selected range: Here track bouncing will be conducted only over the length of 
the range selected in the arranger. 

From project start to the last object: The bounce process includes all objects from 
project start until the end of the last object, including reverberations. 

Complete project: If you select this option, the complete virtual project will be 
bounced. 
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Track Bouncing Settings: Generate 
Create new wave file: The selected range or the virtual project (VIP) creates a new 
wave file. 

Open new wave project: The selected range/virtual project (VIP) is converted into an 
wave project. 

Create new object in VIP: The bounced objects are inserted as new objects in a new 
track in the existing VIP. 

Replace objects in VIP: The objects used in trackbouncing are removed and the result 
is inserted into the selected track. 

Create new VIP: A new virtual project (VIP) will open. The bounced audio material is 
inserted into the first track of the created project. 
 

Trackbouncing criteria: Format 
The target format may be set flexibly. Wave and AIFF files in 16/24-bit mono/stereo 
at 4 variable sample rates are supported, as are MP3, Ogg Vorbis, and FLAC files at 
variable sample and bit rates. For wave files, you can select special codecs such as 
ADPCM by clicking the "Format settings..." button. For other formats such as MP3, 
you will find there further format settings (view page 320). 

• The format setting "Stereo" creates a file that contains the stereo information as 
an "Interleaved file". 

• The format setting "Left & right" may be used to create two files, i.e. "Filename_L" 
and "Filename_R", which provide separate information about the left and right 
channels. 

• The format setting "Left channel only" monitors and outputs the left channel only. 
• The format setting "Right channel only" monitors and outputs the right channel 

only. 
• The format setting "Mono mixdown" calculates the left and right channels 

together according to the formula "(L+R)/2" and then outputs these. 
• The format setting "Mono" is especially useful for hard left or right tracks, since it 

bounces these at the same level. Mono is formed according to the formula "L+R". 
If panorama is set in the middle in the format settings, the trackbouncing process 
will automatically result in a level reduction of 6 dB per channel (panning law -6 
dB). This will ensure that even centered mono signals are not bounced at a too 
high level, but at the original level. 

Note: All files created as a result of trackbouncing are opened in Samplitude Music 
Studio 2013. 

You cannot bounce to the same project twice in succession. You have to close it 
first. If you bounce often and do not require any special mastering options, you can 
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work more effectively by using the "File > Export" command instead of the 
trackbouncing dialog. 

All formats that cannot be directly opened by Samplitude Music Studio 2013 cannot 
be created in the trackbouncing dialog. For bouncing into the WMA format, use 
"Menu File" > "Export" as well. 

 

Trackbouncing settings: Options 
Exclude master effects from bouncing: Master effects are not included during 
bouncing. 

This option is important in combination with the "Create" functions "Create new 
object" and "Replace object(s)". This is set automatically when selecting these 
options so that the master effects are not applied twice. 

Calculate maximum amplitude: Display the maximum volume in dB after bouncing in 
order to correctly set equipment for additional editing or to correct the master level. 
Once bouncing has been completed, the corresponding information window will be 
displayed. 
 

Range trackbouncing 
Use this function to convert the objects within the currently selected range to a new 
WAV file or a HD Wave project. The objects are then replaced in the Arranger. This is 
useful if you wish to combine multiple objects into a single object which can then be 
further edited easily. 

To create performance room, you can render object effects using the range 
trackbouncing feature. 

MIDI bouncing 
In another prompt you can choose whether you want to mix the entire project with all 
MIDI objects or just the selected MIDI objects within the current area into one single 
MIDI object. In this case, the MIDI track and object effects like timestretching, track 
MIDI transpose, program change, etc. are bounced into the resulting MIDI object. 
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Note: Don't confuse MIDI bouncing with the "MIDI object freeze (Object -> Object 
freeze)" function, which replaces the MIDI objects with audio objects in the 
software instrument's audio return signal. 

 

Rename project 
The “Rename project” command allows you to rename a project file rather than save 
it to a different file. For RAM wave projects, only the internal names are changed 
(without being saved), but all corresponding files are renamed immediately in the 
case of HD wave projects. 

RAM wave projects need to be saved after the project is renamed. 
 

Clean up 
Delete virtual projects 
With the "Delete virtual projects" command you can comfortably delete VIPs and all 
wave projects used in the VIP. All files which belong to a multitrack project (the wave 
file containing the audio files, files with the graphics data, and the HDP file with the 
project information) will be lost. 

Warning: There will be no further security query. The data will be deleted immediately 
after pressing "OK". 
 

Save complete VIP in 
This function in menu “Project” allows saving a VIP with all needed wave projects 
(*.RAP., *.HDP) into a specified directory. This makes it easy to copy all files of a VIP 
to a backup disk, etc. 
 

Burn project backup onto CD/DVD 
With this menu you are in the position to burn a complete project backup to a data 
CD, including all used data. The Samplitude Music Studio 2013 burning program is 
opened for this. 
 

Delete HD wave project 
HD wave projects are deleted from the hard disk. Use this command cautiously, since 
all corresponding files are lost. 

If you wanted to delete a HD wave project (HDP) from a file manager (e.g. Windows 
Explorer), then it would also be necessary to delete the graphic files related to the 
project files. 
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Delete Unused Samples 
This function lets you edit all wave projects belonging to the current virtual project in 
such a way that all ranges that aren't used are deleted. It basically deals with the part 
of the audio data to which the objects in the arranger do not refer and don't get played 
at any point. The objects in the virtual project are customized automatically so that 
nothing changes in the arranger view. 

This function deletes physical data and does not feature an "Undo" option. You should 
therefore apply this command carefully. 

If multiple virtual projects refer to the same wave files, all of these projects should be 
open as well. This is the only way to monitor and prevent data loss. 

Using the "Remove unused samples" function saves storage space, but corrections to 
the objects' lengths are limited, since all audio data outside the object borders are 
removed. For this reason, specify backup reserves with "Save additional samples for 
each object". This number of samples is left in front and behind the object borders in 
the audio material. The default value is 22,050 samples, which corresponds to 500 
ms at a 44,100 kHz sample rate. 

The dialog lists all of the wave projects used in the virtual project. You can see the 
total memory space used by the wave projects in the "Size" column here, and beside 
this the free space in the "Unused" column. In the "Edit" column, you'll find a check 
box for each file that may be used to add files to the process. Only those files that 
contain unused sections of audio data are selected. To keep these, remove the check. 

Note: The list may also contain files not actually referenced by the VIP, but 
referenced by the VIP's undo chain. These files are 100% unused samples and will 
be deleted completely when checked. 

For example, if you have discarded an entire recording session, you can delete the 
unused files as well. However, if you had opened audio material from other sessions 
or your private sample library and didn't use them any more after that, you should 
uncheck these files so that they don't get deleted. 

We recommend deleting the "Undo" chain and closing all unused wave projects 
before using the function. 

Tip: If the relevant audio files are required later on for additional production work, 
the following procedure is recommended for archiving the finished production: 

Save your entire project in a new folder ("File -> Save complete VIP in...").  In the 
save dialog, select the command "Copy only samples used in VIP". Now only those 
audio files/samples that are actually required by your archiving project will be found 
in the few folder. You can now save the content of this folder to a backup medium 
(e.g. CD-ROM or DVD). 
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Delete Freeze Data 
Use this function to delete unused data that was created when freezing but is no 
longer needed after "unfreezing". 
 

Close project 
Closes the arrangement. 
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Project properties 
Snap and Grid Setup 
In the general project options dialog you can choose the kind of grid and its activation. 

Shortcut: I 

Virtual projects have an object grid, area grid, beat grid, and frame grid. In the object 
grid, the objects may only be moved to the start, end or the hotspot ("Object -> Set 
hotspot/delete hotspot"). The reference point is normally the front edge of the object 
that is to be moved. As soon as a hotspot has been defined for the object, this is what 
will be used. If several objects are selected, alignment takes place at the forward edge 
of the hotspot of the object that was selected last, and is currently located under the 
mouse cursor. The intervals between the selected projects stay constant. 

 

Grid:  Checking the tick box turns snap on globally. 

Object grid:  This option activates the object grid. This lets objects snap exactly to the 
edges of other objects. 

Snap to range: Activates the range grid with the option to use the current range as 
the basis for snapping. 

Grid/bars: Activates a grid with bars as the basis. The objects snap to the the next 
beat grid. 

Grid/bars (Relative):  Activates a grid with bars as the basis. This means that the 
relative distances between the objects adhere to the beat grid when you move them 
about. 

Grid/frames:  Activates the frame-based grid. 
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Snap offset to project start: Here the snap offset can be set relative to the beginning 
of the project. "Use current position for offset" specifies the current position as the 
grid's zero position. 

Use snap offset also for grid:  The snap offset is used as a reference size for the grid. 
 

Mixer setup 
Here you can open the mixer setup (view page 477) dialog. Use this to set the 
number of tracks, AUX buses and submix buses as well as the routing presets for the 
most frequent use cases. 
 

Playback options 
The play parameters window which appears after selecting this menu option is 
designed to quickly enter playback parameters. 

 

Sample rate: The sample rate can be changed here as long as the sound card 
supports the new rate (some sound cards even support changing the rate while 
playing the sample). This is especially useful for hearing notes in a sample range 
played in a different octave. When selecting half the sample rate, the pitch should be 
the same. It would be played one octave lower. 

Device: Use this dialog box to specify the sound card's driver. This is necessary if 
playback takes place through a single sound card device, and is especially important if 
multiple output devices are located in the computer. 

Autoscroll: This you to activate the "Autoscroll" feature. This is especially useful 
when working with large disk files. The HD wave project window will follow the play 
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cursor during playback. When working in “2” or “3” section display mode, the 
autoscroll feature causes the individual sections to follow the play cursor as well. If 
you have zoomed into one of the sections, the play cursor will move through the 
section faster, resulting in more screen re-draws. 

You can choose between page and soft scrolling, but be careful: Scrolling requires 
CPU power (depending on the processor, graphics adaptor, and resolution), and the 
CPU may be overloaded in critical situations which may result in playback dropouts. 
Deactivate autoscroll mode if this happens. 

Scrubbing: If you "Insert" ("Insert", or "0" on the number pad), Samplitude Music 
Studio 2013 will switch to "Scrubbing" mode, and playback speed can be controlled 
directly by the mouse. The further to the right the mouse goes, the faster Samplitude 
Music Studio 2013 plays. 

In comparison to many HD recording systems, this even works in a virtual multitrack 
project. 

Use scrubbing mode to find passages, crackling, etc. in material. The older generation 
of sound engineers are, no doubt, very familiar with this method from analog tape 
editing. 

There are two scrubbing modes ("P"): 

Relative: The relative distance between the play cursor (positions bar) and the mouse 
position can be used to control the speed. The play cursor follows the movement of 
the mouse. 

Absolute: You can also use the absolute position of the mouse in the window to 
control the speed: 

Left border = Double speed backwards 

Center = No movement 

Right border = Double speed forwards 

Tip for scrubbing: For buffer sizes (4000, 2000 samples) scrolling is "softer".  Test if 
your computer functions at this buffer size without any playback errors. 

Combined with "Soft scroll", editing becomes very convenient on faster computers. 
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Project Auto Save… 
The Autosave dialog is available via the project options.  

 

This dialog provides options for creating backups of projects. The button View backup 
project opens the selected backup in the arranger.  

The button Restore backup status restores the project to the status of the backup. If 
the current project was changed previously and not saved, then the last status may be 
saved with the extension _OLD.vip. 

Autosave Mode 
Autosave mode may be activated with the corresponding check box. Select from the 
following options: 

Save to original: Overwrites the original file in specific intervals with the current 
status. If the option Save in subfolder is selected, the previous status, i.e. the pre-
previous status will also be updated in the Backup subfolder. 

Add backup file (*bak.VIP): Adds a backup file and updates this at specific intervals. 
If the option "Save in subfolder is selected, the backup file will be updated in the 
Backup subfolder each time it is saved. 

Max. 10 backup files (*bak0.VIP until *bak9.VIP): Specify save intervals for up to 10 
backup files and number them. If the option "Save in subfolder is selected", the 
backup files will be updated in the Backup subfolder each time they are saved. After 
10 backup processes, the final backup file will receive the extension *bak9.VIP, the 
oldest backup file will be deleted, and the others will move downwards in the 
sequence. 
 

Project information 
A simple text editor can be used to enter comments for the current project. This text 
can be displayed every time the project is opened so that important information about 
project can be preserved together with the audio material. 
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Project status 
This dialog displays various, project specific information such as name, path, the 
number of ranges as well as marker changes, and time of creation, number of objects 
count and file size. 

You will also find a list of all audio files used in the project. 

Keyboard shortcut:  Alt + I 
 

CD arrange mode 
If you activate this menu feature, Samplitude Music Studio 2013 will arrange the next 
objects introducing a Red Book-standard pause between them.  

The following procedure highly recommended: 

• Open a new VIP with 4 tracks (for example), so that you may reedit it later on 
• Activate the "Special CD arrange" mode in the CD menu 
• Load wave files, audio tracks, or make a recording using the microphone 

You will notice gaps in the VIP between the individual objects; these represent the 
inserted breaks. You can adjust the length of the included pauses in the adjust pause 
length dialog, if you want. 
 

Destructive wave edit mode 
Wave projects can be edited destructively as well as virtually. Please also read the 
corresponding descriptions in the first chapter of the handbook. You can select the 
desired editing method from the list. 
 

Program Preferences 
System / Audio 
This menu item opens the system/options (view page 449) dialog where most 
general project settings can be made for Samplitude Music Studio 2013. 

Keyboard shortcut: Y 
 

Varispeed and Scrub Settings 
This dialog enables tempo changes for virtual project playback to be made. Right click 
the scrub control button in the transport controls. 

Sample rate: The preset project sample rate is displayed here. To change this value, a 
request window will appear to adapt all audio objects to the new sample rate as 
needed. This adjustment may also be made by moving or resampling the audio 
material. MIDI objects may also be adapted to the new sample rate. These may also 
be moved, but the musical position will remain the same. 
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Autoscroll/scrubbing: See "Playback parameters". 

Stop at position: This stops the play cursor at the current position when the "Stop" 
button is pressed and doesn't jump back to the original position. 

Device: Specifies the driver of the sound card for playback. 

Active: Checking this box activates Varipitch/Varispeed. 

Varipitch/Varispeed mode 
Vertical slider: This controller defines the playback from -200% to +200%, in which 
case negative values cause the project to play in reverse. 

Pitch: Double clicking this field enables the speed factor to be input directly, e.g. 0.5 
for half speed, 2.0 for double speed. 

Halftones: This field specifies pitch changes according to semitones; a value of -12  
causes the project to play an octave lower at half speed, and a value of +12 plays back 
the project one octave higher at double speed. 

Internal rate: This specifies the sample rate for Varispeed calculation. At a sample 
rate of 44,100 kHz, a value of 22,050 plays the project an octave lower at half the 
speed. 

BPM orig: Displays the original speed in BPM. 

BPM out: Enter the target speed in BPM. Samplitude Music Studio 2013 calculates the 
varispeed pitch factor from the quotient from the target to the original tempo. 
 

MIDI settings 
Here you can specify which MIDI devices (view page 453) to use in Samplitude 
Music Studio 2013. 
 

Synchronization 
Opens the synchronisation dialog (view page 276). Here you can specify whether 
Samplitude Music Studio 2013 should operate as master or slave, which protocol to 
use, and which interface should be used to send or receive synchronization data. 
 

Editing keyboard shortcuts and menus 
Here you can open the dialog for Editing keyboard shortcuts, menu entries and mouse 
functions (view page 465). 
 

Edit toolbars 
With this command you open the tool bar editor for the according toolbar. The same 
function can be called by right clicking on the tool bar. All tool bars are customizable. 
You can customize any toolbar by adding or removing any command, which is 
available as a toolbar icon.  
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Inside the toolbar editor there is a context-sensitive popup help dialog. 
 

Reset toolbars 
This menu lets you reset several toolbars. 
 

Video height 
Here you can set the height of the displayed video. 
 

Font selection 
Samplitude Music Studio 2013 will also let you specify the font used for text display in 
the various objects. 
 

Font for time display 
This option lets you select the display font for the time display (Menu "Window" > 
"Time display"). 
 

Metronome settings 
This menu item opens the metronome settings (view page 459). 
 

Display mode 
Please read the explanations in the "View" menu. 
 

Color setup 
Here you can adjust the foreground and background color for displaying samples in 
wave projects, the colors of the volume and panorama curve, the grid, the 
oscillograph and the time display. 
 

Color selector 
The standard Windows color selector has its own integrated online help which can be 
accessed with "F1" or "?" in the dialog. 

In addition to the mentioned function attributes, the sets of the user-defined colors 
can be saved onto a file and reloaded again. 

Right click in the color selector dialog to access a menu with all the saved user-
defined color palettes. With "Current user-defined save as..." you can save the current 
palette onto a new file which will then appear under "Color palettes" in the menu. 
 

Undo settings 
This menu opens the basic "Undo" function settings (view page 463). 
 

Object lock definitions... 
Here you can select which functions should not be permitted by locking the objects. 
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The choice consists of: 

Moving: The objects cannot be moved unintentionally (default). This is especially 
useful for multi-track recordings to prevent inadvertent offset between each track 
from the beginning. 

Volume changes: Deactivates the volume handles of the objects. 
 

Destructive Effect Calculation… 
Choose in the advanced destructive effects calculation options if you want to add the 
effect to the original file when editing destructively, write it into the effect file, or 
create a new effect file for each calculation. 
 

Exit 
Closes Samplitude Music Studio 2013. 
 

Recently opened files 
This feature provides a selection of recently opened projects. 
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Edit Menu 
This menu features functions that are applicable only to wave projects ("Edit -> More 
-> Copy to"), and others are only for virtual projects ("Cut silence"). 

Edit functions like "Extract" require range to be selected; other functions like "Copy" 
are available only for active objects. The start and end points of the selected range 
determine the start and end points of a cut, and the vertical position indicates the 
tracks that are affected by the edit. 

Activate the auto crossfade function and all the newly created fade edges will 
automatically be made soft or disappear. 
 

Undo 
Samplitude Music Studio 2013 offers comfortable undo options for VIP -objects. The 
maximum number of undo steps is 100. The actual number can be entered in the 
"File" > "Program settings" > "Undo settings". 

Shortcut:  Ctrl + Z 
 

Redo 
Redo repeats the undo step which took place immediately before. 

Shortcut:  Ctrl + Y 
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Undo List 

 

A list with the last undo commands will open. 

You can return to any work stage. 
 

Mouse mode 
Here you can find available mouse modes You can find detailed information in 
"Mouse functions and mouse modes" (view page 88). 

Note: Not all mouse modes are available in Wave projects. 
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Object mode 

Copy 
Copy 
The current range is copied into the clip, but is not deleted from the project. The 
sample or track length remains unchanged. Please note that any previous clip 
contents are deleted. The properties of the project will be applied to the clip. 

Shortcuts: C 
 Ctrl + C  
 Ctrl + Ins 
 

Copy as… (Wave-Project) 
This function copies the selected range from a wave project  into a new file. 

Shortcut:  Shift + C 
 

More > Copy and silence 
Copies the current range to the clipboard (clip), removes it from the project, and 
replaces it with silence. 

Shortcut:  Ctrl + Alt + C 
 

Cut 
Cut 
Wave projects 
The audio data in the selected range are copied from the current wave project into the 
clip. The material behind the removed range is merged with the material in front of 
the removed range to close the gap. The complete wave project becomes shorter. 

Please keep in mind that the clip always contains the same attributes as the wave 
project the material was copied or removed from. 

If you cut material from a mono wave project, the clip becomes a mono wave project. 
If material from a stereo wave project is cut or copied to the clip, the clip becomes a 
stereo wave project. Another attribute adopted is the bit resolution and the sample 
rate of the originating wave project.  

The previous contents of the clip are deleted. 

After a successful removal of the selected material, Samplitude Music Studio 2013 
drops a marker at the position the removed range previously started. This allows you 
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to insert the contents of the clip into the wave project at the exact same spot if you 
accidentally removed the material. Use the function "Edit -> Paste/Insert clip" to 
insert the clip contents. 
 

Virtual projects (VIP) 
In virtual projects the selected range is copied to the VirtClip and is removed from the 
current VIP. The VirtClip does not contain actual audio information, only the links to 
the audio files. The VirtClip also contains as many tracks as the removed range. 

The material behind the removed range is appended to the material in front of the 
removed range. The VIP project becomes shorter if the selected range did cover all 
tracks. This way you can shorten VIPs which contain empty space behind the last 
object. 

As with the wave projects, a successful removal of the selected range drops a marker 
at the position the removed range previously started. This allows you to insert the 
removed material with "Edit -> Paste/Insert clip". 

Keys: Ctrl + X, or X 
 

Split 
Split Objects 
Use this option to split all selected objects at the cursor position and separate them 
into individual objects. 

If the range is selected, the cut will be made at each border. Ensure that the object 
that is to be edited is contained within the active range. If necessary, all objects may 
be activated by double clicking on the range selected in the range bar. In this case, it is 
not necessary to select the objects beforehand.  

Shortcut:  T 
 

Split objects at the project marker position 
The selected objects are spilt at the positions of the project markers. The newly 
created objects will be named after the previous markers. 
 

Separate objects at the position of track markers 
Selected objects will be split into independent objects at the position of track markers. 
The newly created objects will be named after the previous markers. 
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Insert 
Paste from clip 
The contents of the clip are inserted into the current project behind the position of the 
play cursor or the beginning of the currently selected range. The data or objects that 
are located behind the insert position are moved out of the way to make room for the 
clip contents. The samples or audio tracks become longer. The clip remains 
unchanged during the procedure. If the clip was empty, an error message is displayed. 

After inserting the contents, the program selects a range over the inserted area. If you 
select "Edit -> Delete", the inserted contents are removed and the project is returned 
to the original state. 

In virtual projects using selected ranges, the program utilizes the beginning position 
and relative track position as the insert point for the VirtClip or clip contents. 

Clip Project Clip Channel Project Channel 

Mono 
Stereo 
 
Mono 
 
Stereo 

Mono 
Stereo 
 
Stereo 
 
Mono 

Channel 1 
Channel 1 
Channel 2 
Channel 1 
Channel 1 
Channel 1 

Channel 1 
Channel 1 
Channel 2  
Channel 1 
Channel 2 
Channel 1 

Keys:  Ctrl + V, or V 
 

Overwrite with clip 
The current range is replaced with the clip contents. The overall sample length 
remains unchanged. The data that occupied this position before cannot be recalled. 
The clip contents are not changed. The assignment of the clip channels follows the 
table mentioned above. 

In virtual projects, the selected range determines the position and track in which the 
clip is inserted. 

Keys:   Alt + V, or Insert 
 

Mix with clip 
The range contents and the clip contents are mixed. Similarly to the "Insert" function, 
the rules for channel assignment between project and clip also apply; the clip itself 
remains unaffected. Please note that with this function both components (i.e. the sum 
of both) are entered into the mix at 100%. On the one hand, the volume of the project 
sample is guaranteed not to drop suddenly, but on the other hand, overmodulation 
my occur. You may have to adjust the project's amplitude prior to this ("Edit" menu). 
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Crossfade with clip 
The content of the range is crossfaded with the content of the clip. 
 

Delete 
Delete 
The data in the current range is deleted. The sample data after the deleted range is 
added at the position the deleted range started. The sample length becomes shorter. 

Please note that this command will not save the deleted data to the clip. If you want 
to preserve the deleted sample data, use the “Cut” command. Using this the “Delete” 
command will delete the data from the current sample and preserve the contents of 
the clip. 

Key:  Del 
 

Extract 
This function is the counter part of the "Cut" function. 

wave projects: The current range is retained, the data before and after the range is 
deleted and cannot be recovered. The length of the sample is reduced and the content 
of the clip remains. 

Virtual projects (VIP): All tracks of the VIP keep the length of the selected range, 
irrespective of the position of the range. 

This function does not work track-specifically. The objects before and after the range 
are deleted. This function does not influence the VirtClip. 
 

Silence 
Insert silence 
The "Insert silence" option will insert blank data at the current play cursor position or 
the starting position of the currently selected range. 
 

Set silence 
Copies the selected VIP range into the clip and clears it in the VIP project. The project 
length is not changed. Please note that the previous clip contents are deleted. 

This is a good way to remove a section of a VIP for use elsewhere without affecting 
the length of the track(s) from which the material was removed. 

Keys:  Alt + Del 
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Tempo 
Tempo map... 

Detailed information about the tempo map dialog can be found in the chapter 
"Tempo editing > Tempo map dialog" (view page 232). 

 

Tempo map BPM mode/grid adjustment mode 

Detailed information about the tempo map grid fit mode can be found in the chapter 
"Tempo editing > Grid tapping" (view page 231). 

 

Insert tempo change 
This opens the Tempo and time signature dialog (view page 234) to insert a tempo 
change. 
 

Insert time signature change 
This opens the Tempo and time signature dialog (view page 234) to insert a time 
signature change. 
 

Insert grid position marker 
Here you can insert grid position markers (view page 231) at the current play cursor 
position. 
 

Ignore all tempo markers, use project tempo only 
All tempo markers are ignored, only the project tempo is used. 
 

Metronome active 
Activates/deactivated the metronome. This function can also be activated via the 
"Click" button of the transport console. 
 

Metronome settings 
This menu item opens the metronome settings (view page 459). 
 

Range 
Range all 
The range will cover the complete sample. This command comes in handy if you want 
to apply changes to the entire sample with functions that normally only address 
certain ranges. 

Keys:  A 
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Edit range 
In this submenu you will find options and keyboard shortcuts for adjusting the play 
and edit range in the VIP. 
 

Range start to left/right 
Moves the start of the range to the left/right 

Shortcut: Alt + Arrow left/right 
 

Move range end to left/right 
Moves the end of the range. 

Keyboard shortcut:  

Left:  Alt + "-", or Shift + Arrow left    

Right:  Alt + "+", or Shift + Arrow right   
 

Range to beginning 
The start of the current range will be moved to the start of the project. 
 

Range to end 
The end of the current range will be moved to the end of the project. 
 

Flip range left 
The current range is shifted left by the length of the range and the end will be the 
former beginning position. If there is not enough room to place the range, the 
command will not be executed. 

Keys:  Ctrl + Shift + Arrow left 
 

Flip range right 
The current range is shifted right by the length of the range, and the beginning will be 
the former end position. Keep in mind that if there is not enough room to place the 
range, the command will not be executed. 

Keys: Ctrl + Shift + Arrow right 
 

Find zero crossings 
Beginning of range > 0 
This function shifts the beginning of range to the right of the next zero position. 

Keys:  Page up 
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Beginning of range < 0 
This function shifts the beginning of the range to the left of the next zero position. 

Keys:  Shift + Page up 
 

End of range > 0 
This function shifts the end of the range to the right of the next zero position (change 
in polarity). “Zero position” is the next sample value with zero value or the boundary 
between a positive and a negative sample value (or vice versa). This is particular 
useful for searching for loop points. 

Keys:  Ctrl + Page down 
 

End of range < 0 
This function shifts the end of the range to the left of the next zero position. 

Taste:  Shift + Page down 
 

0 > Range < 0 
This function shifts the beginning of the range to the left and the end of the range to 
the right of the next zero position.  

Taste:  Shift + Page down 
 

Set range start to left marker 
Moves the range start to the next marker on the left, i.e. the range will be expanded. 

Keyboard shortcut: Shift + F2 
 

Start of range to left object edge 
Moves the range start to the next marker on the left, i.e. the range will be extended up 
to the end of the next object on the left. 
 

Set range start to right marker 
Moves the range start to the next marker on the left, i.e. the range will be extended. 

Shortcut:  Shift + F3 
 

Set the end of the range to the right object edge 
Moves the end of the range to the next marker on the left, i.e. the range will be 
extended up to next object on the right. 
 

Area above all selected items 
A range is opened above all previously selected objects. Read the topics "Selecting 
objects with the mouse" and "Ranges". 
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Remove Range 
This command removes the current range from the grid and marker bar. This function 
is also available by right clicking in the grid and marker bar. 
 

Range Not Over Tracks 
This command selects the selected range from the grid and marker bar only, and not 
in the tracks. Switch between the "Range not over tracks", "Range over current track", 
and "Range over all tracks" functions by double clicking in the selected range in the 
grid and marker bar. 
 

Range Over Current Track 
This command selects the selected range from the grid and marker bar as well as in 
the selected track. 
 

Range Over All Tracks 
This command selects the selected range from the grid and marker bar as well as in 
all selected tracks. 
 

Range length 
This command lets you set the range length to 1, 2, 4, 8, and 16 bars. You can set the 
tempo in BPM with "View -> Snap setup". 
 

Split range 
This function is particularly useful for working with loops. If not already displaying in 
split range mode, the project is switched to this mode first to display three sections 
on the screen. 

The upper section displays the whole sample, the section located at the bottom left 
displays the data near the beginning of the range, and the section at the bottom right 
displays the data near the end of the range. 

The boundaries of the range can be positioned exactly in the lower sections, while the 
upper section will display the location of the entire range. You can also define ranges 
across several sections. 

In order to revert splitting, the display setting has to be changed to a section again 
using "View -> Sections -> 1", or "Shift + B". 

Key: B 

Deactivate: Shift+B 
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Split range for video 
This function is in particular useful for working with AVI videos.  

The upper section displays the whole sample. The section located at the bottom left 
displays the data near the beginning of the range. The section at the bottom right 
displays the data near the end of the range. 

Both lower sections are zoomed down to single frame accuracy. 

The boundaries of the range can be exactly positioned in the lower sections, while the 
upper section will display the location of the entire range. You can also define ranges 
across several sections. 

To undo the split, the display has to be returned to a 1 section display with "Shift + B", 
or "View -> Sections -> 1". 
 

Note range 
In Samplitude Music Studio 2013 you can define and store an unlimited number of 
ranges for future retrieval. You can for example specify different loops and compare 
them while you recall their ranges. 

If you select this menu item, you will have to indicate a number under which you 
would like to save the current range. 

All current ranges in a project can be viewed, renamed and played back via "View > 
Range manager". 

Shortcuts: 

Other... 
2 
3 
5 
6 
7 
8 
9 
10 

Alt + F11 
Alt + F2 
Alt + F3 
Alt + F5 
Alt + F6 
Alt + F7 
Alt + F8 
Alt + F9 
Alt + F10 

 

Get range 
Select this option to select one of the defined ranges as the current range. 

Samplitude Music Studio 2013 even lets you choose a range while playing, and the 
specified range becomes the current one and is audible. Using this method, you can 
change between two ranges to compare them with each other. Ranges can also be 
named and recalled with the range manager ("Tools" menu). 
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Keys:  F2 ... F10 
 

Get range length 
By selecting this option you can select the length of one of the defined ranges to be 
the current range. 

Keys:  Ctrl + Shift + F2 ... F10 
 

Range manager 
All saved ranges of the current project are displayed in the range manager. 

A colored bar highlights the current range. 

By selecting a range name, the corresponding range in the project is 
selected/activated. 

In the lower line you can enter/modify the range name. You can also delete ranges 
and save new ranges in the range manager. 

With the "Play once" button you can play the selected range once, "Play loop" 
activates looped playback. This makes the range manager particularly useful as a 
jingle player. 
 

Recall last range 
Restores the last selected range (useful if the adjacent marker was accidentally 
deleted). 
 

Crossfade 
Crossfade Editor 
This menu entry opens the Crossfade Editor (view page 284) that allows you to easily 
set and edit crossfades. 
 

Auto crossfade active 
If this option is turned on, then all newly recorded or cut material in a VIP or material 
copied from a wave project into a VIP track has an automatic crossfade applied to it. 

Global settings for fade-in and fade-out parameters are assigned to the object. These 
settings can be changed with the crossfade editor via "Edit -> Crossfade editor". 

If two objects which had an automatic crossfade applied to them are overlapped, a 
real-time crossfade is the result. 

Auto crossfade mode is an excellent tool to easily perform a linear cut of a spoken 
voice track, jingle, etc. requiring a soft passage without unwanted sounds. If needed, 
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each crossfade can be edited using the editor or by manually manipulating the 
handles.  

Detailed information about object modes can be found under Symbol bars > 
Object modes" (view page 66)FILE31896 
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Track menu 

Insert new tracks 
Add one track 
The virtual project is expanded by one empty track. 
 

Add several tracks 
The virtual project is expanded by one empty track (inserted below the selected 
track). 
 

Insert empty track 
The virtual project is expanded by one empty track (inserted below the selected 
track). 
 

Insert Several Tracks… 
To add multiple tracks, select the command "Insert several tracks". A dialog window 
appears to select the desired number of new tracks.  
 

New MIDI track 
A track is added to the project which is already set for MIDI recording. 
 

New track folder 
Inserts a new folder track in front of the marked track. If a range across several tracks 
was highlighted before creating the folder track, then each of these tracks will be 
added to the folder. 

Tracks can be moved into the folder with drag & drop by clicking on a free area in the 
track box. The mouse pointer turns into a hand. Similarly, tracks can be removed from 
the folder via drag & drop and out of the track box. 

Certain actions can also be grouped. This means an action performed on a folder track 
affects all contained tracks. Tracks in a folder can be: 

• Faded out with the "Reduce track" button. All tracks included in the folder track 
are displayed in reduced size. 

• Switched to mute, lock, monitoring, and solo. 
• Volume controlled. The individual volume faders of the tracks are scaled relative 

to another, independent of the current function of the track volume fader (MIDI, 
CC, or audio level) 

• Activated (the displayed condition corresponds to the first track of the folder, 
joint switching is only possible with different/multi-track recording devices) 
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If the folder track display is enlarged (opened up), all included tracks are displayed as 
well with a frame in the color of the folder track. The track color can be selected in the 
track settings. If the folder track is minimized, the tracks included in the VIP are 
hidden. They continue to be available in the mixer. They are also available in the 
mixer. 

Normally, all the tracks can be seen with the objects they contain in the folder in a 
smaller display. Section marking in the folder track is carried out across all tracks. Use 
this view mode for section-based cut operations across all tracks of the folder track. 

By right clicking on the track box of the folder track, the contained track can be used 
as a reference track. The objects of this track are displayed in the folder and can be 
used for simultaneous object-based cutting operations for all objects of the other 
tracks in the folder track that are grouped with these objects. Object groups like these 
typically originate from multi-track recordings. 

The usual method of working with folder tracks would be as follows: 

1. Initiate a multi-track recording. This creates several grouped objects, one 
below the other. 

2. Select an area over all the objects that you wish to edit together. You can now 
create a folder track. 

3. Minimize the folder track and choose one of the contained tracks as a 
reference. 

4. The object of the reference track now appears in the folder track instead of the 
symbolic display of all contained tracks. All object editing, cuts, fades, and 
object editor effects of this object are now applied to all objects of the folder 
tracks (changes in the object editor take effect only after "Apply/OK" is 
clicked). 
 

Folder tracks are not visible in the mixer. 
 

New submix / AUX bus 
In the "New submix bus" menu item you can add a new submix bus as a new track. 
The "New AUX bus" option is identical. The new bus is always inserted after the 
active track. 
 

Copy track(s) 
All selected tracks in the VIP are copied into the VirtClip. 
 

Insert track(s) 
The clip is inserted from the track with the current range setting. New tracks are 
created in the VIP. 
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Delete track(s) 
All selected tracks are deleted from the actual VIP.  
 

Track type 
Here you can specify whether the track should be an audio track or a MIDI track. 
Moreover the track can be defined as a submix and/or AUX bus. 

So you can define the track as Economy Track. 
 

Input 
Stereo: Records a stereo wave file. 

Mono: Mono recording uses only one input device for recording. 

Mono (Mix): Mono recording records a signal which mixes both input devices. 

MIDI recording: The set MIDI input is recorded. 
 

Track size 
Minimize none 
This option maximizes all tracks. 
 

Maximize track 
This option minimizes all tracks except the selected track. 
 

Track Freeze 
Track freeze 
The selected track is rendered into a wave file which replaces all objects on the active 
track. Object and track effects are added to reduce the PC's processor strain of having 
to process effects and plug-ins. 

The advantage of track freeze is that the frozen track is saved in a separate VIP and 
can be edited/recalled at any time. This way it's also possible to work flexibly and to 
keep resource usage at a minimum even when working with less powerful computers. 
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Track freeze for AUX buses/submix buses 

Bus/Aux bus tracks can be frozen just like regular tracks. This enables a complete 
group of tracks to release the required CPU load including all effects, fades, 
crossfades, and automation settings in one step. 

Submix bus 

• Tracks routed onto the submix bus are not changed but remain instead. 
• The submix bus is muted ("Track -> Track options -> Mute bus input"). 
• The file created while freezing is inserted into the AUX track as an audio object. 
• Changes made to the tracks after freezing which are routed to the submix bus 

have no effect on the signal output while playing. 

AUX bus 

• Only AUX send settings in tracks are taken into account (not in objects). 
• Tracks routed onto the frozen AUX bus are not changed but remain unchanged 

instead. 
• The AUX bus input is muted ("Track -> Track properties -> Mute bus input"). 
• The color of the AUX send fader (mixer) in the affected tracks is blue. 
• An asterisk is added before the name above the AUX send faders (mixer). 
• The file created while freezing is inserted into the submix track as an audio 

object. 
• Changes made after freezing to the tracks transmitting to the AUX bus are not 

updated in the file created while freezing. Therefore, if objects are moved into 
tracks transmitting to an AUX bus, the audio signal on the corresponding AUX 
will remain the same. 

 

Track unfreeze 
This menu item removes the wave file created during "Track freeze" and brings back 
the track that was saved in the temporary trackbouncing VIP. 

Changes made in this project are applied to the track as well. 

Note: If tracks were added in the reference project (the project created while 
freezing), "Track unfreeze" is not possible. 
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Track effect settings 
Copy / Paste track effects settings 
With this command you can copy the complete effects settings of the active track 
into the clipboard. 
 

Copy / Paste track effects settings 
With this command you can copy the complete effects settings of the active track 
into the clipboard (to paste it on another track). 
 

Reset track effects settings 
Reset all track effects settings to its defaults, i.e. no effects are applied at all.  
 

Track information 
Please refer to “Track” menu! 
 

More 
Cut track(s) 
Cuts out the complete tracks that have been selected by the range. 
 

Track effects 
Please read the chapter “Menu effects”. 
 

Dynamics 
Dynamics 
This menu entry opens the Track Dynamics (view page 142). This is a dynamics tool 
that requires little CPU power and can be used in different modes. 
 

Frequency/Filter 
EQ 
This menu opens the Equalizer (view page 102). 
 

Vintage Filter 
Opens the Vintage Effect Suite Filter (view page 110)=. 
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Delay / Reverb 
Delay/Reverb 

 

The reverb effect device offers newly developed and very realistic reverb algorithms 
to add more room depth to your recording. 
 

Reverb 
Reverb gives you a high-quality reverb which can be specified further using the “Room 
Size”, “Time” and “Color” and mixed into the original sound with “Mix”. 

Room size: This controller controls a room simulator, which calculates the reverb 
effect according to the room size. If the controller is turned all the way to the left, then 
it sounds as if the audio object was recorded in a very small room. If it is turned all the 
way to the right, it sounds as if the audio object was recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" level. 

Color: Control the sound of the reverb here,  dampen or brighten it. 

Mix: This controller determines how much of the unprocessed original sound (dry 
signal) is subjected to reverb (wet signal). Application of this effect in an AUX bus 
requires the controller to be set to 100% (all the way to the right). 
 

Delay 
This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the left, 
there is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). Application of this effect in an AUX bus requires 
the controller to be set to 100% (all the way to the right). 
 

Vintage Delay 
Opens the  Vintage Effect Suite Analog Delay (view page 107). 
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Stereo / Phase 
Surround editor 
Please read the chapter "Surround". 
 

Modulation / Special 
Vintage Chorus 
Opens the  Vintage Effect Suite chorus (on page 112). Chorus is one of the most 
familiar and popular effects. 
 

Plug-ins 

 

This dialog allows you to use Microsoft DirectX and VST-compatible plug-ins for 
effects calculation in Samplitude Music Studio 2013. This allows you to use almost 
any effect algorithms of third parties in addition to the effects integrated in 
Samplitude Music Studio 2013.  

Samplitude Music Studio 2013's mixer enables plug-ins to be integrated as real-time 
effects. The plug-ins must be able to process audio data blocks instantly and 
completely without changing the length. This is normally the case for most plug-ins 
(e.g. reverb, echo, dynamic compressors, etc.). Other algorithms are excluded here 
(e.g. timestretching plug-ins because of the resulting length-changing effect). 
 



 

360   

www.magix.com 

MAGIX Plug-Ins 
Vintage Chorus 
Opens the  Vintage Effect Suite chorus (on page 112). Chorus is one of the most 
familiar and popular effects. 
 

Vintage Delay 
Opens the  Vintage Effect Suite Analog Delay (view page 107). 
 

Vintage Filter 
Opens the Vintage Effect Suite Filter (view page 110)=. 
 

Vintage Flanger 
The Flanger (view page 109) is a relatively unknown effect, but it is useful in many 
areas and is an indispensable part of the Vintage Effect Suite. 
 

Vintage Tape Simulation 
Using Tape Simulation you can give digital recordings the missing warmth of the tape 
saturation effect produced by analog equipment. 
 

Vintage Distortion 
Opens the Vintage Effect Suite distortion effect (view page 114). 
 

Vintage BitMachine 
This opens the BitMachine (view page 115). 
 

Track properties 
Here you can edit the properties of the active track. These are: 

Mute: The mute button mutes the active track. 

Solo: Switches the active track to solo mode. 

Solo exclusively: This setting switches the active tack to solo exclusive mode, i. e. you 
will only hear the activated track. All other tracks are muted, unlike solo mode. 

Record: Activates record mode. 

Lock: Locks the activated track. 

Volume/Pan-curve active: Displays the volume or pan curve of the activated track. 

Submix/AUX bus: If the activate track is a bus, it can be defined as a submix and/or 
AUX bus. 
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Surround editor 
Please read the chapter "Surround". 
 

DirectX plug-Ins 
Please read the corresponding explanations in the "Effects" chapter. 
 

Activate next / Previous track 
The next (lower) or previous (upper) track in the VIP from the view of the currently 
activated track is activated. With the cursor keys you can conveniently scroll up or 
down. 

Key: 

Activate next track   Cursor down 

Activate previous track  Cursor up 
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Object menu 
In contrast to the "Edit" menu, all functions in this menu exclusively manipulate 
selected objects in virtual projects. Selected ranges have no effect with these 
functions.  

Ranges are used to determine insertion points or cut positions of objects. When 
inserting material into a virtual project, the range beginning has the same function as 
the play cursor. 
 

Object editor 
Use the object editor for object-oriented editing. This way you can quickly and easily 
edit each selected object independent of your general settings. 

Shortcut:   Ctrl + O 
 

MIDI editor 
This menu point opens the MIDI editor. Here, the content of the MIDI object selected 
in the VIP can be displayed and edited. Here, you can choose from the matrix editor, 
drum editor, score editor, event list, and velocity/controller editor. 

If a MIDI object is not selected, you will be asked if you wish to create one. If you 
confirm this with "YES", a MIDI object in the current track is created at the cursor 
position/start of the range. 

Read more about the MIDI editor in the "MIDI editor" chapter. 

 

Wave editing 
Opens the wave project (contains audio files) belonging to an object and displays it in 
the wave window. 

The range corresponds precisely to the part of the audio data which the object 
accesses. 

You can carry out destructive (offline) editing In the wave window. 

Cut and copy functions are available for destructive editing ("Edit" menu) as well as 
complex effects ("Effects" menu). 

Destructive editing is not necessarily recommended. 
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If you have duplicated objects, i.e. several objects are using the same audio data, then 
all of these objects will have changed when you change the wave project. 

Please note that the cut and copy processes, fades, crossfades, etc. can be performed 
much more elegantly and more quickly as non-destructive virtual projects. 

Almost every effect can be used on objects directly in the virtual project. 

Please also note that it is better to work in single-track virtual projects even if you only 
want to edit wave files in Samplitude Music Studio 2013. You can quickly and 
conveniently perform all editing operations here. If you have to use longer wave files, 
you have to wait after each editing sequence until the audio data has been copied to 
the hard drive. However, you can work considerably faster if you use virtual projects. 

With the "Trackbouncing" function ("Tools" menu), you can create a new wave file 
from the virtual project. 
 

New MIDI object 
A new MIDI object is created on the selected track. After choosing the command, you 
can select a prefabricated MIDI template (from the subdirectory “Templates” in the 
Samplitude Music Studio 2013 directory) from a small pop-up menu. It deals with 
normal standard MIDI files which can be copied into this directory or directly 
exported from Samplitude Music Studio 2013 as a template. If only one file is in the 
template listing, no menu appears the object is created immediately. 
 

New MIDI object in the range 
This function creates a new MIDI object in the current track within the selected range. 
 

New synth object 
Please read the "Synth objects" chapter! 
 

Edit 
Cut objects 
The currently selected object is replaced with empty space and copied to the VirtClip. 
The length of the current project remains and all other non-selected objects remain in 
their positions. The previous contents of the VirtClip are replaced with the cut object. 
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Copy objects 
To place a copy of the currently selected object into the VirtClip select this option. 
The contents of the VirtClip can then be inserted into the project using the “Insert 
objects” option (see below). The previous contents of the VirtClip are replaced. 
 

Insert objects 
Objects in the VirtClip can be inserted in the project at the current play cursor 
position. The other objects in the project maintain their positions. Please note that the 
newly inserted object might cover portions of existing objects. 
 

Delete objects 
The selected objects are deleted from the current project. The length of the current 
project however remains the same. Previously unselected objects keep their positions. 
The contents of the VirtClip remain unchanged. 

Keys:  Ctrl + Del 
 

Duplicate and move 
Duplicates all selected objects, that is, a copy is created in the original project at the 
same point. The original object is underneath (covered). The duplicate can be moved 
to the new desired position using the mouse (in Object/Universal Mode). Duplication 
is also possible using drag & drop (in Object/Universal Mode): 

If multiple objects were selected before duplication, the Ctrl key should be pressed 
before moving so that all objects remain selected and are moved together. 

This way, you can quickly duplicate objects. 
 

Duplicate objects multiple 
This function duplicates multiple objects and places them in a sequence. Another 
dialog is displayed which allows you to determine how many copies of the selected 
objects are to be duplicated, the separating distance, and the overall length of the 
duplication. 

This is also another way to build loop objects. 

The following parameters are available: 

Number of objects: Determines the number of objects created. 

Group created objects: All created objects are grouped together when checked. 

Delta time: This determines the relative position of each created object to the next 
(from the beginning of one object to the beginning of the next). The default setting is 
the length of the selected object. The default setting  lines up the duplicated objects 
without any gaps between them to create a seamless loop. 
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Duration: Alternatively, the duration can be specified, i.e. the combination of the time 
difference and the number of duplicated objects. 
 

Build loop object 
A loop can be defined within an object with this function. An area which indicates the 
loop length must be selected in the object first.  

The object becomes the loop object, and the number of loops can simply be “raised” 
using the “length handles” at the bottom of the object.  

Loop objects generated like this are ideal for generating long drum sequences from 
only one drum loop! Loop objects also help to save memory, since in the VIP only one 
object is handled rather than multiple objects or copies of the same material or very 
long samples! 
 

Split objects 
This function splits or separates selected objects so that individual object sections can 
be manipulated further. All selected objects are separated at the current play cursor 
position, resulting in two independent objects. 

If a range is selected, the cut occurs on both range boundaries. It is not necessary to 
select objects prior to choosing the range and using the "Split objects" function. If an 
underlying object is separated, then the newly created object covers the original 
underlying object. 

Keys:  T 
 

Split objects at project marker positions 
The object will be split into partial objects at the marker positions located within the 
object borders; the new objects will be named using the project marker names. 
 

Split objects at track marker positions 
The object will be split at the position of the markers located within the object 
borders; the new partial objects will be named after the track marker names. 
 

Trim objects 
This function trims the object borders to the currently selected range borders. The 
selected range needs to be located within the confinements of the object you want to 
trim. 

Keys:  Ctrl + T 
 

Trim MIDI objects 
This function moves the object borders of a selected object to the edges of the 
current range. For this to occur, the range must be fully within the object's borders. 
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Group objects 
Builds a new object from those selected using trackbouncing. 
 

Mute objects 
The selected objects will be muted. 
 

Lock objects 
Use this option to protect objects from accidental shifting. First, select the objects you 
want to “lock” in place and activate the lock function. A diagonal line is placed across 
the locked object. 

In the "Options" menu you can specify the functions you want to lock. 
 

Unlock objects 
An object can be unlocked so that it can be moved again. All of the objects selected 
will be unlocked. 
 

Locking options 
The dialog opens displaying the Locking options (view page 463). 
 

Separate MIDI objects according to channels 
If a MIDI object contains several channels, you can use this menu item to split it up 
into several MIDI objects. 

Hint: Please note that the created tracks have to be allocated to the corresponding 
instrument/MIDI device. 

 

Quantization 
MIDI Note Quantize (Standard) 
This command quantizes the ends of the MIDI notes of all selected MIDI objects 
according to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> 
Quantization". 

 

MIDI Humanize Q 
This command applies the current Humanize value in the quantization options. 

Detailed information about quantization is available in "MIDI editors -> 
Quantization". 
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MIDI quantization settings 
This command opens the dialog for MIDI event quantization. To find out more, read 
"Quantize" (view page 205). 
 

Advanced 
Start Q 
This command quantizes the start positions of the MIDI notes for all selected MIDI 
objects according to the MIDI quantization settings. The grid view corresponds to the 
set start quantization value. 

Detailed information about quantization is available in "MIDI editors -> 
Quantization". 

 

Start and Length Q 
This command applies quantization to the start and length of the MIDI notes of all 
selected MIDI objects according to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> 
Quantization". 

 

Length Q 
This command applies quantization to the lengths of the MIDI notes of all selected 
MIDI objects according to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> 
Quantization". 

 

Soft Q (approximation quantization) 
This command lets you can take the current Soft Q (power) value into consideration 
while quantizing. 
 

Quantize Note Ends to Grid 
This command quantizes the ends of the MIDI notes of all selected MIDI objects 
according to the MIDI quantization settings. 

Detailed information about quantization is available in "MIDI editors -> 
Quantization". 
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Reset MIDI Quantization 
Use this command to restore the original offset of start and length values of MIDI 
notes for all selected MIDI objects. This enables you to undo quantization at any time 
(even after the VIP has been saved). 

Detailed information about quantization is available in "MIDI editors -> 
Quantization". 

 

MIDI Input Q (global) 
Use this option to quantize the MIDI recording destructively. The original position 
may be restored via the menu item "Object -> Quantize -> Reset Quantization". 
 

Object effects 
Dynamics 
Dynamics 
Fundamentally, the compressor is an automated, dynamic volume controller. The 
dynamics of a piece are limited, loud sequences remain loud, quiet sequences become 
louder. Compression is often used to add power to audio material or to increase the 
loudness. The level of compression is adjusted by the ratio controller, while the 
activation threshold is determined by the threshold. You can also influence the attack 
and release. 

Editing is carried out using a “look-ahead” method, similar to high-quality studio 
appliances. There are no peak over-modulations or other artifacts, as the algorithm 
can never be ‘surprised’ by sudden level peaks. 

 

Sensor field: You can intuitively influence  the sensor field  of the compressor with 
mouse movements. The graphics  color and the respective effect settings change in 
response to each other. 

Ratio: This parameter controls the amount of compression. 

Threshold: Set the threshold, above which compression is applied. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short attack 
times can create an undesirable "pumping" sound, as the volume is quickly reduced or 
increased correspondingly. 
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Release: Sets the algorithm's reaction speed to falling sound levels. 

A/B: If you have selected a preset for the effect and make manual changes to it later, 
you can compare the original preset sound with the new settings by using the A/B-
button. 

Reset: This resets the effect device to its original neutral starting point where minimal 
processing power is required and no effect is added to the sound. 

Load/Save: Here you can save the current settings as an effect file so that they can be 
used on other projects as well. 
 

Frequency/Filter 
Object equalizer 
Opens the 10-band-EQ for the object 

The 10-band equalizer subdivides the frequency spectrum into ten areas (‘bands’) and 
equips them with separate volume controls. This way it is possible to create many 
impressive effects, from a simple boosting of the bass to complete elimination of a 
certain range of frequencies. Note: If low frequencies are boosted too much, the 
overall sound level is heavily increased which may lead to distortion. In this event, 
adjust the overall volume downward by using the "master volume" control situated in 
the main screen. 

 

Slider controls: Each of the ten frequency ranges can be separately boosted or turned 
down with the ten volume controls. 

Link bands: Using this button flexibly combines the frequency ranges with each other 
to avoid artificial-sounding overemphasis of an individual frequency range. 

A/B: If you have selected a preset for the effect and make manual changes to it later, 
you can compare the original preset sound with the new settings by using the A/B-
button. 

Reset: This resets the effect device to its original neutral starting point where minimal 
processing power is required and no effect is added to the sound. 

Touch screen (right EQ section): This is the "sensor field" of the EQ. Here you can 
draw any type of curve with the mouse. This will be immediately translated into a 
corresponding control setting on the left side of the EQ. 
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Vintage Filter 
Opens the Vintage Effect Suite Filter (view page 110)=. 
 

Delay / Reverb 
Delay/Reverb 

 

The reverb effect device offers newly developed and very realistic reverb algorithms 
to add more room depth to your recording. 
 

Reverb 
Reverb gives you a high-quality reverb which can be specified further using the “Room 
Size”, “Time” and “Color” and mixed into the original sound with “Mix”. 

Room size: This controller controls a room simulator, which calculates the reverb 
effect according to the room size. If the controller is turned all the way to the left, then 
it sounds as if the audio object was recorded in a very small room. If it is turned all the 
way to the right, it sounds as if the audio object was recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" level. 

Color: Control the sound of the reverb here,  dampen or brighten it. 

Mix: This controller determines how much of the unprocessed original sound (dry 
signal) is subjected to reverb (wet signal). Application of this effect in an AUX bus 
requires the controller to be set to 100% (all the way to the right). 
 

Delay 
This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the left, 
there is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). Application of this effect in an AUX bus requires 
the controller to be set to 100% (all the way to the right). 
 



 

Object menu 371  

 

Vintage Delay 
Opens the  Vintage Effect Suite Analog Delay (view page 107). 
 

Time / Pitch 
Resample / Timestretching 
Opens the timestretching/resampling/pitchshifting editor. 

Note: If you only want to change the sample rate of an audio file, then use the 
"Adjust sample rate" option from the "Effects" menu. 

 

All algorithms in this dialog use the time factor parameter and pitch as input 
parameter.  

The time factor calculation (from the original length/original speed and the length 
required/speed required) can be comfortably activated on the right side of the dialog. 
 

Resampling 
Samplers and PCM synthesizers transpose samples during this procedure. Time 
factor and pitch are dependent upon each other; the shorter the audio material, the 
higher the pitch. This effect is comparable with changing the play back speed of 
record players or tape recorders.  

The effect is relatively loss-free, and the sound loss is less than all 
timestretching/pitchshifting procedures. If pitch change is justified by changing the 
speed (and vice versa), use this algorithm. 

When lengthening the audio material by resampling, very small aliasing effects may 
occur. The anti-aliasing filter helps correct this. Alternatively, since this filter creates 
additional CPU load, it can be activated for computation and real-time previewing. 
The filter is also available for the other algorithms that use internal resampling during 
pitchshifting.  
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Default 
"Standard" applies an algorithm which usually delivers very good results, including 
factors from 0.9 to 1.1, and operates in phase-locked mode to maintain the room 
effect of stereo signals. For drum loops or other "beat heavy" material, this algorithm 
is only partially suitable, since it can change the groove and even fade out or double 
beats in rare cases. 

Time compression (sample length is reduced) is more successful with this algorithm 
than timestretching, i.e. it is better to reduce the longer sample than vice versa when 
adjusting two samples to another. 
 

Smoothed 
A considerably more complex algorithm is used which requires more processing time. 
The material can now also be used on very large factors (0.2 - 50) without bringing 
about strong artifacts. The material is "smoothed", making the sound softer and 
emitting it at an adjusted phase level. This smoothing is hardly audible with speech, 
singing, or solo instrumentation. Problems may arise with more complex spectra 
(sound mixes from various instruments or finished mixes). This algorithm is not very 
well suited to drum loops and other material with strong transients. The groove 
remains intact, but the attacks are slurred because of phase shifting. With small 
corrections (factor ca. 0.9 - 1.1) the setting of the smallest possible smoothing value 
should be used.   

Recommended for: 

• Orchestra instruments: String instruments, wind instruments, etc. 
• Speech, single voice, and multi-voice sections 
• Speech with background noise like video sound, etc. 
• Synthesizer areas, guitars, etc. 

Not suited for: 

• Stereo mix 
• Drum loops, percussion 

CPU strain: very high 
 

Beat marker slicing 
This mode focuses on customizing drum loops, but can also be used on other material 
like monophonic bass runs or sequencer lines. The algorithm splits the material into 
individual components, individual notes, or beats, which are then selected via the beat 
marker. 

These "snippets" are then compiled into the new temporal measure. If the tempo is 
increased, then individual beats begin overlapping; if it is slowed down, then short 
pauses between the beats become audible. 
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If this algorithm can be used, then it should be, since the time change occurs without 
any loss of quality at low CPU strain. 

Recommended for: 

• Samples which can be split into individual notes or beats. 
• Drum loops, if the beats do not overlap and there is not much reverb. 

Definitely not suited for: 

• Everything else where beat markers do not exist; the algorithm fails completely 
and silence is the result. 

CPU strain: minimal 
 

Beat marker stretching 
This algorithm functions similarly to the standard algorithm. Unlike the previous 
algorithm, this one synchronizes the stretched material with the beat markers. The 
groove remains perfectly intact, and duplicated or faded-out beats do not occur. 
Unlike the "Beat marker based slicing" algorithm, this algorithm doesn't fail fully when 
there are no markers, or when the markers are placed incorrectly, but the 
synchronization quality may be reduced or contain errors. In practice, automatic 
marker generation is usually enough for good results. You should avoid having beat 
markers which follow one another very closely (<1000 samples). 
 

Monophone voice 
This is a special timestretching and pitchshifting function for vocal solos, speech, or 
solo instruments. The material cannot contain background noise, and excessive 
reverb may also be detrimental to its effects. With suitable material the audio quality 
is very high. 

With the "Use formant correction" option the formants remain the same when 
pitchshifting, i.e. the "Mickey Mouse effect" does not occur. This way, realistic 
background choirs can be "composed" from just one solo voice. However, the 
formants can be shifted by +/- 12 half tones, and vocal distortions can result.  

Typical usage of this algorithm: 

• Intonation correction: The note with the imprecise pitch should be cut out as an 
object, so that it can be manipulated independently of the other notes. 

• Harmonizer effects: An object with vocals can be copied and moved down. If the 
pitch is changed, then the second voice will be changed, etc.  

• Generating background vocals from existing vocal samples 
• Timestretch/Distortion of a speech sample, to make a "grandfather" voice. 
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Recommended for speech, single voice vocals, single voice instruments without 
overlapping, with low reverb and low background noise. 
 

Elastic Audio easy 
Opens the Elastic Audio Easy dialog (view page 144) to edit monophonic material and 
to create harmonic voices. 
 

Stereo / Phase 
Switch channels 
This function switches the left and right stereo channels.  

This is useful for correcting recordings with switched channels. This function can be 
reversed if you don't re-select the range; opening it again will bring back the original 
material.  
 

Invert phase 
The sample data is inverted along the amplitude axis, which means that negative 
values become positive and vice versa. This function allows you to adjust recordings 
with different phases to one another. 

An incorrect phase occurs if during an analog recording parallel cables are switched. 
To correct such errors, some mixers have a switch that can be used to invert the 
phase of an input. If you press the switch by mistake, errors might occur as well. 

This function is reversible, so if you repeat it, the original signal is restored. 
 

Modulation / Special 
Vocoder 
The vocoder principle: Carrier material (e.g. a surface sound or a synth chord) is 
affected by a modulator (e.g. language or singing) so that one gets the impression 
that it is speaking or singing. Rhythmic surface sounds can also be developed if 
modulated with a drum loop.  

This is done via the transmission of the frequency characteristics of the modulator 
(speech) on the carrier (chord).  
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Carrier input 
Here you have to select the desired carrier sample. Some special carrier samples that 
have been loaded automatically from the "Vocoder" directory are listed. 

 Use the "Carrier sample" check box to load any number of samples of 
the current project or predefined carrier sample. 
Here you can play the carrier on its own for test purposes. 

Noise: This controller lets you add noise to the carrier sample. This makes sense if the 
carrier material can not be modulated sufficiently or is irregular. It's good for "filling" 
drum loops which have too many pauses between the beats. 

Material containing all frequencies in equal amounts are particularly suitable, such as 
strings, orchestra chords, broad synthesizer pads, hissing, or wind noise. 
 

Filters 
Dyna: Influences the dynamics of the modulator signal to reduce the modulation 
depth of the vocoder.  

This prevents two often undesired side effects of modulation: On the one hand the 
volume change of the modulator signal is added to the output signal in a slightly more 
moderate form, which may improve the power of the Vocoder voice. On the other 
hand the low-level portions of the modulator signal are ignored in order to prevent 
modulation of the carrier by breathing or noise. 

Smooze: Influences the speed of adjusting the vocoder to the modulator spectrum. As 
this value increases the vocoder starts to follow the modulator more slowly resulting 
in softer, reverberated sound changes in the carriers. 
 

Filter graphic 

 

As with the freely definable filters, here you can also draw any frequency progression 
you want in order to optimize the vocoder output. For example, you can get rid of 
disruptive bass frequencies by adjusting the curve downward in the left area. Or you 
can boost weak highs by adjusting the curve upward in the right area. 
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Mixer 

 

In the Mixer you can also mix parts of the carrier and modulator 
signal to the vocoder output signal (Out).  

If the output signal of a track is used as a carrier in the vocoder, 
this track will first be muted. In the vocoder mixer you can then 
make it audible again. 

 

Presets 

 

In the "Preset" menu you can select predefined vocoder settings. You can save your 
own settings by clicking on the "Save" button. Your own saved presets will also 
appear in the selection menu. 
 

Vintage Chorus 
Opens the  Vintage Effect Suite chorus (on page 112). Chorus is one of the most 
familiar and popular effects. 
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Plug-ins 

 

This dialog allows you to use Microsoft DirectX and VST-compatible plug-ins for 
effects calculation in Samplitude Music Studio 2013. This allows you to use almost 
any effect algorithms of third parties in addition to the effects integrated in 
Samplitude Music Studio 2013.  

Samplitude Music Studio 2013's mixer enables plug-ins to be integrated as real-time 
effects. The plug-ins must be able to process audio data blocks instantly and 
completely without changing the length. This is normally the case for most plug-ins 
(e.g. reverb, echo, dynamic compressors, etc.). Other algorithms are excluded here 
(e.g. timestretching plug-ins because of the resulting length-changing effect). 
 

MAGIX Plug-Ins 
Vintage Chorus 
Opens the  Vintage Effect Suite chorus (on page 112). Chorus is one of the most 
familiar and popular effects. 
 

Vintage Flanger 
The Flanger (view page 109) is a relatively unknown effect, but it is useful in many 
areas and is an indispensable part of the Vintage Effect Suite. 
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Vintage Delay 
Opens the  Vintage Effect Suite Analog Delay (view page 107). 
 

Vintage Filter 
Opens the Vintage Effect Suite Filter (view page 110)=. 
 

Vintage Tape Simulation 
Using Tape Simulation you can give digital recordings the missing warmth of the tape 
saturation effect produced by analog equipment. 
 

Vintage Distortion 
Opens the Vintage Effect Suite distortion effect (view page 114). 
 

Vintage BitMachine 
This opens the BitMachine (view page 115). 
 

Select objects 
Select objects 
Selects all objects located partially or entirely in the selected range, or at the current 
play cursor position.  
 

Select All Objects 
Selects all objects in the arranger window. 

Shortcut:  Ctrl + A 
 

Object lasso 
The normal way to select several objects at once is to click on the free space to the 
right of the object in the lower area of the track and drag a window out around the 
selected objects. 

Sometimes, however, there is not enough space between the objects. The object lasso 
solves this problem. 

Once activated, you can click on an object and pull up a selection frame without 
moving the object you clicked on. 

Once you selected the objects you want, the mouse returns to the standard mode, 
and that you will have to reactivate the object lasso each time you want to use it. 
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Select Previous Object 
Use this command to select the previous object on the same track. 

Shortcut:  Ctrl + Alt + Q, < 
 

Select Next Object 
Use this command to select the next object on the same track. 

Shortcut:  Ctrl + Alt + W, > 
 

Select objects > Switch selection 
Selects all objects located partially or entirely in the selected range, or at the current 
play cursor position. 
 

Unselect objects 
Unselects the object selection. 

Shortcut:  Ctrl + Shift + A 
 

Groups 
Create group 
Orders all selected objects into groups. As soon as an object is selected in the group, 
all objects in the group become highlighted so that you can work on them collectively. 

Shortcut:  Ctrl + G 
 

Dissolve group 
Turns all selected objects into free-standing objects again. 

Shortcut:  Ctrl + U 
 

Move object 
This menu contains functions for moving the objects themselves and also for moving 
the wave project within the object. There are also other functions for moving a 
crosswire between two objects and for changing the loudness of the object.  

This menu mainly exists for issuing keyboard commands (visible next to the entries 
themselves in the menu) and can be changed using the “Keyboard shortcuts and 
menu editing” function. 

In the picture shown here the menu contains the standard settings for the keyboard 
commands. 
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Commands for moving objects can also be found in the lower toolbar (range bar). 
 

Object to play cursor position 
This moves the selected object to the actual play cursor position. 
 

Object to original time position 
This moves the selected object to the original position where the material was 
originally recorded. This is often helpful if an object was accidentally moved. 
 

Set new original time position 
The current object position is used to reset the original position attribute for the 
object. This is also used in the take manager. 
 

Move objects step-by-step 
Samplitude Music Studio 2013 contains a complete set of functions for object and 
crossfade editing. Simply select two overlapping objects; only select the 
corresponding object for object editing. Use the "Ctrl" key to select the left object and 
the "Alt" key to select the right object. 

Object(s) to the left Ctrl + Alt + 1 
Object(s) to the right Ctrl + Alt + 2 
Object start to the left Ctrl + 3 
Object start to the right Ctrl + 4 
Object end to the left Alt + 3 
Object end to the right Alt + 4 
Crossfade to the left Ctrl + Alt + 3 
Crossfade to the right Ctrl + Alt + 4 
Increase volume Ctrl + Alt + 8 
Reduce volume Ctrl + Alt + 7  
Object content(s) to the left Ctrl + Alt + 9 
Object content(s) to the right Ctrl + Alt + 0 

Please note the useful "Object content to the left/right" functions. Here, object 
length and object position are kept, the assigned audio material from the 
corresponding wave project is moved into it. 
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Snap point (Hotspot) 
Hotspot 
The current play cursor position is turned into a reference point for the snap function. 
Instead of the object’s beginning, the hot spot is now used when the object is snapped 
to the grid. Stroked vertical lines illustrate hot spots, and hot spots may stand outside 
an object (in front of or behind the object). This function is very useful for a case 
where the portion of an object to be synchronized does not line up with its beginning.  
 

Delete hotspot 
The set hotspot is removed, the object snaps again to the object start when the object 
grid is switched on. 
 

Object color / name 
Object name 
The selected new name is applied to all selected objects. 
 

Object foreground color 
After selecting the desired color, all selected objects in the project will have the same 
foreground color. 
 

Object background color 
The background color selected in the color grid is applied to all objects. 
 

Tempo and beat recognition 
This menu entry opens the Tempo and beat recognition (view page 287, view page 
286). Tempo and beat recognition is a powerful tool for determining the BPMs (beats 
per minute) and the time position of quarter note beats of any song. This is important, 
for example, when a track on an audio CD has been imported into Samplitude Music 
Studio 2013 and other sounds like drum loops, effects, or synthesizer voices are to be 
mixed in. 
 

Harmony Agent 
The Harmony Agent provides harmony recognition automatically and determines the 
key and chord of any music title. See the guitar tablature of your favorite song in real 
time for the arrangement! 
 



 

382   

www.magix.com 

Harmony display 
After successful analysis with the Harmony agent, this menu entry enables you to 
show/hide the harmony display. 
 

audioid 
It's possible to identify audio files with this function. In contrast to freeDB (view page 
428), the audio file does not need to be a part of an album or CD, and it doesn't even 
need to be played back completely. 

Samplitude Music Studio 2013 analyzes typical sound characteristics of a song or part 
of a song and sends this data as a query to the Internet server. The server compares 
this "acoustic  fingerprint“ with saved information about already known songs and 
then provides the required song information. 
 

Time Stretch/Pitch Shift Patcher... 

 
 

Time Stretch/Pitch Shift Patcher - Overview 
Use this tool to patch wave files for use in Samplitude Music Studio 2013. In this case, 
additional information and settings may be written into the wave project. These 
enable the processing of Time Stretching and Pitch Shifting Algorithms at optimum 
quality. Without the patcher, you would have to search and set the settings and 
additional information for each wave file you wish to edit. 

The following may be patched individually: 

• Algorithms for Time Stretching/Pitch Shifting 
• Time factor/pitch 
• Time factor processing (new length/new BPM) 
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Time Stretch/Pitch Shift Patcher – Patching 
Patches only work if you have opened the wave project in destructive "Wave editing" 
mode and if it is not open in a VIP simultaneously.  

Choose the algorithm you wish to use in the dialog. You may also specify the tempo 
of the wave file using the "Time factor" controller. 

You may now test the selected algorithm in conjunction with the "Play/stop" and 
"Play original" buttons. By clicking the "Patch" button, Samplitude Music Studio 2013 
writes the information permanently to the wave file. 
 

Algorithms for Time Stretching/Pitch Shifting 
Samplitude Music Studio 2013 features the "Beat marker stretching (smoothed)", 
"Smoothed", "Beat marker slicing", "Beat marker stretching" as well as "Monophonic 
voice" algorithms as well as the "Standard" algorithm for real-time Time Stretching. 

Detailed information about this is available in "Offline effects -> Resampling/Time 
Stretching/Pitch Shifting". Use the patcher to save the most suitable time stretch 
algorithm for your needs in the wave project so that the chosen algorithm is used 
automatically on your wave projects when using Time Stretching/Pitch Shifting. 
 

Beat Markers 
Beat markers synchronize the audio material so that the groove remains perfectly 
intact. When using the beat marker-based algorithms, the beat markers are also 
saved in the wave project. 

Note: Unlike with the Time Stretching dialog in the "Effects" menu, the patcher is 
non-modal, meaning that you can move the beat markers in the wave project and 
simultaneously control the result of the Time Stretching. 

 

BPM Value 
The desired BPM value (beats per minute) can be patched here. This is useful for 
when the Time Stretching factor must be determined later to adjust the wave project 
to the tempo of an existing arrangement. If the "New BPM" field in the dialog is 
grayed out, you can change the value using the "Time factor" controller. 
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Playback / Record menu 

Play once 
The project or the range is played once. 

Key:  Space bar 
 

Play loop 
The project or the range is played in a loop. 

Key:  Space bar 
 

Play in range 
If you have specified a range, selecting this menu option (or button) will start 
playback of the sample from the beginning; enter the range and continue to loop 
through the range until you press stop. This mode is very useful for testing loops for 
instrument samples. 

Key:  Space bar 
 

Play with preload 
All buffers are loaded and the playback is ready to be started. Another window will 
appear with which playback can be started at your convenience. No delays will occur. 
This function is useful on slower systems and if synchronization must be started in 
manual mode and an exact start has to be performed. 

Keys: Shift + Space bar 
 

Play only selected objects 
Only selected objects will be played. All not selected objects will be muted. If the play 
cursor is not located at the beginning of the first selected object, it will be moved 
there. 

Shortcut:  Ctrl + Spacebar 
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Restart playback 
Choose this option to restart playback from the original play cursor position. 
 

Stop 
The playback is stopped for all projects types. 
 

Stop and go to current position 
The playback is stopped; the play cursor goes to the current position. 
 

Playback mode 
Loop Mode 
This mode plays the selected ranges in a loop. This corresponds to switching on the 
"Loop" button in the transport control. 
 

Change play direction 
The playback direction can be changed even during the actual playback. 
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Playback options 
The play parameters window which appears after selecting this menu option is 
designed to quickly enter playback parameters. 

 

Sample rate: The sample rate can be changed here as long as the sound card 
supports the new rate (some sound cards even support changing the rate while 
playing the sample). This is especially useful for hearing notes in a sample range 
played in a different octave. When selecting half the sample rate, the pitch should be 
the same. It would be played one octave lower. 

Device: Use this dialog box to specify the sound card's driver. This is necessary if 
playback takes place through a single sound card device, and is especially important if 
multiple output devices are located in the computer. 

Autoscroll: This you to activate the "Autoscroll" feature. This is especially useful 
when working with large disk files. The HD wave project window will follow the play 
cursor during playback. When working in “2” or “3” section display mode, the 
autoscroll feature causes the individual sections to follow the play cursor as well. If 
you have zoomed into one of the sections, the play cursor will move through the 
section faster, resulting in more screen re-draws. 

You can choose between page and soft scrolling, but be careful: Scrolling requires 
CPU power (depending on the processor, graphics adaptor, and resolution), and the 
CPU may be overloaded in critical situations which may result in playback dropouts. 
Deactivate autoscroll mode if this happens. 
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Scrubbing: If you "Insert" ("Insert", or "0" on the number pad), Samplitude Music 
Studio 2013 will switch to "Scrubbing" mode, and playback speed can be controlled 
directly by the mouse. The further to the right the mouse goes, the faster Samplitude 
Music Studio 2013 plays. 

In comparison to many HD recording systems, this even works in a virtual multitrack 
project. 

Use scrubbing mode to find passages, crackling, etc. in material. The older generation 
of sound engineers are, no doubt, very familiar with this method from analog tape 
editing. 

There are two scrubbing modes ("P"): 

Relative: The relative distance between the play cursor (positions bar) and the mouse 
position can be used to control the speed. The play cursor follows the movement of 
the mouse. 

Absolute: You can also use the absolute position of the mouse in the window to 
control the speed: 

Left border = Double speed backwards 

Center = No movement 

Right border = Double speed forwards 

Tip for scrubbing: For buffer sizes (4000, 2000 samples) scrolling is "softer".  Test if 
your computer functions at this buffer size without any playback errors. 

Combined with "Soft scroll", editing becomes very convenient on faster computers. 
 

Record 
Start audio recording according to the Recording options (view page 389). 

Shortcut:  R 
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Record mode / Punch in 
Play while recording 
This option corresponds to the option in the recording options with the same name. 
 

Record without playback 
Use this option to record without playing the VIP. 
 

Punch in mode active 
This option activates the punch mode. Punch in and punch out are processes for 
automating the recording start and end of an audio segment. Once punch mode is 
active, the punch in record feature can be used to record audio segments without 
stopping playback. 

The requirement for this mode is an armed record track. Use the “Rec” button on each 
track to select it for punch recording! 

Punch recording can be done in two ways: 

1. Punch in/ out “On-the-fly”: This allows you to start the recording (punch in) at any 
time during the playback. Once the recording commences, it can be stopped at any 
time (punch-out), while the playback continues. 

This is very similar to tape based multi-track recorders, which allow you to correct 
mistakes during previous recording takes by overwriting segments of the tape. 

Simply start the playback with the space bar. Punch-in recording can be started by 
clicking "Punch record" in the toolbar. 

2. Punch in/ out with markers: The second method is to punch in and out of 
recording using special markers. This is a more automated way of dealing with punch-
in/-out recording. This is useful when specific punch in and punch out points are 
determined and you don’t want to take any risks in possible punching in or out of the 
recording. "Punch in and out with markers" lets you specify the exact points where 
the recording should start and stop. To operate in this mode, a range has to be 
selected which defines the beginning and end of the recording. The "Set punch-in 
marker" and "Set punch-out marker" functions are used to tell Samplitude Music 
Studio 2013 where to punch in and where to punch out. Next, set the play cursor to an 
appropriate position prior to the punch-in point and start playback/recording with the 
"Punch record" button in the "Punch" toolbar. 

Important: When working with the punch in/out functionality, make sure that "Auto 
crossfade" mode is activated by clicking on the corresponding button in the toolbar. 
The auto crossfade will create smooth transitions between the takes. This helps to 
prevent little pops and clicks! 
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There is also a way to perform looped punch-in recording. Simply select a range over 
the desired punch region. The range is played back until you stop the playback with 
the space bar. Each time the program loops through the range, new takes are 
recorded at the punch markers. To find the best take after the recording is 
completed, use the take manager! 

 

Record options 
This menu option opens the "Record" window. All necessary settings for recording 
can be entered here. If you don’t need to open the dialog again once it is set, just start 
recording using the record button on the transport control, or by clicking the toolbar 
icon  

 

Record mode: Select between stereo and mono and if you want to record the audio 
into a RAM wave project or to the hard disk as an HD wave project. 

Preload: The "Preload" option allows you to load all the buffers before recording 
actually begins. This enables an immediate recording once you click the record 
button. Otherwise, Samplitude Music Studio 2013 will load the buffers, and depending 
on the size of the buffers and the overall computer speed, this may take some time. 

Sample rate: Select the audio file's sample rate. Make sure that your sound card 
supports the selected sample rate.  

Resampling to 44.1 kHz: Some Samplitude Music Studio 2013 versions can perform a 
real-time sample rate conversion to 44.1 kHz, if you are recording with a different 
sample rate. For example, a DAT tape is often recorded at 48 kHz, but the tape needs 
to mastered and prepared for Red Book audio CD processing (44.1 kHz). Samplitude 
Music Studio 2013 allows you to automatically convert the audio during the 
recording, eliminating the additional sample rate conversion step after the recording. 
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Device: This selects the desired device driver you want to use for the recording. If you 
have more than one sound card installed in your system, this window will let you 
specify which card to use. Make sure the sound card is properly installed in Windows 
and is operational. If you do not see an entry in this window, check whether a device 
driver has been installed for your sound card. This usually is done during the software 
installation for your sound card. 

? (Device): By clicking the “?” button, you can check the recording capabilities of the 
selected sound card, i.e. information about the sound card driver and its capabilities. 

Info: Dialog for detailing sound card properties. If your sound card supports 24-bit 
recording, you can activate this recording mode via the info dialog. 

Playback while recording: Simultaneous recording and playback is especially 
important when wanting to monitor existing tracks while recording a new track. This 
option allows you to turn the feature on. To conserve system resources and keep the 
recording error free on slower systems, you may need to turn this feature off. 

File name / Browse: The name of the audio file to be produced and the pre-set index 
path are displayed at the bottom of the recording window; both can be changed by 
clicking  "File" button. 

Set CD track marker: While the recording is running, you can set track markers by 
clicking "Set CD track marker" in the recording dialog. 

Automatic recording stop: When this field is activated, recording stops automatically 
after approximately 16 seconds of silence. This allows you to make a recording 
without having to worry about stopping it at the end. 

Automatic CD track recognition: When this field is activated, track markers will be 
set automatically at the end of pauses between songs. 

Create VIP object with name: Samplitude Music Studio 2013 allows you to choose 
whether you want to automatically create objects in a VIP once you are done with the 
recording. 

Monitor: This check box activates the VU meters. Please note that the correct 
recording device must be selected prior to beginning this. While recording, the LED 
control displays move slower, do, however, show each maximum level. 

Recording level: This display indicates that the signal level to be digitized is correctly 
set. Play the loudest part of the material to be recorded and watch the display. 

Low-level recording leads to a loss in sound quality, while high-level recording can 
produce unpleasant ”clipping” sounds. 

You can adjust the record level either on the sound source or with the mixer of your 
sound card. 
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Osc / Correl: Opens the oscillograph or phase correlator. The oscillograph displays 
the wave form at the input in a scalable window. 

The phase correlator displays the phase level of a stereo signal. A vertical line 
corresponds to a mono signal, and a horizontal line corresponds to a 180° phase-
inverted signal which usually indicates an incorrect cable connection. 

Tuner: For “tuning” guitars and other string instruments. A calibrating line appears 
when the A0 note is played. If deviating tones are played, the deviation can be read 
on the basis of the calibration line and the numerically indicated pitch is corrected 
accordingly. 

Record offset: This option allows you to specify an offset, which is calculated in 
samples. Sometimes it is necessary to compensate for any delays due to processing 
speed and other factors, such as your sound card’s ability to switch between playback 
and recording mode. Delays can occur between the recording and the playback of 
audio if the "Playback while recording" feature is turned on. This option allows 
adjustments if this occurs. Good values to start with are in the 20-2000 sample 
range. You can determine this value by playing a project with a distinct start in a 
multitrack VIP and recording it simultaneously. You can then measure the offset 
precisely using the zoom functions. 

Set marker 1: You can drop markers into the project. The current position of the play 
cursor is used to drop a marker at positions you want to select for later clean-up or 
similar tasks. 

Record: Starts recording by activating this button.  

Stop: Stops the recording process. Samplitude Music Studio 2013 will ask you 
whether you wish to keep the recording or delete it. 

Should the computer become overloaded due to swapping data or hard disk access 
for example, simply interrupt the recording with a click of the right mouse button or 
the space key. 

OK: Closes the record parameter dialog. 

Shortcut: "R" (second "R" starts recording) 
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Monitoring 
New, more flexible input signal monitoring is now available via ASIO driver support. 
 

Monitoring > Input monitoring on/off 
This function activates/deactivates the input monitoring (corresponds with “Rec M” 
button on the transport control). When actively monitoring, the input signal of the 
tracks for active monitoring (loudspeaker button in the VIP or mixer is activated) are 
played according to the selected monitoring type at the output. Furthermore, the LED 
peak meters in the VIP and mixers react according to the input signal. 

Note: If the "Rec" button is activated on a track, then the loudspeaker button is 
activated simultaneously in order to switch on monitoring. 

 

Monitoring > Tape player monitoring 
The preset method for monitoring, similar to tape players and familiar from earlier 
versions of Samplitude Music Studio 2013:  

When "Stop" is displayed, the input signal is rendered, "Play" renders the track 
contents, "Record" renders the input signal. If the option is deactivated, the user has 
to choose whether the input signal is shown or not. Use the "Force monitoring" button 
(small loudspeaker symbol beside/above the peak meter in the VIP/mixer).  
 

No audio monitoring (only peakmeter) 
This corresponds with the normal characteristic of the VIP: The peak meter of the 
tracks displays the level at the sound card input. 
 

Monitoring > Software monitoring / Software FX monitoring 
Software monitoring for cards with ASIO drivers is also possible if the card does not 
support hardware monitoring (ASIO direct monitoring). 

Software FX monitoring also calculates the track effects into the monitoring signal 
with the exception of all high latency-affected FX inserts. The amp simulator, 
however, is applicable. Samplitude Music Studio 2013 can therefore also be used as 
an effects device to play live directly. 

If you need all of the mixer effects, then use the conventional live input mode 
(functions without ASIO, but is afflicted with higher latencies). 

Furthermore, software or software FX monitoring must be active to be able to play 
VST instruments live using the "MIDI in" port. 
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Move Play Cursor 
to Beginning 
This option positions the play cursor at the beginning of the project. 

Shortcut:  Home 
 

to End 
This option positions the play cursor at the end of the project. 

Shortcut:  End 
 

to Range Start 
Sets the start position of the play cursor at the beginning of the currently selected 
range. 
 

to Range End 
Positions the start position of the play cursor at the end of the currently selected 
range. 
 

Left/Right Move in Page/Scroll Mode 
Use these commands to move the play cursor to the right or left. 

In "Page" mode, the play cursor moves across the screen to the end of the visible 
section; at that point, the window view shifts to the start of the following section. 

In "Scroll" mode, the play cursor jumps to the middle of the section and remains there 
as the project moves through it. 

Shortcuts: 
Movement in "Page" mode:  Right arrow/left arrow  

Movement in "Scroll" mode:  Alt + left/right arrow 

Note: Once a range open is open, use the "left/right arrow" keys to control the 
beginning of the range. 

 

Object Border Left 
The play cursor jumps to the left to the next object edge in the selected track. 

Shortcut:  Ctrl + Q 
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Object Border Right 
The play cursor jumps forward to the right to the next object edge in the selected 
track. 

Shortcut:  Ctrl + W 
 

Marker Left 
The play cursor jumps to the left to the next marker in the arranger window. 

Shortcut:  Alt + Q 
 

Marker Right 
The play cursor jumps forward to the right to the next marker in the arranger window. 

Shortcut:  Alt + W 
 

Section to play cursor/last stop position 
If you have not selected the option "Stop at current position" in "System options > 
Playback", then the play cursor may be set to the last stop position with this 
command. 

Shortcut:  Ctrl + Alt + , 
 

Marker 
Marker with name 
Sets a marker at the cursor position. In the dialog that opens, you can give markers 
names. 

Shortcut:  ? 
 

Markers with auto numeration 
Sets a marker at the cursor position. Every marker set in this way will be number 
consecutively. 

Shortcut:  Shift + ´ 
 

Place marker at recording position 
If this option is activated, a marker will automatically be set at the positions where 
recording starts. 

Shortcut:  Alt + ? 
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Set marker 
An indefinite number of positions can be saved at the start position of the playback 
marker (position line). This enables you to set markers. 

Shortcut:  Shift + 1 ... 0 
 

Jump to marker 
The new start position of the playback marker (position line) is set at the saved 
position of the corresponding marker number. Playback continues from the new start 
position. Please note that the range between the new start position and the end of the 
sample is played back. 

Shortcut:  1 ... 10 (via the alpha keyboard) 
 

Markers on range borders 
This function sets two markers to the beginning (S) and the end (E) of a selected 
range. 
 

Set markers on silence 
This function sets markers on silent regions in the sample (only in wave projects, i.e. 
HDP or RAP). You can choose the minimal length of the pause, a threshold level, the 
start number, and a prefix for the marker name. 

This is very useful to select the regions of sample CDs, etc. 

Min. time (ms): This is the minimum length in ms of a ”silent” area.  

Threshold (dB): This is the maximum volume of a ”silent” area. The level of the area 
in the project will be set on the level of the threshold in the graphic display!   

Starting number: The markers will start to count from the number you type in this 
dialog box. 

Prefix: This allows you to insert additional symbols (letters would be appropriate), 
which will be placed in front of the marker-numbers. By doing this, you will able to 
distinguish between new and older markers.  
 

Delete marker 
The selected marker will be deleted. 
 

Delete all markers 
All markers of the project will be deleted. 
 

Set start marker 
This function/button sets the punch-in marker 
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Set end marker 
This function/button sets the punch-out marker. 
 

Remove punch markers 
This function/button deletes the punch-in and punch-out markers. 
 

Insert tempo change 
This opens the Tempo and time signature dialog (view page 234) to insert a tempo 
change. 
 

Insert time signature change 
This opens the Tempo and time signature dialog (view page 234) to insert a time 
signature change. 
 

Insert grid position marker 
Here you can insert grid position markers (view page 231) at the current play cursor 
position. 
 

Ignore all tempo markers, use project tempo only 
All tempo markers are ignored, only the project tempo is used. 
 

Marker manager 
The marker manager lists all of the markers contained in the current project and 
makes it possible to jump directly from the list to them or to play them. 

Shortcut:  Ctrl + Shift + Alt + M 
 

Solo JamSession 
Read more on this topic in the Solo JamSession (view page 307) chapter! 

Shortcut:  J 
 

MIDI record modes 
The MIDI record modes define how the newly recorded MIDI data is inserted into the 
VIP if there are already MIDI objects at the recording position. 
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MIDI panic – All notes off 
This command sends a note off command to all MIDI devices which are not 
deactivated in the MIDI options for all 128 notes on all 16 channels. Furthermore, 
sustain (Controller 64) is switched off and the pitch wheel and modulation are set to 
0. In addition, an all notes off command is sent to all VSTi's used in the project. 

If MIDI tracks or objects exist in the project, the same function is also accessible by 
clicking the stop button in the transport console or toolbar when the project is in 
"STOP" state. 
 

Automation menu 

First entries in the automation context menu 
The first entry indicates which parameter you have automated, e.g. Effect 0 volume or 
Effect 1 pan. By checking the corresponding entry you can activate the corresponding 
automation curve. If you haven't activated an element, No effect (track) will be 
displayed. 
 

Editing curves 
Create 
The curve generator will create a beat-based volume curve for you which pulses 
according to eighth, quarter, half, or full notes. As an option for the beat-based 
envelope curve calculation you can enter a minimum and maximum value, or define 
the delay values. 
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Alternatively, you can also let the curve generator write an envelope curve scan. 

 
 

Invert 
This command inverts the active automation curves. 
 

Thin out 
This function thins out the active automation curve by reducing the number of 
automation events. While recording, the automation events are placed in very short 
intervals. The command "Thin out" reduces the number of curve points. The course of 
the automation is then displayed and reproduced even more accurately.  
 

Copy / Paste / Delete 
The activated automation curve can be copied/pasted into other tracks and deleted. 
 

Inactive 
Use this command to deactivate the selected automation curve. This means it will 
remain intact, but no longer affect the corresponding parameter. 
 

Delete all curves 
This command deletes all automation curves of the corresponding track. 
 

Automation mode 
Specify the Automation mode here. 
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Do not display automation 
Deactivate the display of the automation curves for all tracks with this option. 
 

Display track automation (default setting) 
If you select this display option, then only the track automation will be displayed. 
 

Display selected curves only 
This function displays only the selected curves for the corresponding track. This helps 
to keep an overview if several automation curves have been created. 
 

Display unselected curves (cannot be activated) 
(Default setting) 
The unselected automation curves are grayed-out. They cannot be activated with the 
mouse. 
 

Display unselected curves (can be activated) 
The unselected curves are also grayed-out, but can now be activated with the mouse. 

The last section of the context menu lists the ranges for which automation 
parameters are available during automation of the corresponding track or the 
corresponding object.  
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Effects menu 
These menu entries permit access to effects at object level. Nearly all effects are also 
available as offline effects (destructive effects), which is why the last menu item is 
"Apply effects offline" (exception – Vintage Effects Suite is not available as an offline 
effect). 

This menu features different options for adding high-quality audio effects to a wave 
project. 

Notes on destructive effect editing: 

• Most functions can be applied directly to a VIP object. 
• Please note that most functions only work within the selected range in the wave 

window. To apply the functions to the entire sample, the entire sample has to be 
selected (key A, see menu point "Range -> Range all"). 

• Selected objects in VIP projects are changed independently of the selected range 
across the entire range (the only exception here is the "Get noise sample" 
function).  

• If you don't want to change the entire object, then the object must be split first 
(select the desired range and press "t"). It's a good idea to activate "Auto-
crossfade" mode (key combination B/A) to avoid crackling transitions. 

• It's even possible to apply an effect to several selected objects. If multiple objects 
are selected in the VIP, the effect will be applied to the audio material referenced 
by the objects one after the other. 

• A note regarding the different behavior of RAM and HD wave projects: For RAM 
wave projects, you can decide after editing if you want to keep the changed audio 
material. So far it has only been changed in the RAM of the computer. 

• To keep the result, you have to save the project back to hard disk (key "S"). 
• For HD wave projects, on the other hand, the altered audio material will be 

written directly to the hard drive. For testing purposes, it's recommended to 
proceed as follows: 

• Use the preview or test functions of the effects. 
• At first, use a copy of the audio material. Copy the selected range into the clip 

first (key: "C"). Now open or activate the Clip window and then select the entire 
clip (Key A). You can now apply your effects to experiment. 

• The dialog windows for effects included as non-destructive real-time effects in 
the mixer can be accessed directly via the mixer. Simply right click on the 
respective effect in the mixer to start. This way all the parameters are available in 
the mixer as well.  
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Amplitude / Normalize 
Amplitude / Normalize > Normalize 
This function modifies the sample’s overall amplitude. The data is altered so that the 
maximum amplitude occurring in a specified range is set to 100% (or any other value 
between 1-400%). Samplitude Music Studio 2013 attempts to detect the maximum 
and relate it to the selected percentage, and then all other values are weighted with 
the new factor. 

 

The "Normalize" function is designed to fully modulate or overmodulate samples. this 
can be useful for processing done before conversion from a higher sample resolution 
to a lower resolution. Since the dynamic range of the low resolution is smaller, it still 
can be fully utilized by applying the "Normalize" function. 

When you are working with sounds from a single instrument, you should set the 
factor to 100%. 

If, however, your audio material has background percussion, then you will be able to 
overmodulate the sample up to 120-200%. This will only cut off the new percussion 
peaks. The same method allows you to alter the sound of natural instruments by 
overmodulating them (clipping). 

As preparation for further physical processing, e.g. filters, reverb, dynamic 
compression, etc., a level reduction of 50-70% is suggested. This should avoid 
clipping during post processing. 

Important: If the volume level during the recording is relatively low and the material 
is normalized later, the result will not be of the same quality if the recording level is 
maximized to its fullest range. If, for example, the volume level was only set to 50% 
of the possible range, the audio material will be in 15-bit quality. Even normalizing 
the material to 100% will not change this aspect. 

Editing mode: In virtual projects, a virtual normalization function is available. Sample 
data remain unchanged — the object volume is adapted in such a way that the 
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loudest passage in the object equals 0 dB (corresponding to 100%). This virtual 
normalization is non-destructive and extremely fast!  

Selecting several objects: If you have selected several objects, then you can decide 
whether you want to normalize them individually or as a whole. 

Quick access: This section allows you to set the parameters for quick access. Instead 
of having to open the dialog each time you want to normalize, simply press “N”. 

Keys:  Shift + N 
 

Amplitude / Normalize > Loudness adaption 
This function raises the sound volume of all objects to the maximum level without the 
clipping the material. Unlike the master normalization function, each object is 
normalized separately. It serves the purpose of reconciling finished songs (each as 
one object) in volume. This makes the volume of the songs uniform.   

Titles with full volume control can still sound different, since a crucial factor in the 
perception of volume is also the relationship between the soft and the loud parts of a 
piece of music. The average loudness (RMS) of the song therefore has to be identified 
in addition to the absolute level (which is the loudest part of the song) and the object 
level has to be adjusted accordingly.  

Therefore, it may happen that songs with high peak values but a lower level of 
loudness are normalized to a value above 0dB (full volume). In order to avoid clipping, 
the limiter (see MultiMax) is activated automatically. 

Tip: Volume fluctuations within a song can be removed with the “Leveler” presets in 
MultiMAX. 

 

Amplitude/Normalize > Fade in/out 
This function allows sample ranges to be faded in or out. The amplitude is varied 
according to time characteristic from the beginning start value to the range's final end 
value. When the function is activated, a window appears to specify the operations's 
parameters. 

A simple fade-in operation would be performed with the parameters from 0% to 
100%, whereas normal fade-out requires specification from 100% to 0%. Of course, 
you can also try other values to achieve interesting results. The transitions can be 
created with different curve types, from logarithmic to exponential. 

Please note that high-performance real-time fade and crossfade options exist in 
virtual projects, which normally eliminate the requirement of using destructive fade 
routines. 

Key:  F 
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Amplitude/Normalize > Set zero 
Sample data values in a selected range are set to zero to eliminate noise and 
imperfections in a sample (reversible). 
 

Dynamics 
Dynamics 
Fundamentally, the compressor is an automated, dynamic volume controller. The 
dynamics of a piece are limited, loud sequences remain loud, quiet sequences become 
louder. Compression is often used to add power to audio material or to increase the 
loudness. The level of compression is adjusted by the ratio controller, while the 
activation threshold is determined by the threshold. You can also influence the attack 
and release. 

Editing is carried out using a “look-ahead” method, similar to high-quality studio 
appliances. There are no peak over-modulations or other artifacts, as the algorithm 
can never be ‘surprised’ by sudden level peaks. 

 

Sensor field: You can intuitively influence  the sensor field  of the compressor with 
mouse movements. The graphics  color and the respective effect settings change in 
response to each other. 

Ratio: This parameter controls the amount of compression. 

Threshold: Set the threshold, above which compression is applied. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short attack 
times can create an undesirable "pumping" sound, as the volume is quickly reduced or 
increased correspondingly. 

Release: Sets the algorithm's reaction speed to falling sound levels. 

A/B: If you have selected a preset for the effect and make manual changes to it later, 
you can compare the original preset sound with the new settings by using the A/B-
button. 

Reset: This resets the effect device to its original neutral starting point where minimal 
processing power is required and no effect is added to the sound. 

Load/Save: Here you can save the current settings as an effect file so that they can be 
used on other projects as well. 
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Multimax 
MultiMax is a compressor with three independent frequency bands. The dynamics 
are edited separately for each band. 

The benefit of a multi-band compressor in comparison to a "normal" compressor is 
that the "pumping" tendency and other disturbing side effects are dramatically 
reduced when editing the dynamics. For instance, it can prevent a bass top peak from 
"reducing" the entire signal. 

Multi-band technology also lets you specifically edit individual frequency ranges. 

 

Link bands: When this function is activated and one fader is adjusted, all faders are 
changed in the same ratio. However, the way the dynamics are edited is not affected. 

Limiter: MultiMax includes a limiter that prevents clipping by automatically lowering 
the level if it is set too high. Quiet parts remain unaffected.  

High quality: When the "High quality" setting is activated, an even more precise 
algorithm is used which, however, requires more processing power. We recommend 
that you switch on this setting before you export the project. 

Bass/Mid/High: These knobs control the level of compression for each frequency 
band. 

Setting the frequency bands: The settings of the frequency bands are changed 
directly in the graphic. Simply click on the separator lines and move them. 

Presets 

In MultiMax, you can use the presets to open further special functions: 

Dynamic expander: Too high a compression rate will result in audible noise (usually 
defined as a pumping sound). Radio recordings in particular are recorded with very 
high compression rates to increase the perceived volume. Unfortunately compression 
reduces the dynamics (interval between the quietest and loudest part). The expander 
enhances the dynamics of the recording. 

Tape NR-B Decoder: Samplitude Music Studio 2013 simulates decoding of Dolby B + 
C noise suppression if no Dolby player is available. Cassettes recorded with Dolby B 
or C sound more muffled and slurry if played back without corresponding Dolby.  
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Noise Gate: This cleaning function completely suppresses noises which are below a 
certain volume threshold. This lets you create song transitions that are entirely noise-
free, for example. 

Leveler: This setting automatically sets the entire material to an identical volume 
level. The volume control knob is no longer required. You can use this function to 
equalize greater volume differences within a song. To equalize volume variations 
between different songs, you can also use the function "Loudness adaptation" from 
the Effects menu. 

DeEsser: These special presets are for removing overstressed hiss sounds from 
speech recordings. 
 

AM-Track SE 
This familiar and high-quality vintage compressor offers a combination analog 
compressor and tape simulator. High-quality tape machine sound emulation makes 
typical aspects of the large, saturated sound characteristics of magnetic recordings a 
digital-quality reality. 
 

efx_Compressor 
The (essential) eFX Compressor (view page 129) is a simple, efficient tool for 
reducing dynamics with soft characteristics and adaptive control processing. It is a 
very musical compressor. 
 

Frequency/Filter 
Rack EQ 
The 10-band equalizer subdivides the frequency spectrum into ten areas (‘bands’) and 
equips them with separate volume controls. This way it is possible to create many 
impressive effects, from a simple boosting of the bass to complete elimination of a 
certain range of frequencies. Note: If low frequencies are boosted too much, the 
overall sound level is heavily increased which may lead to distortion. In this event, 
adjust the overall volume downward by using the "master volume" control situated in 
the main screen. 

 

Slider controls: Each of the ten frequency ranges can be separately boosted or turned 
down with the ten volume controls. 
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Link bands: Using this button flexibly combines the frequency ranges with each other 
to avoid artificial-sounding overemphasis of an individual frequency range. 

A/B: If you have selected a preset for the effect and make manual changes to it later, 
you can compare the original preset sound with the new settings by using the A/B-
button. 

Reset: This resets the effect device to its original neutral starting point where minimal 
processing power is required and no effect is added to the sound. 

Touch screen (right EQ section): This is the "sensor field" of the EQ. Here you can 
draw any type of curve with the mouse. This will be immediately translated into a 
corresponding control setting on the left side of the EQ. 
 

Parametric EQ 
This menu opens the Equalizer (view page 102). 
 

Vintage Filter 
Opens the Vintage Effect Suite Filter (view page 110)=. 
 

Delay / Reverb 
Delay/Reverb 

 

The reverb effect device offers newly developed and very realistic reverb algorithms 
to add more room depth to your recording. 
 

Reverb 
Reverb gives you a high-quality reverb which can be specified further using the “Room 
Size”, “Time” and “Color” and mixed into the original sound with “Mix”. 

Room size: This controller controls a room simulator, which calculates the reverb 
effect according to the room size. If the controller is turned all the way to the left, then 
it sounds as if the audio object was recorded in a very small room. If it is turned all the 
way to the right, it sounds as if the audio object was recorded in a cathedral. 

Time: This is where you set the reverb tail's length, i.e. the sound's "sustain" level. 

Color: Control the sound of the reverb here,  dampen or brighten it. 
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Mix: This controller determines how much of the unprocessed original sound (dry 
signal) is subjected to reverb (wet signal). Application of this effect in an AUX bus 
requires the controller to be set to 100% (all the way to the right). 
 

Delay 
This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the left, 
there is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). Application of this effect in an AUX bus requires 
the controller to be set to 100% (all the way to the right). 
 

Room Simulator 
This function lets you add a high-quality room simulator to the audio material. 

 

Reverb type: Here you can choose between a short, medium and long sustain. 

Reverb share: Here you can set the balance between the original signal (without 
reverb) and the actual reverb. 

Preview: This button activates the preview function. A short reverb section is 
calculated and then played so that you get an impression of the settings. 
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eFX_StereoDelay 
Opens the Stereo Delay (view page 125) in the essential FX (view page 119). 
 

Vintage Delay 
Opens the  Vintage Effect Suite Analog Delay (view page 107). 
 

Time / Pitch 
Resample / Timestretching 
Opens the timestretching/resampling/pitchshifting editor. 

Note: If you only want to change the sample rate of an audio file, then use the 
"Adjust sample rate" option from the "Effects" menu. 

 

All algorithms in this dialog use the time factor parameter and pitch as input 
parameter.  

The time factor calculation (from the original length/original speed and the length 
required/speed required) can be comfortably activated on the right side of the dialog. 
 

Resampling 
Samplers and PCM synthesizers transpose samples during this procedure. Time 
factor and pitch are dependent upon each other; the shorter the audio material, the 
higher the pitch. This effect is comparable with changing the play back speed of 
record players or tape recorders.  

The effect is relatively loss-free, and the sound loss is less than all 
timestretching/pitchshifting procedures. If pitch change is justified by changing the 
speed (and vice versa), use this algorithm. 
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When lengthening the audio material by resampling, very small aliasing effects may 
occur. The anti-aliasing filter helps correct this. Alternatively, since this filter creates 
additional CPU load, it can be activated for computation and real-time previewing. 
The filter is also available for the other algorithms that use internal resampling during 
pitchshifting.  
 

Default 
"Standard" applies an algorithm which usually delivers very good results, including 
factors from 0.9 to 1.1, and operates in phase-locked mode to maintain the room 
effect of stereo signals. For drum loops or other "beat heavy" material, this algorithm 
is only partially suitable, since it can change the groove and even fade out or double 
beats in rare cases. 

Time compression (sample length is reduced) is more successful with this algorithm 
than timestretching, i.e. it is better to reduce the longer sample than vice versa when 
adjusting two samples to another. 
 

Smoothed 
A considerably more complex algorithm is used which requires more processing time. 
The material can now also be used on very large factors (0.2 - 50) without bringing 
about strong artifacts. The material is "smoothed", making the sound softer and 
emitting it at an adjusted phase level. This smoothing is hardly audible with speech, 
singing, or solo instrumentation. Problems may arise with more complex spectra 
(sound mixes from various instruments or finished mixes). This algorithm is not very 
well suited to drum loops and other material with strong transients. The groove 
remains intact, but the attacks are slurred because of phase shifting. With small 
corrections (factor ca. 0.9 - 1.1) the setting of the smallest possible smoothing value 
should be used.   

Recommended for: 

• Orchestra instruments: String instruments, wind instruments, etc. 
• Speech, single voice, and multi-voice sections 
• Speech with background noise like video sound, etc. 
• Synthesizer areas, guitars, etc. 

Not suited for: 

• Stereo mix 
• Drum loops, percussion 

CPU strain: very high 
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Beat marker slicing 
This mode focuses on customizing drum loops, but can also be used on other material 
like monophonic bass runs or sequencer lines. The algorithm splits the material into 
individual components, individual notes, or beats, which are then selected via the beat 
marker. 

These "snippets" are then compiled into the new temporal measure. If the tempo is 
increased, then individual beats begin overlapping; if it is slowed down, then short 
pauses between the beats become audible. 

If this algorithm can be used, then it should be, since the time change occurs without 
any loss of quality at low CPU strain. 

Recommended for: 

• Samples which can be split into individual notes or beats. 
• Drum loops, if the beats do not overlap and there is not much reverb. 

Definitely not suited for: 

• Everything else where beat markers do not exist; the algorithm fails completely 
and silence is the result. 

CPU strain: minimal 
 

Beat marker stretching 
This algorithm functions similarly to the standard algorithm. Unlike the previous 
algorithm, this one synchronizes the stretched material with the beat markers. The 
groove remains perfectly intact, and duplicated or faded-out beats do not occur. 
Unlike the "Beat marker based slicing" algorithm, this algorithm doesn't fail fully when 
there are no markers, or when the markers are placed incorrectly, but the 
synchronization quality may be reduced or contain errors. In practice, automatic 
marker generation is usually enough for good results. You should avoid having beat 
markers which follow one another very closely (<1000 samples). 
 

Monophone voice 
This is a special timestretching and pitchshifting function for vocal solos, speech, or 
solo instruments. The material cannot contain background noise, and excessive 
reverb may also be detrimental to its effects. With suitable material the audio quality 
is very high. 

With the "Use formant correction" option the formants remain the same when 
pitchshifting, i.e. the "Mickey Mouse effect" does not occur. This way, realistic 
background choirs can be "composed" from just one solo voice. However, the 
formants can be shifted by +/- 12 half tones, and vocal distortions can result.  
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Typical usage of this algorithm: 

• Intonation correction: The note with the imprecise pitch should be cut out as an 
object, so that it can be manipulated independently of the other notes. 

• Harmonizer effects: An object with vocals can be copied and moved down. If the 
pitch is changed, then the second voice will be changed, etc.  

• Generating background vocals from existing vocal samples 
• Timestretch/Distortion of a speech sample, to make a "grandfather" voice. 

Recommended for speech, single voice vocals, single voice instruments without 
overlapping, with low reverb and low background noise. 
 

Elastic Audio easy 
Opens the Elastic Audio Easy dialog (view page 144) to edit monophonic material and 
to create harmonic voices. 
 

Distortion 
Vintage Distortion 
Opens the Vintage Effect Suite distortion effect (view page 114). 
 

Vintage BitMachine 
This opens the BitMachine (view page 115). 
 

Vandal SE 
Vandal SE is a high-quality guitar amplifier simulation that will raise the heart rate of 
any guitar fan! 
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Restoration 
Declipping 
Samplitude Music Studio 2013 contains a special function for removing digital 
clipping and analog distortions. Who isn't familiar with this situation? You've got a 
flawless live recording, but the decisive sections are overmodulated, rendering the 
recording useless. 

 

Using sophisticated algorithms, the overmodulated passages are interpolated based 
on audio material surrounding the clipping area. The entire volume of the material can 
then be reduced so that the interpolated parts can be played back without 
overmodulation. The De-clipping algorithm is particularly suitable for audio material 
with clearly audible overmodulation, e.g. distorted piano or vocals. The sound of 
overmodulated drumbeats on the other hand is hardly ever improved upon. 

Min. level of clipped samples: Here you can enter the level at which the algorithm will 
consider a sample to be clipped and correct it. This is important, as different sound 
cards show different clipping behavior. Some DAT recorders have a protective analog 
switch, so that the level never reaches the digital mains. In this case, a value of -0.5 
dB or less is suitable. 

With an input of, for example, -6dB, all samples above half the control level are 
registered as overmodulated and recalculated. 

This way, material damaged by analog means can also be repaired. 
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Remove DC offset 

 

This function removes the DC offset of an object. This can be useful if your sound 
card overlays your sample with a constant DC offset during recording, which leads to 
crackling during playback or editing. 
 

Stereo / Phase 
Switch channels 
This function switches the left and right stereo channels.  

This is useful for correcting recordings with switched channels. This function can be 
reversed if you don't re-select the range; opening it again will bring back the original 
material.  
 

Rack Multiband Enhancer 
The Enhancer enables the justification of the audio material in the stereo panorama to 
be adjusted. If the stereo recordings sound unfocused and undifferentiated, an 
extension of the stereo base-width can often provide better transparency. 
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Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the complete 
panorama. The reduction of left and right levels is displayed under the control 
buttons. 

Pan-direction: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme 
left), unchanged base width (normal stereo), and maximum base width (wide, 
extreme right). Raising the bandwidth (values over 100) diminishes the mono 
compatibility. This means that recordings edited this way sound hollow when listened 
to in mono. 

Maximize strengthens the spatial component of the recording, which also increases 
the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to review the orientation of the signal in the 
stereo balance and the effect of the stereo enhancer. To maintain mono-compatibility, 
the "cloud" shown should always be higher than it is wide. 
 

Invert phase 
The sample data is inverted along the amplitude axis, which means that negative 
values become positive and vice versa. This function allows you to adjust recordings 
with different phases to one another. 

An incorrect phase occurs if during an analog recording parallel cables are switched. 
To correct such errors, some mixers have a switch that can be used to invert the 
phase of an input. If you press the switch by mistake, errors might occur as well. 

This function is reversible, so if you repeat it, the original signal is restored. 
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Modulation / Special 
Vocoder 
The vocoder principle: Carrier material (e.g. a surface sound or a synth chord) is 
affected by a modulator (e.g. language or singing) so that one gets the impression 
that it is speaking or singing. Rhythmic surface sounds can also be developed if 
modulated with a drum loop.  

This is done via the transmission of the frequency characteristics of the modulator 
(speech) on the carrier (chord).  

  
 

Carrier input 
Here you have to select the desired carrier sample. Some special carrier samples that 
have been loaded automatically from the "Vocoder" directory are listed. 

 Use the "Carrier sample" check box to load any number of samples of 
the current project or predefined carrier sample. 
Here you can play the carrier on its own for test purposes. 

Noise: This controller lets you add noise to the carrier sample. This makes sense if the 
carrier material can not be modulated sufficiently or is irregular. It's good for "filling" 
drum loops which have too many pauses between the beats. 

Material containing all frequencies in equal amounts are particularly suitable, such as 
strings, orchestra chords, broad synthesizer pads, hissing, or wind noise. 
 

Filters 
Dyna: Influences the dynamics of the modulator signal to reduce the modulation 
depth of the vocoder.  

This prevents two often undesired side effects of modulation: On the one hand the 
volume change of the modulator signal is added to the output signal in a slightly more 
moderate form, which may improve the power of the Vocoder voice. On the other 
hand the low-level portions of the modulator signal are ignored in order to prevent 
modulation of the carrier by breathing or noise. 

Smooze: Influences the speed of adjusting the vocoder to the modulator spectrum. As 
this value increases the vocoder starts to follow the modulator more slowly resulting 
in softer, reverberated sound changes in the carriers. 
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Filter graphic 

 

As with the freely definable filters, here you can also draw any frequency progression 
you want in order to optimize the vocoder output. For example, you can get rid of 
disruptive bass frequencies by adjusting the curve downward in the left area. Or you 
can boost weak highs by adjusting the curve upward in the right area. 
 

Mixer 

 

In the Mixer you can also mix parts of the carrier and modulator 
signal to the vocoder output signal (Out).  

If the output signal of a track is used as a carrier in the vocoder, 
this track will first be muted. In the vocoder mixer you can then 
make it audible again. 
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Presets 

 

In the "Preset" menu you can select predefined vocoder settings. You can save your 
own settings by clicking on the "Save" button. Your own saved presets will also 
appear in the selection menu. 
 

eFX_ChorusFlanger 
This opens the Chorus/Flanger effect in the essential FX. 
 

eFX_Phaser 
Opens the Phaser in the essential FX. 
 

eFX_Vocalstrip 
Opens Vocal Strip (view page 127) from essential FX. 
 

Vintage Chorus 
Opens the  Vintage Effect Suite chorus (on page 112). Chorus is one of the most 
familiar and popular effects. 
 

Vintage Flanger 
The Flanger (view page 109) is a relatively unknown effect, but it is useful in many 
areas and is an indispensable part of the Vintage Effect Suite. 
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Vintage Tape Simulation 
Using Tape Simulation you can give digital recordings the missing warmth of the tape 
saturation effect produced by analog equipment. 
 

Reverse 
The sample data in the selected range is reversed along the time axis, i.e. the file will 
now play backwards with the end placed at the beginning. This can create very 
interesting effects, not to mention hidden messages frequently rumoured to be in 
various songs.... 

This function is reversible: if you do not select a new range, activating this function 
again resets the original material. 

The option is only available when working in destructive editing mode, i.e. on an HD 
wave file directly. 
 

Sample manipulation 
Change sample rate 
Use this function to change the sample rate of a whole audio file. This may be needed 
to convert a DAT recording at 48 kHz to 44.1 kHz for use on an audio CD. 

 

After choosing the new sample rate you can select a file name for the new project. 

If the resolution is increased the sample rate change will take place without any 
quality loss, and the sample material will not experience fidelity reductions, but the 
required hard disk space will increase. 

If the resolution is reduced, then the overtones or high frequencies may be lost during 
the sample rate change. For example, if the resolution of a 44.1 kHz sample is reduced 
to 22.05 kHz, the frequency response of the resulting sample is reduced to 11.025 
kHz. The frequency response is always half of the resolution specified. For a 
conversion from a 48 kHz sample to 44.1 kHz, this loss in quality is not significant, 
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since the human ear only recognizes frequencies up to 20 kHz. (A resolution of 48 
kHz is often only used because the digital to analog conversion can take place with 
much higher precision without a lot of effort.) 

Please note that resampling to 44.1 kHz can also be done while recording in real-time. 

The "Playback parameter" window ("P") contains a "Vari-speed" option for real-time 
resampling during playback. The "Record" window ("R") lets you resample to 44.1 
kHz in real-time from any of the selected sampling rates. 
 

Reverse 
The sample data in the selected range is reversed along the time axis, i.e. the file will 
now play backwards with the end placed at the beginning. This can create very 
interesting effects, not to mention hidden messages frequently rumoured to be in 
various songs.... 

This function is reversible: if you do not select a new range, activating this function 
again resets the original material. 

The option is only available when working in destructive editing mode, i.e. on an HD 
wave file directly. 
 

Build physical loop 
This function utilizes a complex algorithm for optimizing loops in wave projects. It is 
useful when samples are to be used for instrumental sounds as well as the wave table 
synthesizer. 

Before you can process a sample you need to select a range in your sample that 
already defines the rough edges of the sample loop. Remember that you can shift and 
vary a range during playback to find the best loop position. A comfortable way to look 
at the loop positions is by activating the split range mode (“B”). The sample will be 
displayed in 3 sections. 

To gain an interruption-free loop, the outer limits of the range will be set to zero. By 
applying a crossfade to the material at the loop end containing the sample data in 
front of the loop beginning, Samplitude Music Studio 2013 will create a "smooth" 
transition between loop's end and beginning. 

When a marker is set in front of the selected range, the range between the marker 
and the beginning of the loop will be used for the crossfade. This offers you a feature 
found in professional hardware samplers. To achieve a short crossfade set the marker 
close to the loop beginning. To receive a long crossfade position the marker further 
away from the loop beginning. 

Notice that the distance between marker and beginning of the loop range needs to be 
smaller than the loop range itself to make a crossfade possible. 
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Plug-ins 

 

This dialog allows you to use Microsoft DirectX and VST-compatible plug-ins for 
effects calculation in Samplitude Music Studio 2013. This allows you to use almost 
any effect algorithms of third parties in addition to the effects integrated in 
Samplitude Music Studio 2013.  

Samplitude Music Studio 2013's mixer enables plug-ins to be integrated as real-time 
effects. The plug-ins must be able to process audio data blocks instantly and 
completely without changing the length. This is normally the case for most plug-ins 
(e.g. reverb, echo, dynamic compressors, etc.). Other algorithms are excluded here 
(e.g. timestretching plug-ins because of the resulting length-changing effect). 
 

Working method and use 
When you open the plug-ins dialog you will see a list of the DirectX and VST 
compatible plug-ins that are installed on your computer on the right-hand side. 
Activate one of them and press the arrow in the middle; the activated plug-in is 
transferred into the list of active plug-ins to the left. The surface of the plug-in is also 
opened to make specific changes to the effect settings. You can set up a chain of 
effects in this way, but it is important to ensure that the plug-ins are all compatible 
with one another. For instance, stereo and mono plug-ins must not be coupled 
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together. The plug-in selected in each case in the list on the left can be deleted again 
with the “Remove” button. 
 

Dialog buttons 
Save/load: The two buttons in the upper right of the dialog field enable a complete 
plug-in setup (the sequence of plug-ins and all their set parameters) to be entered 
and saved. Plug-in setups can therefore be conveniently transferred if different 
options for plug-in use in Samplitude Music Studio 2013 are used. 

Copy/paste: Entire plug-in configurations can be transferred between different tracks 
and objects.  

Play/stop: This button activates the real-time preview of the active plug-in listed on 
the left. This function is ideal for testing the settings of a plug-in if it operates quickly 
enough for real-time calculation. 

Settings: Opens the following dialog... 
 

DirectX / VST plug-in set-up 
• The “Write DirectX logfile” option only serves support purposes and should 

normally be switched off.  
• The “Start all object-related plug-ins” option can be activated at play/start. Some 

plug-ins cause delays when switched on, and in this case they should be switched 
on at play/start, because otherwise there could be a failure when the relevant 
object starts to play. 

• Deactivate all DirectX effects during the scrubbing/jogging: Under certain 
circumstance DirectX plug-ins can cause errors during the scrubbing/jogging or 
simply break down. With this option the link to the DirectX plug-ins can be 
deactivated and thus circumvented. 

 

essential FX 
MAGIX essential FX is a collection of "bread and butter effects" for the most 
important applications. They are embedded as VST plug-ins (MAGIX plug-ins 
directory) and may be used in the object or in the track. For object application, see 
"FX plug-ins" in the "Audio effects" chapter or "Track effects" in the "Mixer" chapter. 

These are simple but solid tools with clear feature sets for daily application. They 
include fewer controllers and require less resources. 
 

eFX_ChorusFlanger 
This opens the Chorus/Flanger effect in the essential FX. 
 

eFX_Phaser 
Opens the Phaser in the essential FX. 
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eFX_Vocalstrip 
Opens Vocal Strip (view page 127) from essential FX. 
 

eFX_StereoDelay 
Opens the Stereo Delay (view page 125) in the essential FX (view page 119). 
 

efx_Compressor 
The (essential) eFX Compressor (view page 129) is a simple, efficient tool for 
reducing dynamics with soft characteristics and adaptive control processing. It is a 
very musical compressor. 
 

MAGIX Plug-Ins 
AM-Track SE 
AM-Track SE is a combination of an analog compressor and a tape simulator. This 
professional plug-in lends more power and vitality to your audio material. 
 

Vintage Chorus 
Opens the  Vintage Effect Suite chorus (on page 112). Chorus is one of the most 
familiar and popular effects. 
 

Vintage Flanger 
The Flanger (view page 109) is a relatively unknown effect, but it is useful in many 
areas and is an indispensable part of the Vintage Effect Suite. 
 

Vintage Delay 
Opens the  Vintage Effect Suite Analog Delay (view page 107). 
 

Vintage Filter 
Opens the Vintage Effect Suite Filter (view page 110)=. 
 

Vintage Distortion 
Opens the Vintage Effect Suite distortion effect (view page 114). 
 

Vintage Tape Simulation 
Using Tape Simulation you can give digital recordings the missing warmth of the tape 
saturation effect produced by analog equipment. 
 

Vandal SE 
Vandal SE is a high-quality guitar amplifier simulation that will raise the heart rate of 
any guitar fan! 
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Waveform Generator 
This menu entry opens the Waveform Generator (view page 285). 
 

SMPTE Generator 
This menu entry opens the SMPTE Generator (view page 306). This serves to create 
SMPTE timecode, which allows you to synchronize external, analog material. 
 

Process only left (right) stereo channel 
Only the left/right channel of a stereo wave project will be affected by effects when 
”Left/Right processing only” is activated. This options is only available when in wave 
editing /destructive editing mode. 

The same effect have the L/R buttons in the lower left corner of the wave project 
window.   
 

Process Effects Offline 
All effects opened using this menu are calculated destructively, provided the option 
"Apply effects offline" is active. The option to work with a copy is available in order to 
preserve the original audio material. The "Create copy" option is already selected in 
the corresponding dialog. 
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CD menu 
The CD menu contains all special functions for audio CDs and CD mastering 
processes, e.g. setting CD tracks and subindexes as well as the "Create CD" function. 
The options at a glance: 
 

Load audio CD tracks 
This menu entry opens the dialog for loading audio CD tracks (view page 282). 
 

Make CD 
This opens the dialog for burning audio CDs (view page 279). 
 

Indices (Track markers) 
Set CD title index 
Use this function to set a track marker at the position of the play cursor (index 
makers). The numbers of previously set markers are adjusted automatically. Each title 
of a CD requires a track marker, which is typically placed shortly before the track 
starts. 

Use the function "Set Track Indices on Object Edges" to create a track marker 
automatically at each object in the virtual project. 

To manage the markers or rename them, use the "CD track/index manager (view 
page 426)". 

Shortcut:  Ctrl + Alt + I 
 

Set CD Sub Index 
Choose this option to place a sub-index marker at the current play cursor position. 
The numbers of the subsequent sub-index markers are customized automatically. 

Sub-index markers are not required for CD creation, but they allow CD players to cue 
to specific points within an audio track. 
 

Set CD pause index 
The CD pause index is a special Sub index (Index 0). Choose this option to place a 
pause marker at the current play cursor position. 

Pause markers allow CD players to switch their output to absolute silence until the 
next Track Marker. and to count backwards to the start of the next track. 
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Set CD End Index 
This command marks the end of the CD. Setting an end marker corresponds with two 
main applications: 

1. It may be the case with some projects that the last object reverberates after its 
actual ending. To prevent Samplitude Music Studio 2013 from cutting this section of 
audio during burning, you can place the CD end marker at an appropriate distance 
after the last object. 

2. If you only want to burn a project partially to a CD, place the first track marker at 
the desired position in the arrangement and mark the end of the burn process with 
the CD end marker. Remove all track markers prior to the first track to be burned and 
then set the end marker after the last track to be burned. 
 

Set track markers automatically 
If you are inserting a larger audio file which contains various titles (for example a live 
take, or recordings on DAT), then you can automatically insert track markers between 
the titles using this function. 
 

Set track indices on object edges 
This function sets track markers (Index markers) automatically at the beginning of 
each VIP object in the first VIP track. 

Prior to using the function, execute "Remove all indices" to delete any possible track 
markers. 

If there are multiple objects that make up a single track or title, then you may want to 
use the "Bouncing" function to combine the objects to ensure proper track 
assignments. 
 

Set Track Indices on Object Edges - Options 
Set also Pause Indices on Object Ends 
This option automatically generates pause markers at the object ends. This option 
allows you to set an offset for the generated track markers. 
 

Time Offset for Indices on Object Edges 
This dialog provides options for adding an offset before the object edges when placing 
indices. 
 

No indices on Object Crossfades 
This option prevents track indices from being placed between objects that are 
connected by a crossfade. 
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Remove index 
Use this function to remove a previously set track or subindex marker. First, click on 
the marker (the small rectangle below the number), and then activate this function to 
delete it! 
 

Remove All Indices 
Choose this option to delete all previously set track and sub-index markers. 

Shortcut:  Ctrl + Alt + Shift + I 
 

CD track/index manager 
This dialog displays all the CD tracks and sub-indices in the current project in a list. 

When you select markers, you can enter 
their position numerically in the Track start 
field. 

For every track you can also enter 
metadata (track name, artist, album, year, 
genre). These are used during e. g. during 
export to MP3 files and can be burned as 
CD text to a CD.  

New: By clicking the corresponding button 
you can set new CD tracks, CD sub-indices 
and CD pauses. 

Delete selected: Deletes the selected 
markers. 
Delete all Markers: Deletes all markers. 
Play Marker: Starts playback from the 
position of the selected marker. 
Play Loop: Plays a loop around the marker. 
Stop: Stops playback. 
OK: Applies your settings. 
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CD disc options 
This dialog configures settings for the current CD.  
 

CD title 
The title is written to the CD and is used in the TOC printer application to print the 
CD information. 
 

Number of first CD track 
Under certain circumstances, such as writing with "Track-at-once", the number of the 
first track can be determined with this setting. When using the "Disk-at-once" mode, 
this setting does not have any significance. The CD will always start with track 1 in 
this mode. 
 

Set pause time 
Use this function to set the length of the default pause between two tracks. The pause 
length is needed for the grid function which lets the sample objects snap to the edges 
of other objects + this pause time. Normally a pause time of 2 seconds is used. 
 

CD arrange mode 
If you activate this menu feature, Samplitude Music Studio 2013 will arrange the next 
objects introducing a Red Book-standard pause between them.  

The following procedure highly recommended: 

• Open a new VIP with 4 tracks (for example), so that you may reedit it later on 
• Activate the "Special CD arrange" mode in the CD menu 
• Load wave files, audio tracks, or make a recording using the microphone 

You will notice gaps in the VIP between the individual objects; these represent the 
inserted breaks. You can adjust the length of the included pauses in the adjust pause 
length dialog, if you want. 
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Get CD info (freeDB Internet) 
Select this option to request freeDB information for an audio CD. This function 
requires an Internet connection. You must be registered to use the freeDB features. 
 

freeDB options 
Submit CD to freeDB 
Allows you to add a CD to the online CD database. The freeDB project relies on user 
contributions to keep an updated database available. 

If you own a CD that’s not in the database, you may add it to the database.  

• Insert the CD in the drive 
• Select “Add CD to freeDB” 
• Enter data in the dialog. Please double check your data. 
• Press “OK” 
• Your contribution should be online after an hour or two 
 

Clear freeDB cache 
The freeDB online database assigns a cache to your hard disc containing all files that 
can be read online . This allows you to read files without having to go online. This 
option allows you to delete the cache.  
 

Show CD-R drive information 
This dialog shows you information about the active CD-R drive(s). Among the 
information displayed is the manufacturer, drive name, hardware revision, cache size, 
and the features supported by the drive mechanism. 

The “Disc at once” feature is extremely important, since it is needed to produce Red 
Book compatible audio CDs that are accepted as masters by pressing plants 
 

Show CD-R disc information 
This dialog shows information about the currently inserted CD-R media. The most 
important information is the maximum length that cannot be exceeded during the 
production (i.e. 74 minutes and 5 seconds). 
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audioid 
It's possible to identify audio files with this function. In contrast to freeDB (view page 
428), the audio file does not need to be a part of an album or CD, and it doesn't even 
need to be played back completely. 

Samplitude Music Studio 2013 analyzes typical sound characteristics of a song or part 
of a song and sends this data as a query to the Internet server. The server compares 
this "acoustic  fingerprint“ with saved information about already known songs and 
then provides the required song information. 
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Menu view 
This menu contains tools for manipulating Samplitude Music Studio 2013's display. 
 

Mixer 
Opens the mixer. Please refer to the "Mixer" chapter! 

Key:  M 
 

Multitrack recorder MR-64 
This menu entry opens the multitrack recorder (MR-64). The multitrack recorder 
(MR-64) looks like a hardware mixer and can also be operated in the same way. In 
contrast to earlier mixers, now it can be opened using the "View" menu in order to 
conduct multi-track recordings just like with a real mixing board. The MR-64 unites 
the advantages of the analog look with digital technology: realistic appearance, direct 
workflows, and familiar functionality. 

Keyboard shortcut:  Shift + M 
 

Mastering Suite 
This opens the Mastering Suite (view page 102). 
 

Transport control 
The transport control window contains the most important commands for playback, 
recording, and positioning. 

"Start", "Stop", "Forward", and "Rewind" buttons: These allow positioning similar to 
that of any audio player. 

Right clicking the "Playback" button opens the playback parameter window for the 
stereo master operation. This lets you determine the sample rate, playback device, 
and the scrubbing/varipitch options. 

Record: Starts recording for all active tracks. This means that tracks with the red REC 
button enabled need to be configured with the proper recording devices prior to 
starting the recording. Right click on the REC button for each track to select the 
device. 
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Right clicking "Record" displays the record parameters window. This lets you make 
settings such as "Playback during recording", and also lets you record material directly 
from the record parameter window. 

Time display: This displays the current playback position of the project. Double 
clicking on the window lets you numerically enter a new playback position. Clicking 
the green arrow lets you set various units of measurement. 

L/R time display: This displays the length of a selected range and is editable by 
double clicking the display. 

Marker 1-12: Clicking on one of the marker buttons saves the current playback 
position to the button. If it already contains a previously saved position (marker 
appears in light color), the program will place the playback position to the saved 
position. A right click clears the button memory and allows you to store a new 
position to the button. 

Marker: This button open the marker manager for more detailed marker editing. 

Punch: This button switch Samplitude Music Studio 2013 into punch record mode. 
This means that the recording process can be started any time during playback. This 
is also called "On-the-fly recording". This can be repeated numerous times. Punch-in 
and out markers are set automatically. You can stop a punch in recording process 
with another click on the record button. However, this does not stop the playback of 
the project. 

Punch in: This sets the punch in position. 

Punch out: This sets the punch out position. If the both the punch in and punch out 
markers are set, the punch recording can be started with the "Playback" button. The 
program will play back the project until it reaches the punch in point. 

Sync: This button opens the synchronization window. 

Loop: The loop button activates loop mode, meaning that playback continues to loop 
through a previously selected range. 

RCMON: This button activates Samplitude Music Studio 2013's "Record monitoring" 
feature. All tracks that have their REC buttons activated are monitored with the peak 
meters. The inputs of the audio device(s) are directly routed to the outputs of the 
sound card, if the sound card offers this functionality (check with your sound card 
manufacturer). This offers the same functionality as with audio players. 

Scrub >>  <<: These buttons allow you to scrub through your project. During 
scrubbing the playback of the project continues with varying speed while the playback 
direction can be changed. This also offers a convenient way of finding audio sections 
such as clicks or mistakes in the audio material. 
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Jog & shuttle wheel: The transport control includes a jog & shuttle wheel which you 
can use to "scrub" over the files. The "Scrubbing" function behaves like the editing 
function of an audio player. The motor is switched off, the tape, however, remains at 
the sound head. With a digital system it is more difficult to realize scrubbing as there 
are no mechanical moving parts. Turning the tape reels manually moves the material 
slowly along the player. Using the scrubbing function in Samplitude Music Studio 
2013 is similar to using a tape player, since playback follows the movement of the 
mouse. Quickly moving the mouse increases the playback speed, while slowly moving 
it decreases the speed accordingly. 

Tempo: In the tempo section of the transport console you can change the playback 
speed and the beat of the whole arrangement. All objects in the VIP are adapted to 
the speed of your choice with timestretching. 

"Tap tempo..." opens a dialog where you can "tap in" the beat by clicking on the "Tap" 
button, or by pressing the "T" key on your keyboard. 

In addition, you can fade in the bar grid with the "SNAP“ button and switch on the 
metronome click with the "CLICK“ button. 
 

Time display 
Shows or hides the time display window 

This lets you read the current position while externally synchronizing large sections. 
Fonts and colors of the display can be selected in the context menu (right click on the 
time display). 

In the context menu of the time display the number of lines/fields that are to be 
displayed can be set between 1 and 5. For each line/field the size that is to be 
displayed can be selected from the menu. 

Double clicking lets you edit the sizes (with the exception of the current mouse 
position and the current mixer value). 

The most important options: 

Position/Start of range: Displays the current position of the current play cursor, or of 
the beginning of the range. When moving the objects, you can see the starting 
position of the object here. Should you enter a negative number into the range when 
editing, the play cursor will be set to the end of the range. 

Range length: "Object -> Object Length; negative number" saves the end of the range 
instead of the start of the range. 

End of the range: "End of the object, negative number -> Start of the range". 

Current mouse position: Not editable 
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Current mixer value: Value of the mixer fader which was just changed, or the volume 
or pan fader in the VIP; not editable. 
 

Visualization 
The visualization screen displays the audio material graphically. You can integrate the 
visualization interface into the Docker or open it in its own window. 

You can choose between the following display options via the context menu: peak 
meter, oscilloscope, phase correlator, spectroscope, and spectrogram. 
 

Peak meter 

 

The peak meter provides an exact display of the volume level. 
 

Oscilloscope 

 
 

Phase correlation 

 
 

Spectroscope 
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Spectrogramme 

 
 

Tuner 
Tune guitars and other instruments with this option.  

 

It makes sense to use the tuner only when the visualization is opened from the 
recording window, since it is the input signal that should be analyzed. 

1.  Select the track to which you would like to record your guitar. 
2. Open the Recording options (view page 478) dialog. 
3. Make sure that the "Monitor" option is activated. At the least, the Software FX 

Monitoring (view page 391) mode must be used for acoustic monitoring. 
4. With the "Visual" button you can open recording visualization. As default, this 

window will open as a peakmeter to monitor the input signal. 
5. Right-click the visualization window and select "Tuner". 

 
In the middle you will see the note name of the pitch being played. A calibration mark 
shows the deviation of the played note from the right pitch, and red triangles to the 
right and left show whether the string should be tuned up or down. If the tuning is 
exact, the triangles turn green. By default, the tuner will try to recognize each note 
(display: "chromatic"). You can select the conventional tunings for guitars, basses and 
ukuleles from the list. Then, only the notes relevant in each corresponding tuning will 
be recognized. 
 

Export tool 
This menu entry opens the Export page (view page 30) for easily exporting the 
current project. 
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Managers/Docker 
Opens the docker which provides multiple Managers (view page 297) for different 
tasks. Visualization (view page 433), time display (view page 432) and transport 
console (view page 53) can also be integrated into the docker. The managers can be 
opened directly in the submenu "Managers". See also: Docking 
 

Manager 
Offers direct access to the various Samplitude Music Studio 2013 managers. 

Shortcut: 

File manager Ctrl + Shift + B 

Soundpool manager Ctrl + Alt + Shift + P 

Object manager Ctrl + Shift + O 

Track manager Ctrl + Shift + S 

Marker manager Ctrl+Alt+Shift+M 

Range manager Ctrl+Alt+Shift+B 

VSTi manager Ctrl + Shift + V 

 
 

Track editor 
This menu entry activates or deactivates the Track editor in the arrangement window 
in Samplitude Music Studio 2013. 
 

Rebuild graphic data 
Display inaccuracies after complicated sample processing can be fixed by using this 
menu option. The screen (window) will be cleared and redrawn to display the project 
properly. 
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Sections 
Samplitude Music Studio 2013 enables you to display one, two or three different 
sections of a wave project or a virtual project. 

In other audio programs, only one section of a project is usually shown. This is also 
possible in Samplitude Music Studio 2013, of course. If you select the option "View > 
Sections > 2", two project views, each of which can be worked in independently, open 
one under the other. It is for example possible to view the complete project in one 
section, while magnifying a certain area in the other. 

The "3 (sections)" mode can be especially helpful when searching for loop points. The 
upper large display shows the entire sample, while the two lower displays can be used 
to zoom in for setting loop start and end. 

If you wish to apply zoom commands to a section by using the position buttons 
(position bar (view page 61)) for example, it is necessary to specify the section 
beforehand for which the corresponding positioning is required. This happens by 
clicking on the right or lower scroll bars of the section. 
 

Hide submix / AUX buses 
This function lets you hide or minimize the tracks of the mixer buses. Please read the 
corresponding notes in the mixer chapter. 
 

Grid view 
Grid 
This function gives the project a coordinates grid with valid units. 

Shortcut:  ´ 
 

Grid lines 
Defines the type of grid used for the "Show grid" option. Choose from several line 
styles. 
 

Units of measurement 
In this submenu, you can adjust the various measurement settings. They will affect 
the start and length details of the current range in the project window, the grid 
measurement, and the position details of the play cursor (position line). 
Measurement units like samples, milliseconds, SMPTE (with different frame rates), 
bars, and CD-MSF are commonly used. 
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Snap active 
The grid can be activated and deactivated with this function. Virtual projects have an 
object grid. Here, objects can be moved only to the beginning, end or the HotSpot of 
another object. Normally, the front edge of the object to be moved is the reference 
point. As soon as a HotSpot is defined for an object, it will be taken into account. If 
several objects are selected, the orientation always takes place on the front edge (or 
on the HotSpot) of the object selected last (and located under the mouse cursor). The 
interval between projects remains constant, e. g. not all objects align on the grid! 
Using the "Grid according to objects" function, it is easy to rearrange audio patterns 
as you wish and still retain sample-precise cut positions. 

There are additional grid types for all project files. 

Grid on/off: 

Shortcut:  Ctrl + ´ 
 

Snap and Grid Setup 

Detailed information on snap and grid settings can be found under "File -> Project 
Properties -> Snap and Grid Setup (view page 332)". 

 

VIP display 
Definition 
Opens the general settings dialog in Design -> Display options (view page 469). 
 

Mode 1 
Mode 1 has been selected for displaying virtual projects 
 

Mode 2 
Mode 2 has been selected for displaying virtual projects 

This mode also includes an enlarged display of volume and panorama points, and you 
can quickly switch between normal and enlarged display modes with "Tab". 
 

Change mode 
Switches the display of virtual projects between both modes. 

Key:  Tab 
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Overview mode 
This mode provides navigation and overview in the arrangement. The actual 
arrangement window displays an overview of the arrangement. Selection matches the 
section which can be seen there. 

Select a specific range in the overview and the corresponding section length in the 
arrangement will be zoomed into. Use the right mouse button to zoom in vertically. A 
single mouse click moves the visible section to the selected position. 

 
 

Horizontal 
This menu contains all the functions of the horizontal (red) position bar. 
 

Vertical 
This menu contains all the functions of the vertical (blue) position bar. 
 

Cascade 
This function arranges all open windows in a cascade style. 
 

Tile 
All open windows are moved next to each other, making use of the whole display 
area. This is useful when dragging physical sample ranges into VIPs. 

Keys:  Enter 
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Untile 
This function will return the window order to the previous state. 

Keys:  Shift + Enter 
 

Window 
Arrange icons 
All icons are rearranged along the lower portion of the screen. 
 

Close all windows 
Closes all open projects. A query will first ask you whether you would like to save the 
project first. 

Shortcut:  Ctrl + H 
 

Iconize all wave projects 
This function will reduce all wave projects to their icons to make room for the display 
of the virtual projects. 
 

Hide all wave projects 
This function will hide all wave projects to make room for the display of the virtual 
projects. 
 

Half height 
The Samplitude Music Studio 2013 screen is shown in the upper half of the display. 

This is particularly useful if you want to simultaneously use a sequencer program so 
that both programs are operated simultaneously, without having to switch between 
programs with "Alt + Tab". 
 

Toolbars 
Main toolbar 
Please use this command for hiding or showing the main toolbar (view page 59). Here 
you will find buttons for frequently used Samplitude Music Studio 2013 commands. 

A check behind the menu item indicates that the toolbar is visible. 
 

Position bar 
Shows or hides the positioning bar on the lower portion of the display. 
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Mouse mode toolbar 
Shows or hides the mouse mode toolbar with buttons to select different mouse 
modes in VIPs. 
 

Range bar 
Shows or hides the range bar on the lower portion of the display. 
 

Snap bar 
Use this command to hide or show the grid bar. 
 

Workspace bar 
Displays or hides the workspace bar at the bottom part of the screen. 
 

Tabs toolbar 
This toolbar contains buttons for the step-by-step mode (view page 21). 
 

Menu search 
This toolbar is a search field. Enter the name of the function you are searching for or a 
keyword that you need help with and Samplitude Music Studio 2013 will search for 
the corresponding function or help topic. 
 

Internet bar 
This toolbar enables access to Catooh, magix.info and MAGIX News Center. 
 

Status bar 
Shows or hides the status bar on the lower portion of the display. A tick behind the 
menu point shows that the status bar is visible. 

The status bar is located at the bottom of the screen and describes the current status 
of the program. 
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The "Share" menu 
The Share menu provides access to online social networks as well as transfer 
functions to other MAGIX programs. 

Here you'll find options for uploading individual objects in the arranger or files from 
the Media Pool as well as the entire arrangement, as audio or video. You can also 
transfer your arrangement to another MAGIX program (if it is installed) e.g. to use it 
as background music for your slideshow. 
 

Community upload 
The menu entries featured under "File" > "Export" >"Community upload" or via the 
Export assistant allow you to upload the finished song to different web communities. 
 

MAGIX Online Album 
Converts your project into an MP3 file and uploads it to your personal MAGIX Online 
Album. 
 

Upload song to Soundcloud 
Soundcloud is a community that is especially designed for musicians. The free version 
provides 120 minutes of storage space for your songs. Every song may be embedded 
as a player widget into external websites; the widget even allows comments along the 
timeline of the song and an optional download of the original song. 

For more information about the possibilities provided by the Soundcloud community 
and the different premium accounts see www.soundcloud.com 
http://www.soundcloud.com. 
 

Facebook 
Upload your arrangement to Facebook as a video. You need a Facebook account 
because you have to log in during the upload process. 
 

YouTube 
Upload your arrangement to Youtube as a video. You need a Youtube account 
because you have to log in during the upload process. 
 

E-mail 
Creates a file in Windows Media Format. Your email program is activated 
simultaneously and the created file is added to an opened message as attachment. 
Thus, any attachment can be compressed without intermediate steps and sent as an 
email immediately. 
 

http://www.soundcloud.com/�
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Use as background music 
Converts your arrangement into MP3 format and sends it to one of the specified 
programs, where it can be used as background music.  

• Video easy 3 SE 
• Video easy 3 HD 
• Movie Edit Pro MX HD 
• Movie Edit Pro MX Plus HD 
• Movie Edit Pro MX Premium HD 
• Photo Manager 10 
• Photo Manager 10 deluxe 
• Photo Manager MX 
• Photo Manager MX deluxe 

Note: This function is only available if you have at least one of the above programs 
installed.  

 

Add to music collection 
Converts your arrangement into MP3 format and sends it directly to a MAGIX music 
management program (e. g. MP3 deluxe MX), where it is added to an existing music 
collection.  

Note: This function is only available if you have installed an appropriate MAGIX 
program. 
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Help menu 

Help 
This command is available for almost every feature of the program, and it opens the 
"Help" file for the corresponding topic. Use this command to get help on any of 
Samplitude Music Studio 2013's functions. 

Keyboard shortcut: F1 
 

Help index 
Use this command to show the index of the help. From this page you can jump to 
specific commands or read through the instructions step by step. 
 

Context help 
Use this command to get help about any part of Samplitude Music Studio 2013. By 
pressing the "Context help" button in the top tool bar, the mouse indicator will 
become an arrow with a question mark. Then, click on any button or menu in one of 
the tool bars. Information about this topic will then be displayed. 
 

Open PDF manual 
Opens the manual in PDF format. 
 

Watch the introductory video 
Use this command to start the introductory video, which outlines the major functions 
of Samplitude Music Studio 2013 in a straightforward way. 
 

Online tutorials 
Opens the magix.info with online tutorial videos. 
 

About Samplitude Music Studio 2013 
Copyright notices and version numbers are displayed. 
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MAGIX auto-update 
Automatically searches the Internet for updates to Samplitude Music Studio 2013. An 
Internet connection must first be provided for this purpose. 
 

Open magix.info 
Directly from within the program you'll be able to access magix.info, the Multimedia 
Community from MAGIX. You'll find answers to all the most frequently asked 
questions about MAGIX products and multimedia in general. Were you unable to find 
a solution to your particular problem? No problem, just ask the question yourself. 
 

magix.info 

 

Do you have questions, need help, or are looking for expert tips and tutorial videos on 
using your MAGIX product? At magix.info you will find answers and solutions as well 
as workshops and a comprehensive user forum for software and multimedia queries. 

You can access magix.info online at www.magix.info 

 
By clicking this button or on the "Ask questions online..." you can 
place a question into the knowledge database. Internet access is 
necessary. 

The corresponding Internet page opens. 
 

Present music on magix.info... 
Show other magix.info users your music, discuss your own and their projects or be 
inspired by the photos, videos and music by other users.  
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Open magix.info - Multimedia Community 
Opens the magix.info main page. 
 

Product registration 
This option opens the MAGIX homepage for online registration where you can 
register yourself as a MAGIX user.  

Registration grants you access to the MAGIX support website 
http://support.magix.net (see support) where various program updates and help 
programs can be downloaded.  

With the registration form supplied (start menu under "Samplitude Music Studio 
2013 -> Service and support -> Register") you can register via post or fax. Simply print 
it out, fill it in, and send it off! 

Keyboard shortcut: F12 
 

Download more 
instruments/Sounds/Soundpools 
Opens a browser with offers for additional instruments, sounds and soundpools. 
 

Screen transfer  - MAGIX Screenshare 
MAGIX Screenshare allows you and other users to offer or accept help directly via the 
Internet.  

MAGIX Screenshare can be used in two different modes; either as a guest or as a 
host. The user who offers the transfer (session) is the host, and the receiver is the 
guest. 

As a host, start MAGIX Screenshare in your MAGIX software via the menu item 
"Share -> Screen transfer -> As host". This will require an online connection. Since 
you are taking the initiative as a host, an 8-digit number (session ID) will be 
displayed; this is required for any PC screenshare connection. 

http://support.magix.net/�
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The host/guest either owns the same application as you, or quickly downloads the 
free guest module with just a mouse click. As soon as the number you passed on to 
them via email, phone, or chat is entered into the guest application's module, your 
guest will be able to see your desktop on his screen. You can now open any 
application on your PC and your guest will see the same screen content as you via the 
online connection. 

Tip: In order for guests to know what is currently being shown, it makes sense to talk 
to them on the phone or via a chat tool while holding the demonstration. 

 

Register as host for a screen transfer 
1. If you want to start a screenshare instance yourself, then you have to register 

as a host first. To do this, open the menu "Share" and then select "Screen 
transfer as host...". 

2. In the dialog you can enter a name for the screen session. Your user account 
name is used here by default. 

3. Now click on "Start session". A small window will now open in the bottom 
right corner which displays the status of your screen session. A number will 
also be displayed (session ID) which serves as a password for your guests.  

4. Start the screenshare instance. 
 

 

Register as guest of a screen session 
1. You have to register as a guest to view a screensharing instance. To do this, 

open the menu "Share" and then select "Screen transfer as guest...". 
2. Enter the password you received from your host (8-digit session ID). 
3. Now click on "Start session". A window will open displaying a smaller version 

of your host's screen. 
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Restore original program settings 
Resets Samplitude Music Studio 2013 to its default values. 
 

MP3 Encoder activation 
Why activate? 
For importing (decoding) or exporting (encoding) specific audio and video formats 
you require a suitable codec for importing or exporting such formats. Integrating third 
party de- and encoders usually incurs costs. By offering you such costs as an option 
and not including them in our programs in general, MAGIX will in future also be able 
to offer to you our software at good value for money. 
 

How does activation work? 
Activation is fee-based and can be done online or via post/fax. The quickest and 
easiest way to order an activation code is via the Internet. Ordering the activation 
code takes just a few minutes via email. The order of your activation code via post/fax 
takes a few days.  
 

This is how activation works: 
Order activation code online 
Click on "Order online..." (Field 1). Your web browser will open where you can register 
your Samplitude Music Studio 2013 first (if you have not already done so). You will 
then be forwarded to a website where you can request the corresponding activation 
to be carried out. 

Order activation code via post/fax 
After clicking on "Order via post/fax" (field 2) your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on "Continue to 
order form" to transfer your user code automatically to the post/fax form. Now send 
the completed form as a print out to the address/fax no. mentioned. Once payment 
has been processed successfully, your activation code will be sent to you in the 
post/via fax in just a few days. Optionally it can also be sent by mail if an email 
address is stated.  

Enter activation code 
After receiving your personal activation code, you can use the activation dialog for the 
corresponding file format to start exporting for the respective format. if you receive 
the activation code via email, then copy it into the input field in the dialog and click  
"Activate...".  
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Activation problems 
Problem: The entered code is incorrect (telephone activation) 

Make sure your entry is correct; in most cases a typo is to blame. 
If the code is entered correctly, dial the number of our Call Center. Our support staff 
will help you personally. 

The MAGIX website won't open 

Check your Internet connection; you may have to use manual dial-up. 

The form for ordering via post/fax won't open 

• Check that an adequate text editing program is installed and activated (for 
example, MS Word). 

I still haven't received an email with the activation code 

• Check that your inbox isn't full. 
• Have a look in your spam folder. 

You can always send questions via email to our support whenever you like. Please 
have the following information at hand so that we can assist you as quickly and as 
specifically as possible. 

• Complete product name 
• Exact version number (to be found in the about box in the "About" menu item of 

the "Help" menu) 
• Encoder/Decoder name 
• Your user code (accessible via the "Activate via post/fax" dialog) 

Problem: I have installed Samplitude Music Studio 2013 on a new computer, installed 
a new hard drive in my old computer (sound card, memory...), or installed it multiple 
times on the same computer. My activation code is no longer accepted! 

If the program cannot be activated again after it has been activated multiple times, 
please contact the MAGIX customer service (view page 14). 
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Preset keyboard shortcuts 
All preset keyboard shortcuts can be displayed via the "Export list" option in the "Edit 
Keyboard Shortcuts, Menu and Mouse" (view page 465) dialog. Select "Copy" to 
copy the list to the clipboard and to add it to a spreadsheet or word processing 
program later. 
 

Mouse 
Center click Start/Stop playback 
Wheel Horizontal scrolling 

Shift + Wheel Fine tuning for active dials/faders 

+ Ctrl Horizontal zoom 

+ Shift Vertical zoom 

 (Enlarge/diminish waveform) 

+ Ctrl + Shift Vertical scrolling in VIPs (tracks) 

 

General settings 
You can access the project-independent Samplitude Music Studio 2013 settings this 
way. These settings are also global. 

"Easy mode" displays a simplified dialog with the most important basic settings. 

Keyboard shortcut: Y 
 

System / Audio 
In the “System” menu, you have options to fine-tune Samplitude Music Studio 2013.  

In detail, these are: 

• Audio playback settings (playback devices) 
• Audio record settings (recording devices) 
• Program options 
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• Paths/Skins 
• View options 
• Color setup (colors) 
• Metronome settings (MIDI options) 

Most of the dialogs can also be activated separately via the different menus and are 
explained at a the corresponding position. In the following, you can find the 
explanations on system settings directly via the system/audio dialog. 

 

Audio setup (audio playback settings) 
The installed sound cards are listed in the large window at the top of the dialog. The 
"Device info" button opens a small dialog. There you will find information on the 
sound card activated in the adjacent window (supported sample rates, manufacturer, 
etc.). 

 

Device address/driver communication 

Here you can specify the bit resolution for addressing the audio driver for recording 
and playback. Usually, resolution selection is automatic. If the output device is not 
able to output at the desired resolution (e.g. 24-bit), Samplitude Music Studio 2013 
automatically creates an appropriate lower resolution (dithered) which is then sent to 
the driver. In certain circumstances, if the driver triggers error messages (because it 
registers certain resolutions but can not actually play/record them), you can force a 
16-bit driver address. 
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Driver system 

You can choose between MME, multi-channel MME and ASIO. MME is the standard 
Windows multimedia driver system. multi-channel MME (WDM compatible): try to 
use this driver if your sound card supports 24/32-bit audio playback and problems 
occur when playing back high-resolution audio files. 

ASIO 

However, if your sound card model uses ASIO drivers, you have some distinct 
advantages over MME: 

MAGIX LoLa is included, a universal ASIO driver which can be applied by many 
sound cards which do not have ASIO drivers. 

• Lower latency of the driver system. This results in considerably lower response 
times for real-time editing. This enables software monitoring of the inputs (and 
VST instruments). The CPU load of the system drops, more high-quality effects 
are possible without intermediate bouncing operations. 

• Driver-side synchronization between recording and playback is available. This 
ensures that overdub recordings are 100 % stable regarding timing. This also 
allows for mechanisms for compensating latency for effects permitting software 
FX monitoring. 

• ASIO also offers a general method for treating multi-channel audio. All bit-
resolution and multi-channel problems which may appear with WDM drivers 
under Win2K/XP are avoided from the outset. 

• Advanced hardware monitoring options are possible due to the use of ASIO 
direct monitoring (flexible routing including pan & volume, regardless of sound 
card). 

ASIO setup 

ASIO drivers: The drivers of each ASIO device currently or previously available in the 
system are listed here. "Settings" opens the settings dialog of the sound card driver. 
Please refer to the sound card manual for more information. 

Buffer settings 

Play/Record buffer: Specifies the buffer sizes for playback or recording of audio data. 

In principle, the larger the buffer, the safer playback will operate on slower systems or 
at full load. The number of simultaneously playable tracks increases. However, this 
reduces the reaction time of the PC, which can particularly disturb processing of real-
time effects. We therefore recommend searching for an optimum compromise for 
your system. 
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When recording and playing simultaneously (record while play), the record and play 
buffer have to be the same size. 

HD buffer: 8000 samples buffer are the default preset. This buffer is applied during 
playback directly in HD wave projects. Test smaller values here for even faster 
reaction times! 

VIP buffer: 16000 samples buffer are the default preset for use during playback of 
virtual projects. Since error-free playback is usually more important than fast reaction 
times, this value should be raised to 16000 or 32000 during playback occurs from 
various tracks. When playing virtual projects or using the mixer only these settings 
are relevant. 

Test buffer: 8000 values are the default preset. This buffer is only used for real-time 
preview of effects from the "effects menu". 

Buffer number: Specify here how many of the buffers described above should be used 
(between 2 and 10). More buffers increase reliability, but also increase the memory 
requirements. Reaction times become longer. You can check the current buffer usage 
levels in the status bar to the bottom right. 
 

Record devices 
The installed sound cards are listed in the large window at the top of the dialog. With 
"Device info" you can open the small dialog for information on the sound card 
activated in the adjacent window (supported sample rates, manufacturer, etc.). 
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MIDI 

 

Playback devices: Here you can define which devices should be available for 
Samplitude Music Studio 2013 and which should not. 

Global playback devices: Select the driver that Samplitude Music Studio 2013 should 
use by default to play back MIDI tracks. Of course, an individual driver or one of the 
installed VST plug-ins (only in the VIP track) can be selected for any VIP track. 

Global recording devices: Select the driver Samplitude Music Studio 2013 should use 
to record MIDI tracks. 

Recording offset: Here you can enter the delay in milliseconds to be used when 
starting recording.  

Audio/MIDI synchronization: If the box for synchronization punch through is 
checked you can specify the intensity of Audio/MIDI synchronization coupling. 

0% Very soft 
50% Mid-value 
100% Very strong 

Activate SysEx input: Selecting this option enables Samplitude Music Studio 2013 to 
receive SysEx data from external devices. 

System time as MIDI timestamp: If this option is activated, then the MIDI device 
driver's time stamp will be ignored. This is helpful if drivers provide a timestamp that 
is not synchronized with the audio or is completely incorrect. 
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This function recognizes invalid driver time stamps and then provides automatic 
fallback onto the system time. This helps fix MIDI recording problems with MIDI 
devices. 

Couple VIP-Q and MIDI editor-Q: The quantization grid in the VIP and individual 
MIDI objects are always moved together.. 

Deactivate all MIDI functions: This allows you to disable all MIDI functions 
completely.  

Note On Chasing: "Note On Chasing" has the effect that held MIDI notes are also 
played back when they receive their "Note On" command before playback starts. 

Send "All Notes Off" to VST instruments on (monitor) stop: As an alternative to the 
"All Notes Off" mechanism, an individual "Note Off" mechanism is available for VST 
instruments, since "All Notes Off" is ignored by some VST instruments. You can 
completely shut off "All Notes Off for VSTis in the MIDI systems settings. 
 

Hardware controller 
Installing a hardware controller 
Open the hardware controller setup dialog by pressing "Y". You are now in the 
system/options dialog. Now open the subcategory "Hardware controllers". 

The hardware controller setup contains two tabs. The first one is used for general 
settings while the second one is used for learning functions. 

1. Press the "Select controller" button. Then select your controller or a 
compatible model from the list. With Delete or "Del" you can remove selected 
controllers again. You can use the mouse to change the order of the controllers 
and their internal assignment. A controller that is indented corresponds to an 
expansion module. You can use the check box above the controller or the 
"Activate controller" button to temporarily deactivate a controller. 

2. On the right you can select the MIDI parts that are connected to your 
controller. 

3. Your controller is ready for action after you have closed the dialog. 
 

 

Track number 
Specifies the number of tracks in a bank available to the controller. These are usually 
8 tracks. Mackie Control and HUI Protocol can only access 8 channels per bank. 
However, there are also controllers that have a native mode letting you learn several 
channels. Here you can set this value to 16 or 24 (max. 64). The value is set to "1" for 
single-track controllers. 
 

Ignore SysEx input data 
SysEx data sent by the controller is not processed by Samplitude Music Studio 2013. 
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Hardware controller – "Internal" mode 
The internal modes are used to adjust to different hardware controllers that operate 
differently. Depending on the mode, the controller display is addressed differently and 
Samplitude Music Studio 2013 interprets the controller messages correspondingly. 

Hint: If you are using a controller which is different than the one listed here, then you 
should select one from the list that is similar to yours in concept and design. 

Internal modes description: 

Mackie Multitrack 

Track 

Press first time: Track mode 

Press second time: Active control mode 

• Each activated mixer element (recognizable by the red marking) is controlled by 
the first fader 

PAN 

• Pan mode (like track mode, except for the display) 

EQ 

Press first time: EQ Phat Channel Bandwise mode 

• Gain, frequency, and quality accessible via the knobs 
• Use the bank switch keys to access the other bands 

Note: The bank switch functions have to be learned, which is usually the case 

Press second time: EQ Phat Channel Typewise mode 

• Gain, frequency, and quality accessible via the knobs (differently grouped than in 
Bandwise mode) 

• Using the bank switch keys, each of the other EQ functions can be accessed 

AUX 

Press first time: AUX track mode 

• AUX 1 to 6 of the active track using the knobs 
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Press second time: AUX slot mode 

• Set AUX for each track 
• Select number of AUX tracks to be controlled using the Bank Switch keys 

Plug-in 

• The VST plug-in slots are listed for the active track (flip through via bank switch 
keys) 

• Selection of the VST plug-in to be adjusted by pressing the corresponding knob 
• Thereafter the parameters for the selected plug-ins are shown 
• Changing the parameter using the knob 
• Page through the parameters 

Frontier AlphaTrack 

Track 

Press first time: Panorama mode 

• Panorama control 
• Navigate to markers 
• Move selected track 

Press second time: Active control mode 

• Changes the value of the selected element in the mixer with the fader. 

AUX 

• Select other track 
• Select other slot 
• Change AUX send of the selected track/selected slot 

EQ 

Controlling the input volume, frequency, and quality bands of the selected EQs. The 
individual bands are selected with "Mixer track up/down". 

Plug-in 

• Select track 
• Select plug-in slot in the track with "Mixer track up/down" key 

Now you can control 3 parameters of the corresponding plug-ins with the vpots. The 
display page is toggled with the keys "Mixer track   up/down". 
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Frontier transport 

Functions: For transport only 
 

JLCooper (MCS) 

Track 

Press first time: Track mode 

Press second time: Active control mode 

• Each activated mixer element (recognizable by the red marking) is controlled by 
the first fader 

AUX 

Controls all AUX sends in the selected channel. 

EQ 

Controls the EQ of the selected track via the knobs. 
 

Output 
Deactivate: If your PC does not have a motor fader, you can use this option to 
deactivate the transmission of controller data. 

Normal send: The MIDI controller data is received and processed. Program data (e.g. 
fade changes in the mixer) are sent to the controller. 

Send echo: The MIDI controller data is received and processed and forwarded 
straight back to the controller. Controllers need this for their displays (lamps, LEDs). 
Program data (e.g. fade changes in the mixer) are sent to the controller. If your 
controller has difficulties with this (e.g. .Logic Control), activate "Normal send". 

Send echo (without fader touch): The MIDI controller data is received, processed and 
returned to the controller. However, the fader values are not sent back while it is 
moved (activated fader touch). Only the last value is released to prevent increased 
data volumes. Program data (e.g. fade changes in the mixer) are sent to the controller. 
If your controller has difficulties with this (e.g. Logic Control), activate "Normal send". 
 

Customizing controllers 
Most devices available on the market understand protocols such as Mackie Control or 
HUI. If your device is not included in the list, simply select the nearest compatible 
device. 

If you can't find your device in the list or want to change the default settings, you 
should proceed as follows: 
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Before adapting an existing template to your controller, you should save it under a 
new name using the "Save as..." option. 

Now go to the "Adapt controller" tab. The following dialog appears: 

Use Mackie Control if your controller can emulate this mode. In this case 7-bit values 
are transmitted. You can see this in the MIDI Input Monitor. Pressing a displays a new 
line, another line is displayed upon release. HUI receives 14-bit messages, i.e. two 
lines respectively. 

In the mixer, which should be open at the same time, you can now select the element 
you wish to program on your controller. The saved function is displayed in the section 
Program function, e.g. "Fader master" for the fader in the Samplitude Music Studio 
2013 mixer. Alternatively, you can open the context menu in "Samplitude/Sequoia 
function". This contains a list of all remotely controllable functions in Samplitude 
Music Studio 2013. You can now assign them to your controller one after another. 
The uppermost commands are purely mixer functions and are suited solely for the 
controller connection. The lower ones represent the entire menu structure of 
Samplitude Music Studio 2013. You can use this to assign each command from a 
menu to a controller key. Please note that when working with menu commands, the 
key lights of the controllers don't work. 

Now move the fader or press the corresponding key on your controller. The MIDI data 
for this element is displayed in the section "Last MIDI data". Press the Learn button to 
allocate the new data to the function. 

Note: Hardware controllers with touch-sensitive faders transmit data to Samplitude 
Music Studio 2013 when released again, so that the "learn" button has to be pressed 
after moving and before releasing a fader! 

If you want to use a key/fader for multiple tracks, e.g. learn mute, select 
"Mixer/Tracks/Track Mute" in "Samplitude Music Studio 2013 functions. Now tick 
"Track "Auto Increment" and start programming the first track. After pressing 
"Learn", the value of the track is automatically increased by "1". All you have to do is 
to actuate the next element on your controller and press "Learn" again. 

You can use the "Delete" button to unselect a function assignment. However, you can 
also simply overwrite the data by "relearning".  

If a controller should move in the wrong direction after programming, please repeat 
the programming sequence and activate Invert Vpot direction upon button release. 

If you want to know which functions have been assigned to a key of your controller, 
simply press this key. The data appears in the list of assigned functions. 
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This way you can let Samplitude Music Studio 2013 learn individual control elements 
of your hardware controller. 

Hint: If "Object" mode is active, you can jump to the next object with the hardware 
controller's  Rewind/FastForward transport controls. The same applies to Marker 
Mode, where you can jump to the previous or next controller in the project. 
 

Metronome options 

Please also read the section "Options -> Program settings -> Metronome options". 

 

Recording settings 
Format: The higher the bit depth, the more disk space will be needed, but the 
recording quality will also increase. Higher bit depths are only sensible when the 
sound card records in this format. 

Note: Many sound cards are advertised as 24-bit, but in some cases this refers only 
to playback. 

Save each take in a new file: This option results in each take being saved to a new file. 
Loop recordings will be processed as one take and saved to one file. 

Record offset (samples): Here you can enter an offset in sample words, which is 
created between sound card playback and recording start of the "Record-while-
playing" mode. This allows you to balance the delay between record and play start of 
some cards. Typical values are between 20 and 1000 samples. Find this value by 
playing a project with a distinctive beginning in a multi-track VIP and recording it at 
the same time. You can then measure the offset precisely using the zoom functions. 

Update object during recording: The object will be displayed in the VIP already during 
recording, and it can be observed how it grows in length. 

Scroll recording position: Depending on playback settings, you can scroll during 
recording, too. This means that the visible range of the arrangement follows the 
current object end. 

Show confirmation window after recording (OK/delete): After stopping recording, a 
dialog appears with the question whether the recording should be saved. 

Set playback cursor at the end of recording - the next recording will start at this 
position: If this option is activated, the cursor will be set at the end of the recording, 
and playback or recording will start at this position. 

Recording button ends playback following standard recording: When the recording 
is stopped, playback will also be paused. 
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Playback settings 

 

Keyboard shortcut:  P 

Check the "Stop at current position" option to keep the play cursor at the current 
position when stopping playback. If this option is not active, the play cursor will jump 
to the original position or back to the start of the range when playback is stopped. 

The "Test space bar (play, stop) in the background as well" option also allows the 
space bar to be used for "Play" and "Stop" in Samplitude, even while using a different 
software application in the foreground. 

The keyboard combination "Ctrl + space bar for playback of selected objects" can 
also be used. 

The pre-roll time is a necessary parameter for editing in Samplitude. Pre-roll time is 
used to define the time section in seconds which is to be played before the start of the 
selected range. 

The maximum reverberation time for objects without fade-out can be set up to 60 
seconds here. 

Note: Please note that long reverberation times can lead to performance problems. 

The option "Pre-run harmony display (beats)" ensures that the chords detected by 
the Harmony Agent are displayed in advance in the set number of quarter note beats. 
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Autoscroll 
Use Autoscroll to activate a feature which is especially useful when working with long 
HD Wave Projects: The graphical display always changes when the playback marker 
(position line) leaves the visible section. This way you can always keep an eye on 
things, whereby it has proven most sensible to display the current project in two 
sections (Setup > 2 sections), one displaying the entire project and one in a useful 
zoom depth with Autoscrolling. 

You can choose between page and soft scrolling. But be careful: Scrolling requires a 
certain CPU power (depending on the processor, graphics adaptor and resolution), so 
that the computer may be overloaded in critical situations which may result in 
playback dropouts. You should then deactivate autoscroll mode. 
 

Scrubbing 
If you press the Insert key (Ins or 0 on the number pad), Samplitude Music Studio 
2013 will be in "Scrubbing Mode". This means that the playback speed can be 
controlled directly with the mouse. The further the mouse goes to the right, the faster 
Samplitude Music Studio 2013 plays. 

In comparison to many HD recording systems, this even works in a virtual multitrack 
project. 

The Scrubbing Mode is great in finding passages in unsorted material, in tracking 
crackling, etc. in material – the older generation of sound engineers are, no doubt, very 
familiar with this method from analog tape editing. 

There are 2 scrubbing modes available (in the playback parameter window - Key P): 

Relative: The relative distance between the playback marker (position bar) and the 
mouse position can be used to control the speed. The playback marker follows the 
movement of the mouse. 

Absolute: You can use the absolute position of the mouse in the window to control 
the speed: 

• Left border = double speed backwards, 
• Mids = no movement, 
• Right border = double speed forward. 

Tip for scrubbing: For small buffer sizes (4000, 2000 samples) scrolling is "softer". 
Test if your computer functions at this buffer size without drop-outs. Combining with 
the Soft Scroll Mode guarantees that working on your computer is easy and fast. 
 

Global playback device 
Here   you can define the driver of the sound card which is to be used for playback if 
playback is to occur via a card. This is particularly important if you have a sound card 
with several outputs or if you have several cascadable sound cards in your computer.  
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Program 
General 

 

Open VIP and record window on program start: If this option is active, Samplitude 
Music Studio 2013 will automatically open an empty virtual project (VIP) and the 
"Recording parameters" dialog when the program is started. 

Open wave projects in destructive editing mode: If this option is active, wave 
projects will be opened in destructive editing mode. 

Performance display: This option activates the DSP performance display in the lower 
left corner. Your PC is overloaded if the displayed rate is 100% or higher. Try one of 
the following steps: 

• Reduce the number of real-time effects in the mixer or in the object editor. 
• Reduce the number of tracks by muting tracks that are not needed. 
• Increase the VIP buffer size to 16000 or 32000 samples. 

Please note the comments displayed in the status bar should an overload occur during 
real-time previewing of complex effects. 

Lock VIP size against zoom out: If you zoom the virtual project out beyond the 
section size, this option will automatically stop it from being extended. 



 

General settings 463  

 

Play cursor independent of range: This option allows the play cursor to be set 
independently in "Loop" mode and playback to be started outside of the selected loop 
range. 

Hide wave projects loaded into virtual projects: Hides windows in wave projects that 
are loaded directly into the VIP. 

Use project tooltips: If this option is active, additional information is displayed when 
the mouse pointer hovers over an interactive element. 

Show extended project tool tips: If this option is activated, the extended tool tips are 
displayed if the mouse pointer is held over an inactive element. 

Show window "Create new project": If you set the option "Do not show this window 
again" in the dialog, you can reset it here. Please also read the section  "New virtual 
project (VIP)" (view page 313). 

Reset all "Don't show this message again" boxes: Press this button to reactivate all 
tips dialogs that have been deactivated. 

Folders 
New virtual projects: All new virtual projects as well as recorded and imported wave 
projects will be saved under this path. 

Project files: All other wave files which are to be saved on the hard drive and that 
cannot be allocated to a specific project are saved under the specified path. 

FTP download: All files downloaded via the integrated FTP client will be saved under 
the specified path. 

Temporary files: This preset path is directed to the standard temporary files folder. 
Please ensure that this folder should be on a hard drive or partition with sufficient free 
storage space. 
 

Undo definitions 
The depth of undo can be specified when working with VIPs. A value of “20” means 
that the last 20 changes can be undone. 
 

Locking objects/tracks 
Here you can select which functions should not be permitted by locking the objects. 

Disable Moving: The objects cannot be moved unintentionally (default). This is 
especially useful for multi-track recordings to prevent inadvertent offset between 
each track from the beginning!  

Block volume changes: The object's volume handles are deactivated. 
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Disable fade-in/out: Deactivates the fade handles of the objects. 

Disable Length Changes: Deactivates the length handles of the objects. 
 

VST/DirectX/ReWire setup/plug-in buffer 
The option "Write DirectX logfile" is for support purposes. This may normally remain 
inactive. 

You can also activate the "Start all object-related plug-ins at play start" option. Some 
plug-ins cause delays when switched on; in this case, these plug-ins should be 
switched on before starting playback, since otherwise errors may occur when the 
corresponding objects are played. 

Disable all DirectX effects while scrubbing/jogging: DirectX plug-ins may cause 
errors when scrubbing or jogging. Use this option to disable communication with 
DirectX plug-ins. 

 

Plug-in buffer 

The default presets usually cover most applications when working with plug-ins. Try 
out various presets if you are experiencing problems with plug-ins or DSP cards. 
Specify the buffer size sent to the plug-in for XD and VST plug-ins directly.  

VST plug-in path: This sets the path to VST plug-in effects and VST instruments. The 
selected folder may be scanned for VSTs. Not only are all the plug-ins imported, but 
they are also checked for usability within Samplitude Music Studio 2013. This scan is 
only necessary once, since available VST plug-ins are saved during this process. If 
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more than one VST plug-in folder is present, then other folders may also be specified 
for scanning. Samplitude Music Studio 2013 automatically finds newly installed plug-
ins in the specified folders only. The corresponding data is saved in the file "VSTplug-
ins.ini". 

Activate ReWire: If this option is activated, rewire-compatible client applications may 
be integrated into Samplitude Music Studio 2013 as synthesizers. 

Additional information about ReWire can be found in the chapter "Software 
instruments/VST plug-ins/ReWire -> ReWire client applications". 

 

Edit keyboard shortcuts and menus 
In this dialog you can freely specify keyboard shortcuts for all menu functions in the 
main menu and for the Solo JamSession. This way, it's possible to set the commands 
you use most often to a special key combination so they can be opened quickly. 

 

The shortcut settings are saved into the MusStu.ini file in the Windows directory 
when you exit Samplitude Music Studio 2013. It's also possible to export sets of 
keyboard shortcuts or menu definitions in files. 

Note: Users of previous Samplitude Music Studio 2013 versions can thus load the 
old menu structure; we have included a "Menu" file for this purpose. 
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The display of the entire menu tree of Samplitude Music Studio 2013 is the key 
function of the dialog. 

Here, you can select for which menu item you want to create a new shortcut or 
whether the menu item should appear in the main menu of Samplitude Music Studio 
2013. 

Note: Shortcuts in brackets (<>) cannot be changed. 

 

Shortcut list 
Export list: You can use this to export the shortcut as a list in a text file in different 
formats. A window will open in the shortcut editor which displays a complete list of 
the current shortcuts. The "Copy" button can be used to copy this list to the Windows 
clipboard to be edited and printed using a text editor. 

Reset: Activates all preset shortcuts again. 

Load/Save: Previously saved shortcuts are loaded and activated or the current 
shortcuts are saved under a file name. 
 

Shortcut 
To add a new shortcut, click on the desired menu item and then on the input box at 
the bottom. Then click on the shortcut key. 

You can also use combinations of any key with "Shift", "Alt", or "Ctrl". Please do not 
use the space bar, "Esc", or "Insert" key ("0" on the number block), since the functions 
of these keys are permanently set in Samplitude Music Studio 2013 and cannot be 
changed. 

Assign shortcut: This button can be used to activate the key sequence on the left as a 
shortcut. A warning will be displayed if this command has already have been 
assigned. However, you can also check in advance whether the key combination has 
already been assigned. To do this, click "Search" (binoculars) once the key sequence 
has been entered. An assigned menu command will then be displayed in the top list.  

Delete: Deletes the selected shortcut. 

Assigned: Shows all the shortcuts assigned to menu points. You can assign menu 
commands to multiple shortcuts. 
 



 

General settings 467  

 

Mouse 
You can define several special options for keyboard and mouse to achieve 
compatibility with older versions. These are: 

• Disable range zoom for double mouse clicks 
• Zoom lasso allows vertical zoom without "Shift" key  
• Disable zoom for vertical mouse movement in timeline 
• Downward compatible use of "Shift - click" on mute/solo/record (instead of "Alt 

+ Shift" - click). This lets you change the keyboard shortcut for "exclusive 
switching" of solo, mute and record. By clicking the "Solo/Mute/Record" button 
for the selected key combination "Shift + Alt" / "Shift", you can switch the 
individual channels temporarily to "Exclusive" mode.  

• Treat knobs like faders: If this option is active, knobs can be pulled up and down 
like faders by dragging with the mouse. 

• 2nd click required to move objects: This option requires a second click for moving 
objects. The first click selects objects and prevents unintentional moving. 

• Move delay: When an object is selected by clicking on it, you might 
unintentionally move the object. If "Move threshold" is activated, Sequoia will 
wait the set time before it performs the shift. 

"Mouse wheel" allows you to re-define the function of the mouse wheel for zooming 
and scrolling in the virtual project. You can define which modifier ("Alt", "Ctrl", 
"Shift") controls which function in combination with the mouse wheel. 
 

Solo JamSession 
Editing here is basically identical to editing in the main menu. However, you cannot 
set any keyboard shortcuts, but rather MIDI commands or joystick actions. 

The commands listed here do not exist in any menu, therefore the buttons "Show 
menu/Hide menu" and "Reset" (from the menu command show/hide) are grayed 
out. The list cannot be exported or saved. 

Reset: Activates all preset shortcuts again. 

Note: The MIDI input device can be set in the metronome options. 

Keyboard shortcuts 

To assign a new shortcut to a command, enter the type of shortcut in the flip menu 
"Status". 

Note: MIDI commands can also be learned. If you use control change events for 
remote controlling, you can choose between "CtrlUpDn" and "CtrlChg" in the 
"Status" menu after learning. 



 

468   

www.magix.com 

• CtrlUpDn: This is a special adaptation for use with a sustain pedal from the MIDI 
keyboard. A command is activated only when the pedal is "tapped" lightly, 
because, when playing, the sustain pedal is typically held longer than it takes to 
actually activate an assigned command. 

• NoteOn: Note On events are always transmitted when a key on the MIDI 
keyboard is pressed. It may also be possible for other keys of the MIDI keyboard 
to transmit Note On events. Please refer to the instructions of your MIDI device. 

• CtrlChg: Control Change events are transmitted to the MIDI device if the 
controllers are adjusted. It may be possible to program the MIDI device so that 
pressing a key will transmit such a Control Change event. Please refer to the 
instructions of your MIDI device. 

• PrgChg: Program Change events are actually there to effect a sound change in 
the synthesizer. 

• PitchWheel: The Pitch Wheel normally serves to modulate the pitch of the sound 
played. When using it, a quick movement is all that's necessary to execute an 
assigned command. 

• Joystick1/2: Use the buttons 1-4 of your joystick to control the Solo Jam Session. 
In the field beside it, "Button", enter the corresponding number of the desired 
button. Here, you cannot set the channel as joysticks don't have anything to do 
with MIDI devices. 

• Channel: MIDI Channel 1 is always set as the default. In case your MIDI device 
transmits to a different MIDI channel, you can set it here. 

• Assign: With this button you can activate the specified MIDI event or the joystick 
button as a new shortcut. A warning will be displayed if it has already been 
assigned to another command. 

• Delete: Deletes the selected keyboard shortcut again. 
• Shows all shortcuts assigned to the function. You can assign multiple shortcuts to 

a function. 

Learning MIDI commands 

1. Select the function you want to remotely control via MIDI from the list at the 
top. 

2. Click on "Learn". This now turns red. 
3. Activate the MIDI command from the MIDI device to start the function. 
4. In the dialog, click on the "Assign" button to complete the learning process. 
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Design 
Display options 
This dialog can be used to change and select both alternative display formats for 
objects in virtual projects. 

Keyboard shortcut: Shift + Tab 

 
 

Draw mode 1/2 
Switching between the two modes is possible by pressing "Tab". You can also toggle 
between mode 1 and mode 2 by selecting the appropriate mode from the menu item.  
 

Waveform display 
Draw samples: The audio sample representation is switched on. Usually you will leave 
this on, but it can be advantageous to deactivate sample representation if you want to 
see the volume and pan curves more clearly.  

Scale with fades/curves: In this default representation mode the waveform drawing 
is scaled according to the settings of the fade in/out or volume curves. The decay of 
the sound during a fade out (or volume changes caused by a volume curve) are more 
obviously visible. 
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Halve: The graphical representation of the audio material can be displayed as a whole 
waveform or half the form for higher definition. Checking this box will display the 
waveform with half its information. This mode is recommended, because the grid 
function (key #) and the vertical zoom functions ("Ctrl + cursor up/down") are 
perfectly adapted to this draw mode. Volume curves results also display better in this 
mode. 

 

Separate stereo: If this option is active, stereo tracks in VIP projects are displayed 
with a two-channel waveform. This allows you to expand the display to both channels 
rather than displaying just one composite channel display. Please keep in mind that 
this will also affect the wave project display for stereo wave projects. 

 

Envelope only: When this radio button is selected only the waveform outline 
(envelope) is drawn. This can be useful when constructing crossfades, allowing for 
easier view of the overlapped waveforms. 
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Transparent: When this radio button is selected the colors of both crossfade 
waveforms are overlapped. This works best in front of a dark background (default). 
We recommend that you combine this mode and the draw mode option "Waveform 
colors -> Red/Blue alternation" to display the crossfade areas optimally. 

 

Interleaved: When this radio button is selected a sample of the left object and a 
sample of the right object is drawn alternately within a crossfade. You can then 
visually assess the fade area, especially if the adjacent objects have different colors. 

 
 

VIP 
Various VIP components (buttons/sliders, peak meters, show borders, arrangement 
text, and vertical auto zoom) can be activated and deactivated here. 
 

Objects 
Background: Each object in the VIP track can be assigned its own color. The color is 
displayed if this option is checked.  

Object name: Objects in VIP windows can have their own name. If this option is 
checked, the object name is displayed.  

Large object handles: When selected, larger handles for objects and volume / 
panorama curves will be displayed.  

Project name: Samplitude Music Studio 2013 also allows you to display the audio file 
name in each object. This is especially useful if you quickly want to identify the wave 
project used in an object.  

Object properties: This shows you which object related effects are applied to the 
object, e.g. EQ for equalizers, DYN for dynamics etc... 

Group number: Objects in VIP windows can be grouped together. When grouping 
objects, it is helpful if the group number is displayed in the object. This option allows 
you to display that information in the object. 

Object lock button: When locked, an object cannot be moved. Setting this option will 
let you comfortably change the lock/unlock status of an object by clicking on the key 
in the lower region of the object. 
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Waveform colors 
Red/Blue alternation: This representation mode alternately colors the waveforms of 
adjacent objects red and blue, to improve the visibility of crossfades in the transparent 
and interleaved drawing modes. 
 

Colors 
All colors used in the program can be set here. You can also load and save these 
colors as presets. 

Use automatic sample colors for record: Here a separate random color is chosen for 
each recorded object per track. 

Restore 

Restore last state: Restores the last status of the color settings before the dialog was 
opened. 

Original state: Resets all colors to their default settings. 

Semitransparent display 

There are transparent displays in several effects dialogs and editors. These can be 
deactivated here to increase performance. 
 

Easy setup 
Sound card & drivers 

Select the driver system or the sound card. Entries which start with "Asio" are ASIO 
drivers which enable shorter latencies, e.g. to play VST plug-ins live, etc. 

Note: If your sound card offers ASIO drivers, then it's best to use them. Only use 
"ASIO MAGIX Low Latency" drivers if you are having problems. 

Audio: Input & Output 

Select the input and output channels for your sound card which should be preset for 
recording or playback. 

MIDI: Input & Output 

Select the MIDI input and output devices which should be preset for recording or 
playback. 

Mixer preset: 
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These are the most conventional presets for different applications concerning track 
number, AUX and submix busses. 

Plug-ins directory 

Enter the path to the installed VST plug-ins. 

"Advanced" switches to the Settings dialog with all available options (view page 
449). 

 

Project options 
Here you will find all settings that are specific to Wave projects (.HDP) and virtual 
projects (.VIP). 
 

General 
Shortcut: I, Ctrl + Shift + ´ 

Here you can see the most important information about the current project at a 
glance. This includes Bar/BPM, Recording, Editing, and Snap/Grid settings. 
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Project options– Project 
Sample rate (Hz): This indicates the project's sample rate. You can also change the 
sample rate for the project and adjust audio and MIDI objects to the modified sample 
rate. 

Damping: Here you can adjust the level in 6 dB stages. Volume reduction can be 
necessary when working on multi-track virtual projects if you are working with 16-bit 
internal precision 

When working with 32-bit float internal accuracy, 0 dB can be used to prevent 
internal clipping. Simply set the master level to 0 dB via the master mixer faders. 

Note: Keep in mind that Samplitude Music Studio 2013 reduces the volume of wave 
projects by the value set in the virtual project. This way you can quickly toggle 
between virtual projects and wave projects without the volume level changing. If on 
the other hand a wave project is the only project opened (i.e., without the virtual 
project it uses), it will always be played at maximum volume. 

Project start time: Specify the project's starting time here. 

Project length: The project length is displayed here in bars and beats. 
 

System options - Recording/Editing 
Here you'll find various presets for recording and editing: 

• Lock recorded objects: Protects against unintentional moving of recorded objects. 
• Group object according to Multirecord: Objects that belong together will be 

grouped in a multi-track recording. 
• Offline audio editing (only for Wave projects): Detailed information about 

destructive editing is available in the chapter"Working in the project window -> 
Samplitude Music Studio 2013 as a wave editor". 

• Auto Crossfade Mode: Use this function to activate a mode which adds a 
crossfade to all newly recorded objects created from cuts or from wave projects 
that have been integrated into your project. Every object may be assigned a 
standard fade-in, and this can be edited via the "Object Editor Fade" menu via 
"Get/Set Global Crossfade". If two objects overlap in this mode, a realtime 
crossfade will occur at the intersection. 

• CD arrange mode: If this is activated, Samplitude Music Studio 2013 arranges 
newly added objects so that there is a Red Book Standard-compatible pause 
between the objects. 

 



 

Project options 475  

 

Project options - Bar/BPM 
Bar/BPM/PPQ: Enter the time signature (counter/signature), the tempo in beats per 
minute (BPM), and the timer resolution in peaks per quarter (PPQ/clicks per quarter 
note) here. 

Get BPM from selected range: If you enter the number of beats into the field beside 
"Selected range has beats:", Samplitude Music Studio 2013 will calculate the BPM 
based on the selected range when the button is pressed. 
 

Project options – Snap/Grid 
Snap to: Switches the global snap on/off. 

Objects: This option activates the object grid. This lets objects snap exactly to the 
edges of other objects. 

Range: Activates the range grid and enables the current range to be used as the basis 
for snapping. 

Beats/bars: Activates a grid with bars as the basis for snapping. 

Bar grid (relative): Activates a grid with bars as the basis for snapping. The selected 
object will maintain a relative distance to the snap markings when moved. 

Grid/frames: Activates the frame-based grid. 

Snap offset to project start: Sets the snap offset relative to the beginning of the 
project. "Use current position for offset" specifies the current position as the grid's 
zero position. 

Show grid: If this is selected, the grid will be displayed for the project according to the 
unit set in the selection box beside it. 

Use snap offset also for grid: The snap offset is used as a reference size for the grid. 
 

Project options - Standard pitch for tuner (Hz) 
This field indicates a standard pitch of A at 440 Hz. You can change this value 
anytime you like. 
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Project Auto Save… 
The Autosave dialog is available via the project options.  

 

This dialog provides options for creating backups of projects. The button View backup 
project opens the selected backup in the arranger.  

The button Restore backup status restores the project to the status of the backup. If 
the current project was changed previously and not saved, then the last status may be 
saved with the extension _OLD.vip. 

Autosave Mode 
Autosave mode may be activated with the corresponding check box. Select from the 
following options: 

Save to original: Overwrites the original file in specific intervals with the current 
status. If the option Save in subfolder is selected, the previous status, i.e. the pre-
previous status will also be updated in the Backup subfolder. 

Add backup file (*bak.VIP): Adds a backup file and updates this at specific intervals. 
If the option "Save in subfolder is selected, the backup file will be updated in the 
Backup subfolder each time it is saved. 

Max. 10 backup files (*bak0.VIP until *bak9.VIP): Specify save intervals for up to 10 
backup files and number them. If the option "Save in subfolder is selected", the 
backup files will be updated in the Backup subfolder each time they are saved. After 
10 backup processes, the final backup file will receive the extension *bak9.VIP, the 
oldest backup file will be deleted, and the others will move downwards in the 
sequence. 
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Mixer setup 
Opens the mixer setup dialog where you adjust the general settings for the mixer 
routing design.  

 

Project and mixer configuration: Sets the number of VIP and mixer tracks as well as 
the submix and AUX buses. 

Device setup: Sets the various routing paths. 
 

Synchronization 
Opens the synchronisation dialog (view page 276). Here you can specify whether 
Samplitude Music Studio 2013 should operate as master or slave, which protocol to 
use, and which interface should be used to send or receive synchronization data. 
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Recording options 

 

Shortcut:  R 

Recording mode: Choose between stereo, mono, and different bit depths. 

Preload: The recording is prepared and all buffers will be loaded. A requester appears; 
by clicking it you can start recording without delay. This function is useful if you wish 
to start recording without delay. 

Sample rate: This option allows you to select the sample rate of the recording. Please 
make sure your sound card supports the selected sample rate. 

Resample to 44100 Hz: With this button you can specify whether it should be 
recorded at 48 kHz or 32 kHz or even be converted into 44.1 kHz while recording. 
This is useful when recording from DAT recorders via a digital sound card if the 
material is to be used on CDs with 44.1 kHz. 

Recording start/length: Here you can program a recording. The recording length can 
be specified in different time formats. 

Record device: Here you can select the sound card driver that is to be used for 
recording. If there is no entry here, or a wrong one, then the card is not installed in 
Windows correctly. Try to do this later on via Control Panel > Driver. 

Info: Here you can access a dialog that provides information on the sound card 
properties. If your sound card supports 24-bit recordings, you can activate this record 
mode via the Info dialog. 
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File name/File path: The name of the audio file that is to be created and the preset 
directory path are displayed at the bottom of the record window. Both can be 
changed by clicking the folder button. 

Playback while recording: This option corresponds to the option in the recording 
options with the same name. 

Create VIP object: With this mode you can specify whether all recordings should be 
automatically integrated into a virtual project or not. 

Set CD track marker: While recording you can already set track markers by clicking 
on the button "Set CD track marker" in the recording dialog. 

Automatic recording stop: If this field is activated, recording will cease automatically 
after approx. 16 seconds of silence. This way you will not have to worry about 
stopping the recording once the source you're recording from, an LP, for instance, has 
reached the end. 

Automatic CD track recognition: If this field is activated, track markers are 
automatically set at the end of the pauses between the tracks. 

Advanced options: Opens the system options with the advanced record settings 
(view page 459). 

Monitor: Here the control displays can be activated. Please note that the correct 
recording device must be selected prior to beginning this. While recording, the control 
displays move slower, but they nevertheless show each maximum level. 

Visual: Indicates whether the level of the signal that is to be digitized is adjusted 
correctly. To set the level, play the loudest part of the material you want to record and 
monitor the display. 
Level settings that are too low will have adverse effects on sound quality, distortions 
will lead to unpleasant "clippings". 
You can adjust the recording level either on the sound source itself or with the mixer 
window of your sound card. 

Osci./Correl: Here you can open an oscillograph or a phase correlator. The 
oscillograph displays the wave form at the input in a scaleable window. 
The phase correlator displays the phase level of a stereo signal. A vertical line 
corresponds to a mono signal, and a horizontal line corresponds to a 180° phase-
inverted signal which usually indicates an incorrect cable connection. 

Reset peak meter: Here you can reset the LED peak meters (Peak Hold Display). 

Tuner: Tune guitars and other strings with this option. The visualization displays a 
calibration line at note A0. If divergent tones are played, the deviation can be read off 
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the calibration line, and the numerically displayed tone pitch directly and can be 
corrected accordingly. 

Set marker 1: While recording you have the option of selecting a marker at the current 
position of the playback marker (position line), in order to, for example, mark an 
incorrect passage for correction later. 

Recording: Click this button to start the actual recording process. Please note that 
with active external synchronization as a Slave, the recording does not start 
immediately, but rather at the start of each master. 

Stop: Ends a running recording process. Should the computer be overloaded, for 
example, as a result of swapping or disk access, the recording can be canceled by 
pressing the right mouse button. 

OK: Closes the recording window. 
 

Varipitch/practice mode 
Samplitude Music Studio 2013 supports any tempo changes during playback - even in 
virtual multi-track projects. Right-click on the scrub control of the transport control.  

Active: Activates the Varispeed mode.  

Note: Once the Varispeed mode has been activated, you can close the dialog, 
control occurs via the scrub control of the transport control.  

Practice mode: If the practice mode is activated the pitch remains independent of the 
playback speed. It is especially useful for pieces used for practice (e.g. an 
accompaniment with guitar) that must be played slower because the player might 
otherwise feel overstrained.  

Vertical controller: The playback speed can be changed manually from -200% to + 
200%. 

Pitch: The speed factor can be specified precisely, for example, 0.5 for half speed. 

Internal rate: Here you can specify a sample rate for the Varispeed calculation. If, for 
example, a wave project with 48 kHz is to be played on a sound card that only 
supports 44.1 kHz, enter 44100 as playback rate (left in the dialog) and 48000 as 
internal rate. What follows is a real-time resample during playback - a strong feature 
for all those, who have to convert between DAT (48 Khz) and CD (44.1 Khz) a lot.  

BPM: Here you can specify an original and a target speed in BPM. Samplitude Music 
Studio 2013 calculates the Varispeed factor from the ration to play a 120 bpm sample 
in real-time with 135 bpm, for example.  
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Important: Varispeed also works during recording!  

If your singing voice does not quite hit the highest note, simply set Varispeed on -2 
halftones during recording and record - also with "Playback while recording".  

Deactivate Varispeed after that and your voice will reach undreamt of highs. But be 
careful, if used too in excess, Mickey mouse is not far away.   

Keyboard shortcut:  P 
 

If you still have questions 

Tips for program help 
The "Help" file features hints on how to use the program and additional information. 
Many important terms are indicated in the text in italics and clicking on them displays 
an explanation. 

Context help: Press the "F1" key at any point in the opened program and the help file 
will open with the matching topic (context help). 

Search function: Use the search function to find out information about specific words. 
Enter either the individual word or use logical operators (OR, AND, NEAR) to refine 
your search if you have several search words. 

• "OR" (between two words): All topics which contain both words or one of the 
words will be listed. 

• "AND" (between two words): Only those topics will be listed which contain both 
words. 

• "NEAR" (between two words): Only those topics will be listed which contain both 
words. A maximum of six other words may be added between the search terms. 

• "NOT" (before a word): Topics which contain this word will not be listed. 

Print: Use the help program's print function to make a printout of individual topics or 
entire sections. The print button is located at the top of the help window in the 
toolbar. 
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System requirements 
For Microsoft® Windows® XP | Vista® | 7 

Minimum configuration 

• Processor: Intel® Pentium® or AMD® Athlon® 1.5 GHz and up 
• RAM: 1 GB recommended 
• Hard drive space: 4.3 GB free 
• Graphics card: Resolution 1024 x 768 
• Sound playback: Sound card (ASIO-enabled sound card recommended) 
• DVD drive 

Optional: 

• Burn CDs/DVDs with CD/DVD±R(W) recorder 
• MP3 export with Windows Media® Player 10, or higher 

Note: Artist rights and ancillary publisher copyrights must be respected. Only non 
copy-protected audio CDs can be imported. 

 

Uninstalling the program 
If you would like to uninstall Samplitude Music Studio 2013, you can do this in the 
control panel under "Software" or go to "Programs > MAGIX > Samplitude Music 
Studio 2013 > Service and Support > Uninstall Samplitude Music Studio 2013". 
 

Serial number 
A serial number is included in each product. This serial number is required for the 
installation of the software and enables usage of additional bonus services. Please 
store this number in a safe place. 

What can a serial number do? 
With a serial number your program is clearly assigned to you and only you. This will 
allow you take advantage of the free email support service. Serial numbers also help 
to protect against software piracy which ensures that we are able to continually 
provide our customers with an optimal price/performance ratio. 

Where can the serial number be found? 
The serial number can be found on the reverse side of your CD/DVD case. If your 
product is packed in a DVD box, you'll find the serial number on the inside. 
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If you have purchased the download version, you will receive a confirmation email 
with the serial number. 

When will you need the serial number? 
The serial number is required when you start or register the program for the first time. 

Note: We explicitly recommend registering your product (free), since only then are 
you entitled to download updates and to use MAGIX support services (view page 
14) or activate codecs. 
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More about MAGIX 

MAGIX Online World 
MAGIX Online World from MAGIX offers you a range of new services for your 
photos, videos, and music that are accessible directly from the "Share" menu in 
Samplitude Music Studio 2013: 
 

MAGIX Online Album 
MAGIX Online Album is your personal multimedia album on the Internet. If you want 
to present slideshows or videos online, then MAGIX Online Album is the perfect 
service.  
 

MAGIX Website Maker 
MAGIX Website Maker helps you create a personal Internet showcase with a 
professional design in just a few mouse clicks – without prior knowledge, including 
your own chosen domain and email address. Publish slideshows and videos and 
accessorize your site with music and various effects  – anything from a simple 
business card to a fireworks display of effects, professional or private – show your 
best side! 

More about this topic can be found under MAGIX Website Maker. (view page 324) 
 

Catooh – the Online Content Library 
If your project is missing pictures, videos, DVD menus, sounds, or samples, then you 
should have a look at the huge selection available at Catooh. There you'll be able to 
buy media in excellent quality for low prices: DVD menus, Slideshow Maker styles, 
decorative elements, 3D power effects, 3D transition series, MAGIX Soundpools, 
songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects. 
 

magix.info 
Do you have questions, need help, or are looking for expert tips and tutorial videos on 
using your MAGIX product? At magix.info you will find answers and solutions as well 
as workshops and a comprehensive user forum for software and multimedia queries. 

You can access magix.info online at www.magix.info 
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Soundpool DVD Collection 
Samplitude Music Studio 2013 includes thousands of sound and video building blocks. 
Other media can be ordered later. MAGIX Sound  Essentials includes professionally 
produced loops and samples in impressive quality – the ideal enhancement for the 
most varying of music styles, including: 

• Ambient 
• Big Beat 
• Easy listening 
• Dance / Electro 
• Disco / House 
• Soundtrack 
• Hip hop 
• Rock/Pop 
• Techno / trance 
• Special effects 

 

In the upper menu bar under "Tasks" > "Discover more", you can order the MAGIX 
Sound  Essentials directly. 

Tip: At www.magix.com you'll always find the latest soundpool offers. 
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